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Overview

Welcome to the Generative Shape Design User's Guide !

This guide is intended for users who need to become quickly familiar with the product.

This overview provides the following information: 

●     Generative Shape Design in a Nutshell 

●     Before Reading this Guide 

●     Getting the Most Out of this Guide 

●     Accessing Sample Documents 

●     Conventions Used in this Guide 

 

Generative Shape Design in a Nutshell 
The Generative Shape Design workbench allows you to quickly model both simple and complex 
shapes using wireframe and surface features. It provides a large set of tools for creating and editing 
shape designs and, when combined with other products such as Part Design, it meets the 
requirements of solid-based hybrid modeling. 

The feature-based approach offers a productive and intuitive design environment to capture and re-
use design methodologies and specifications. 

This new application is intended for both the expert and the casual user. Its intuitive interface offers 
the possibility to produce precision shape designs with very few interactions. The dialog boxes are 
self explanatory and require practically no methodology, all defining steps being commutative. 

As a scalable product, Generative Shape Design can be used with other Version 5 products such as 
Part Design and FreeStyle Shaper and Optimizer. The widest application portfolio in the industry is 
also accessible through interoperability with CATIA Solutions Version 4 to enable support of the full 
product development process from initial concept to product in operation.

This User's Guide has been designed to show you how to create and edit a surface design part. There 
are numerous techniques to reach the final result. This book aims at illustrating these various 
possibilities. 

Before Reading this Guide
Before reading this guide, you should be familiar with basic Version 5 concepts such as document 
windows, standard and view toolbars. Therefore, we recommend that you read the Infrastructure 
User's Guide that describes generic capabilities common to all Version 5 products. It also describes 
the general layout of V5 and the interoperability between workbenches.

You may also like to read the following complementary product guides:

●     Part Design User's Guide



Getting the Most Out of this Guide 
To get the most out of this guide, we suggest that you start reading and performing the step-by-step 
Getting Started tutorial. This tutorial will show you how create a basic shape design part.

Once you have finished, you should move on to the Basic Tasks and Advanced Tasks sections, which 
deal with handling all the product functions.

The Workbench Description section, which describes the Generative Shape Design workbench, and 
the Customizing section, which explains how to set up the options, will also certainly prove useful. 

Navigating in the Split View mode is recommended. This mode offers a framed layout allowing direct 
access from the table of contents to the information.

Accessing Sample Documents 
To perform the scenarios, sample documents are provided all along this documentation. For more 
information on accessing sample documents, refer to Accessing Sample Documents in the 
Infrastructure User's Guide.



Conventions
Certain conventions are used in CATIA, ENOVIA & DELMIA documentation to help you recognize and 
understand important concepts and specifications. 

Graphic Conventions

The three categories of graphic conventions used are as follows:

●     Graphic conventions structuring the tasks

●     Graphic conventions indicating the configuration required

●     Graphic conventions used in the table of contents

Graphic Conventions Structuring the Tasks

Graphic conventions structuring the tasks are denoted as follows:

This icon... Identifies...

estimated time to accomplish a task

a target of a task

the prerequisites

the start of the scenario

a tip

a warning

information

basic concepts

methodology

reference information

information regarding settings, customization, etc.

the end of a task



functionalities that are new or enhanced with this release

allows you to switch back to the full-window viewing mode

Graphic Conventions Indicating the Configuration Required 

Graphic conventions indicating the configuration required are denoted as follows:

This icon... Indicates functions that are... 

specific to the P1 configuration

specific to the P2 configuration

specific to the P3 configuration

Graphic Conventions Used in the Table of Contents

Graphic conventions used in the table of contents are denoted as follows:

This icon... Gives access to...

Site Map

Split View mode

What's New?

Overview

Getting Started

Basic Tasks

User Tasks or the Advanced Tasks

Workbench Description

Customizing

Reference

Methodology

Glossary



Index

Text Conventions

The following text conventions are used:

●     The titles of CATIA, ENOVIA and DELMIA documents appear in this manner throughout the text.

●     File -> New identifies the commands to be used.

●     Enhancements are identified by a blue-colored background on the text.

How to Use the Mouse

The use of the mouse differs according to the type of action you need to perform.

Use this
mouse button... Whenever you read...

 
●     Select (menus, commands, geometry in graphics area, ...)

●     Click (icons, dialog box buttons, tabs, selection of a location in the document 
window, ...)

●     Double-click

●     Shift-click

●     Ctrl-click

●     Check (check boxes)

●     Drag

●     Drag and drop (icons onto objects, objects onto objects)

●     Drag

●     Move

●     Right-click (to select contextual menu)



What's New?

New Functionalities

Managing Multi-Result Operations
Creating Variable Offset Surfaces
Creating Rough Offset Surfaces
Inserting a Body into an Ordered Geometrical Set

Creating Volumes

Creating a Multi-Sections Volume
Creating a Swept Volume
Creating a Draft 
Creating a Variable Angle Draft
Creating a Draft from Reflect Lines 
Creating a Shell
Creating a Sew Surface
Trimming Volumes

Working With the BiW Templates

Creating a Bead

Enhanced Functionalities

Creating Wireframe Geometry

Creating Points
New Circle/Sphere center sub-type

Creating Lines
New Up to option to create a line up to an element (point, curve, or surface)

Creating Circles
New Center and axis sub-type with or without projection
New Dia/Radius button to switch to a Diameter or Radius value
New Axis computation button to create axis features while creating or modifying a circle

Creating Parallel Curves
The second parallel curve created using the ''Both Sides'' option is now aggregated under the 
first one

Creating Surfaces

Creating Offset Surfaces
New Automatic smoothing to clean the geometry of a surface
New flag notes to obtain accurate diagnosis for each erroneous sub-element
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New Temporary Analysis mode to check connections between surfaces or curves

Performing Operations on Shape Geometry

Smoothing Curves
The maximum deviation is now displayed on the curve
You can specify a continuity mode when smoothing the curve: point, tangent or curvature 
continuity

Splitting Geometry
You can now select several elements to cut

Extracting Geometry
 You can now select a volume as the extracted element

Performing a Symmetry on Geometry
You can now select an axis system as the element to be transformed by symmetry

Transforming Elements from an Axis to Another
You can now select an axis system as the element to be transformed into a new axis system

Creating Shape Fillets
You can now create a bitangent fillet with relimiters
New Law button to select an external law

Extrapolating Curves
New Up to option to extrapolate a curve up to another curve

Using Tools

Defining an Axis System
You can now choose the destination of the axis system

Working With a Support
You can now create an infinite plane from a limited planar surface

Working With a 3D Support
You can now featurize the grid lines as lines or planes

Analyzing Using Parameterization 
New Bodies filter

Selecting Using Multi-Output
You can now select a geometrical set or a multi-output feature as input

Managing Geometrical Sets and Ordered Geometrical Sets 

Managing Ordered Geometrical Sets
You can now insert a body into an ordered geometrical set.

Patterning

Creating Rectangular Patterns
You can now duplicate volumes

Creating Circular Patterns
You can now assign distinct angle values between each instance
You can now duplicate volumes



Working with the Generative Shape Optimizer Workbench 

Deforming Surfaces According to Curve Wrapping
You can now keep the tangency constraint on the first, and/or last, pair of curves

Deforming Surfaces According to Surface Wrapping
Automatic extrapolation of the reference and target surfaces when necessary

Working with the Developed Shapes Workbench 

Unfolding a Surface
A new tab lets you transfer curves or points

Working With the BiW Templates

Creating a Mating Flange
New Local thickness option
New Both sides option

Customizing

General Settings
Tolerant laydown is now available with the Fill and Extrapol commands
New Stacked analysis option to set the analysis as temporary



Getting Started
Before getting into the detailed instructions for using Generative Shape Design, the following 
tutorial aims at giving you a feel of what you can do with the product. It provides a step-by-
step scenario showing you how to use key functionalities. 

 The main tasks described in this section are: 

Entering the Workbench
Lofting, Offsetting and Intersecting

Splitting, Lofting and Filleting
Sweeping and Filleting

Using the Historical Graph
Transforming the Part

 

 
This tutorial should take about 20 minutes to complete.

You will use the construction elements of this part to build up the following shape design.

 



Entering the Workbench

 
This first task shows you how to enter the Shape Design workbench and open a wireframe design part.

Before starting this scenario, you should be familiar with the basic commands common to all workbenches. These are 
described in the Infrastructure User's Guide.

1.  Select Shape -> Generative Shape Design from the Start menu.

The Shape Design workbench is displayed.

2.  Select File -> Open then select the GettingStartedShapeDesign.CATPart document.

A wireframe design part is displayed.

If you wish to use the whole screen space for the geometry, remove the specification tree clicking off the View -> 
Specifications Visible menu item or pressing F3.
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Lofting, Offsetting and Intersecting

This task shows you how to create a multi-sections and an offset surfaces as well as an 
intersection.

1.  Click the Multi-sections Surface icon .

The Multi-sections Surface Definition dialog box appears.

2.  Select the two section curves.

3.  Click within the Guides window then select the two guide curves.

 

4.  Click OK to create the multi-sections surface.



 

5.  Click the Offset icon .

 

6.  Select the multi-sections surface.

7.  Enter an offset value of 2mm.

The offset surface is displayed normal to the multi-sections surface.

 

 8.  Click OK to create the offset surface.



 

9.  Click the Intersection icon .

The Intersection dialog box appears. 

10.  Select the offset surface then the first plane (Plane.2) to create the intersection 

between these two elements.

 

 11.  Click OK in the dialog box.



 

 The created elements are added to the specification tree:

 

 

 



Splitting, Lofting and Filleting

This task shows how to split surfaces then create a multi-sections surface and two fillets.

1.  Click the Split icon .

The Split Definition dialog box appears. 

2.  Select the offset surface by clicking on the portion that you want to keep after the split.

3.  Select the first plane (Plane.2) as cutting element.

4.  Click OK to split the surface.

 



5.  Repeat the previous operations by selecting the multi-sections surface then the second 

plane (Plane.3) to define the intersection first, then to cut the surface.

6.  Click OK to split the surface.

 

7.  Click the Multi-sections Surface icon .

The Multi-sections Surface Definition dialog box appears.

8.  Select the intersection edges of the two split surfaces as sections.

 



 10.  Click OK to create the multi-sections surface between the two split surfaces.

 



11.  Click the Shape Fillet icon  .

The Fillet Definition dialog box appears. 

12.  Select the first split surface as the first support element.

13.  Select the multi-sections surface you just created as the second support element.

14.  Enter a fillet radius of 3mm.

The orientations of the surfaces are shown by means of arrows.

 



 

15.  Make sure that the surface orientations are correct (arrows pointing down) then click 

OK to create the first fillet surface.

16.  Repeat the filleting operation, clicking the icon, then selecting the second split surface 

as the first support element.

17.  Select the previously created filleted surface as the second support element.

18.  Enter a fillet radius of 3mm.

19.  Make sure that the surface orientations are correct (arrows pointing up) then click OK 

to create the second filleted surface.

 

  

The created elements are added to the specification tree:

 



Sweeping and Filleting
This task shows how to create swept surfaces and fillets on both sides of the part. 

You will use the profile element on the side of the part for this. In this task you will also create 
a symmetrical profile element on the opposite side of the part.

1.  Click the Sweep icon .

The Swept Surface Definition dialog box appears.

2.  Click the Explicit sweep icon.

3.  Select the profile element (Corner.1).

4.  Select the guide curve (Guide.1).

5.  Select the central curve (Spline.1) as the spine.

 



 
6.  Click OK to create the swept surface.



 

7.  Click the Symmetry icon  .

The Symmetry Definition dialog box appears.

8.  Select the profile element to be transformed by symmetry.

9.  Select the YZ plane as reference element.

 

 

 10.  Click OK to create the symmetrical profile element.



11.  Click the Sweep icon  again.

12.  Select the profile (Symmetry.3) and the guide curve (Guide.2).

13.  Select the central curve (Spline.1) as the spine.

14.  Click OK to create the swept surface.

 

 

15.  To create a fillet between the side portion and the central part click the Shape Fillet 

icon  .

16.  Select the side sweep element and the central portion of the part, then enter a fillet 

radius of 1mm (make sure the arrows are pointing up).

17.  Click Preview to preview the fillet, then OK to create it.

18.  Repeat the filleting operation between the other sweep element and the central portion 

of the part, and entering a fillet radius of 1mm (make sure the arrows are pointing up).

19.  Click OK to create the fillet.

 



 

 The created elements are added to the specification tree:

 

 

 



Using the Historical Graph

 
This command is only available with the Generative Shape Design 2 product.

 
This task shows how to use the historical graph.

 
1.  Select the 

element for 

which you 

want to 

display the 

historical 

graph.

2.  Click the 

Show 

Historical 

Graph icon 

.

The Historical Graph 
dialog box appears.
In this case, you can examine the history of events that led to the construction of the Multi-sections surface.1 element. Each 
branch of the graph can be expanded or collapsed depending on the level of detail required.

The following icon commands are available.

●     Add graph

●     Remove graph

●     Reframe graph

●     Surface or Part representation

●     Parameters filter

●     Constraints filter

     
 

Right-clicking 
anywhere in the 
historical graph 
enables the user to:

●     hide or show an 
element

●     display the 
properties of an 
element

●     reframe the 
graph

●     display the whole 
graph of the part 
(as well as the 
roots and their 
first parents)

●     clean the graph

●     refresh the graph



●     display the 
parents of the 
elements in the 
graph (but not 
the roots)

Selecting and right-clicking an element enables the user to add the children to the selected element.
    

3.  Just click the Close icon to exit this mode.

 

 



Transforming the Part

This task shows you how to modify the part by applying an affinity operation.

1.  Click the Affinity icon 

.

The Affinity Definition 
dialog box appears.

2.  Select the end section 

profile to be transformed 

by the affinity.

3.  Specify the characteristics 

of the axis system to be 

used for the affinity 

operation:

●     point PT0 as the origin

●     plane XY as reference plane

●     horizontal edge of the corner 

profile as x-axis.



4.  Specify the affinity ratios: 

X=1, Y=1 and Z=1.5.

5.  Click OK to create the new profile.

6.  Edit the definition of the lofted surface (Multi-sections Surface.1), by double-clicking it, 

then select the second section, click the Replace button and select the new profile.

7.  Click OK in the dialog box.

8.  If needed, click the Update icon  to update your design.

 Multi-selection is available. Refer to Selecting Using Multi-Mutput to find out how to display 
and manage the list of selected elements.

 



Basic Tasks
The basic tasks you will perform in the Generative Shape Design workbench will involve creating and 
modifying wireframe and surface geometry that you will use in your part. 

The table below lists the information you will find in this section. 

Creating Wireframe Geometry
Creating Surfaces

Performing Operations on Shape Geometry
Editing Surfaces and Wireframe Geometry

Using Tools 

 

When creating a geometric element, you often need to select other elements as inputs. When 
selecting a sketch as the input element, some restrictions apply, depending on the feature you 
are creating.  

You should avoid selecting self-intersecting  sketches as well as sketches containing 
heterogeneous elements such as a curve and a point for example. 

However, the following elements accept sketches containing non connex elements (i.e. 
presenting gaps between two consecutive elements) as inputs, provided they are of the same 
type (homogeneous, i.e. two curves, or two points):

●     Intersections

●     Projections

●     Extruded surfaces

●     Surfaces of revolution

●     Joined surfaces

●     Split geometry

●     Trim geometry

●     All transformations: translation, rotation, symmetry, scaling, affinity and axis to axis

●     Developed wires (Developed Shapes)



Creating Wireframe Geometry
Generative Shape Design allows you to create wireframe geometry such as points, lines, planes and 
curves. You can make use of this elementary geometry when you create more complex surfaces later 
on. 

Create points by coordinates: enter X, Y, Z coordinates.

 Create points on a curve: select a curve and possibly a reference point, and enter a length or 
ratio.

 
Create points on a plane: select a plane and possibly a reference point, then click the plane.

 Create points on a surface: select a surface and possibly a reference point, an element to set 
the projection orientation, and a length.

 
Create points as a circle center: select a circle.

 
Create points at tangents: select a curve and a line.

 
Create point between another two points: select two points

Create multiple points: select a curve or a point on a curve, and possibly a reference point, set 
the number of point instances, indicate the creation direction or indicate the spacing between 
points.

Create extrema: select a  curve and a direction into which the extremum point is detected.

Create polar extrema: select a contour and its support, a computation mode, and a reference 
axis-system (origin and direction) .

Create lines between two points: select two points.

 Create lines based on a point and a direction: select a point and a line, then specify the start 
and end points of the line.

 Create lines at an angle or normal to a curve:  select a curve and its support, a point on the 
curve, then specify the angle value, the start and end points of the line.

 Create lines tangent to a curve:  select a curve and a reference point, then specify the start 
and end points of the line.

 Create lines normal to a surface: select a surface and a reference point, then specify the start 
and end points of the line.



 
Create bisecting lines: select two lines and a starting point, then choose a solution.

Create an Axis: select a geometric element, a direction, then choose the axis type.

Create polylines: select at least two points, then define a radius for a blending curve is needed.

Create an offset plane: select an existing plane, and enter an offset value.

 Create a parallel plane through a point: select an existing plane and a point. The resulting 
plane is parallel to the reference plane and passes through the point.

 Create a plane at an angle: select an existing plane and a rotation axis, then enter an angle 
value (90° for a plane normal to the reference plane).

 
Create a plane through three points: select any three points

 
Create a plane through two lines: select any two lines

 
Create a plane through a point and a line: select any point and line

 
Create a plane through a planar curve: select any planar curve

 
Create a plane normal to a curve: select any curve and a point

 
Create a plane tangent to a surface: select any surface and a point

 
Create a plane based on its equation: key in the values for the Ax + Bu + Cz = D equation 

 
Create a mean plane through several points: select any three, or more, points

Create n planes between two planes: select two planes, and specify the number of planes to be 
created

Create a circle based on a point and a radius: select a point as the circle center, a support 
plane or surface, and key in a radius value. For circular arcs, specify the start and end angles.

 Create a circle from two points: select a point as the circle center, a passing point, and a 
support plane or surface. For circular arcs, specify the start and end angles.



 Create a circle from two points and a radius: select the two passing points, a support plane or 
surface, and key in a radius value. For circular arcs, specify the arc based on the selected 
points.

 Create a circle from three points: select three points. For circular arcs, specify the arc based on 
the selected points.

 Create a circle tangent to two curves, at a point: select two curves, a passing point, a support 
plane or surface, and click where the circle should be created. For circular arcs, specify the arc 
based on the selected points.

 Create a circle tangent to two curves, with a radius: select two curves, a support surface, key 
in a radius value, and click where the circle should be created. For circular arcs, specify the arc 
based on the selected points.

 
Create a circle tangent to three curves: select three curves.

Create conics: select a support plane, start and end points, and any other three constraints 
(intermediate points or tangents).

Create spirals: select a support plane, center point, and reference direction, then set the 
radius, angle, and pitch as needed.

Create splines: select two or more points, if needed a support surface, set tangency conditions 
and close the spline if needed.

Create a helix: select a starting point and a direction, and specify the helix pitch, height, 
orientation and taper angle.

Create a spine: select several planes or planar curves to which the spine is normal

Create corners: select a first reference element (curve or point), select a curve, a support 
plane or surface, and enter a radius value.  

Creating connect curves: select two sets of curve and point on the curve, set their continuity 
type and, if needed, tension value.

Create parallel curves: select the reference curve, a support plane or surface, and specify the 
offset value from the reference. 

Create a 3D Curve Offset: select the reference curve, a direction and specify the offset value 
from the reference. 

Create projections: select the element to be projected and its support, specify the projection 
direction, 

 
Create combined curves: select the curves, possibly directions, and specify the combine type.

 
Create reflect lines: select the support and direction, and specify an angle.

Create intersections: select the two elements to be intersected.
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Creating Points

 

This task shows the various methods for creating points: 
●     by coordinates

●     on a curve

●     on a plane

●     on a surface

●     at a circle/sphere center

●     tangent point on a curve

●     between

 
Open the Points3D1.CATPart document.

 
1.  Click the Point icon  .

The Point Definition dialog box appears.

2.  Use the combo to choose the desired point type.

Coordinates 
●     Enter the X, Y, Z 

coordinates in the 
current axis-system.

●     Optionally, select a 
reference point.

The 
corresponding 
point is 
displayed.

 

 

When creating a point within a user-defined axis-system, note that the Coordinates in absolute 
axis-system check button is added to the dialog box, allowing you to be define, or simply find 
out, the point's coordinates within the document's default axis-system.
If you create a point using the coordinates method and an axis system is already defined and set 
as current, the point's coordinates are defined according to current the axis system. As a 
consequence, the point's coordinates are not displayed in the specification tree.

The axis system must 
be different from the 
absolute axis.

 

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/Points3D1.CATPart


On curve 
●     Select a curve

●     Optionally, select a 
reference point.

If this point is 
not on the 
curve, it is 
projected 
onto the 
curve.
If no point is 
selected, the 
curve's 
extremity is 
used as 
reference.

 
●     Select an option 

point to determine 
whether the new 
point is to be 
created: 

❍     at a given 
distance along 
the curve from 
the reference 
point

❍     a given ratio 
between the 
reference point 
and the curve's 
extremity.

    



●     Enter the distance 
or ratio value.
If a distance is 
specified, it can be: 

❍     a geodesic 
distance: the 
distance is 
measured along 
the curve

❍     an Euclidean 
distance: the 
distance is 
measured in 
relation to the 
reference point 
(absolute value).

The corresponding 
point is displayed.

If the reference point is located at the curve's extremity, even if a ratio value is defined, the 
created point is always located at the end point of the curve.

You can also: 
●     click the Nearest extremity button to display the point at the nearest extremity of the 

curve.

●     click the Middle Point button to display the mid-point of the curve.

Be careful that the arrow is orientated towards the inside of the curve (providing the curve is not 
closed) when using the Middle Point option.

●     use the Reverse Direction button to display: 
❍     the point on the other side of the reference point (if a point was selected originally)

❍     the point from the other extremity  (if no point was selected originally).

●     click the Repeat object after OK if you wish to create equidistant points on the curve, using 
the currently created point as the reference, as described in Creating Multiple Points in the 
Wireframe and Surface User's Guide. 

You will also 
be able to 
create planes 
normal to the 
curve at 
these points, 
by checking 
the Create 
normal 
planes also 
button, and 
to create all 
instances in a 
new 
geometrical 
set  by 
checking the 



Create in a 
new 
geometrical 
set button.
If the button 
is not 
checked the 
instances are 
created in the 
current 
geometrical 
set .

 

●     If the curve is infinite and no reference point is explicitly given, by default, the reference point 
is the projection of the model's origin

●     If the curve is a closed curve, either the system detects a vertex on the curve that can be 
used as a reference point, or it creates an extremum point, and highlights it (you can then 
select another one if you wish) or the system prompts you to manually select a reference 
point.

 

Extremum points 
created on a closed 
curve are now 
aggregated under their 
parent command and 
put in no show in the 
specification tree.

On plane 
●     Select a plane.

●     Optionally, select a 
point to define a 
reference for 
computing 
coordinates in the 
plane.

If no point is 
selected, the 
projection of 
the model's 
origin on the 
plane is taken 
as reference. 

 

 



 
●     Optionally, select a 

surface on which the 
point is projected 
normally to the 
plane.

If no surface 
is selected, 
the behavior 
is the same.

Furthermore, 
the reference 
direction (H 
and V 
vectors) is 
computed as 
follows: 
With N the 
normal to the 
selected 
plane 
(reference 
plane), H 
results from 
the vectorial 
product of Z 
and N (H = 
Z^N). 
If the norm of 
H is strictly 
positive then 
V results from 
the vectorial 
product of N 
and H (V = 
N^H).
Otherwise, V 
= N^X and H 
= V^N.

Would the 
plane move, 
during an 
update for 
example, the 
reference 
direction 
would then 
be projected 
on the plane. 

●     Click in the plane to display a point.



On surface 
●     Select the surface 

where the point is to 
be created.

 
●     Optionally, select a 

reference point. By 
default, the 
surface's middle 
point is taken as 
reference. 

●     You can select an 
element to take its 
orientation as 
reference direction 
or a plane to take its 
normal as reference 
direction.
You can also use the 
contextual menu to 
specify the X, Y, Z 
components of the 
reference direction.

●     Enter a distance 
along the reference 
direction to display 
a point.

 
    

Circle/Sphere 
center 

●     Select a circle, 
circular arc, or 
ellipse, or

●     Select a sphere or a 
portion of sphere.



A point is 
displayed at 
the center of 
the selected 
element.

    

Tangent on 
curve 

●     Select a planar 
curve and a 
direction line.

A point is 
displayed at 
each tangent. 

    

The Multi-
Result 
Management 
dialog box is 
displayed 
because 
several points 
are 
generated. 

●     Click YES: you can 
then select a 
reference element, 
to which only the 
closest point is 
created.

●     Click NO: all the 
points are created.

For further information, 
refer to the Managing 
Multi-Result Operations 
chapter.



Between
●     Select any two 

points.

●     Enter the ratio, that 
is the percentage of 
the distance from 
the first selected 
point, at which the 
new point is to be.
You can also click 
Middle Point 
button to create a 
point at the exact 
midpoint (ratio = 
0.5).

Be careful that the arrow is orientated towards the inside of the curve (providing the curve is not 
closed) when using the Middle Point option.

●     Use the Reverse 
direction button to 
measure the ratio 
from the second 
selected point.

 
If the ratio value is greater than 1, the point is located on the virtual line beyond the selected 
points.

3.  Click OK to create the point.

The point (identified as Point.xxx) is added to the specification tree.

●     Parameters can be edited in the 3D geometry. For more information, refer to the Editing 
Parameters chapter.

●     You can isolate a point in order to cut the links it has with the geometry used to create it. To 
do so, use the Isolate contextual menu. For more information, refer to the Isolating Features 
chapter.



Creating Multiple Points and Planes

 
This task shows how to create several points, and planes, at a time:

 

Open the MultiplePoints1.CATPart document.
Display the Points toolbar by clicking and holding the arrow from the Point icon.

 
1.  Click the Point & Planes Repetition 

icon  .

2.  Select a curve or a Point on curve.

The Points Creation Repetition 
dialog box appears.

3.  Define the number or points to be 

created (instances field).

Here we chose 5 instances.

You can choose the side on which 
the points are to be created in 
relation to the initially selected 
point on a curve. Simply use the 
Reverse Direction button, or 
clicking on the arrow in the 
geometry.

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/MultiplePoints1.CATPart


If you check the With end points 
option, the last and first instances 
are the curve end points.

4.  Click OK to create the point 

instances, evenly spaced over the 

curve on the direction indicated by 

the arrow.

The points (identified as Point.xxx as for any 
other type of point) are added to the 
specification tree.

 

●     If you selected a point on a curve, you 
can select a second point, thus defining 
the area of the curve where points should 
be created.
Simply click the Second pointfield in the 
Multiple Points Creation dialog box, then 
select the limiting point. 
If you selected the Point2 created above 
as the limiting point, while keeping the 
same values, you would obtain the 
following:

 

If the selected point on curve 
already has a Reference point (as 
described in Creating Points - on 
curve), this reference point is 
automatically taken as the second 
point.
By default, the Second point is 
one of the endpoints of the curve. 



●     When you select a point on a curve, the 
Instances & spacing option is available 
from the Parameters field.
In this case, points will be created in the 
given direction and taking into account 
the Spacing value.
For example, three instances spaced by 
10mm.

 

●     Check the Create normal planes also 
to automatically generate planes at the 
point instances.

●     Check the Create in a new geometrical 
set if you want all object instances in a 
separate Geometrical Set.
A new Geometrical Set will be created 
automatically.
If the option is not checked the instances 
are created in the current Geometrical 
Set.

 



Creating Extremum Elements

 
This command is only available with the Generative Shape Design 2 product.

This task shows you to create extremum elements (points, edges, or faces), that is elements at 
the minimum or maximum distance on a curve, a surface, or a pad, according to given 
directions.

    

 

Open the Extremum1.CATPart document.
Display the Points toolbar by clicking and holding the arrow from the Point icon.

 
1.  Click the Extremum icon  

.

The Extremum Definition 

dialog box is displayed.

2.  Set the correct options:

●     Max: according to a given 

direction the highest point on 

the curve is created

●     Min: according to the same 

direction the lowest point on the 

curve is created

Extremum Points on a 
curve:

3.  Select a curve.

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/Extremum1.CATPart


4.  Select the direction into 

which the extremum point 

must be identified.

5.  Click OK.

The point (identified as 
Extremum.xxx) is added to the 
specification tree.

Extremum on a surface:

3.  Select a surface.

4.  Select the direction into 

which the extremum must 

be identified.

If you click OK, the 

extremum face is created. 

 

Giving only one direction is not always enough. You need to give a second, and possibly a third 
direction depending on the expected result (face, edge or point) to indicate to the system in 
which direction you want to create the extremum element. These directions must not be 
identical.



3.  Select a second direction.

If you click OK, the 

extremum edge is 

created. 

 

4.  Select a third direction.

5.  Click OK.

The point (identified as Extremum.xxx) is added to the specification tree.

 

 



Creating Polar Extremum Elements

 
This command is only available with the Generative Shape Design 2 product.

 
This task shows how to create an element of extremum  radius or angle, on a planar contour.

 
Open the Extremum2.CATPart document.

 
1.  Click the Polar Extremum icon  

.

The Polar Extremum Definition 
dialog box appears.

2.  Select the contour, that is a connex 

planar sketch or curve on which the 

extremum element is to be created.

 
Non connex elements, such as the letter A in the sample, are not allowed.

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/Extremum2.CATPart


3.  Select the supporting surface of the 

contour.

4.  Specify the axis origin and a reference direction, in order to determine the axis system 

in which the extremum element is to be created.

5.  Click Preview:

Depending on the selected computation type, the results can be: 

●     Min radius: the extremum element is 
detected based on the shortest distance 
from the axis-system origin



●     Max radius: the extremum element is 
detected based on the longest distance 
from the axis-system origin

●     Min angle: the extremum element is 
detected based on the smallest angle 
from the selected direction within the 
axis-system

●     Max angle: the extremum element is 
detected based on the greatest angle 
from the selected direction within the 
axis-system



 
The radius or angle value is displayed in the Polar Extremum Definition dialog box for 

information.

6.  Click OK to create the extremum point.

The element (identified as Polar extremum.xxx), a point in this case, is added to the 
specification tree.

 

 



Creating Lines
This task shows the various methods for creating lines: 

●     point to point

●     point and direction

●     angle or normal to curve

●     tangent to curve

●     normal to surface

●     bisecting

 
It also shows you how to create a line up to an element, define the length type and 
automatically reselect the second point.

 
Open the Lines1.CATPart document.

1.  Click the Line icon  .

The Line Definition dialog box is displayed. 

2.  Use the drop-down list to choose the desired line type.

 
A line type will be proposed automatically in some cases depending on your first element 
selection.

 

Defining the line type
 

Point - Point 

 
This command is only available with the 
Generative Shape Design 2 product.

●     Select two points.

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/Lines1.CATPart


A line is displayed between the 
two points.
Proposed Start and End points 
of the new line are shown.

●     If needed, select a support surface.
In this case a geodesic line is created, 
i.e. going from one point to the other 
according to the shortest distance 
along the surface geometry (blue line 
in the illustration below).
If no surface is selected, the line is 
created between the two points based 
on the shortest distance.

If you select two points on closed surface 
(a cylinder for example), the result may 
be unstable. Therefore, it is advised to 
split the surface and only keep the part on 
which the geodesic line will lie. 

 
The geodesic line is not available with the Wireframe and Surface workbench.



 
●     Specify the Start and End points of the new line, that is the line endpoint location in 

relation to the points initially selected. These Start and End points are necessarily beyond 
the selected points, meaning the line cannot be shorter than the distance between the initial 
points.

●     Check the Mirrored extent option to create a line symmetrically in relation to the selected 
Start and End points.

 
The projections of the 3D point(s) must already exist on the selected support. 

Point - Direction 
 

●     Select a reference Point and a 
Direction line.
A vector parallel to the direction line is 
displayed at the reference point. 
Proposed Start and End points of the 
new line are shown.



●     Specify the Start and End points of 
the new line.
The corresponding line is displayed.

 
The projections of the 3D point(s) must already exist on the selected support. 

  

Angle or Normal to curve
 

●     Select a reference Curve and a 
Support surface containing that 
curve.



- If the selected curve is planar, 
then the Support is set to 
Default (Plane).

- If an explicit Support has 
been defined, a contextual 
menu is available to clear the 
selection.

 
●     Select a Point on the curve.

●     Enter an Angle value.

A line is displayed at the given 
angle with respect to the 
tangent to the reference curve 
at the selected point. These 
elements are displayed in the 
plane tangent to the surface at 
the selected point. 
You can click on the Normal to 
Curve button to specify an 
angle of 90 degrees. 
Proposed Start and End points 
of the line are shown. 

●     Specify the Start and End points of the new line.
The corresponding line is displayed.



●     Click the Repeat object after OK if 
you wish to create more lines with the 
same definition as the currently 
created line. 
In this case, the Object Repetition 
dialog box is displayed, and you key in 
the number of instances to be created 
before pressing OK.

As many lines as indicated in the dialog 
box are created, each separated from the 
initial line by a multiple of the angle 
value.

 

You can select the Geometry on Support check box if you want to create a geodesic line onto 

a support surface. 

The figure below illustrates this case.

 

Geometry on support option not checked Geometry on support option checked

 
This line type enables to edit the line's parameters. Refer to Editing Parameters to find out how 
to display these parameters in the 3D geometry.



Tangent to curve
 

●     Select a reference Curve and a point 
or another Curve to define the 
tangency. 

❍     if a point is selected (mono-
tangent mode): a vector tangent 
to the curve is displayed at 
the selected point.

❍     If a second curve is selected (or a 
point in bi-tangent mode), you 
need to select a support plane. 
The line will be tangent to both 
curves.

 - If the selected curve is a line, 
then the Support is set to 
Default (Plane).

- If an explicit Support has 
been defined, a contextual 
menu is available to clear the 
selection.

 When several solutions are 
possible, you can choose one 
(displayed in red) directly in the 
geometry, or using the Next 
Solution button.

     

 

 

Line tangent to curve at a given point Line tangent to two curves
●     Specify Start and End points to define the new line.

The corresponding line is displayed.



 

Normal to surface 
 

●     Select a reference Surface and a 
Point.
A vector normal to the surface is 
displayed at the reference point. 
Proposed Start and End points of the 
new line are shown.

 
If the point does not lie on the support surface, the minimum distance between the point and 
the surface is computed, and the vector normal to the surface is displayed at the resulted 
reference point.



●     Specify Start and End points to define 
the new line.
The corresponding line is displayed.

Bisecting 
 

●     Select two lines. Their bisecting line is 
the line splitting in two equals parts 
the angle between these two lines. 

●     Select a point as the starting point for 
the line. By default it is the 
intersection of the bisecting line and 
the first selected line.



 

●     Select the support surface onto which 
the bisecting line is to be projected, if 
needed.

●     Specify the line's length in relation to 
its starting point (Start and End 
values for each side of the line in 
relation to the default end points).
The corresponding bisecting line, is 
displayed.

●     You can choose between two 
solutions, using the Next Solution 
button, or directly clicking the 
numbered arrows in the geometry.



3.  Click OK to create the line.

The line (identified as Line.xxx) is added to the specification tree.

  
●     Regardless of the line type, Start and End values are specified by entering distance values 

or by using the graphic manipulators.

●     Start and End values should not be the same.

●     Check the Mirrored extent option to create a line symmetrically in relation to the selected 
Start point. 
It is only available with the Length Length type.

●     In most cases, you can select a support on which the line is to be created. In this case, the 
selected point(s) is projected onto this support.

●     You can reverse the direction of the line by either clicking the displayed vector or selecting 
the Reverse Direction button (not available with the point-point line type).

     

Creating a line up to an element
 This capability allows you to create a line up to a point, a curve, or a surface.

●     It is available with all line types, but the Tangent to curve type.

 

Up to a point
●     Select a point in the Up-to 1 and/or 

Up-to 2 fields.

Here is an example with the Bisecting 
line type, the Length Length type, 
and a point as Up-to 2 element.



 

Up to a curve
●     Select a curve in the Up-to 1 and/or 

Up-to 2 fields.

Here is an example with the Point-
Point line type, the Infinite End 
Length type, and a curve as the Up-to 
1 element.

 

Up to a surface
●     Select a surface in the Up-to 1 and/or 

Up-to 2 fields.

Here is an example with the Point-
Direction line type, the Length Length 
type, and the surface as the Up-to 2 
element.

  
●     If the selected Up-to element does not intersect with the line being created, then an 

extrapolation is performed. It is only possible if the element is linear and lies on the same 
plane as the line being created.
However, no extrapolation is performed if the Up-to element is a curve or a surface.

●     The Up-to 1 and Up-to 2 fields are grayed out with the Infinite Length type, the Up-to 1 
field is grayed out with the Infinite Start Length type, the Up-to 2 field is grayed out with 
the Infinite End Length type.

●     The Up-to 1 field is grayed out if the Mirrored extent option is checked.

●     In the case of the Point-Point line type, Start and End values cannot be negative.

  
 

Defining the length type



 
●     Select the Length Type: 

❍     Length: the line will be defined according to the Start and End points values

❍     Infinite: the line will be infinite

❍     Infinite Start Point: the line will be infinite from the Start point

❍     Infinite End Point: the line will be infinite from the End point

By default, the Length type is selected.
The Start and/or the End points values will be greyed out when one of the Infinite options is 
chosen.

  
 

Reselecting automatically a second point
This capability is only available with the Point-Point line method.

1.  Double-click the Line icon .

The Line dialog box is displayed.

2.  Create the first point.

 

The Reselect Second Point at next 
start option appears in the Line dialog 
box.

3.  Check it to be able to later reuse 

the second point.

4.  Create the second point.

5.  Click OK to create the first line.

  



 

The Line dialog box opens again 
with the first point initialized 
with the second point of the 
first line.

6.  Click OK to create the second line.

 To stop the repeat action, simply uncheck the option or click Cancel in the Line dialog box.
  

●     Parameters can be edited in the 3D geometry. For more information, refer to the Editing 
Parameters chapter.

●     You can isolate a line in order to cut the links it has with the geometry used to create it. To 
do so, use the Isolate contextual menu. For more information, refer to the Isolating 
Features chapter.

 



Creating an Axis

This task shows you how to create an axis feature.

 
Open the Axis1.CATPart document.

1.  Click the Axis icon  .

The Axis Definition dialog box appears.

2.  Select an Element where to create the axis.

 

This element can be:
●     a circle or a portion of circle

●     an ellipse or a portion of ellipse

●     an oblong curve

●     a revolution surface or a portion of revolution surface

Circle
 

●     Select the direction (here we chose the yz plane), when not normal to 
the surface.

●     Select the axis type:
❍     Aligned with reference direction

❍     Normal to reference direction

❍     Normal to circle

      
 

 Aligned with reference direction Normal to reference direction Normal to circle
 

Ellipse
 

 

●     Select the axis type:
❍     Major axis

❍     Minor axis

❍     Normal to ellipse

       

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/Axis1.CATPart


 

 Major axis Minor axis           Normal to ellipse
 

Oblong Curve
 

 

●     Select the axis type:
❍     Major axis

❍     Minor axis

❍     Normal to oblong

      
 

 Major axis Minor axis           Normal to oblong
 

Revolution Surface
 

 

The revolution surface's axis is used, 
therefore the axis type combo list is 
disabled.

The axis can be displayed in the 3D geometry, either infinite or limited to the geometry block of the input element. This 

option is to be parameterized in Tools -> Options -> Shape -> Generative Shape Design -> General.

To have further information, please refer to the General Settings chapter in the Customizing section.



 
3.  Click OK to create the axis.

The element (identified as Axis.xxx) is added to the specification tree.



Creating Polylines
This task shows you how to create a polyline, that is a broken line made of several connected 
segments.
These linear segments may be connected by a blending radii.
Polylines may be useful to create cylindrical shapes such as pipes, for example.

 
Open the Spline1.CATPart document.

 
1.  Click the Polyline  

icon.

The Polyline Definition 
dialog box appears.

2.  Select several points in a 

row.

Here we selected Point.1, 

Point.5, Point.3 and 

Point.2 in this order.

The resulting polyline 
would look like this: 

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/Spline1.CATPart


3.  From the dialog box, 

select Point.5, click the 

Add After button and 

select Point.6.

4.  Select Point.3 and click 

the Remove button.

The resulting polyline 
now looks like this: 

5.  Still from the dialog box select Point.5, click the Replace button, and select Point.4 in 

the geometry.

The added point automatically becomes the current point in the dialog box. 

6.  Click OK in the dialog box 

to create the polyline.

The element (identified as 
Polyline.xxx) is added to the 
specification tree.

7.  Double-click the polyline from the specification tree. 

The Polyline Definition dialog box is displayed again.

8.  Select Point.6 within the 

dialog box, enter a value 

in the Radius field, and 

click Preview.

A curve, centered on Point.6, and 
which radius is the entered value 
(R=30 here) is created.



●     You can define a radius for each point, except end points.

●     You can also define radii at creation time.

●     The blending curve's center is located on the side of the smallest angle between the two 
connected line segments.

9.  Click OK to accept the new definition of the polyline.

●     The polyline's orientation depends on the selection order of the points.

●     You can re-order selected points using the Replace, Remove, Add, Add After, and Add 
Before buttons.

●     You cannot select twice the 
same point to create a 
polyline. However, you can 
check the Close polyline 
button to generate a closed 
contour.

 

 



Creating Planes

 
This task shows the various methods for creating planes:

 

●     offset from a plane

●     parallel through point

●     angle/normal to a plane

●     through three points

●     through two lines

●     through a point and a 
line

●     through a planar 
curve

●     normal to a 
curve

●     tangent to a 
surface

●     from its equation

●     mean through 
points

 

 
Open the Planes1.CATPart document.

 
1.  Click the Plane icon  .

The Plane Definition dialog box appears.

2.  Use the combo to choose the desired Plane type.

 
Once you have defined the plane, it is represented by a red square symbol, which you can 
move using the graphic manipulator.

Offset from plane

●     Select a reference Plane then 
enter an Offset value.

A plane is displayed offset from the 
reference plane.

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/Planes1.CATPart


Use the Reverse Direction button to  
reverse the change the offset 
direction, or simply click on the arrow 
in the geometry.

      
●     Click the Repeat object after OK if you 

wish to create more offset planes . 
In this case, the Object Repetition dialog 
box is displayed, and you key in the number 
of instances to be created before pressing 
OK.

As many planes as indicated in the 
dialog box are created (including the 
one you were currently creating), each 
separated from the initial plane by a 
multiple of the Offset value. 

 

Parallel through point 

●     Select a reference Plane and a 
Point.



A plane is displayed parallel to the 
reference plane and passing through 
the selected point.

Angle or normal to plane 

●     Select a reference Plane and a 
Rotation axis.
This axis can be any line or an 
implicit element, such as a 
cylinder axis for example. To 
select the latter press and hold the 
Shift key while moving the pointer 
over the element, then click it.

●     Enter an Angle value.

 



A plane is displayed passing through 
the rotation axis. It is oriented at the 
specified angle to the reference plane. 

●     Click the Repeat object after OK if you wish to create more planes at an angle from the 
initial plane. 
In this case, the Object Repetition dialog box is displayed, and you key in the number of 
instances to be created before pressing OK.

As many planes as indicated in the 
dialog box are created (including the 
one you were currently creating), each 
separated from the initial plane by a 
multiple of the Angle value.

Here we created five planes at an 
angle of 20 degrees.

 This plane type enables to edit the plane's parameters. Refer to Editing Parameters to find out 
how to display these parameters in the 3D geometry.

Through three points 

●     Select three points.



The plane passing through the three 
points is displayed. You can move it 
simply by dragging it to the desired 
location.

Through two lines 

●     Select two lines.

The plane passing through the two 
line directions is displayed.
When these two lines are not 
coplanar, the vector of the second line 
is moved to the first line location to 
define the plane's second direction. 



Check the Forbid non coplanar lines button to specify that both lines be in the same plane.

Through point and line 

●     Select a Point and a Line.

The plane passing through the point 
and the line is displayed. 

 



Through planar curve 

●     Select a planar Curve.

The plane containing the curve is 
displayed.

Tangent to surface 

●     Select a reference Surface and a 
Point.



A plane is displayed tangent to the 
surface at the specified point.

Normal to curve 

●     Select a reference Curve.

●     You can select a Point. By default, 
the curve's middle point is selecte.



A plane is displayed normal to the 
curve at the specified point. 

Mean through points 

●     Select three or more points to 
display the mean plane through 
these points.

It is possible to edit the plane by first 
selecting a point in the dialog box list 
then choosing an option to either:

●     Remove the selected point

●     Replace the selected point by 
another point.



Equation 

●     Enter the A, B, C, D components 
of the Ax + By + Cz = D plane 
equation.

 

Select a point to position the plane 
through this point, you are able to 
modify A, B, and C components, the 
D component becomes grayed.

 

Use the Normal to compass button 
to position the plane perpendicular to 
the compass direction.

Use the Parallel to screen button to 
parallel to the screen current view.



3.  Click OK to create the plane.

The plane (identified as Plane.xxx) is added to the specification tree.
  

●     Parameters can be edited in the 3D geometry. For more information, refer to the Editing 
Parameters chapter.

●     You can isolate a plane in order to cut the links it has with the geometry used to create it. 
To do so, use the Isolate contextual menu. For more information, refer to the Isolating 
Features chapter.

 



Creating Planes Between Other Planes

 
This task shows how to create any number of planes between two existing planes, in only one 
operation:

 
Open the Planes1.CATPart document.

 
1.  Click the Planes Repetition icon  .

The Planes Between dialog box appears.

2.  Select the two planes between which the new 

planes must be created.

3.  Specify the number of planes to be created between the two selected planes.

4.  Click OK to create the planes.

The planes (identified as Plane.xxx) are added to the 
specification tree.

 
Check the Create in a new geometrical set button to create a new Geometrical Set 
containing only the repeated planes.

 

 

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/Planes1.CATPart


Creating Circles

 

This task shows the various methods for creating circles and circular arcs: 

●     center and radius

●     center and point

●     two points and radius

●     three points

●     center and axis

●     bitangent and radius

●     bitangent and point

●     tritangent

●     center and tangent

 

Open the Circles1.CATPart document.
Please note that you need to put the desired geometrical set in show to be able to perform the corresponding scenario. 

 
1.  Click the Circle icon .

The Circle Definition dialog box appears. 

2.  Use the drop-down list to choose the desired circle type.

 

Center and radius 
 

●     Select a point as circle Center.

●     Select the Support plane or surface where the circle 
is to be created.

●     Enter a Radius value.

Depending on the active Circle Limitations icon, the 
corresponding circle or circular arc is displayed.
For a circular arc, you can specify the Start and End 
angles of the arc.

 

 
If a support surface is selected, the circle lies on the plane tangent to the surface at the selected point.

Start and End angles can be specified by entering values or by using the graphic manipulators.
     

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/Circles1.CATPart


Center and point 
 

●     Select a point as Circle center.

●     Select a Point where the circle is to be created.

●     Select the Support plane or surface where the circle 
is to be created.

The circle, which center is the first selected point and 
passing through the second point or the projection of 
this second point on the plane tangent to the surface at 
the first point, is previewed. 

Depending on the active Circle Limitations icon, the 
corresponding circle or circular arc is displayed.
For a circular arc, you can specify the Start and End 
angles of the arc.

 

 

      

Two points and radius 
 

●     Select two points on a surface or in the same plane.

●     Select the Support plane or surface.

●     Enter a Radius value.

The circle, passing through the first selected point and 
the second point or the projection of this second point 
on the plane tangent to the surface at the first point, is 
previewed. 

Depending on the active Circle Limitations icon, the 
corresponding circle or circular arc is displayed. 
For a circular arc, you can specify the trimmed or 
complementary arc using the two selected points as end 
points. 

You can use the Second Solution button, to display 
the alternative arc.

  

     



Three points 
 

●     Select three points where the circle is to be created.

Depending on the active Circle Limitations icon, the 
corresponding circle or circular arc is displayed. 
For a circular arc, you can specify the trimmed or 
complementary arc using the two of the selected points 
as end points.

 

    

Center and axis 

●     Select the axis/line.
It can be any linear curve.

●     Select a point.

●     Enter a Radius value.

●     Set the Project point on axis/line option:
❍     checked (with projection): the circle is centered 

on the reference point and projected onto the 
input axis/line and lies in the plane normal to 
the axis/line passing through the reference 
point. The line will be extended to get the 
projection if required.

❍     unchecked (without projection): the circle is 
centered on the reference point and lies in the 
plane normal to the axis/line passing though the 
reference point.

 

 With projection Without projection
   



Bi-tangent and radius 
 

●     Select two Elements (point or curve) to which the 
circle is to be tangent.

●     Select a Support surface.

 If one of the selected inputs is a planar curve, then the Support is set to Default (Plane).
If an explicit Support needs to be defined, a contextual menu is available to clear the selection in order to select the desired support.

This automatic support definition saves you from performing useless selections.

 
●     Enter a Radius value.

●     Several solutions may be possible, so click in the region where you want the circle to be.

Depending on the active Circle Limitations icon, the corresponding circle or circular arc is displayed. 
For a circular arc, you can specify the trimmed or complementary arc using the two tangent points as end points. 

 

 You can select the Trim Element 1 and Trim Element 
2 check boxes to trim the first element or the second 
element, or both elements.
Here is an example with Element 1 trimmed.

These options are only available with the Trimmed 
Circle limitation.

    



Bi-tangent and point 
 

●     Select a point or a curve to which the circle is to be 
tangent.

●     Select a Curve and a Point on this curve.

●     Select a Support plane or planar surface.

The point will be projected onto the curve.

 If one of the selected inputs is a planar curve, then the Support is set to Default (Plane).
If an explicit Support needs to be defined, a contextual menu is available to clear the selection in order to select the desired support.

This automatic support definition saves you from performing useless selections.

 

●     Several solutions may be possible, so click in the region where you want the circle to be.

Depending on the active Circle Limitations icon, the corresponding circle or circular arc is displayed. 

Complete circle
For a circular arc, you can choose the trimmed or complementary arc using the two tangent points as end points.

Trimmed circle Complementary trimmed circle

You can select the Trim Element 1 and Trim Element 
2 check boxes to trim the first element or the second 
element, or both elements.
Here is an example with both elements trimmed.

These options are only available with the Trimmed 
Circle limitation.

     



Tritangent 
 

●     Select three Elements to which the circle is to be 
tangent.

●     Select a Support planar surface.

 If one of the selected inputs is a planar curve, then the 
Support is set to Default (Plane).
If an explicit Support needs to be defined, a contextual 
menu is available to clear the selection in order to select 
the desired support.

This automatic support definition saves you from 
performing useless selections.

 
●     Several solutions may be possible, so select the arc 

of circle that you wish to create.

Depending on the active Circle Limitations icon, the 
corresponding circle or circular arc is displayed. The first 
and third elements define where the relimitation ends. 
For a circular arc, you can specify the trimmed or 
complementary arc using the two tangent points as end 
points.

  

 You can select the Trim Element 1 and Trim Element 
3 check boxes to trim the first element or the third 
element, or both elements.
Here is an example with Element 3 trimmed.

These options are only available with the Trimmed 
Circle limitation.

     
 

Center and tangent
 

There are two ways to create a center and tangent 
circle:



 

1.  Center curve and radius

●     Select a curve as the Center Element.

●     Select a Tangent Curve.

●     Enter a Radius value.

 

 

2.  Line tangent to curve definition

●     Select a point as the Center Element.

●     Select a Tangent Curve.

  
●     If one of the selected inputs is a planar curve, then the Support is set to Default (Plane).

If an explicit Support needs to be defined, a contextual menu is available to clear the selection in order to select the desired support.

This automatic support definition saves you from performing useless selections.

●     The circle center will be located either on the center curve or point and will be tangent to tangent curve.

●     Please note that only full circles can be created.

   

4.  Click OK to create the circle or circular arc.

The circle (identified as Circle.xxx) is added to the specification tree.
  

●     You can click the Diameter button to switch to a Diameter value. Conversely, click the Radius button to switch back to the Radius 
value. 
This option is available with the Center and radius, Two point and radius, Bi-tangent and radius, Center and tangent, and 
Center and axis circle types.

Note that the value does not change when switching from Radius to Diameter and vice-versa.

●     You can select the Axis computation check box to automatically create axes while creating or modifying a circle. Once the option is 

checked, the Axis direction field is enabled. 

❍     If you do not select a direction, an axis normal to the circle will be created.

❍     If you select a direction, two more axes features will be created: an axis aligned with the reference direction and an axis normal to 

the reference direction.

In the specification tree, the axes are aggregated under the Circle feature. You can edit their directions but cannot modify them.

If the datum mode is active, the axes are not aggregated under the Circle features, but one ore three datum lines are created.



 

 
Axis normal to the circle

Axis aligned with the reference 
direction
(yz plane)

Axis normal to the reference direction
(yz plane)

If you select the Geometry on Support option and the selected support is not planar, then the Axis Computation is not possible.

 
●     You can select the Geometry on Support check box if you want the circle to be projected onto a support surface.

In this case just select a support surface.

This option is available with the Center and radius, Center and point, Two point and radius, and Three points circle types.

 
●     When several solutions are possible, click the Next Solution button to move to another arc of circle, or directly select the arc you 

want in the 3D geometry.

A circle may have several points as center if the selected element is made of various circle arcs with different centers.

  
●     Parameters can be edited in the 3D geometry. For more information, refer to the Editing Parameters chapter.

●     You can isolate a plane in order to cut the links it has with the geometry used to create it. To do so, use the Isolate contextual menu. 
For more information, refer to the Isolating Features chapter.

 

 



Creating Conic Curves

 

This task shows the various methods for creating conics, that is curves defined by five 
constraints: start and end points, passing points or tangents. The resulting curves are arcs of 
either parabolas, hyperbolas or ellipses.
The different elements necessary to define these curves are either:

●     two points, start and end tangents, and a parameter

●     two points, start and end tangents, and a passing point

●     two points, a tangent intersection point, and a parameter

●     two points, a tangent intersection point, and a passing point

●     four points and a tangent

●     five points.

 
Open the Conic1.CATPart document.

1.  Click the Conic icon .

The Conic Definition dialog box opens. 

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/Conic1.CATPart


2.  Fill in the conic curve parameters, depending on the type of curve to be created by 

selecting geometric elements (points, lines, etc.):

●     Support: the plane on which the resulting curve will lie

 Constraint Limits:
 

●     Start and End points: the curve is defined from the starting point to the end point

●     Tangents Start and End: if necessary, the tangent at the starting or end point defined by 
selecting a line

●     Tangent Intersection Point: a point used to define directly both tangents from the start 
and end point. These tangents are on the virtual lines passing through the start (end) point 
and the selected point.

 
 a. Selecting the support plane

and starting point
b. Selecting the ending point

 

 

c. Selecting the tangent 
at the starting point 

d. Selecting the tangent 
at the ending point



 
Resulting conic curve 

If you check  the Tgt Intersection Point option, and select a point, the tangents are created 
as passing through that point:

 
 Using a tangent intersection  point Resulting conic curve

Intermediate Constraints
 

●     Point 1, 2, 3: possible passing points for the curve. These points have to be selected in 
logical order, that is the curve will pass through the start point, then through Point 1, 
Point 2, Point 3 and the end point.
Depending on the type of curve, not all three points have to be selected.
You can define tangents on Point 1 and Point 2 (Tangent 1 or 2).

●     Parameter: ratio ranging from 0 to 1 (excluded), this value is used to define a passing 
point (M in the figure below) and corresponds to the OM distance/OT distance.
If parameter = 0.5, the resulting curve is a parabola
If 0 < parameter < 0.5, the resulting curve is an arc of ellipse,
If 1 > parameter > 0.5, the resulting curve is a hyperbola.



3.  Click OK to create the conic curve.

The conic curve (identified as Conic.xxx) is added to the specification tree.

 

 



Creating Spirals

 
This task shows how to create curves in the shape of spirals, that is a in 2D plane, as opposed 
to the helical curves.

 
Open the Spiral1.CATPart document.

 
1.  Click the Spiral 

icon  .

The Spiral 
Curve 
Definition 
dialog box 
appears.

     

2.  Select a 

supporting plane 

and the Center 

point for the 

spiral.

3.  Specify a Reference direction along which the Start radius value is measured and 

from which the angle is computed, when the spiral is defined by an angle.

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/Spiral1.CATPart


The spiral is 
previewed 
with the 
current 
options:

4.  Specify the Start radius value, that is the distance from the Center point, along the 

Reference direction, at which the spiral's first revolution starts.

5.  Define the spiral's Orientation, that is the rotation direction: clockwise or counter 

clockwise

6.  Specify the spiral creation mode, and fill in the corresponding values:

●     Angle & Radius: 
the spiral is defined 
by a given End 
angle from the 
Reference 
direction and the 
radius value, the 
radius being 
comprised between 
the Start and End 
radius, on the first 
and last revolutions 
respectively (i.e. the 
last revolution ends 
on a point which 
distance from the 
center point is the 
End radius value). 

 

Ref. direction = Z, Start radius = 5mm, Angle = 45°, 
 End radius = 20mm, Revolutions = 5



●     Angle & Pitch: the 
spiral is defined by a 
given End angle 
from the Reference 
direction and the 
pitch, that is the 
distance between 
two revolutions of 
the spiral.

 
Ref. direction = Z, Start radius = 5mm, Angle = 45°, 

 Pitch = 4mm, Revolutions = 5

●     Radius & Pitch: 
the spiral is defined 
by the End radius 
value and the pitch.
The spiral ends 
when the distance 
from the center 
point to the spiral's 
last point equals the 
End radius value.

 
Ref. direction = Z, Start radius = 5mm, 

End radius = 20mm, Pitch = 4mm

 
Depending on the selected creation mode, the End angle, End radius, Pitch, and  
Revolutions fields are available or not.

7.  Click OK to 

create the spiral 

curve.

The curve (identified as 
Spiral.xxx) is added to 
the specification tree.

Parameters can be edited in the 3D geometry. To have further information, please refer to the 
Editing Parameters chapter.

 

 



Creating Splines 

 
This task shows the various methods for creating spline curves.

 
Open the Spline1.CATPart document.

1.  Click the Spline icon  .

The Spline Definition dialog box appears.

2.  Select two or more points where the spline is to be created.

An updated spline is visualized each time a point is selected. 

3.  It is possible to edit the spline by first selecting a point in the dialog box list then choosing a button to either:

●     Add a point after the selected point

●     Add a point before the selected point

●     Remove the selected point

●     Replace the selected point by another point

4.  You can select  the Geometry on support check box, and select a 

support (plane, surface),  if you want the spline to be projected onto 

a support surface.

It is better when the tangent directions belong to the support, that 
is when a projection is possible.

In this case just select a surface or plane. 

In the  figure above,  the spline was created
on a planar support grid. 

file:///E|/www/spuCXR14/SdgEnglish/sdgug.doc/src/samples/Spline1.CATPart


5.  Click on the Add Parameter button to display further options. 

6.  To set tangency conditions onto any point of the spline, select the 

point and click on Tangent Dir. 

There are two ways of imposing tangency and curvature constraints:

1.  Explicit: select a line or plane to which the tangent on the spline is 
parallel at the selected point

2.  From curve: select a curve to which the spline is tangent at the 
selected point.

Use the Remove Tgt., Reverse Tgt., or Remove Cur. to manage the different imposed tangency and curvature constraints.



Spline with a tangency constraint on endpoint (tension = 2) Spline with reversed tangent

7.  To specify a curvature constraint at any point of the spline, once a tangency constraint has been set, indicate a curvature direction 

and enter a radius value:

The curvature direction is projected onto a plane normal to the tangent direction.
If you use the Create line contextual menu, and want to select the same point as a point already used to define the tangent direction, you 
may have to select it from the specification tree, or use the pre-selection navigator.

 

 
Spline with tangency constraint

Spline with tangency constraint and 
curvature constraint
 (radius = 50mm)

Spline with tangency constraint and curvature constraint 
(radius = 2mm)

Note that there are prerequisites for the Points Specifications and you must enter your information in the following order: 
●     Tangent Dir. (tangent direction)

●     Tangent Tension

●     Curvature Dir. (curvature direction)

●     Curvature Radius (to select it, just click in the field)

The fields become active as you select values.

8.  Click OK to create the spline.

The spline (identified as Spline.xxx) is added to the specification tree.

To add a parameter to a point, select a line in the Points list. This list is highlighted.
You have two possibilities:

1.  extended parameters
2.  select any line or plane for the direction.

●     Use the Close Spline option to create a closed curve, provided the geometric configuration allows it.

file:///E|/www/spuCXR14/BasEnglish/basug.doc/src/basugbt0603.htm


Spline with Close Spline option unchecked Spline with Close Spline option checked

 

 



Creating a Helix

 

This task shows the various methods for creating helical curves, such as coils and springs for example.
These curves are 3D curves, as opposed to the spirals.

 
Open the Helix1.CATPart document.

1.  Click the Helix icon .

The Helix Curve Definition dialog 
box appears.

2.  Select a starting point and an axis.

3.  Set the helix parameters:

●     Pitch: the distance between two 
revolutions of the curve

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/Helix1.CATPart


You can define the evolution of 
the pitch along the helix using a 
law.

 
Defining Laws

 

1.  Click the Law button to display the 
Law Definition dialog box. 

2.  Choose type of law to be applied to 
the pitch: It can stay Constant, or 
evolve according to a S type law.

For the S type pitch, you need to 
define a second pitch value. The 
pitch distance will vary between 
these two pitch values, over the 
specified number of revolutions.

3.  The Law Viewer allows you to:
- visualize the law evolution and the 
maximum and minimum values,
- navigate into the viewer by 
panning and zooming (using to the 
mouse),
- trace the law coordinates by using 
the manipulator,
- change the viewer size by 
changing the panel size
- reframe on by using the viewer 
contextual menu
- change the law evaluation step by 
using the viewer contextual menu 
(from 0.1 (10 evaluations) to 0.001 
(1000 evaluations)).

4.  Click OK to return to the Helix Curve 
Definition dialog box.



 
●     Height: the global height of the helical curve, in the case of a constant pitch type helix

●     Orientation: defines the rotation direction (clockwise or counter clockwise)

●     Starting Angle: defines where the helical curve starts, in relation to the starting point.
This parameter can be set only for the Constant pitch only.

●     Taper Angle: the radius variation from one revolution to the other. It ranges from -90° to 90° excluded. 
For a constant radius, set the taper angle to 0.

●     Way: defines the taper angle orientation.
Inward: the radius decreases
Outward: the radius increases.

●     Profile: the curve used to control the 
helical curve radius variation. The radius 
evolves according to the distance 
between the axis and the selected 
profile (here the orange curve).
Note that the Starting point must be 
on the profile.

4.  Click the Reverse Direction button to invert the curve direction.

5.  Click OK to create the helix.

The helical curve (identified as 
Helix.xxx) is added to the 
specification tree.

Parameters can be edited in the 3D geometry. To have further information, please refer to the Editing Parameters 
chapter.

 

 



Creating a Spine

 
This command is only available with the Generative Shape Design 2 product.

 

This task shows how to create a spine, that is a curve normal to a list of ordered planes or 
planar curves. These spines are useful when creating complex surfaces such as swept, lofted, 
or filleted surfaces.

 
●     Creating a Spine Based on Planes

●     Creating a Spine Based on Guiding Curves

●     Reversing the Spine's Starting Direction

Creating a Spine Based on Planes

 

Open the Spine1.CATPart document.
Display the Curves toolbar by clicking and holding the arrow from the Spine icon.

 
1.  Click the Spine icon  .

The Spine Curve Definition 

dialog box is displayed.

2.  Successively select planes or 

planar profiles. 

3.  Click Preview. 

The spine is displayed.

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/Spine1.CATPart


4.  You can also select a start 

point.

The point is projected onto 

the first plane as the spine 

starting point, as illustrated 

here (point.3 is selected) 

except if it is already lying 

onto this first plane.

●     Use the contextual menu on the 

Start point field to create a 

point. (See Stacking 

Commands). 

●     If you do not select a start point 

(default mode) one is computed 

automatically.

●     To remove a selected point, 

check the Computed start 

point button.

5.  Select one of the elements 

in the dialog box, then 

click: 

●     Replace, then select the 

replacing element in the 

geometry or the specification 

tree

●     Remove to delete it from the 

spine definition

●     Add then select a new element 

to be added after the last one.



Using the contextual menu, you 

can choose to Add After or 

Add Before the selected 

element.

6.  Click OK.

The curve (identified as Spine.xxx) is added to the specification tree.

 
When non planar curves are selected, their mean planes are used to compute the spine.

Creating a Spine Based on Guiding Curves

 
Open the Spine2.CATPart document.

 
1.  Click the Spine icon  .

The Spine Curve Definition 

dialog box is displayed.

2.  Click within the Guide list 

and successively select two 

guiding curves.

The spine is immediately 

previewed. 

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/Spine2.CATPart


3.  Click OK to create the spine. 

The curve (identified as Spine.xxx) is added to the specification tree.

 
This type of spine is very useful when creating a swept surface, as illustrated below:

Swept surface without any spine Swept surface with specified spine
 

Reversing the Spine's 
Starting Direction

 



This option can only be used if the 
first profile is a plane.

 

 
Open the Spine3.CATPart 
document.

1.  Double-click the spine.

The Spine Curve Definition 

dialog box is displayed.

2.  Click the Reverse 

Direction button.

3.  Click OK to create the 

reverse spine. 

 
 

 

 

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/Spine3.CATPart


Creating Corners 

 
This task shows you how to create a corner between two curves or between a point and a curve.

 
Open the Corner1.CATPart document.

 
1.  Click the Corner icon  .

The Corner Definition dialog box appears. 

The Corner On Vertex check box enables you to create a corner by selecting a point or a curve as Element 1 

(Element 2 is grayed as well as the Trim Element 1 and 2 options). 

It is checked by default.

2.  Choose the Corner Type:

Corner on Support:

the support can be a surface or a plane 

1.  Select a curve or a point as first reference 

element.

2.  Select a curve as second reference 

element.

The corner will be created between these 

two references.

3.  Select the Support surface. 

Here we selected the zx plane.

The resulting corner is a curve seen as 
an arc of circle lying on a support place 
or surface. 

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/Corner1.CATPart


 
The reference elements must lie on this support, as well as the center of the circle defining the corner.

 

3D Corner: 

corner between two 3D curves. 

1.  Select a 3D curve or a point as first 

reference element.

2.  Select a 3D curve as second reference 

element.

The corner will be created between these 

two references.

3.  Select a Direction.

Here we selected Line.2.

The resulting corner is a 3D curve seen 
as an arc of circle along the user input 
Direction. 

 

The input elements must not be collinear to the 3D Corner direction. Moreover, if the plane projection of an input 
element along the user input direction is singular or is self intersected, some corner solution might not be computed.

3.  Enter a Radius value.

 
In the case of a curve as Element 1, note that: 

●     all corners have the same radius

●     closed wires can be selected

4.  Select a direction or a support depending on the corner type you chose. 

In case there are several solutions, the corner closest to the selected point will be created.

 



The example above shows a corner defined by a point as Element 1

 

 The example above shows a corner defined by a curve as Element 1

5.  Several solutions may be possible, so click the Next 

Solution button to move to another corner solution, 

or directly select the corner you want in the 

geometry.

Not all four solutions are always available, 

depending on the support configuration (if the 

center of one of the corners does not lie on the 

support for example). 



6.  You can select the Trim element check buttons if you want to trim and assemble the two reference elements to 

the corner.

 The elements can be trimmed and assembled individually.

7.  Click OK to create the corner. 

The corner (identified as Corner.xxx) is added to the 

specification tree.

●     When the selected curves are coplanar, the default support is the background plane. However, you can explicitly 
select any support.

●     When the selected curves are not coplanar, an implicit plane can be created, provided the curves intersect and are 
locally coplanar at this intersection. However, you can explicitly select any support.

 
●     You can edit the corner's parameters. Refer to Editing Parameters to find out how to display these parameters in the 

3D geometry.

 

 



Creating Connect Curves 

 
This task shows how to create a connecting curve between two curves.

Open the Connect1.CATPart document.

 
1.  Click the Connect Curve icon  .

The Connect Curve Definition dialog box appears.

2.  Select the Connect type.

Normal

1.  Select a first Point on a 
curve then a second Point 
on a second curve.
The Curve fields are 
automatically filled.

   

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/Connect1.CATPart


Base Curve

1.  Select a base curve as the 
curve reference.
The orientation of the 
connect curve will be the 
orientation of the base 
curve.

2.  Select a first Point on a 
curve then a second Point 
on a second curve.

 

The support Curve is optional (it is 
set as Default)

The first point can be either on the 
base curve or on the support curve.

The Base Curve option is useful 
when creating several profiles or 
guides that have the same shape.

 

This option is only available with the 
Generative Shape Design 2 product.

 
Normal curve Base Curve



3.  Use the combos to specify the desired Continuity type: Point, Tangency or 

Curvature.

4.  If needed, enter tension values.

 
If the Base Curve type is selected, the Continuity and Tension options for the first and the 

second curve are grayed out and set to Tangency and 1 respectively.

The connect curve is displayed between the two selected points according to the specified 
continuity and tension values.

Normal curve with point continuity at both 
points

 

Normal curve with point continuity at one point
and tangent continuity at the other

Normal curve with point continuity at one 
point

and curvature continuity at the other

Normal curve with tangent continuity at one 
point

and curvature continuity at the other



Normal curve with curvature continuity at 
both points

Normal curve with tangent continuity at both 
points

5.  An arrow is displayed at each extremity of the curve. You can click the arrow to reverse 

the orientation of the curve at that extremity or click the Reverse button..

A graphic manipulator also allows you to modify the tension at the extremity of the connect 
curve, rather than in the dialog box.

 
If the Base Curve type is selected, the Reverse Direction options are grayed out.

6.  You can select  the Trim elements check box if you want to trim and assemble the two 

initial curves to the connect curve.

 
If no Base Curve type is selected, the Trim option is grayed out.

 
Normal curve Base Curve



7.  Click OK to create the connect curve.

The curve (identified as Connect.xxx) is added to the specification tree. 

 
Normal curve Base Curve

 



Creating Parallel Curves 

 
This task shows you how to create a curve that is parallel to a reference curve.

Open the ParallelCurves1.CATPart document.

 
1.  Click the Parallel Curve icon  .

The Parallel Curve Definition dialog box 
appears.

2.  Select the reference Curve to be offset.

3.  Select the Support plane or surface on which the reference curve lies.

 
4.  Specify the offset of the parallel curve either by:

a.  entering a value or using the graphic 

manipulator in the Constant field.

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/ParallelCurves1.CATPart


 

b.  selecting a point in the Point field (in 

both Geodesic and Euclidean mode)

In that case, the Constant field is 

grayed.

5.  Choose the parallelism mode to create the parallel curve:

●     Euclidean: the distance between both curves will be the shortest possible one, regardless of the support. 

If you select this mode, you can choose to offset the curve at a constant distance from the initial element, or according 

to a law. In this case, you need to select a law as defined in Creating Laws. 

 
Defining Laws

 
The law can be negative, providing the curves are curvature continuous.
Please note that:

- it is advised to use curvature continuous laws,
- it is advised not to use laws with a vertical tangency,
- it is possible to create a parallel curve with a law that reverses (which means becoming either positive or 
negative) only on a curve that is tangency continuous.

 
This option is only available with the Generative Shape Design 2 product.

1.  Click the Law... button to display the Law 

Definition dialog box. The 2D viewer enables you 

to previsualize the law evolution before applying it.

2.  Enter Start and End values.

3.  Choose the law type to be applied to the pitch.
 Four law types are available: 

a. Constant: a regular law, only one value is 
needed.
b. Linear: a linear progression law between the 
Start and End indicated values
c. S type: an S-shaped law between the two 
indicated values
d. Advanced: allowing to select a Law element as 
defined in Creating Laws. 

For the S type pitch, you need to define a second 
pitch value. The pitch distance will vary between 
these two pitch values, over the specified number 
of revolutions.



4.  The Law Viewer allows you to:

- visualize the law evolution and the maximum 

and minimum values,

- navigate into the viewer by panning and zooming 

(using to the mouse),

- trace the law coordinates by using the 

manipulator,

- change the viewer size by changing the panel 

size

- reframe on by using the viewer contextual menu

- change the law evaluation step by using the 

viewer contextual menu (from 0.1 (10 

evaluations) to 0.001 (1000 evaluations)).

5.  Check the Inverse law button to reverse the law 
as defined using the above options.

6.  Click OK to return to the Parallel Curve Definition 

dialog box.

●     Geodesic: the distance between both curves will be the shortest possible one, taking the support curvature into 
account. 
In this case, the offset always is constant in every points of the curves and you do not need to select a corner type.

 
This option is only available with the Generative Shape Design 2 product.

6.  Select corner type  (useful for curves presenting sharp angles):

 
●     Sharp: the parallel curve takes into account the angle 

in the initial curve
●     Round: the parallel curve is rounded off as in a corner

In this case, the offset always is constant in every points 
of the curves and you do not need to select a corner 
type.



The parallel curve is displayed on the support surface and normal to the reference curve.

7.  Click OK to create the parallel curve.

 Parallel curve defined by an constant offset value Parallel curve defined by a passing point
The curve (identified as Parallel.xxx) is added to the specification tree.

 
●     You can smooth the curve by checking either: 

❍     None: deactivates the smoothing result

❍     G1 : enhances the current continuity to tangent 
continuity

❍     G2 : enhances the current continuity to curvature 
continuity

You can specify the maximum deviation for G1 or G2 

smoothing by entering a value or using the spinners. 

If the curve cannot be smoothed correctly, a warning 

message is issued.

Moreover, a topology simplification is automatically 

performed for G2 vertices: cells with a curvature 

continuity are merged.

Please refer to the Customizing General Settings chapter.



The Smoothing option is only available with the Generative Shape Design 2 product.

●     You can use the Reverse Direction button to display the parallel curve on the other side of the reference curve or 
click the arrow directly on the geometry.

●     When the selected curve is a planar curve, its plane is selected by default. However, you can explicitly select any 
support.

●     when you modify an input value through the dialog box, such as the offset value or the direction, the result is 
computed only when you click on the Preview or OK buttons.

●     Would the value be inconsistent with the selected 
geometry, a warning message is displayed, along with 
a warning sign onto the geometry. If you move the 
pointer over this sign, a longer message is displayed 
to help you continue with the operation.

●     Check the Both Sides button to create two parallel 
curves, symmetrically in relation to the selected curve, 
and provided it is compatible with the initial curve's 
curvature radius.

The second parallel curve has the same offset value as 
the first parallel curve. In that case it appears as 
aggregated under the first element.
Therefore both parallel curves can only be edited together 
and the aggregated element alone cannot be deleted.

If you use the Datum mode, the second parallel is not 
aggregated under the first one, but two datum elements 
are created.

 

●     Use the Repeat object after OK checkbox to create 
several parallel curves, each separated from the initial 
curve by a multiple of the offset value.
Simply indicate in the Object Repetition dialog box the 
number of instances that should be created and click 
OK.

●     The options set in the dialog box are retained when exiting then returning to the Parallel curve function.

 
Parameters can be edited in the 3D geometry. To have further information, please refer to the Editing Parameters 
chapter.

 

 



Creating a 3D Curve Offset

 
This task shows you how to create a 3D curve that is offset from a reference curve.

Open the 3DCurveOffset1.CATPart document.

 
1.  Click the 3D Curve Offset icon .

The 3D Curve Offset Definition dialog box 
appears.

2.  Select the reference Curve to be offset.

3.  Select the offset Pulling Direction.

A direction arrow appears in the 3D 

geometry and lets you change the direction.

The pulling direction corresponds to a draft direction. 
It does not correspond to the direction of the 3D 
curve.
If you select a plane as the pulling direction, the 
latter is normal to the plane.

 
4.  Specify the Offset value by entering a value 

or using the spinners.

 
5.  Click Preview to see the offset curve.

6.  Click OK.

The curve (identified as 3D curve offset.xxx) is added to the specification tree.

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/3DCurveOffSet1.CATPart


 

Here is the case of a closed curve:

  
3D corner parameters enable to manage singularities:

●     Radius: if the curvature radius of the input curve is smaller than the offset value, 3D corner curves 

are created to fill the holes

●     Tension: for the 3D corner curves, if needed

3D Curve Offset with a radius of 20 mm and a 
tension of 1

3D Curve Offset with a radius of 5 mm and a tension 
of 1

    
 

 3D Curve Offset with a tension of 2 and a radius of 
20 mm

3D Curve Offset with a tension of 0.3 and a radius of 
20 mm 



The input curve must be tangency continuous and must not be collinear to the offset direction.



Creating Projections

 

This task shows you how to create geometry by projecting one or more elements onto a  
support. The projection may be normal or along a direction.
You can project: 

●     a point onto a surface or wireframe support

●     wireframe geometry onto a surface support

●     any combination of points and wireframe onto a surface support.

Generally speaking, the projection operation has a derivative effect, meaning that there may 
be a continuity loss when projecting an element onto another. If the initial element presents a 
curvature continuity, the resulting projected element presents at least a tangency continuity. If 
the initial element presents a tangency continuity, the resulting projected element presents at 
least a point continuity.

Open the Projection1.CATPart document.

1.  Click the Projection icon  .

 The Projection Definition dialog box 
appears as well as the Multi-Selection 
dialog box allowing to perform multi-
selection.

 

   

2.  Select the element to be Projected.

You can select several elements to be 
projected.  In this case, the 
Projected field indicates: x 
elements

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/Projection1.CATPart


3.  Select the Support element. 

4.  Use the combo to specify the direction 

type for  the projection:

●     Normal: the projection is done normal to 

the support element.

●     Along a direction: you need to select a line 
to take its orientation as the translation 
direction or a plane to take its normal as the 
translation direction.

You can also specify the direction by means of 
X, Y, Z vector components by using the 
contextual menu on the Direction field.



●     Whenever several projections are possible, you can select the Nearest Solution check box 
to keep the nearest projection.
The nearest solutions are sorted once the computation of all the possible solutions is 
performed.

●     You can smooth the element to be projected 
by checking either: 

❍     None: deactivates the smoothing result

❍     G1 : enhances the current continuity to 
tangent continuity

❍     G2 : enhances the current continuity to 
curvature continuity

●     You can specify the maximum deviation for 

G1 or G2 smoothing by entering a value or 

using the spinners. 

If the element cannot be smoothed correctly, 

a warning message is issued.

Moreover, a topology simplification is 

automatically performed for G2 vertices: 

cells with a curvature continuity are merged.

5.  Click OK to create the projection element.

The projection (identified as Project.xxx) is added to the specification tree. 

The following capabilities are available: Stacking Commands and Selecting Using Multi-Output.

 

 



Creating Combined Curves

This task shows you how to create combined curves, that is a curve resulting from the 
intersection of the extrusion of two curves.

Open the Combine1.CATPart document.
Display the Project-Combine toolbar by clicking and holding the arrow from the Projection 
icon.

1.  Click the Combine icon  .

The Combine Definition dialog box appears.

2.  Choose the combine type: normal or along directions.

●     Normal: the virtual extrusion are computed as normal to the curve planes

●     Along directions: specify the extrusion direction for each curve (Direction1 and 

Direction2 respectively).

Normal Type

3.  Successively select the two curves to be 

combined.
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Using the Normal type, the combine 
curve is the intersection curve between 
the extrusion of the selected curves in 
virtual perpendicular planes.
This illustration represent the virtual 
extrusions, allowing the creation of the 
intersection curve that results in the 
combine curve. 

4.  Click OK to create the element.

The curve (identified as Combine.xxx) is 
added to the specification tree. 

Along Directions Type

3.  Successively select the two curves to be 

combined and a direction for each curve.



Using the Along directions type, the 
combine curve is the intersection curve 
between the extrusion of the selected 
curves along the selected directions, as 
illustrated here:

4.  Click OK to create the element.

The curve (identified as Combine.xxx) is 
added to the specification tree. 

The Nearest solution option, allows to automatically create the curve closest to the first 
selected curve, in case there are several possible combined curves.

 

 



Creating Reflect Lines
This task shows you how to create reflect lines, whether closed or open. Reflect lines are 
curves for which the normal to the surface in each point present the same angle with a 
specified direction.
Open the ReflectLine1.CATPart document.
Display the Project-Combine toolbar by 
clicking and holding the arrow from the 
Projection icon.

 

1.  Click the Reflect Lines icon  .

The Reflect Line Definition 
dialog box appears.

2.  Successively select the support 

surface and a direction.

3.  Key in an angle, representing the 

value between the selected 

direction and the normal to the 

surface.

Here we keyed in 15°.

You can also use the displayed manipulators to modify the angle value (ANG 
manipulator) or to reverse its direction (Support arrow). 

The Normal option lets you choose 
whether the angle should be computed:  

●     between the normal to the support and 
the direction (option checked)
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●     between the plane tangent to the 
support and the direction (option 
unchecked)

4.  Click OK to create the element.

The Reflect Line (identified as 
ReflectLine.xxx) is added to the 
specification tree. 

●     Use the Repeat object after OK 

checkbox to create several reflect lines, 

each separated from the initial line by a 

multiple of the Angle value.

Simply indicate in the Object Repetition 

dialog box the number of instances that 

should be created and click OK. 

 
●     When several reflect lines are created, 

as for example on a cylinder as 
illustrated here, you are prompted to 
choose to either keep both elements 
within the Reflect Line object, or to 
choose one as the reference, as 
described in Creating the Nearest Entity 
of a Multiple Element.

Do not use a null angle value on a closed surface issued from a circle for example.

 
Parameters can be edited in the 3D geometry. To have further information, please refer to the 
Editing Parameters chapter.

 

 



Creating Intersections 

This task shows you how to create wireframe geometry by intersecting elements.

You can intersect:

●     wireframe elements

●     surfaces

●     wireframe elements and a surface.

Open the Intersection1.CATPart document.

 
1.  Click the Intersection icon .

 The Intersection Definition dialog box appears as well as 
the Multi-Selection dialog box allowing to perform multi-
selection. 

 

2.  Select the two elements to be intersected.

The intersection is displayed.

 

Multi-selection is available on the first selection, meaning you can select several elements to be intersected, but only one 
intersecting element.

3.  Choose the type of intersection to be displayed: 

●     A Curve: when intersecting a curve with another one

 

●     Points: when intersecting a curve with another one
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●     A Contour: when intersecting a solid element with a surface 

●     A Face: when intersecting a solid element with a surface (we 
increased the transparency degree on the pad and surface)

4.  Click OK to create the intersection element.

This element (identified as Intersect.xxx) is added to the specification tree. 

This example shows the line resulting
from the intersection of a plane and a surface

This example shows the curve resulting
from the intersection of two surfaces

  

Several options can be defined to improve the preciseness of the intersection.

Open the Intersection2.CATPart document.

 
●     The Extend linear supports for intersection option enables you to extend the first, second or both elements. 

Both options are unchecked by default.

 

Here is an example with the option checked for both elements.

 
●     The Extrapolate intersection on first element check box enables you to perform an extrapolation on the first selected element, in 

the case of a surface-surface intersection. In all the other cases, the option will be grayed.

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/Intersection2.CATPart


 

 Intersection without the Extrapolation option checked Intersection with the Extrapolation option checked
 

●     The Intersect non coplanar line segments check box enables you to perform an intersection on two non-cutting lines. In all the other 
cases, the option will be grayed.

 When checking this option, both Extend linear supports for intersection options are checked too.
 

 Intersection between the light green line and the blue line: the 
intersection point is calculated after the blue line is extrapolated

Intersection between the pink line and the blue line: the intersection is 
calculated as the mid-point of minimum distance between the two 

lines
  

●     Avoid using input elements which are tangent to each other since this may result in geometric instabilities in the tangency zone.

●     If you intersect closed surfaces, they need to be created in two different geometrical sets.

 
The following capabilities are available: Stacking Commands and Selecting Using Multi-Output.

 



Creating Surfaces
Generative Shape Design allows you to model both simple and complex surfaces using techniques 
such as lofting, sweeping and filling. 

Create extruded surfaces: select a profile, specify the extrusion direction, and define the start 
and end limits of the extrusion

Create revolution surfaces: select a profile, a rotation axis, and define the angular limits of 
the revolution surface

Create spherical surfaces: select the center point of the sphere, the axis-system defining the 
meridian and parallel curves, and define the angular limits of the spherical surface

Create cylindrical surfaces: select the center point of the circle and specify the extrusion 
direction.

Create offset surfaces: select the surface to be offset, enter the offset value and specify the 
offset direction

Create variable offset surfaces: select the surface to be offset, select the surfaces to remove 
and specify a constant or variable offset direction

Create rough offset surfaces: select the surface to be offset, enter the offset value and 
specify the deviation

Create swept surfaces: select one or more guiding curves, the profile to be swept, possibly a 
spine, reference surface, and start and end values

Create adaptive swept surfaces: select a guiding curve, a profile to be swept, points to define 
more sections if needed, set the constraints on each section, and choose a spine

Create fill surfaces: select curves, or surface edges,  forming a closed boundary, and specify 
the continuity type

Create multi-sections surfaces: select two or more planar section curves, possibly guide 
curves and a spine, and specify tangency conditions

Create blend surfaces: select two curves, and possibly their support, specify the tension, 
continuity, closing point and coupling ratio, if needed

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/sdgugbt0202.htm
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Creating Extruded Surfaces

 
This task shows how to create a surface by extruding a profile along a given direction.

 
Open the Extrude1.CATPart document.

 
1.  Click the Extrude icon  .

The Extruded Surface Definition dialog box 
appears. 

2.  Select the Profile to be extruded 

and specify the desired extrusion 

Direction.

You can select a line to take its 
orientation as the extrusion 
direction or a plane to take its 
normal as extrusion direction. 

 

 
You can also specify the direction by means 
of X, Y, Z vector components by using the 
contextual menu on the Direction area.
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3.  Enter length values or use the 

graphic manipulators to define the 

start and end limits of the 

extrusion.

4.  Click OK to create the surface.

The surface (identified as 

Extrude.xxx) is added to the 

specification tree.

You can click the Reverse Direction button to display the extrusion on the other side of the 

selected profile or click the arrow in the 3D geometry.

 
Parameters can be edited in the 3D geometry. For further information, refer to the Editing 
Parameters chapter.

 

 



Creating Revolution Surfaces 

 
This task shows how to create a surface by revolving a planar profile about an axis.

 
Open the Revolution1.CATPart document.

 
1.  Click the Revolve icon  .

The Revolution Surface Definition dialog 

box appears. 

 

2.  Select the Profile and a line indicating 

the desired Revolution axis.

3.  Enter angle values or use the graphic 

manipulators to define the angular limits 

of the revolution surface.
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4.  Click OK to create the surface.

The surface (identified as Revolute.xxx) is added 
to the specification tree. 

●     There must be no intersection between the axis and the profile. However, if the result is 
topologically consistent, the surface will still be created.

●     If the profile is a sketch containing an axis, the latter is selected by default as the 
revolution axis. You can select another revolution axis simply by selecting a new line.

 
Parameters can be edited in the 3D geometry. To have further information, please refer to the 
Editing Parameters chapter.

 

 



Creating Spherical Surfaces

 

This task shows how to create surfaces in the shape of a sphere.
The spherical surface is based on a center point, an axis-system defining the meridian & 
parallel curves orientation, and angular limits.

 
Open the Sphere1.CATPart document.

 
1.  Click the Sphere icon  from the 

Extrude-Revolution toolbar.

The Sphere Surface Definition dialog 

box is displayed. 

2.  Select the center point of the sphere.

3.  Select an axis-system.

This axis-system determines the 

orientation of the meridian and 

parallel curves, and therefore of the 

sphere. 

By default, if no axis-system has 
been previously created in the 
document, the axis-system is the 
document xyz axis-system. 
Otherwise the default axis-system is 
the current one.
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4.  Click Preview to preview the surface.

5.  Modify the Sphere radius and  the 

Angular Limits as required. 

Here we choose -90° and 90° for the 

parallel curves, and 240° and 0° for the 

meridian curves, and left the radius at 

20 mm.

 

Parallel angular limits are comprised within the -90° and 90° range.
Meridian angular limits are comprised within the -360° and 360° range.

6.  Click OK to create the spherical surface.

The spherical surface (identified as Sphere.xxx) is added to the specification tree.

You can also choose to create a whole sphere. 

In this case, simply click the  icon from the 

dialog box to generate a complete sphere, 
based on the center point and the radius. The 
parallel and meridian angular values are then 
grayed.

 
Parameters can be edited in the 3D geometry. To have further information, please refer to the 
Editing Parameters chapter.

 

 



Creating Cylindrical Surfaces

 
This task shows how to create a cylinder by extruding a circle along a given direction.

 
Open the Cylinder1.CATPart document.

 
1.  Click the Cylinder icon  .

The Cylinder Surface Definition dialog box appears. 

 
2.  Select the Point that gives the center of the circle to be extruded and specify the desired Direction of the cylinder axis.

You can select a line to take its orientation as the direction or a plane to take its normal as direction. 

You can also specify the direction by means of X, Y, Z vector components by using the contextual menu on the 

Direction area.

3.  Select the Radius of the cylinder.

4.  Enter values or use the graphic manipulators to define the start and end limits of the extrusion.

 

 
5.  You can click the Reverse Direction button to display the direction of the cylinder on the other side of the selected point 

or click the arrow in the 3D geometry.

6.  Click OK to create the surface.

The surface (identified as Cylinder.xxx) is added to the specification tree.
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Creating Offset Surfaces

This task shows you how to create a surface, or a set of surfaces, by offsetting an existing surface, or a set of surfaces.
It can be any type of surface, including multi-patch surfaces resulting from fill or any other operation.

Open the Offset1.CATPart document.

 
1.  Click the Offset icon .

The Offset Surface Definition dialog box appears. 

2.  Select the Surface to be offset.

An arrow indicates the proposed direction for the 

offset.

3.  Specify 200mm as the Offset value.

4.  Click Preview to preview the offset surface.

The offset surface is displayed normal to the 
reference surface. 

5.  Click OK to create the surface.

The surface (identified as Offset.xxx) is added to the specification tree.

 

Depending on the geometry configuration and the offset value, an offset may not be allowed as it would result in a debased 
geometry. In this case, you need to decrease the offset value or modify the initial geometry.

The Parameters tab allows you to:

●     display the offset surface on the other side of the 
reference surface by clicking either the arrow or the 
Reverse Direction button.
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●     define the smoothing:
❍     None: the smoothing is constant

❍     Automatic (you can use the Offset3.CATPart 
document): a local smoothing is applied only if the 
constant offset cannot be performed. It cleans the 
geometry of the surface and enables the offset.
A warning panel is launched and the modified surface 
is shown in the 3D geometry.
If a surface still cannot be offset, no smoothing is 
performed and a warning message is issued (as in the 
constant offset mode).

●     generate two offset surfaces, one on each side of the 
reference surface, by checking the Both sides option.

●     create several offset surfaces, each separated from the 
initial surface by a multiple of the offset value, by 
checking the Repeat object after OK option.
Simply indicate in the Object Repetition dialog box the 
number of instances that should be created and click OK.
Remember however, that when repeating the offset it 
may not be allowed to create all the offset surfaces, if it 
leads to debased geometry.

●     Would the value be inconsistent with the selected 
geometry, a warning message is displayed, along with a 
warning sign onto the geometry. If you move the pointer 
over this sign, a longer message is displayed to help you 
continue with the operation.

Furthermore, the manipulator is locked, and you need to 
modify the value within the dialog box and click Preview.

●     The options set in the dialog box are retained when exiting then returning to the Offset function.

●     When you modify an input value through the dialog box, such as the offset value or the direction, the result is computed only 
when you click on the Preview or OK buttons.

 
Removing Sub-Elements

The Sub-Elements to remove tab helps you for the analysis in case the offset encounters a problem.

 
Open the Offset2.CATPart document.

 
1.  Perform steps 1 to 4.

2.  Click Preview.
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The Warning dialog box appears, the geometry shows the 
erroneous sub-elements, and flag notes display sub-elements 
to remove.

 
3.  Click Yes to accept the offset.

 

In the Offset Surface Definition dialog box, the Sub-Elements 
to remove tab lists the erroneous sub-elements and a 
preview of the offset is displayed.

●     If you move the mouse over a flag note, a longer message giving an accurate diagnosis is displayed.

●     You can remove a sub-element by right-clicking it and choosing Clear Selection from the contextual menu.

  
The following modes are optional, you may use them if you need to add or remove a sub-element to create the offset. 

●     Add Mode: 
when you click an unlisted element in the geometry, it is added to the list 
when you click a listed element, it remains in the list

●     Remove Mode: 
when you click an unlisted element in the geometry, the list is unchanged 
when you click a listed element, it is removed from the list

 

If you double-click the Add Mode or Remove Mode button, the chosen mode is permanent, i.e. successively selecting elements will 
add/remove them. However, if you click only once, only the next selected element is added or removed.
You only have to click the button again, or click another one, to deactivate the mode.

The list of sub-elements to remove is updated each time an element is added. 
Note that if you modify an input in the Offset dialog box, the list is re-initialized.

4.  Click Preview.

The offset surface is displayed normal to the reference 

surface.

5.  Click OK to create the surfaces.

The surfaces (identified as Offset.xxx) are added to 

the specification tree.



Performing a Temporary Analysis
While in the Offset command, you can perform a temporary analysis in order to check the connections between surfaces or curves.

Open the Offset4.CATPart document.

1.  Perform steps 1 to 4 (set 20mm as the Offset value).

2.  Click Preview.

The Temporary Analysis icon is available from the Tools toolbar.

3.  Click the Temporary Analysis mode icon .

4.  Select the analysis to be performed in the Analysis toolbar by clicking either the Connect checker icon  or the Curve 

connect checker icon .

5.  Click OK in the Connect checker or Curve connect checker dialog box.

You must activate the temporary analysis mode before 
running any analysis. Otherwise, a persistent analysis will be 
performed. 
The Temporary Analysis node is displayed in the specification 
tree and the associated analysis (here Curve Connection 
Analysis.1) appears below. 

 The analysis is not persistent. Thus when you click OK in the Offset Definition dialog box to create the curve, the Temporary Analysis 
node disappears from the specification tree.

 
An option is available from Tools -> Options to let you automatically set the analysis as temporary. Refer to the Customizing 

section.

Parameters can be edited in the 3D geometry. To have further information, refer to the Editing Parameters chapter.
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Creating Swept Surfaces
You can create a swept surface by sweeping out a profile in planes normal to a spine curve while 
taking other user-defined parameters (such as guide curves and reference elements) into account.

You can sweep an explicit profile:

●     along one or two  guide curves (in this case the first guide curve is used as the spine by default)

●     along one or two guide curves while respecting a specified spine.

The profile is swept out in planes normal to the spine.

In addition, you can control the positioning of the profile while it is being swept by means of a  
reference surface.
The profile position may be fixed with respect to the guide curve (positioned profile) or user-defined 
in the first sweep plane. 

You can sweep an implicit linear profile along a spine. This profile is defined by:

●     two guide curves and two length values for extrapolating the profile

●     a guide curve and a middle curve

●     a guide curve, a reference curve, an angle and two length values for extrapolating the profile

●     a guide curve, a reference surface, an angle and two length values for extrapolating the profile

●     a guide curve, and a reference surface to which the sweep is to be tangent

●     a guide curve and a draft direction

You can sweep an implicit circular profile along a spine. This profile is defined by:

●     three guide curves

●     two guide curves and a radius value

●     a center curve and two angle values defined from a reference curve (that also defines the radius)

●     a center curve and a radius.

You can sweep an implicit conical profile along a spine. This profile is defined by:

●     three guide curves

●     two guide curves and a radius value

●     a center curve and two angle values defined from a reference curve (that also defines the radius)

●     a center curve and a radius.
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●     Generally speaking, the sweep operation has a derivative effect, meaning that there may 
be a continuity loss when sweeping a profile along a spine. If the spine presents a 
curvature continuity, the surface presents at least a tangency continuity. If the spine 
presents a tangency continuity, the surface presents at least a point continuity.

 

●     Generally speaking, the spine must present a tangency continuity.
However, in a few cases, even though the spine is not tangent continuous, the swept 
surface is computed:

❍     when the spine is by default the guide curve and is planar, as the swept surface is 
extrapolated then trimmed to connect each of its segments. Note that if a spine is 
added by the user, the extrapolation and trim operations are not performed.

❍     when consecutive segments of the resulting swept surface do not present any gap.

 

 
Tangency discontinuous spine
with connex swept segments

(the sweep is created)

Tangency discontinuous spine
with non connex swept segments

(the sweep is not created)

 

Defining Laws for Swept Surfaces 
Whatever the type of sweep, 
whenever a value is requested 
(angle or length) you can click 
the Law button to display the 
Law Definition dialog box. It 
allows you to define your own law 
to be applied rather than the 
absolute value.



The Law Viewer allows you to:

- visualize the law evolution and 

the maximum and minimum 

values,

- navigate into the viewer by 

panning and zooming (using to 

the mouse),

- trace the law coordinates by 

using the manipulator,

- change the viewer size by 

changing the panel size

- reframe on by using the viewer 

contextual menu

- change the law evaluation step 

by using the viewer contextual 

menu (from 0.1 (10 evaluations) 

to 0.001 (1000 evaluations)).

 

Four law types are available:

a. Constant: a regular law, only one value is needed.
b. Linear: a linear progression law between the Start and End indicated values
c. S type: an S-shaped law between the two indicated values
d. Advanced: allowing to select a Law element as defined in Creating Laws. 

Check the Inverse law button to reverse the law as defined using the above options.

You can also apply laws created with the Knowledge Advisor workbench to swept surfaces. 



 The law can be negative, providing the curves are curvature continuous.

 
 

 Removing Twisted Areas
During creation or edition, you can now generate swept surfaces that have a twisted area by 
delimiting the portions of the swept surface to be kept. The generated surface is therefore 
composed of several unconnected parts.

    
This capability is available with all types of swept surfaces, except for the With tangency 
surface and With two tangency surfaces subtypes of the linear profile, and the One guide 
and tangency surface and With two surfaces subtypes of the circular profile.

Open the Sweep-Twist.CATPart document.

 Let's take an example by creating a swept surface with an implicit linear profile.

1.  Click the Sweep icon .

The Swept Surface Definition dialog box appears.

2.  Click the Line profile icon and choose the With Reference surface subtype.

3.  Select Curve.1 as the Guide Curve 1.

4.  Select the xy plane as the reference surface.
5.  Define a Length 1 of 30 mm and a Length 2 of 10 mm.

6.  Click Preview.

 An error message displays 
asking you to use a guide 
with a smaller curvature.

7.  Click OK in the 

dialog box.
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 Two manipulators 
("cutters") appear for 
each untwisted zone. 
Their default positions are 
the maximal zone 
delimiters out of which 
they cannot be dragged. 
This maximal zone 
corresponds to the larger 
untwisted portion of the 
swept surface.

8.  Use these 

manipulators to 

delimit the 

portions of the 

swept surface you 

want to keep. 

These cutters are 

stored in the 

model as points on 

curve with ratio 

parameters when 

the guide curve is 

not closed. 

We advise you to cut a bit 
less than the maximal 
zone to delimit a safety 
area around the twisted 
portion.
A contextual menu is 
available on the 
manipulators:

●     Reset to initial 

position: sets the 

manipulators back to 

their default positions, 

thqt is the position 

defined as the 

maximal zone.



●     Remove twisted 
areas management: 
removes the 
manipulators and 
performs the swept 
surface generation 
again.

 

9.  Click Preview 

again in the Swept 

Surface Definition 

dialog box.

The swept 
surface is 
generated.

     
 

10.  Click OK to create 

the swept surface.



●     If you modify the length value after clicking Preview, and the swept surface to be 

generated has no twisted area, the generated swept surface will still be cut. Use the 

Remove twisted areas management option to start the operation again.

●     As the generated surface is composed of several unconnected part, the Multi-result 

management dialog box opens. For further information,  refer to the Managing Multi-Result 

Operations chapter.



Creating Swept Surfaces Using an Explicit Profile

This task shows you how to create swept surfaces that use an explicit profile. These profiles must not be T- or H-shaped profiles.

 The following sub-types are available:
●     With reference surface

●     With two guide curves

●     With pulling direction

 

You can use the wireframe elements shown in this figure.

Open the Sweep1.CATPart document.

 

 

1.  Click the Sweep icon .

The Swept Surface Definition dialog box appears.

2.  Click the Explicit profile icon, then use the drop-down list to choose the subtype.

 
With reference surface

 

●     Select the Profile to be swept out (DemoProfile1).

●     Select a Guide curve (DemoGuide1).

●     Select a surface (by default, the reference surface is the mean 

plane of the spine) in order to control the position of the profile 

during the sweep.

Note that in this case, the guiding curve must lie completely on 

this reference surface, except if it is a plane. You can impose 

an Angle on this surface.
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With two guide curves

 

●     Select the Profile to be swept out (DemoProfile1).

●     Select a first Guide curve (DemoGuide1).

●     Select a second Guide curve (DemoGuide2).

 

 



 

You can also specify anchor points for each guide. These anchor points are intersection points between the guides and the profile's 
plane or the profile itself, through which the guiding curves will pass.

There are two anchoring types:

●     Two points: select anchor points on the profile which will be matched respectively to Guide Curve 1 and 2.
If the profile is open, these points are optional and the extremities of the profile are used.

●     Point and direction: select an anchor point on the profile which will be matched onto Guide Curve 1 and an anchor direction.
In each sweeping plane, the profile is rotated around the anchor point so that the anchor direction (linked to this profile) is 
aligned with the two guide curves, from Guide Curve 1 to Guide Curve 2.

 

 

 
Sweep without positioning
Two points anchoring type

 

 
Sweep without positioning
Point and direction anchoring type

If the profile is manually positioned defining anchor points will position the profile between the guides, matching the anchor points 
with guide intersection points, prior to performing the sweeping operation.



 

 
With pulling direction
The With pulling Direction subtype is equivalent to the With reference surface subtype with a reference plane normal to the pulling 
direction.

 

●     Select the Profile to be swept out (DemoProfile1).

●     Select a first Guide curve (DemoGuide1).

●     Select a Direction.

 

 
Check the Projection of the guide curve as spine option so that the projected spine is the projection of the guide curve onto the 

reference plane.

●     This option is not available with the Two guides sub-type. 

●     It is available with the Reference surface sub-type if the reference surface is a plane.

●     It is available with the Pulling direction sub-type.



 

3.  If needed, select a Spine.

If no spine is selected, the guide curve is implicitly used as 

the spine.

Here is an example with a linear spline.

You can define spine relimiters (points or planes) in order to 
longitudinally reduce the domain of the sweep, if the swept surface 
is longer than necessary for example. 

Besides is an example with a plane as Relimiter 1.
When there is only one relimiter, you are able to choose the 
direction of the sweep by clicking the green arrow.

●     Relimiters can be selected on a closed curve (curve, spine, or 
default spine). In that case, you are advised to define points as 
relimiters, as plane selection may lead to unexpected results 
due to multi-intersection.

●     You can relimit the default spine, thus avoiding to split it to 
create the sweep.

●     You can stack the creation of the elements by using the 
contextual menu available in either field. 

●     In the Smooth sweeping section, you can check: 
❍     the Angular correction option to smooth the sweeping 

motion along the reference surface.  This may be necessary 
when small discontinuities are detected with regards to the 
spine tangency or the reference surface's normal. The 
smoothing is done for any discontinuity which angular 
deviation is smaller than 0.5 degree, and therefore helps 
generating better quality for the resulting swept surface.

❍     the Deviation from guide(s) option to smooth the 
sweeping motion by deviating from the guide curve(s).

4.  If you want to manually position the profile, click the 

Position profile  check button.

You can then directly manipulate the profile using the 

graphic manipulators in the geometry, or  access 

positioning parameters clicking on the Show 

Parameters>> button. 

These parameters allow you to position the profile in the 

first sweep plane. 
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●     Specify a positioning point in the first sweep plane by either entering coordinates or selecting a point.

●     Specify the x-axis of the positioning axis system by either selecting a line or specifying a rotation angle.

●     Select the X-axis inverted check box to invert the x-axis orientation (while keeping the y-axis unchanged).

●     Select the Y-axis inverted check box to invert the y-axis orientation (while keeping the x-axis unchanged).

●     Specify an anchor point on the profile by selecting a point. This anchor point is the origin of the axis system that is associated 
with the profile.

●     Specify an axis direction on the profile by selection a direction. If no anchor direction was previously defined, the x-axis of the 
positioning axis system is used to join the extremities of the profile. The x-axis is aligned with the reference surface.

Reference Surface Two Guides

 

This option is P2 only.

If you want to go back to the original profile, uncheck the Position profile button.

5.  Click OK to create the swept surface.

The surface (identified as Sweep.xxx) is added to the specification tree.

It is not mandatory that the profile be a sketch.

Parameters can be edited in the 3D geometry. To have further information, please refer to the Editing Parameters chapter.
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Creating Swept Surfaces Using a Linear Profile

 
This task shows how to create swept surfaces that use an implicit linear profile.

The following subtypes are available:
●     Two limits

●     Limit and middle

●     With reference curve

●     With reference surface

●     With tangency surface

●     With draft direction

●     With two tangency surfaces

Open the Sweep1.CATPart document.

 
1.  Click the Sweep icon .

The Swept Surface Definition dialog box appears.

2.  Click the Line profile icon, then use the drop-down list to choose the subtype.

 

Two limits:
●     Select two guide curves.

●     You can enter one or two length values to define the width 
of the swept surface.

file:///E|/www/spuCXR14/SdgEnglish/sdgug.doc/src/samples/Sweep1.CATPart


●     Select two guide curves.

●     Select the Limit and middle option from the list to use 
the second guide curve as middle curve. 

Checking the Second curve as middle curve button 
automatically selects this mode.

 

With reference surface:
●     Select a guide curve, a reference surface,  and key in an 

angle value.
The guiding curve must lie completely on this reference 
surface, except if the latter is a plane.

●     You can enter one or two length values to define the width 
of the swept surface.

 

Limit and middle:



 

With tangency surface:
●     Select a guide curve, and a reference surface to which the 

sweep is to be tangent.

●     Depending on the geometry, there may be one or two 
solutions from which to choose, either by clicking on the 
solution displayed in red (inactive) or using the Next 
button. 

 

Check the Trim with tangency surface to perform a trim 
between the swept surface and the tangency surface. The part 
of the tangency surface that is kept is chosen so that the final 
result is tangent.   

 

 Choosing Solution 2 Solution 2 with Trim option

 

With two tangency surfaces:

 

With reference curve:
●     Select a guide curve, a reference curve, and key in an 

angle value.

●     You can enter one or two length values to define the width 
of the swept surface.



Open the Sweep5.CATPart document.

 
●     Select a spine, and two tangency surfaces.

 

Check the Trim with tangency surface to perform a trim 
between the swept surface and the tangency surface. The part 
of the tangency surface that is kept is chosen so that the final 
result is tangent.

 

 Swept surface without trim Trim with both surfaces

 

Trim with first tangency surface Trim with second tangency surface

In any of the above cases, you can select a spine using the Spine field if you want to specify a spine different from the first guide curve.
If no spine is selected, the guide curve is implicitly used as the spine.

 
Defining Relimiters

 You can define relimiters (points or planes) in order to 
longitudinally reduce the domain of the sweep, if the swept 
surface is longer than necessary for example.

 Besides is an example with a plane as Relimiter 1.
When there is only one relimiter, you are able to choose the 
direction of the sweep by clicking the green arrow.
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●     Relimiters can be selected on a closed curve (curve, spine, 
or default spine). In that case, you are advised to define 
points as relimiters, as plane selection may lead to 
unexpected results due to multi-intersection.

●     You can relimit the default spine, thus avoiding to split it to 
create the sweep.

●     You can stack the creation of the elements by using the 
contextual menu available in either field

This option is available with the Draft direction sweep type.

●     In the Smooth sweeping section, you can check: 
❍     the Angular correction option to smooth the sweeping 

motion along the reference surface.  This may be 
necessary when small discontinuities are detected with 
regards to the spine tangency or the reference surface's 
normal. The smoothing is done for any discontinuity 
which angular deviation is smaller than 0.5 degree, and 
therefore helps generating better quality for the 
resulting swept surface

❍     the Deviation from guide(s) option to smooth the 
sweeping motion by deviating from the guide curve(s).
A curve smooth is performed using correction default 
parameters in tangency and curvature.
This option is not available for with tangency surface 
subtype.

3.  Click OK to create the swept surface.

The surface (identified as Sweep.xxx) is added to the specification tree.

 
Click the Law button if you want a specific law to be applied rather that the absolute angle value. See Defining Laws for Swept Surfaces.

Parameters can be edited in the 3D geometry. To have further information, please refer to the Editing Parameters chapter.

 

With draft direction:

Open the Sweep6.CATPart document.

●     Select a guide curve and a draft direction (a line, a plane or 
components), 

❍     Select the draft computation mode: 
■     Square: equivalent to implicit linear profile swept 

surface with reference surface, using a plane normal 
to the draft direction as reference surface, and the 
projection of the guide curve onto this plane as 
spine

■     Cone: envelop of cones defined along a given curve. 
In order to have swept start and end planes similar 
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as the square mode, the guide curve needs to be 
extrapolated and the resulting surface split as 
explained in the following figure.

❍     Choose the angular definition: 
■     Wholly defined: the angular value varies during 

the whole sweeping operation

■     G1-Constant: a different draft value for every G1 
section can be set; in this case, a relimiting plane is 
requested when defining lengths

■     Location values: on given points on the curve, 
angular values can be defined.

 

In the Wholly defined tab, you can click the Law... button to 
display the Law Definition dialog box. The 2D viewer enables 
you to previsualize the law evolution before applying it.

1.  Enter Start and End values.
2.  Choose the law type to be applied to the pitch.

Four law types are available: 

a. Constant: a regular law, only one value is needed.
b. Linear: a linear progression law between the Start and End 
indicated values
c. S type: an S-shaped law between the two indicated values
d. Advanced: allowing to select a Law element as defined in 
Creating Laws. 

For the S type pitch, you need to define a second pitch value. 
The pitch distance will vary between these two pitch values, 
over the specified number of revolutions.

The Law Viewer allows you to:
- visualize the law evolution and the maximum and minimum 
values,
- navigate into the viewer by panning and zooming (using to 
the mouse),
- trace the law coordinates by using the manipulator,
- change the viewer size by changing the panel size
- reframe on by using the viewer contextual menu
- change the law evaluation step by using the viewer 
contextual menu (from 0.1 (10 evaluations) to 0.001 (1000 
evaluations)).

3.  Check the Inverse law button to reverse the law as 

defined using the above options.
4.  Click Close to return to the Swept Surface Definition 

dialog box.
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This option is available with both Square and Cone 
computation mode.

●     Choose the length types: 
❍     From curve: the swept surface starts from the curve

❍     Standard: the length is computed in sweeping planes

❍     From/Up to: the length is computed by intersecting a plane or a surface; a point can be selected: a plane parallel to the draft 
plane would be computed

❍     From extremum: the lengths are defined along  the draft direction from an extremum plane; L1 corresponds to the "maximum 
plane" in the draft direction,  L2 corresponds to the "minimum plane" in the draft direction

❍     Along Surface: The boundary opposite to the guide curve is computed: it is the exact euclidean parallel curve of the guide curve.

The location value tab is only available for a square computation mode and will work only on G1 curves.

The start (or end) section of the swept surface (in yellow) does 
not coincide with the expected relimiting plane (in green). As a 
consequence, the blue portion needed is missing.

Here are the steps performed to create the swept 
surface:

1.  The guide curve is extrapolated in curvature (pink 
curve)

2.  The result is split by the green plane to obtain the 
green end section.

As an information purpose, we put all the elements explaining 
the steps above in Open_body 2, so that you understand how 
the sweet surface is created.



1. In the example above, we selected the 
following values 

Curve.1 as guide curve
Plane.1 as draft direction
Square as computation mode
20deg as Wholly constant angle
Standard Length type
50mm as Length 1

2. In the example above, we selected the following 
values 

Curve.1 as guide curve
Plane.1 as draft direction
Square as computation mode
35deg as Wholly constant angle
From / Up To
Point 1 as Relimiting element 1
20mm as Length 2

3. In the example above, we selected the 
following values 

Curve.1 as guide curve
Plane.1 as draft direction
Cone as computation mode
25deg as Wholly constant angle
From Extremum type
50mm as Length 1

4. In the example above, we selected the following 
values 

Curve.1 as guide curve
Plane.1 as draft direction
Square as computation mode
20deg as Wholly constant angle
Along surface type
30mm as Length 1



Creating Swept Surfaces Using a Circular Profile

This command is only available with the Generative Shape Design 2 product.

This task shows how to create swept surfaces that use an implicit circular profile.

 The following subtypes are available:
●     Three guides

●     Two guides and radius

●     Center and two angles

●     Center and radius

●     Two guides and tangency surface

●     One guide and tangency surface

  

You can use the wireframe elements shown in this figure.

Open the Sweep1.CATPart document.

 

 

1.  Click the Sweep icon .

The Swept Surface Definition dialog box appears.

2.  Click the Circle icon, then use the drop-down list to choose the subtype.

 The two following cases are possible using guide curves.

 

Three guides:
●      Select three guide curves.
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●     Select a Center Curve and a Reference angle curve.
You can relimit the swept surface by entering two angle 
values.

In the example above, we selected a spine

 

 
Two guides and radius:

 

●     Select two guide curves and enter a Radius value.
You can then choose between four possible solutions by 
clicking the Other Solution button.

In the example above, the radius value is 45.

 The two following cases are possible using a center curve. 

 
Center and two angles:



In the example above, we selected the following values: 

Center curve: DemoGuide 3
Reference angle: DemoGuide 1

Angle 1: 0 deg
Angle 2: 60 deg

   

The two following cases are possible using a reference surface to which the swept surface is to be tangent:

 

Two guides and tangency surface:
●     Select two guide curves, and a reference surface to which 

the sweep is to be tangent.

●     Depending on the geometry, there may be one or two 
solutions from which to choose. The  solution displayed in 
red shows the active sweep.

 

Center and radius:
●     Select a Center Curve and enter a Radius value.



 

  Choosing a solution Resulting Sweep 

 

One guide and tangency surface:
●     Select a guide curves, a reference surface to which the 

sweep is to be tangent, and enter a radius value. 

 Check the Trim with tangency surface to perform a trim 
between the swept surface and the tangency surface. The part 
of the tangency surface that is kept is chosen so that the final 
result is tangent.

 

Choosing a solution

 

Resulting Sweep 

 



Sweep 2 with Trim option

In any of the above cases, you can select a spine using the Spine field if you want to specify a spine different from the first guide 
curve or center curve.

   

 Defining Relimiters

 You can define relimiters (points or planes) in order to 
longitudinally reduce the domain of the sweep, if the swept 
surface is longer than necessary for example.

 
Besides is an example with a plane as Relimiter 1.
When there is only one relimiter, you are able to choose the 
direction of the sweep by clicking the green arrow.

●     Relimiters can be selected on a closed curve (curve, spine, 
or default spine). In that case, you are advised to define 
points as relimiters, as plane selection may lead to 
unexpected results due to multi-intersection.

●     You can relimit the default spine, thus avoiding to split it to 
create the sweep.

●     You can stack the creation of the elements by using the 
contextual menu available in either field. 

In the Smooth sweeping section, you can check: 
●     the Angular correction option to smooth the sweeping motion along the reference surface.  This may be necessary when small 

discontinuities are detected with regards to the spine tangency or the reference surface's normal. The smoothing is done for any 
discontinuity which angular deviation is smaller than 0.5 degree, and therefore helps generating better quality for the resulting 
swept surface.

●     the Deviation from guide(s) option to smooth the sweeping motion by deviating from the guide curve(s).
A curve smooth is performed using correction default parameters in tangency and curvature.
This option is not available for One guide and tangency surface subtype.

3.  Click OK to create the swept surface.

The surface (identified as Sweep.xxx) is added to the specification tree.

 

Click the Law button if you want a specific law to be applied rather that the absolute angle value.
See Defining Laws for Swept Surfaces.
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Creating Swept Surfaces Using a Conical Profile

This command is only available with the Generative Shape Design 2 product.

 

This task shows how to create swept surfaces that use an implicit conical profile, such as parabolas, hyperbolas or ellipses
These swept surfaces are created based on guide curves and tangency directions. The latter can be defined either by the supporting 
surface or a curve giving the direction.

 The following sub-types are available:
●     Two guides

●     Three guides

●     Four guides

●     Five guides

Open the Sweep2.CATPart.

 
1.  Click the Sweep icon .

The Swept Surface Definition dialog box appears.

2.  Click the Conic icon, then use the drop-down to choose the subtype.

 

Two 
guides

  

●     Select two 
guide curves 
and their 
tangency 
supports, 
indicating an 
angle value in 
relation to the 
support, if 
needed.

●     Set the 
Parameter 
value. It is a 
ratio ranging 
from 0 to 1 
(excluded),  
and is used to 
define a 
passing point 
as described 
in Creating 
Conic Curves 
and illustrated 
in the 
diagram.

 

   
 

Three 
guides
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●     Select three 
guide curves, 
and the 
tangency 
supports for 
the first and 
last guides. If 
needed, 
indicate an 
angle in 
relation to the 
support.

     
 

Four 
guides

  

●     Select four 
guide curves 
and the 
tangency 
support for 
the first 
guide. 
If needed, 
indicate an 
angle in 
relation to the 
support.



   
 

Five 
guides

  

Open the 
Sweep3.CATPart.

●     Select five 
guide curves.

   
In any of the above cases, you can select a spine using the Spine field if you want to specify a spine different from the first guide curve 
or center curve.

   
 You can define relimiters (points or places) in order 

to longitudinally reduce the domain of the sweep, if 
the swept surface is longer than necessary for 
instance.

 Besides is an example with a plane as Relimiter 1.
When there is only one relimiter, you are able to 
choose the direction of the sweep by clicking the 
green arrow.

●     Relimiters can be selected on a closed curve 
(curve, spine, or default spine). In that case, you 
are advised to define points as relimiters, as 
plane selection may lead to unexpected results 
due to multi-intersection.

●     You can relimit the default spine, thus avoiding 
to split it to create the sweep.

●     You can stack the creation of the elements by 
using the contextual menu available in either 
field. 

Provided you are using two, three, or four guides, in the Smooth sweeping section, you can check: 
●     the Angular correction option to smooth the sweeping motion along the reference surface.  This may be necessary when small 

discontinuities are detected with regards to the spine tangency or the reference surface's normal. The smoothing is done for any 
discontinuity which angular deviation is smaller than 0.5 degree, and therefore helps generating better quality for the resulting swept 
surface.

●     the Deviation from guide(s) option to smooth the sweeping motion by deviating from the guide curve(s).

3.  Click OK to create the swept surface.

The surface (identified as Sweep.xxx) is added to the specification tree.

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/Sweep3.CATPart


 
Click the Law button if you want a specific law to be applied rather that the absolute angle value. See Defining Laws for Swept Surfaces.

 



Creating Adaptive Swept Surfaces

 

This task shows how to create swept surfaces that use an implicit profile and its constraints along a guiding curve.
These swept surfaces are created based on sections along the guiding curve and constraints that can be specified for each 
of these sections.

 The implicit profile is a sketch and as such supports the creation of associative sketch elements over multi-cell surfaces. 
This allows, when creating the swept surface, to impose a constraint over a multi-cell surface that is use as a construction 
element.

 When designing the profile to be swept, keep in mind that the constraints imposed on the sketched profile affect the 
resulting swept surface. For example, with the apparently similar sketch (only its construction differs, but there is a 
coincidence constraint between the sketch extremity and the point on the guiding curve) you can obtain the following 
results: 

Sketch  based on
the point (no coincidence constraint, but a 

geometric superimposition)

Sketch  based on 
the point

as the intersection 
of the sketch

and the guiding 
curve

Sketch  based on projection
of the point in 3D

 Similarly, it is best to use angle constraints rather than tangency or perpendicularity constraints, to avoid changes in the 
sketch orientation as it is swept along the guiding curve. In some cases, with tangency or perpendicularity constraints, the 
sketch may be inverted and lead to unsatisfactory results.

Open the AdaptiveSweep1.CATPart document.

 
1.  Click the Adaptive Sweep icon .

The Adaptive Sweep dialog box appears.
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2.  Select the Guiding curve (Sketch.5 here).

If no guiding curve already exists, use the contextual menu on the Guiding curve field  to create, either a line, 
or a boundary.

 

The Reference surface is optional. It is the surface on which the guiding curve lies and is used to define the axis system 

in which the swept surface is created.

In our example, may you wish to define a reference surface, select the xy plane. Otherwise the mean plane is used as 

default.

 If you choose a boundary as the guiding curve, the reference surface automatically is the surface to which the boundary 
belongs.
You can de-select a reference surface using the Clear Selection contextual menu on the Reference surface field.

3.  Select the Sketch to be swept along the guiding 

curve  (Sketch.4 here).

An axis-system is displayed defining the plane in 

which the first section is created. 

 

4.  Select the end point of the guiding curve to create 

another section.

The axis-system is displayed at this new section.

 

5.  Click the Sweep sections preview to have a quick 

wireframe preview of the adaptive sweep surface.

This option lets you see the evolution of the sketch along 

the guide curve.



 A contextual menu is available on the manipulators:

●     Create a section here: lets you create a section at 

the manipulator's place. A new point is dropped on the 

guide curve with the corresponding ratio. If the guide 

curve is closed, the created point is a 3D coordinates 

point.

●     Use Interpolated Manipulator: the interpolation 

value between the section parameters is computed. 

You can move the manipulator along the guide curve to 

visualize the parameters evolution.

The list in the Sections tab is automatically updated with:
●     the first section being at the intersection of the selected 

sketch and guiding curve

●     the second section at the selected point on the guiding 
curve.

 

●     Use the Remove current section icon, or choose the Remove Section contextual menu, to delete a section from 
the swept surface. The first section cannot be deleted.

●     Use the Rename current section icon, or choose the Rename Section contextual menu, to give a new - more 
explicit - name to any user section.

 
6.  Set the Deviation value: it corresponds to a point tolerance.

Decreasing this value increases the precision but leads to slower performances.

By default the value is 0.1mm (maximum value).

7.  Click Preview to preview the swept surface:

8.  Click the Parent tab to display the elements 

making up the sweep.

 



 
You can select one of the parents from the list and click the  icon, or choose the Replace parent 

contextual menu to choose a new parent for the swept surface.

9.  Click the Parameters tab to display and redefine 

the constraints on a given section.

Use the combo to choose Usersection.2. 

10.  Change the constraint value to 5mm, and click 

Apply.

The modified sweep is previewed.

 
The Moving Frame tab is used to display the spine, and 
possibly select a new one. 

Changing to this tab automatically activates the acquisition 
field of the spine.

 

 By default, the spine is the guiding curve.

11.  Click OK to create the swept surface.

The surface (identified as Adaptive sweep.xxx) is added to 
the specification tree.

 

Once you have selected the guiding curve, you can select an existing sketch or create one using the Create Sketch 
contextual menu on the Sketch field to start the sketcher within the adaptive sweep context.



In this case, the Sketch Creation for Adaptive 
Sweep dialog box is displayed, and allows you to 
define the construction elements for a new 
sketch in relation to existing geometry: 

1.  Select a point, used to position the sketch on the 
guiding curve, as well as the origin of the sketch.

2.  If needed, select construction elements (another 
guiding curve, support surfaces, and so forth).

3.  Click OK.

The selection in the geometry implies a global 
selection of the 3D elements.

The system automatically loads the Sketcher workbench, and provided the correct option is active, sets the 
sketch plane parallel to the screen. You can then define a new sketch. 

Once you exit the Sketcher, you return to the adaptive sweep command after the sketch selection, as described 
above in step 3.

This local definition of the sketch is particularly interesting as it allows to redefine the swept surface simply by 
editing the local sketch (add/remove construction elements, or constraints for example).

 

In this case, would you want to exit the Adaptive Sweep command, after having created the sketch using the Create 
Sketch contextual menu, yet retain the sketch itself, simply press the To cancel the command but keep the sketch 
button.

 

●     You also have the possibility to create your sketch using the Sketcher workbench before entering the Sweep 
command.
In this case, when you select the 3D construction elements, please be careful to select them directly 

●     To avoid unsatisfactory surface quality such as gaps between surfaces for example, you can perform one of the 
following:

1.  select a boundary on an adjacent surface as a constraining element when creating the sketch.
The selection of the boundary allows a better topological splitting, and therefore better quality for the created 
surface.

Swept surface (blue) without selected boundary Swept surface (blue) with selected boundary



2.  impose more sections along the guiding curve
3.  decrease the discretization step value

to better define the sweeping along the guiding curve.

 

 



Creating Fill Surfaces

 
This task shows how to create fill surfaces between a number of boundary segments.

Open the Fill1.CATPart document.

 
1.  Click the Fill icon .

The Fill Surface Definition dialog box appears.

2.  Select curves or surface edges to form a closed 

boundary.

You can select a support surface for each curve or edge. 
In this case continuity will be assured between the fill 
surface and selected support surfaces.

3.  Use the combo to specify the desired continuity 

type between any selected support surfaces and 

the fill surface:

●     Point

●     Tangent, or

●     Curvature continuity.

  The fill surface is displayed within the boundary.
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4.  You can edit the boundary by first selecting an element in the dialog box list then choosing a button to either:

●     Add a new element after or before the selected one

●     Remove the selected element

●     Replace the selected element by another curve

●     Replace the selected support element by another support surface

●     Remove the selected support element.

5.  Click in the Passing point field, and select a point.

This point is a point through which the filling surface must pass, thus adding a constraint to its creation. 

However, you may need to alleviate the number of constraints by removing the supports.

 
This point should lie within the area delimited by the selected curves. If not, the results may be inconsistent.

The Planar Boundary Only check box allows you to fill only planar boundaries, when the boundary is defined by one curve 

on one surface.

6.  Click OK to create the fill surface.

The surface (identified as Fill.xxx) is added to the specification tree.

 

Filling surface without specified supports Filling surface with a passing point and no specified supports



Filling surface with specified supports (Extrude 1 and 
Extrude 2) and a tangency continuity

Filling surface with a passing point, specified supports (Extrude 
1 and Extrude 2) and a tangency continuity 

 

●     The selected curves or surface edges can intersect. 
Therefore a relimitation of the intersecting boundaries 
is performed to allow the creation of the fill surface.

Two consecutive boundaries must have only one 
intersection.
Selected curves cannot be closed curves.

 
●     The selected curves or surfaces edges can have non-coincident boundaries. Therefore, an extrapolation is performed to 

allow the creation of the fill surface.

The distance between non-coincident boundaries must be smaller than 0.1mm.

 

A two-side fill surface cannot be created in the following 
ambiguous cases:

 

 

●     one intersection and two distances below 0.1 mm



 

 

●     no true intersection (therefore there may be several 
distances below 0.1 mm)

 



Creating Multi-sections Surfaces 

 

This task shows how to create a multi-sections surface and includes the following functionalities: 

●     Relimitation

●     Planar Surface Detection

●     Coupling

You can generate a multi-sections surface by sweeping two or more section curves along an automatically 
computed or user-defined spine. The surface can be made to respect one or more guide curves. 

 
Open the Loft1.CATPart document.

1.  Click the Multi-sections Surface icon  .

The Multi-sections Surface Definition 
dialog box appears.

2.  Select two or more planar section curves.

The curves must be continuous in point.

You can select tangent surfaces for the 
start and end section curves. These 
tangent surfaces must not be parallel to 
the sections.

A closing point can be selected for a 
closed section curves. 

Example of a multi-sections surface defined by three planar 
sections: 

 

3.  If needed, select one or more guide curves.

Guide curves must intersect each section 

Example of a multi-sections surface defined by 2 planar 
sections and 2 guide curves: 

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/Loft1.CATPart


curve and must be continuous in point.

The first guide curve will be a boundary of 
the multi-sections surface if it intersects 
the first extremity of each sections curve.

Similarly, the last guide curve will be a 
boundary of the multi-sections surface if it 
intersects the last extremity of each 
section curve. 

 

You can make a multi-sections surface tangent to an adjacent surface by selecting an end section that lies on the 
adjacent surface. In this case, the guides must also be tangent to the surface. 

In Figure 2 a multi-sections surface tangent to the existing surface has been created:

Figure 1
Figure 2

You can also impose tangency conditions by specifying a direction for the tangent vector (selecting a plane to take 
its normal, for example). This is useful for creating parts that are symmetrical with respect to a plane. Tangency 
conditions can be imposed on the two symmetrical halves.
Similarly, you can impose a tangency onto each guide, by selection of a surface or a  plane (the direction is tangent 
to the plane's normal). In this case, the sections must also be tangent to the surface.

4.  In the Spine tab page, select the Spine check box to use a spine that is automatically computed by the 

program or select a curve to impose that curve as the spine. 

Note that the spine curve must be normal to each section plane and must be continuous in tangency.

You can create multi-sections surface surfaces between closed section curves. These curves have point continuity at 
their closing point.
This closing point is either a vertex or an extremum point automatically detected and highlighted by the system. 
By default, the closing points of each section are linked to each other.

The red arrows in the figures below represent the closing points of the closed section curves. You can change the 
closing point by selecting any point on the curve.  



The surface is twisted A new closing point has been imposed
to get a non-twisted surface

 
Extremum points are now aggregated under the 
parent command that created them and put in no 
show in the specification tree.

In the Smooth parameters section, you can check: 
●     the Angular correction option to smooth the 

lofting motion along the reference guide curves. 
This may be necessary when small 
discontinuities are detected with regards to the 
spine tangency or the reference guide curves' 
normal. The smoothing is done for any 
discontinuity which angular deviation is smaller 
than 0.5 degree, and therefore helps generating 
better quality for the resulting multi-sections 
surface.

●     the Deviation option to smooth the lofting 
motion by deviating from the guide curve(s).

5.  It is possible to edit the multi-sections 

surface reference elements by first selecting 

a curve in the dialog box list, or by selecting 

the text on the figure, then choosing a 

button to either:

●     remove the selected curve

●     replace the selected curve by another curve

●     add another curve



More possibilities are available with the contextual 
menu and by right-clicking on the red text or on the 
object. For example, it is possible to remove and 
replace tangent surfaces and closing points.

 
The following example illustrates the result when the tangency condition is removed between the blue multi-
sections surface and the adjacent surface.



6.  Click OK to create the multi-sections surface.

The surface (identified as Multi-sections Surface.xxx) is added to the specification tree.

●     Sections can be 3D curves with following restrictions: 
❍     the intersection between one 3D profile and all guides must be coplanar (if three guides or more are 

defined)

❍     in case of a user-defined spine, this spine must be normal to the plane implicitly obtained above.

Relimitation 
The Relimitation tab lets you specify the 
relimitation type. (Open the Loft3.CATPart 
document).
You can choose to limit the multi-sections 
surface only on the Start section, only on 
the End section, on both, or on none. 

a.  when one or both are checked: the multi-sections surface is limited to corresponding section
b.  when one or both are when unchecked: the multi-sections surface is swept along the spine: 

❍     if the spine is a user spine, the multi-sections surface is limited by the spine extremities

❍     if the spine is an automatically computed spine, and no guide is selected:
the multi-sections surface is limited by the start and end sections 

❍     if the spine is an automatically computed spine, and guides are selected:
the multi-sections surface is limited by the guides extremities.

 

Multi-sections surface relimitation option checked
 on both Start and End section

 

Multi-sections surface relimitation option unchecked
 on End section only

After the multi-sections surface is relimited, the following constraint needs to be fulfilled: the plane normal to the 
spine defined at the relimitation point must intersect the guide(s) and the point(s) resulting from this intersection 
must belong to the section.

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/Loft3.CATPart


Planar Surface Detection
●     Use the Canonical portion detection check 

button in the Canonical Element tab to 
automatically detect planar surfaces to be used 
as planes for features needing one in their 
definition.

Initial multi-sections surface with planar faces Using a planar face as reference for a sketch

Resulting sketch

 

Coupling

 

This task presents the two kinds of coupling during the creation of the multi-sections surface surface: 
●     coupling between two consecutive sections

●     coupling between guides

These couplings compute the distribution of isoparameters on the surface.

 
Open the Loft2.CATPart document.
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Coupling between two consecutive 
sections

This coupling is based on the curvilinear abscissa.

1.  Click the Multi-sections Surface icon  .

The Multi-sections Surface Definition 
dialog box appears.

2.  Select the two consecutive sections.

3.  Click OK to create the multi-sections surface.

If you want to create a coupling between particular 
points, you can add guides or define the coupling 
type.



Coupling between guides

This coupling is performed by the spine.
If a guide is the concatenation of several curves, the resulting multi-sections surface will contain as many surfaces 
as curves within the guide.

 

Several coupling types are available, depending on 
the section configuration: 

●     Ratio: the curves are coupled according to the 
curvilinear abscissa ratio.



●     Tangency: the curves are coupled according to 
their tangency discontinuity points. If they do 
not have the same number of points, they 
cannot be coupled using this option. 

 
●     Tangency then curvature: the curves are coupled according to their tangency continuity first then curvature 

discontinuity points. If they do not have the same number of points, they cannot be coupled using this option. 

●     Vertices: the curves are coupled according to their vertices. If they do not have the same number of vertices, 
they cannot be coupled using this option. 

Manual Coupling
If the number of vertices differ from one section to another, you need to perform a manual coupling.

1.  Select the sections for the multi-sections 

surface, and check their orientations.

2.  In the Coupling tab, choose the Tangency 

option and click Apply.

An error message is displayed as the 

number of discontinuity points on the first 

section is greater than on the other two 

sections.

The points that could not be coupled, are displayed 
in the geometry with specific symbol depending on 
the selected mode, along with coupling lines:

●     In Tangency mode: uncoupled tangency 
discontinuity points are represented by a square

 
●     In Tangency then curvature mode:  

❍     uncoupled tangency discontinuity points are 
represented by a square

❍     uncoupled curvatures discontinuity points are 
represented by a empty circle

●     In Vertices mode: uncoupled vertices are 
represented by a full circle



3.  Click in the coupling list, or choose Add 

coupling in the contextual menu, or using 

the Add button, and manually select a point 

on the first section.

The Coupling dialog box is displayed.

4.  Select a corresponding coupling point on 

each section of the multi-sections surface.

The Coupling dialog box is updated 

consequently, and the coupling curve is 

previewed, provided the Display 

coupling curves option is active.

When a coupling point has been defined 

on each section, this dialog box 

automatically disappears.

5.  Click OK.

The multi-sections surface is created as 
defined with the coupling specifications.

The same multi-sections surface without 
coupling and with Ratio option would have 
looked like this:

Note the increased number of generated 
surfaces.



●     You can create coupling point on the fly, using the Create coupling point contextual menu item (click on the 
document background to display the contextual menu) instead of selecting an existing point.

●     To edit the coupling, simply double-click the coupling name in the list (Coupling tab) to display the Coupling 
dialog box. Then you select the point to be edited from the list and create/select a replacing coupling point, then 
click OK.

●     Use the contextual menu on the coupling list to 
edit defined couplings.

 



Creating Blended Surfaces

 

This task shows how to create a blended surface, that is a surface between two wireframe elements, 
taking a number of constraints into account, such as tension, continuity, and so forth.

Several cases are worth surveying: 

●     blend between curves

●     blend between closed contours

●     coupling blend

 
Open the Blend1.CATPart document.

1.  Click the Blend icon  .

The Blend Surface Definition dialog 
box appears.

 

 
Blend between curves:

1.  Successively select the first curve and its support, then the second curve and its support.

These can be surface edges, or any curve.
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2.  Set the continuity type using the Basic 

tab.

It defines the continuity connection 

between the newly created surface and 

the curves on which it lies.

The illustration above, shows the 

Tangency continuity, and the 

following illustrations show the 

Point and Curvature continuity 

types:



 
Point continuity on both limits Curvature 

3.  Activate the Trim first/second 

support option, on one or both 

support surfaces to trim them by the 

curve and assemble them to the blend 

surface:

By default the blend surface borders 
are tangent to the support surface 
borders.

You can also specify whether and where the blend boundaries must be tangent to the 
supports boundaries:

●     Both extremities: the tangency constraint applies at both ends of the curve

●     None: the tangency constraint is disregarded 

●     Start extremity: the tangency constraint applies at the start endpoint of the curve 
only

●     End extremity: the tangency constraint applies at the end endpoint of the curve only

The Start and End extremities are defined according to the arrows in the blended surface's 
preview.



4.  Set the tension type using the Tension 

tab.

It defines the tension of the blend at 

its limits.

It can be constant or linear, and can 

be set for each limit independently.

 A third tension type is available: S Type. It 
enables to set a variable tension.

 
If you choose any of the tension types in the 

drop-down list, the Default button is 

deselected.

5.  Click OK. 

 
Blend between closed contours: 

 

1.  Successively select two contours.

2.  Click Preview.

The surface to be generated is twisted.

To avoid this you need to define a 

closing point.

By default, the system detects and highlights a vertex on each curve that can be used as a closing 
point, or it creates an extremum point (you can also manually select another one if you wish).

3.  Choose the Closing Point tab, and using the contextual menu, choose Create Projection.



 

4.  The Projection Definition dialog box is 

displayed.

5.  Select the closing point on the second 

contour, then the first curve onto 

which the point is to be projected.

6.  Click OK in the Projection Definition 

dialog box.

7.  Click OK in the Blend Definition dialog 

box.

The blend is correctly created. 

 
Coupling blend: 

 



1.  Select the elements to be blended and 

click Preview.

2.  Select the Coupling tab and define the 

coupling type.

●     Ratio: the curves are coupled according to the curvilinear abscissa ratio.

●     Tangency : the curves are coupled according to their tangency discontinuity points. If they do not 

have the same number of points, they cannot be coupled using this option. 

●     Tangency then curvature: the curves are coupled according to their tangency continuity first 

then curvature discontinuity points. If they do not have the same number of points, they cannot 

be coupled using this option. 

●     Vertices: the curves are coupled according to their vertices. If they do not have the same 

number of vertices, they cannot be coupled using this option. 



3.  Click in the coupling list, or choose 

Add coupling in the contextual menu, 

or using the Add button, and manually 

select a point on the first section.

The Coupling dialog box is 

displayed.

4.  Select a corresponding coupling point 

on each section.

The Coupling dialog box is updated 

consequently, and the coupling 

curve is previewed, provided the 

Display coupling curves option is 

active.

When a coupling point has been 

defined on each section, this dialog 

box automatically disappears.

5.  Click OK.

The surface (identified as Blend.xxx) is added to the specification tree.
●     Selecting a support is not compulsory.

●     You can create closing points using the contextual menu on the First or Second closing point 
fields in the dialog box, or using the contextual menu directly on one of the selected curves.

●     Use the Replace, Remove, or Reverse buttons, to manage the selected elements (curves, support, 
closing and coupling points).

●     You can also use the contextual menu on the texts displayed on the geometry to set the 
continuities, trim the supports or manage the curves and support in general.



Performing Operations on Shape Geometry
Generative Shape Design allows you to modify your design using techniques such as trimming, 
extrapolating and filleting. 

Join geometry: select at least two curves or surfaces to be joined.

 
Heal geometry: select at least two surfaces presenting a gap to be healed.

 
Smooth a curve: select the curve to be smoothed and set the tangency threshold

 
Restore an element: select a split element, and click the icon.

Disassemble elements: select a multi-cell element, and choose the disassembling mode.

Split geometry: select the element to be split and a cutting element.

Trim geometry: select two elements to be trimmed and specify which side of  element.

Create boundary curves: select a surface's edge, set the propagation type, and re-define the 
curve limits if needed.

Extract geometry: select an edge or the face of a geometric element, and set the propagation 
type.

Extract multiple edges: select one or more element(s) of a sketch, and click OK.

Create bitangent shape fillets: select two support surfaces, and define required parameters.

Create tritangent shape fillets: select two support surfaces, select the surface to remove, and  
enter a radius value.

Create edge fillets: select an internal edge of a surface, the surface itself, define the type of 
fillet and propagation mode, and enter a radius value.

Create variable radius fillets: select an edge to be filleted, specify the fillet extremity type, the 
propagation mode, select a point on the edge where the radius will vary, and enter the radius 
value at this point.
Create variable radius fillets using a spine: select edges with no tangency continuity to be 
filleted, specify the fillet extremity type, the propagation mode, click the circle option, and 
select a spine.



Create face-face fillets: select a support surface, the two faces to be filleted, specify the 
relimitation mode, and enter a radius value.

Create tritangent fillets: select a support surface, specify the relimitation mode, the two faces 
to be filleted and the one to be removed.

Reshape Corners: click either the Edge Fillet icon or the Variable Radius Fillet icon, select 
the edge to be filleted, click More>> and define the corner to reshape and the setback 
distance.

Translate geometry: select an element, a translation direction (line, plane or vector), specify 
the translation distance.

Rotate geometry: select an element, a line as the rotation axis, and specify the rotation angle.

Perform symmetry on geometry: select an element, then a point, line, or plane as reference 
element.

Transform geometry by scaling: select an element, then a point, plane, or planar surface as 
reference element, and specify the scaling ratio.

Transform geometry by affinity: select an element to be transformed, specify the axis system 
characteristics, and the enter the affinity ratio values.

Transform geometry from an axis to another: select an element to be transformed, specify the 
axis system characteristics, and the enter the affinity ratio values.

Extrapolate a surface: select a surface boundary then the surface itself, specify the 
extrapolation limit (value or limiting surface/plane), and specify the extremities constraints 
(tangent/normal).

Extrapolate a curve: select a curve endpoint then the curve itself, specify the extrapolation 
limit (length value or limiting surface/plane), and specify the continuity constraints 
(tangent/curvature).
Invert geometry orientation: select the Insert -> Operations -> Invert Orientation menu 
item, then the surface or curve whose orientation is to be inverted, click the orientation arrow, 
and click Invert Orientation again to accept the inverted element.
Create the nearest sub-element: select the Insert -> Operations -> Near menu item, the 
element made of several sub-elements, then a reference element whose position is close to the 
sub-element to be created.

 
Create laws: select a reference line and a curve.

  



Joining Surfaces or Curves

 
This task shows how to join surfaces or curves.

 
Open the Join1.CATPart document.

 
1.  Click the Join  icon.

The Join Definition 
dialog box appears. 

 

 In Part Design workbench, the 
Join capability is available as a 
contextual command named 
'Create Join' that you can access 
from Sketch-based features dialog 
boxes.

2.  Select the surfaces or 

curves to be joined.

3.  You can edit the list of elements to be joined:
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●     by selecting elements in the geometry: 
❍     Standard selection (no button clicked):

when you click an unlisted element, it is added to the list 
when you click a listed element, it is removed from the list

❍     Add Mode: 
when you click an unlisted element, it is added to the list 
when you click a listed element, it remains in the list

❍     Remove Mode: 
when you click an unlisted element, the list is unchanged 
when you click a listed element, it removed from the list

●     by selecting an element in the list then using the Remove\Replace contextual menu items.

 

If you double-click the Add Mode or Remove Mode button, the chosen mode is permanent, i.e. 
successively selecting elements will add/remove them.  However, if you click only once, only the 
next selected element is added or removed.
You only have to click the button again, or click another one, to deactivate the mode.

4.  Right-click the elements 

from the list and choose 

the Check Selection 

command.

This let's you check 
whether any element to 
be joined presents any 
intersection (i.e. at least 
one common point) with 
other elements prior to 
creating the joined 
surface:

The Checker dialog box 
is displayed, containing 
the list of domains (i.e. 
sets of connected cells) 
belonging to the 
selected elements from 
the Elements To Join 
list.

5.  Click Preview.

   



 

●     An Information message is 
issued when no intersection is 
found.

   

●     When an element is self-
intersecting, or when several 
elements intersect, a text is 
displayed on the geometry, 
where the intersection is 
detected.

6.  Click Cancel to return to the Join Definition dialog box.

7.  Right-click the elements again and choose the Propagation options to allow the selection of 

elements of same dimension.

 
●     G0 Propagate: the tolerance corresponds to the Merging distance value.

●     G1 Propagate: the tolerance corresponds to the Angular Threshold value, if defined. 
Otherwise, it corresponds to the G1 tolerance value as defined in the part.

Each new element found by propagation of the selected element(s) is highlighted and added to 
the Elements To Join list.
Please note that:

●     The initial element to propagate cannot be a sub-element

●     Forks stop the propagation

●     Intersections are not detected



8.  Click Preview in the Join 

Definition dialog box.

The joined element is 

previewed, and its 

orientation displayed. 

Click the arrow to invert 

it if needed.

 

The join is oriented according to the first element in the list. If you change this element, the join's 
orientation is automatically set to match the orientation of the new topmost element in the list.

9.  Check the Check 

tangency button to find 

out whether the elements 

to be joined are tangent. If 

they are not, and the 

button is checked, an error 

message is issued.

10.  Check the Check 

connexity button to find 

out whether the elements 

to be joined are connex. If 

they are not, and the 

button is checked, an error 

message is issued 

indicating the number of 

connex domains in the 

resulting join.

When clicking Preview, the 

free boundaries are 

highlighted, and help you 

detect where the joined 



element is not connex.

11.  Check the Check manifold 

button to find out whether 

the resulting join is 

manifold.

 

The Check manifold button is 
only available with curves.
Checking it automatically checks 
the Check connexity button.

●     The Simplify the result check button allows the system to automatically reduce the number 
of elements (faces or edges) in the resulting join whenever possible.

●     The Ignore erroneous elements check button lets the system ignore surfaces and edges 
that would not allow the join to be created.

12.  You can also set the tolerance at which two elements are considered as being only one 

using the Merging distance.

13.  Check the Angular Threshold button to specify the angle value below which the elements 

are to be joined.

If the angle value on the edge between two elements is greater than the Angle Tolerance 

value, the elements are not joined. This is particularly useful to avoid joining overlapping 

elements.

14.  Click the Federation tab to generate groups of elements belonging to the join that will be 

detected together with the pointer when selecting one of them. 

 
For further information, see Using the Federation Capability.



15.  Click the Sub-Elements 

To Remove tab to display 

the list of sub-elements in 

the join.

These sub-elements are 

elements making up the 

elements selected to 

create the join, such as 

separate faces of a 

surface for example, 

that are to be removed 

from the join currently 

being created.

You can edit the sub-

elements list as 

described above for the 

list of elements to be 

joined. 

16.  Check the Create join with sub-elements option to create a second join, made of all the 

sub-elements displayed in the list, i.e. those that are not to be joined in the first join.

This option is active only when creating the first join, not when editing it.

17.  Click OK to create the joined surface or curve.

The surface or curve (identified as Join.xxx) is added to the specification tree. 

 

Sometimes elements are so close that it is not easy to see if they present a gap or not, even 
though they are joined. Check the Surfaces' boundaries option from the Tools -> Options 
menu item, General, Display, Visualization tab.



 
This option is only available with the Generative Shape Design 2 product.

The purpose of the federation is to regroup several elements making up the joined surface or 
curve. This is especially useful when modifying linked geometry to avoid re-specifying all the input 
elements.

 
Open the Join2.CATPart document.

1.  Create the join as usual, selecting all elements to be joined.

(Make sure you do not select the Sketch.1).

2.  From the Join Definition 

dialog box click the 

Federation tab, then 

select one of the elements 

making up the elements 

federation.

You can edit the list of 
elements taking part in 
the federation as 
described above for the 
list of elements to be 
joined.

3.  Choose a propagation 

mode, the system 

automatically selects the 

elements making up the 

federation, taking this 

propagation mode into 

account.

 

Using the Federation Capability
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●     No federation: only the 
elements explicitly selected are 
part of the federation

●     All: all elements belonging to 
the resulting joined 
curve/surface are part of the 
federation

●     Point continuity: all elements 
that present a point continuity 
with the selected elements and 
the continuous elements are 
selected; i.e. only those that 
are separated from any 
selected element is not 
included in the federation



●     Tangent continuity: all the 
elements that are tangent to 
the selected element, and the 
ones tangent to it, are part of 
the federation

Here, only the top faces 
of the joined surface are 
detected, not the lateral 
faces.

 To federate a surface and its 
boundaries in tangency, you need 
to select the face as well as the 
edges: both face and edges will be 
federated.

 
●     No propagation: only the 

elements explicitly selected are 
part of the propagation

4.  Choose the Tangency 

Propagation federation 

mode as shown above.

5.  Move to the Part Design 

workbench, select the 

Sketch.1, and click the Pad 

 icon to create an up 

to surface pad, using the 

joined surface as the 

limiting surface.

6.  Select the front edge of the 

pad, and create a 2mm 

fillet using the Edge Fillet 



 icon.

7.  Double-click the Sketch.1 from the specification tree, then double-click the constraint on 

the sketch to change it to 10mm from the Constraint Definition dialog box.

Sketch prior to modification lying 
over two faces

Sketch after modification lying over one face only

8.  Exit the sketcher .

The up to surface pas is automatically recomputed even though it does not lie over the same faces 
of the surface as before, because these two faces belong to the same federation. This would not 
be the case if the federation including all top faces would not have been created, as shown below.

9.  Double-click the joined surface (Join.1) to edit it, and choose the No propagation 

federation mode.

10.  Click OK in the Join Definition dialog box.

A warning message is issued, informing you that an edge no longer is recognized on the pad.

11.  Click OK.

The Update Diagnosis dialog box is displayed, allowing you to re-enter the specifications for the 
edge, and its fillet.



You then need to edit the edge and re-do the fillet to obtain the previous pad up to the joined 
surface. 

12.  Select the Edge.1 line, click the Edit button, and re-select the pad's edge in the geometry.

13.  Click OK in the Edit dialog box.

The fillet is recomputed based on the correct edge.

 

 



Healing Geometry
This task shows how to heal surfaces, that is how to fill any gap that may be appearing between two surfaces.
This command can be used after having checked the connections between elements for example, or to fill slight gaps 
between joined surfaces.

 
Open the Healing1.CATPart document from the Join Healing toolbar.

 
1.  Click the Healing  icon.

The Healing Definition dialog box appears. 

2.  Select the surfaces to be healed.

 

3.  You can edit the list of elements in the definition list:

●     by selecting elements in the geometry: 

❍     Standard selection (no button clicked):

when you click an unlisted element, it is added to the list 

when you click a listed element, it is removed from the list

❍     Add Mode: 

when you click an unlisted element, it is added to the list 

when you click a listed element, it remains in the list

❍     Remove Mode: 

when you click an unlisted element, the list is unchanged 

when you click a listed element, it removed from the list

●     by selecting an element in the list then using the Remove\Replace contextual menu items.
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If you double-click the Add Mode or Remove Mode button, the chosen mode is permanent, i.e. successively selecting 
elements will add/remove them.  However, if you click only once, only the next selected element is added or removed.
You only have to click the button again, or click another one, to deactivate the mode.

 
Parameters tab

4.  Define the distance below which elements are to be healed, that is deformed so that there is no more gap, 

using the Merging distance.

Elements between which the gap is larger than the indicated value are not processed.

In our example, we increase it to 1mm. 

You can also set the Distance objective, i.e. the maximum gap allowed between two healed elements. By default it is 
set to 0.001 mm, and can be increased to 0.1 mm.

5.  Change the continuity type to Tangent. 

In that case, the Tangency angle field becomes active, allowing you to key in the angle below which the 

tangency deviation should be corrected.

The Tangency objective is, similarly to the Distance objective, the maximum allowed tangency deviation 
allowed between healed elements. The default value is 0.5 degree, but can range anywhere between 0.1 
degree to 2 degrees.

 

6.  Click Preview to visualize the maximum 

deviation value between the input surfaces and 

the result in the 3D geometry.

The value is displayed on the edge or the face onto 
which the deviation is maximal, not exactly where the 
maximum deviation is located.

 
Freeze tab

 

6.  Click the Freeze tab.

You can then define the list of frozen 

elements, that is the elements that should 

not be affected by the healing operation. 

You can edit the list as described above for 

the list of elements to be healed. 

Similarly to the Elements to freeze list, when the Freeze Plane elements or Freeze Canonic elements options are 

checked, no selected plane/canonic element is affected by the healing operation.



7.  Click OK to create the healed surfaces.

The surface (identified as Heal.xxx) is added 

to the specification tree. 

●     Check the Surfaces' boundaries option from the Tools -> Options menu item, General -> Display -> 
Visualization tab to display the boundaries. This may be especially useful when selecting, and also to identify 
gaps.

 
Sharpness tab  

●     Provided the Tangent mode is active, you can 
retain sharp edges, by clicking the Sharpness tab, 
and selecting one or more edges.
You can edit the list of edges as described above 
for the list of elements to be healed.

●     The Sharpness angle allows to redefine the limit 
between a sharp angle and a flat angle. This can 
be useful when offsetting the resulting healed 
geometry for example.  By default this angle value 
is set to 0.5 degree.

     
 

●     In some cases, depending on the geometry 
configuration and the set parameters, the Multi-
Result Management dialog box is displayed.
Click No or refer to the Managing Multi-Result 
Operations chapter for further information.

    



 

When the healing fail, an update error dialog is issued.
Click OK to improve the geometry.

The erroneous elements are displayed on the 
geometry.

 
Visualization tab  

 

The Visualization tab enables you to better understand 
the discontinuities in the model and the results of the 
healing action.

It lets you define the way the messages are displayed 
on the smoothed element.

You can choose to see:
●     All the messages, that is to say the messages 

indicating where the discontinuity remains as well 
as those indicating where the discontinuity type 
has changed (in point (><) and tangency (^)).

●     only the messages indicating where the 
discontinuity is Not corrected and still remains. 



●     None of the messages.

You can also choose to see:
●     Display information interactively: only the 

pointers in the geometry are displayed, above 
which the text appears when passing the pointer

●     Display information sequentially: only one 
pointer and text are displayed in the geometry, 
and you can sequentially move from one pointer to 
another using the backward/forward buttons

 

 



Smoothing Curves

This option is only available with the Generative Shape Design 2 product.

This task shows how to smooth a curve, i.e. fill the gaps, and smooth tangency and curvature discontinuities, in 
order to generate better quality geometry when using this curve to create other elements, such as swept surfaces 
for example.

Open the Smooth1.CATPart document.

1.  Click the Curve 

Smooth icon  in 

the Operations 

toolbar.

The Curve Smooth 

Definition dialog 

box is displayed. 

2.  Select the curve to 

be smoothed.

Texts are displayed on the 
curve indicating its 
discontinuities before 
smoothing, and type of 
discontinuity (point, 
curvature or tangency) and 
their values (In area). These 
values type are expressed in 
the following units: 

●     for a point discontinuity: 
the unit is the 
document's distance unit 
(mm by default)

●     for a tangency 
discontinuity: the unit is 
the document's angular 
unit (degree by default)

●     for a curvature 
discontinuity: the value 
is a ratio between 0 and 
1 which is defined as 
follows:

if ||Rho1-Rho2|| / 
||Rho2|| < (1-r)/r 
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where Rho1 is the 
curvature vector on one 
side of the discontinuity, 
Rho2 the curvature 
vector on the other side, 
and r the ratio specified 
by the user;
then the discontinuity is 
smoothed. 

For example, r=1 
corresponds to a 
continuous curvature and 
r=0.98 to the model 
tolerance (default value). 
A great discontinuity will 
require a low r to be 
smoothed.

3.  Click Preview to 

display texts 

indicating the curve 

discontinuities still 

present after the 

smoothing operation, 

and whether they are 

within the threshold 

values (yellow box) 

or outside the set 

values (red box) 

(Out area).

The following 

elements C0, C1 

and C2 that are 

displayed before 

the discontinuity 

information 

indicate that the 

vertex is 

respectively point 

continuous (C0), 

tangent 

continuous (C1) 

and curvature 



continuous (C2). 

The value and 

location of the 

Maximum 

deviation between 

the curve to be 

smoothed and the 

smoothed curve 

are displayed in 

the 3D geometry.

In the example, from top to bottom, once the curve is smoothed: 
●     the tangency discontinuity still is present

●     there is no more discontinuity, the point discontinuity is corrected

●     the curvature discontinuity still is present, even though it is slightly modified (different In and Out values)

●     the curvature discontinuity still is present and not improved at all

 Basically: 
●     a red box indicates that the system could not find any solution to fix the discontinuity while complying with the 

specified parameters

●     a yellow box indicates that some discontinuity has been improved, where there was a point discontinuity there 
now is a tangency discontinuity for example

●     a green box indicates that the discontinuity no longer exists; it has been smoothed.

 
Defining tangency and curvature thresholds, the maximum deviation and the 
continuity

4.  From the 

Parameters tab 

modify the 

Tangency 

threshold, that is 

the tangency 

discontinuity value 

below which the 

curve is smoothed.

If the curve presents 

a tangency 

discontinuity greater 

than this threshold, it 

is not smoothed.

If you increase the 

threshold value to 



1.0 in our 

example, you 

notice that the 

Tangency 

discontinuity 

which value was 

below 1 changes 

to a curvature 

discontinuity. 

5.  Similarly, you can check the Curvature threshold button to set curvature discontinuity value below which 

the curve is smoothed.

6.  Define a Maximum deviation value to set the allowed deviation between the initial curve and the 

smoothed curve. 

Therefore, the resulting smoothed curve fits into a pipe which radius is the maximum deviation value and 

the center curve is defined by the selected curve.

7.  Define the Continuity, that is the correction mode for the smoothing:

 
●     Threshold: default mode. The tangency and curvature thresholds options are taken into account.

 
●     Point (there is no point 

discontinuity in our 

example)

 

 

●     Tangency

You notice that the 

Tangency discontinuity 

changes to a curvature 

discontinuity. 

In this case, the Tangency 

threshold field is grayed 

out and the defined value is 

ignored.



 

●     Curvature

You notice that there is 

no discontinuity any 

more.

In this case, the Curvature 
threshold field is grayed 
out and the defined value is 
ignored.

Optionally, you can select a 

surface on which the curve 

lies.

In this case the smoothing is 

performed so that the curve 

remains on the Support 

surface. From this ensues 

that the maximum degree of 

smoothing is limited by the 

support surface's level of 

discontinuity.

 
Selecting Elements not to be smoothed

 
8.  Click the Freeze tab.

This tab enables 
you to select sub-
elements of the 
curve that should 
not be smoothed.
These sub-
elements can 
either be vertices 
or edges. In case 
of a vertex, the 
local 
neighborhood 
remains 
unchanged, thus 



keeping the 
discontinuity.

The Remove 

button enables to 

remove a single or 

a set of sub-

elements.

External elements cannot be 
selected as sub-elements.

 
Setting continuity 
conditions

 

 You now set continuity 
conditions on the resulting 
smoothed curve for each 
extremity with regards to 
the input curve. As a 
comparison basis, the 
continuity condition was 
previously always curvature: 
the output curve had the 
same extremity points, 
tangencies and curvatures 
as the input curve.

9.  Click the 

Extremities tab and 

define the continuity 

conditions at each 

curve's extremity:

●     Curvature (by default): 

extremity point, 

tangency and curvature 

are the same

●     Tangency: extremity 

point and tangency are 

the same (curvature can 

be different)

●     Point: extremity points 

are the same (tangency 

and curvature can be 

different)



 

You can also right-click the 
icon at the curve's extremity 
and choose one of the 
following options:

Point and Tangency 
conditions can only be 
successfully applied if the 
Maximum Deviation is larger 
than 0.005mm. Note that 
these extremity conditions 
do not affect closed curves.

 

You can also sequentially 
move from one conditions to 
the next one by clicking on 
the icons.

 

 
Visualizing 
messages

 

10.  Click the 

Visualization tab.

This tab lets you 
define the way the 
messages are 
displayed on the 
smoothed 
element. You can 
choose to see:

●     All the 
messages: 
those 
indicating 
where the 
discontinuity 
remains (red 
box) as well as 
those 
indicating 
where the 
discontinuity 
type has 
changed, or 
allows 
smoothing.



●     only those messages 
indicating where the 
discontinuity is Not 
corrected and remains.

●     None of the messages.

You can also choose to:
●     Display information 

interactively: only the 
pointers in the geometry 
are displayed, above 
which the text appears 
when passing the 
pointer 

       
 

●     Display information 
sequentially: only one 
pointer and text are 
displayed in the 
geometry, and you can 
sequentially move from 
one pointer to the other 
using the 
backward/forward 
buttons 

The Topology simplification check button automatically deletes vertices on the curves when the curve is 
curvature continuous at these vertices, thus reducing its number of segments.
When this is the case, the displayed text indicates: Out: discontinuity erased to inform you that a simplification 
operation took place.
This text is also displayed when two vertices are very close to each other and the system erases one to avoid the 
creation of very small edges (i.e. shorter than 10 times the model tolerance) between two close vertices.

  

11.  Click OK.

The smoothed curve (identified as Curve smooth.xxx) is added to the specification tree.

When smoothing a curve on support that lies totally or partially on the boundary edge of a surface or on an internal 
edge, a message may be issued indicating that the application found no smoothing solution on the support. In this 
case, you must enter a Maximum deviation value smaller than or equal to the tolerance at which two elements are 
considered as being only one (0.001mm by default)  to keep the result on the support.



Restoring a Surface

In this task you will learn how to restore the limits of a surface or a curve when it has been split 

using the Break Surface or Curve   icon (see Splitting Geometry for the Generative Shape 

Design workbench).

Open the Untrim1.CATPart document.

1.  Click the 

Untrim icon 

 in the 

Operations 

toolbar.

The Untrim 

dialog box is 

displayed. 

2.  Select the 

surface which 

limits should be 

restored.

The dialog 

box is 

updated 

accordingly. 

3.  Click OK in the dialog box.
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A progression bar is 
displayed, while the 
surface is restored.
It automatically 
disappears once the 
operation is complete 
(progression at 
100%).  

The initial 
surface is 
automatically 
restored.

 
The restored surface or curve is identified as Surface Untrim.xxx or Curve Untrim.xxx.

You can perform a local 
untrim on faces. Three 
modes of selection are 
available:

●     selection of the 
face: the initial 
surface is restored



●     selection of an 
inner loop: only this 
loop is restored

●     selection of the 
outer loop: only 
this loop is restored

●     If the surface has been trimmed several times, it is the initial surface which is restored. To 
partially untrim the surface, you need to use the Undo command right after the trim.

●     If the surface to be restored is closed (in the case of a cylinder) or infinite (in the case of an 
extrude), the limits of the untrim feature will be the bounding boxes of the initial surface. 
Therefore, the initial surface and the untrim surface may be identical.

●     You can individually select a vertex or a boundary from the restored surface or curve.

●     Multi-selection is available and allows to create several untrim features in one step. All untrim 
features will appear in the specification tree.

●     The datum creation capability is available from the Dashboard.

 

 



Disassembling Elements

In this task you will learn how to disassemble multi-cell bodies into mono-cell bodies.

Open the Disassembling1.CATPart document, or any document containing a multi-cell element.

1.  Select the element to be disassembled.

You can select only an edge of a surface, the 

system recognizes the whole element to be 

disassembled.

Here we selected the join made of three 

elements, each made of several cells.

2.  Click the Disassemble icon  in the Join-

Healing toolbar.

The Disassemble dialog box is displayed.
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3.  Choose the disassembling mode: 

●     All Cells: all cells are disassembled, i.e. for all 

the selected element, a separate curve is created 

for each cell.

●     Domains Only: elements are partially 
disassembled, i.e. each element is kept as a 
whole if its cells are connex, but is not 
decomposed in separate cells. A resulting element 
can be made of several cells. 

In the illustrations, we have colored the resulting 
curves for better identification.

 
Results when disassembling all cells

(seven curves are created)
Results when disassembling domains only

(three curves are created)

4.  Click OK in the dialog box.

A progression bar is displayed, while the surface is being disassembled.
It automatically disappears once the operation is complete (progression at 100%). 



The surface is disassembled, that is to say independent surfaces are created, that can be 
manipulated independently.

Multi-selection is available.

 



Splitting Geometry

 

This task shows how to split a surface or wireframe element by means of a cutting element.
You can split a wireframe element by a point, another wireframe element or a surface; or a surface by a wireframe element or 
another surface.

 
●     Keeping or Removing Elements

●     Intersections and extrapolations

●     Splitting Wires

●     Splitting a surface by a curve or a surface by a surface

●     Splitting Volumes

 
Open the Split1.CATPart document.

1.  Click the Split icon .

The Split Definition dialog box appears. 

 

2.  Select the element to be split.

You should make your selection by clicking on the portion that 
you want to keep after the split.
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You can select several elements to cut. In that case, click the 

Element to cut field again or click the bag icon . The 

Elements to cut field opens. Select as many elements as 

needed. Click Close to return to the Split Definition dialog box. 

The number of selected elements is displayed in the Element 

to cut field.

Use the Remove and Replace buttons to modify the elements 
list.
Use the Invert button to reverse the portion to be kept, 
element by element.

3.  Select the cutting element.

A preview of the split appears. You can change the 
portion to be kept by selecting that portion. 

You can also select the portion to be kept by clicking 
the Other side button. 
This option applies on all selected elements to cut.

●     You can select several cutting elements. In that case, note that the selection order is important as the area to be split is defined 
according to the side to be kept in relation to the current splitting element. 

 
●     You can create a Join as the splitting element, by right-clicking in the Cutting Elements field and choosing the Create Join 

item.
If you split a surface and you keep both sides by joining the resulting splits, you cannot access the internal sub-elements of the 
join: indeed, splits result from the same surface and the cutting elements are common.

4.  Click OK to split the element.

The created element (identified as Split.xxx) is 
added to the specification tree. 

In the case several elements to cut were used, the 
created elements are aggregated under a Multi-
Output.xxx feature.

 In the illustrations below, the top-left line is the first splitting element. In the left illustration it defines an area that intersects with the 
other three splitting curves, and in the illustration to the right, these three elements are useless to split the area defined by the first 
splitting element.



Would you need to remove, or replace, one of these cutting elements, select it from the list and click the Remove or Replace 
button.

 
Keeping or Removing Elements
The Elements to remove and Elements to keep options allows to define the portions to be removed or kept when performing the 
split operation. 

1.  Click in the field of your choice to be able to select the elements in the 3D geometry.
2.  Right-click in the field either to clear the selection or display the list of selected elements.

Only the selected element is removed.
All other elements are kept.

The selected elements are kept.
All other elements are removed.

●     You must select sub-elements as elements to keep or to 
remove; otherwise, a warning message is issued.



 
●     You can also select a point to define the portion to keep or 

to remove. 

A contextual menu is available on the Elements to 
remove and Elements to keep fields.

 

You do not need to select elements to keep if you already selected elements to remove and vice-versa.

●     Check the Keep both sides option to retain the other side of the split element after the operation. In that case it appears as 
aggregated under the first element.
Therefore both split elements can only be edited together and the aggregated element alone cannot be deleted.

If you use the Datum mode, the second split element is not aggregated under the first one, but two datum surfaces are created.

In case there are several elements to cut, the Keep/Remove options only apply on the first selected element.

 
Intersections and extrapolations

 

●     Check the Intersections computation button to create 
an aggregated intersection when performing the splitting 
operation. This element will be added to the specification 
tree as Intersect.x.

In case there are several elements to cut, the Intersections computation option only applies on the first selected element.

 

●     Uncheck the Automatic extrapolation button if do not 
you want the automatic extrapolation of the cutting curve. 
When a splitting curve is extrapolated, the extrapolation 
will performed on the original curve, providing the 
underlying geometry (that is the curve) is long enough to 
be used for the extrapolation.
If the Automatic extrapolation button is unchecked, an 
error message is issued when the cutting element needs to 
be extrapolated, and the latter is highlighted in red in the 
3D geometry.

This option is available in the case of a split surface/curve or 
surface/surface.

 
Splitting Wires

●     When splitting a wire (curve, line, sketch and so forth) by another wire, you can select a support to define the area that will be 
kept after splitting the element. It is defined by the vectorial product of the normal to the support and the tangent to the splitting 
element. 
This is especially recommended when splitting a closed wire. 

The non disconnected elements of the element to cut are kept in the result of the split.



 

Splitting with no support selected: first solution Splitting with no support selected: second solution

Splitting with a selected support (xy plane): first solution Splitting with a selected support (xy plane): second solution

  
Splitting a surface by a curve or a surface by a surface

The following steps explain how split a surface by a curve or another surface.

 Split surface/curve

1.  First, the cutting element (the curve) is laid down the surface.
2.  Then, the result of step 1 is tangentially extrapolated in order to split the surface correctly (as shown in following figure). 

However, when this extrapolation leads to the intersection of the cutting element with itself prior to fully splitting the initial 
element, an error message is issued as there is an ambiguity about the area to be split.  

If the cutting element does not reach the free edges of the element to cut, an extrapolation in tangency is performed using the part 
of the cutting element that lays down the surface.

 Split surface/surface

Open the Split2.CATPart document.
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1.  First, an intersection (the green wire) is created between 
the two elements (the surfaces).

2.  Then, the result of the intersection is automatically 
extrapolated in tangency up to the closest free edges of 
the element to cut.
The result of the extrapolation is used as the cutting 
element and the split is created.

Please note that it is not the cutting element which is 
extrapolated but the result of the intersection.

If the result of the split is not what was expected, it is also possible to manually extrapolate the cutting element with the extrapolate 
feature before creating the split.

1.  Extrapolate the cutting element (the red surface) in order 
to fully intersect the element to cut.



2.  Then, use the extrapolated surface as the cutting element 
to split the surface.

Avoid using input elements which are tangent to each other since this may result in geometric instabilities in the tangency zone.

In case surfaces are tangent or intersect face edges, please process as follow in order to avoid indeterminate positioning. 

Use the border edge of the cutting surface to split the element to 
cut:

1.  Delimit the boundary of the cutting surface
2.  Project this boundary onto the surface to split
3.  Use this projection as the cutting element

Steps 2 and 3 may be optional if the tangency constraint between 
the two surfaces has been clearly defined by the user during the 
surface creation.

The following cases should be avoided when possible (especially 
when the tangency constraint between the two surfaces has not 
been clearly defined by the user during the surface creation), as 
the result of the positioning is likely to be indeterminate and the 
result of the intersection to be unstable.  
  

  
When these cases cannot be avoided, it is recommended, first to 
create the intersection between the two surfaces, then to split the 
element to cut with the resulting intersection. Doing so, the 
position can be properly defined but the instability of the result 
relating to the intersection remains. 



 Providing the element to be cut is a volume and the cutting element is a volume or a surface, you can choose whether you want the 
result of the split to be a surface or a volume. To do so, switch to either Surface or Volume option. This switch only concerns 
volumes since the transformation of a surface can only be a surface.
Note that the switch between surface and volume is greyed out when editing the feature.
If the result of the split is a volume, the split is a modification feature.
If the result of the split is a surface, the split is a creation feature.
To have further information about volumes, please refer to the Creating Volumes chapter.

   

●     Avoid splitting geometry when the intersection between the 
element to cut and the cutting element is merged with an 
edge of the element to cut.
In that case, you can use the Elements to remove and 
Elements to keep options to remove the positioning 
ambiguity.

 

 
●     When splitting a closed surface or a curve by connex elements, an error message is issued. You need to create a join feature of 

non connex elements and cut the closed surface or curve with this join feature. 

 
●     The selection of the feature prevails over the selection of the sub-element.

To select a sub-element, you need to apply the ''Geometrical Element'' filter in the User Selection Filter toolbar.
For further information, refer to the Selecting using a Filter chapter in the CATIA Infrastructure User's Guide.

 

 

 
Splitting Volumes



 Trimming Geometry

 
This task shows how to trim two surfaces or two wireframe elements.

 
Open the Trim1.CATPart document.

 
1.  Click the Trim icon .

The Trim Definition dialog box appears. 

2.  Select the two surfaces or two wireframe 

elements to be trimmed.

A preview of the trimmed element 
appears. You can change the portion to 
be kept by selecting that portion.

You can also select the portions to be 
kept by clicking the Other side of 
element 1 and Other side of element 
2 buttons. 

3.  Click OK to trim the surfaces or wireframe 

elements.

The trimmed element (identified as 
Trim.xxx) is added to the specification 
tree. 
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●     You should make your selections by clicking on the portions that you want to keep after the trim.

●     Please refer to the Splitting Geometry chapter in the case surfaces intersect face edges. 

In case the elements to be trimmed are tangent, you are advised to use the Elements to remove and 
Elements to keep options to define the portions to be kept or removed.

●     Click in the field of your choice to be able to select the elements in the 3D geometry.

●     Right-click in the field either to clear the selection or display the list of selected elements.

Only the selected portion is removed.
All other elements are kept.

Only the selected portions is kept.
All other elements are removed.

 

●     You can also select a point to define the portion 
to keep or to remove. 

A contextual menu is available on the 
Elements to remove and Elements to keep 
fields.

●     You do not need to select elements to keep if you already selected elements to remove and vice-versa.

  

●     When trimming wires (curve, line, sketch and so forth) by another wire, you can select a support to 
define the area that will be kept after trimming the element. It is defined by the vectorial product of the 
normal to the support and the tangent to the trimming element.

This is especially recommended when trimming a closed wire.



In our example, the Sketch composed of two lines 
(Sketch.11) is trimmed by the circle (Sketch.10).

Resulting trimmed element without support 
selection Resulting trimmed element with support selection

●     Check the Result simplification button to allow the system to automatically reduce the number of 
faces in the resulting trim whenever possible.

●     Check the Intersection computation button 
to create a completely independent element 
when performing the trimming operation. In 
that case it appears as a separate Intersect.xxx 
element in the specification tree.

 

●     Uncheck the Automatic extrapolation button 
if you do not want the automatic extrapolation 
of the elements to trim. 
If the Automatic extrapolation button is 
unchecked, an error message is issued when 
the elements to trim need to be extrapolated, 
and the latter are highlighted in red in the 3D 
geometry.



 

To be able to trim the two surfaces or wireframe 
elements, check the Automatic extrapolation 
button.

 



Creating Boundary Curves

 
This task shows how to create the boundary curve of a surface.

Open the Boundaries1.CATPart document.

1.  Click the Boundary icon .

The Boundary Definition dialog 
box appears. 

 

2.  Use the combo to choose the Propagation type:

●     Complete boundary: the selected edge is propagated around the entire surface boundary.

●     Point continuity: the selected edge is propagated around the surface boundary until a point 
discontinuity is met.

●     Tangent continuity: the selected edge is propagated around the surface boundary until a tangent 
discontinuity is met.

●     No propagation: no propagation or continuity condition is imposed, only the selected edge is kept.

 You can now select the propagation type 
before selecting an edge.

 

 
3.  Select a Surface edge.

The boundary curve is displayed according 
to the selected propagation type.

 

 No propagation Tangent continuity
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 Point continuity Complete boundary
   
 

4.  You can relimit the boundary curve by means of two elements.

If you relimit a closed curve by means of only one element, a point on curve curve for example, the 
closure vertex will be moved to the relimitation point, allowing this point to be used by other features.

 
5.  Click OK to create the boundary curve.

The curve (identified as Boundary.xxx) is added to the specification tree.

●     If you select the surface directly, the 
Propagation type no longer is available, 
as the complete boundary is 
automatically generated. 

 

Provided the generated boundary 
curve is continuous, you can still 
select limiting point to limit the 
boundary. 



 

Using the arrows you can then 
invert the limited boundary. 

If you select a curve which has an open contour, the Propagation type becomes available: choose the 
No Propagation type and select the curve again. The extremum points will define the boundary curve.

 
●     You cannot copy/paste a boundary from a document to another. If you wish to do so, you need to 

copy/paste the surface first into the second document then create the boundary.

 

 



Extracting Geometry

 
This task shows how to perform an extract from elements (curves, points, solids, volumes and 
so forth). 

This may be especially useful when a generated element is composed of several non-connex 
sub-elements. Using the extract capability you can generate separate elements from these sub-
elements, without deleting the initial element.

 
Open the Extract1.CATPart document.

 
1.  Select an edge or the face of an element.

The selected element is highlighted. 

 
2.  Click the Extract icon .

The Extract Definition dialog 

box is displayed. 

 In Part Design workbench, the Extract 
capability is available as a contextual 
command named Create Extract that 
you can access from Sketch-based 
features dialog boxes.

 
3.  Choose the Propagation type: 

 

●     Point continuity: the extracted 
element will not have a hole.
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●     Tangent continuity: the extracted 
element will be created according to 
tangency conditions. 

 
●     Curvature continuity: the extracted 

element will be created according to 
curvature conditions.

Define a Curvature Threshold value. 
For a curvature discontinuity: the 
value is a ratio between 0 and 1 which 
is defined as follows:

if ||Rho1-Rho2|| / ||Rho2|| < (1-r)/r 
where Rho1 is the curvature vector on 
one side of the discontinuity, Rho2 the 
curvature vector on the other side, 
and r the ratio specified by the user;
then the discontinuity is smoothed. 

For example, r=1 corresponds to a 
continuous curvature and r=0.98 to 
the model tolerance (default value). A 
great discontinuity will require a low r 
to be taken into account.

The extracted element must be a wire.

 

●     No propagation: only the selected 
element will be created.

 
4.  Click OK to extract the element.

 

The extracted element (identified as Extract.xxx) is added to the specification tree.



 

●     If you extract an edge that you want 
to propagate, and there is an 
ambiguity about the propagation side, 
a warning is issued and you are 
prompted to select a support face. In 
this case, the dialog box dynamically 
updates and the Support field is 
added.

 

●     The Complementary mode option, 
once checked, highlights, and 
therefore selects,  the elements that 
were not previously selected, while 
deselecting the elements that were 
explicitly selected.

 
●     Check the Federation button to generate groups of elements belonging to the resulting 

extracted element that will be detected together with the pointer when selecting one of its 
sub-elements.  For further information, see Using the Federation Capability.

You can select a volume as the element 
to be extracted.
To do so, you can either:

1.  select the volume in the 
specification tree, or

2.  use the User Selection Filter 
toolbar and select the Volume 
Filter mode.
For further information, refer to 
the Selecting Using A Filter 
chapter in the CATIA 
Infrastructure User's Guide.

In both cases, the result of the 
extraction is the same whatever 
the chosen propagation type.



●     In a .CATProduct document containing several parts, you can use the extract capability in 
the current part from the selection of an element in another part, provided the propagation 
type is set to No Propagation.
In this case, a curve (respectively a surface or point) is created in the current part if the 
selected element is a curve (respectively a surface or point); the Extract parent therefore 
being the created curve (respectively the surface or point).
Note: 

❍     if another propagation type is selected, the extraction is impossible and an error 
message is issued.

❍     when editing the extract, you can change the propagation type as the parent belongs to 
the current part.

●     In the current model, if you select an element using the Tangent or Point continuity as the 
Propagation type, a warning is issued and you have to select No propagation instead.

●     If the selected element has a support face and is not a surface, even though the 
Complementary mode option is checked, the Complementary mode will not be taken into 
account for the extraction and the option will therefore be inactive. After the extraction, the 
option will be available again.

●     When the result of an extract is not connex (during creation or edition) due to naming 
ambiguity, you can now select the part to keep to solve the ambiguity.

●     You cannot copy/paste an extracted element from a document to another. If you wish to do 
so, you need to copy/paste the initial element first into the second document then perform 
the extraction.

 



Extracting Multiple Edges

 

This task shows how to extract a subpart from a sketch to generate geometry from only one of 
the sketch's elements.

 

Open the Extract2.CATPart document.
It contains a sketch composed of several elements.

 
1.  Click the Multiple Edge Extract 

icon  from the Extracts 

toolbar.

The Extract Definition dialog box 

is displayed. 

2.  Select the element(s) you want to 

extract from the sketch.

The selected element(s) is 

highlighted. 

 

To remove one of the selected element, select it from the list then click the Delete sub-
element entry line button.
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3.  Click OK to extract the element.

The extracted element (identified as Extract.xxx) is added to the specification tree and can be 
used as any regular geometry.

   
You cannot copy/paste an extracted element from a document to another. If you wish to do so, 
you need to copy/paste the initial element first into the second document then perform the 
extraction.

 

 



Creating Bitangent Shape Fillets
This task shows how to create a shape fillet between two surfaces.
The fillet surface is obtained by rolling a sphere between the selected surfaces.

Open the ShapeFillet1.CATPart document.

 
1.  Click the Shape Fillet icon  

.

The Fillet Definition dialog box 

appears.

2.  Choose the BiTantent Fillet 

ype.

3.  Select a surface as the first 

support element.

4.  Select another surface as the 

second support element.

 
Constant Radius Fillet  

1.  Enter the value of the 

fillet Radius.

Up to four fillet 
locations may be 
possible. 
To help you decide 
on the location an 
arrow is displayed 
on each selected 
surface. You can 
click on the arrows 
to specify the 
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desired fillet 
location. 

   

2.  Click Preview to see 

the filleted surface.

 
Variable Radius Fillet  

 
With Spine and Hold Curve  

Open the ShapeFillet3.CATPart 
document.
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You can generate a variable bi-tangent 
radius fillet by selecting a Hold curve. 
In this case, you need to select a 
previously defined limiting curve that 
will control the fillet radius, and a 
previously defined spine that defines the 
planes in which the filleted surface 
section will pass. Both these curves 
must be larger than the surfaces 
involved, and the Hold curve must lie on 
one of these initial surfaces. The 
resulting filleted surface is tangent to 
the initially selected surfaces and limited 
by the hold curve. 

●     The Radius field is deactivated as 
the hold curve defines the variable 
radius.

●     The Spine curve can be close or 
open.

 
The Hold Curve and Spine options are 
only available with the Generative 
Shape Design 2 product.

 
See also Creating a variable bi-tangent 
circle radius fillets using a spine.

   

With Laws and Relimiters
 

 The Law button becomes available 

when the Spine field is filled in.

 

Open the ShapeFillet3.CATPart 
document.

 

1.  Select two surfaces.
2.  Select Line.1 as the spine.

Law relimiters are displayed on 
each extremity of the spine to 
delimit the radius law range. 
Manipulators enable you to 
move them along the spine.

You can use a close spine, in that case, 
only the Law relimiter 1 field is 
enabled.

 
 With Basic or Advanced Law  
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3.  Click the Law... button to 

display the Law Definition dialog 

box. The 2D viewer enables you 

to previsualize the law evolution 

before applying it.

4.  Enter Start and End values.

5.  Choose the law type to be 
applied to the pitch.
 Four law types are available: 

a. Constant: a regular law, 
only one value is needed.
b. Linear: a linear 
progression law between the 
Start and End indicated 
values
c. S type: an S-shaped law 
between the two indicated 
values. The pitch distance will 
vary between these two pitch 
values, over the specified 
number of revolutions.
d. Advanced: allowing to 
select a Law element as 
defined in Creating Laws.

The Law Viewer allows you 

to:

- visualize the law evolution 

and the maximum and 

minimum values,

- navigate into the viewer by 

panning and zooming (using 

to the mouse),

- trace the law coordinates by 

using the manipulator,

- change the viewer size by 

changing the panel size

- reframe on by using the 

viewer contextual menu

- change the law evaluation 

step by using the viewer 

contextual menu (from 0.1 

(10 evaluations) to 0.001 

(1000 evaluations)).



You can check the Inverse law button 
to reverse the law as defined using the 
above options.

 With Implicit Law and Relimiters  
 e. Implicit: allowing the 

selection of points on the 
spine the association of 
values for these points.

 

 - Select points on the spine. 
By default, the spine 
extremities (relimiters) are 
selected.
- Define a radius for each 
point. For instance, set 30mm 
for Point.2 and 60 for Point.3.
The radius law applies 
between these two points. 
The radius values are 
interpolated into a curvature 
continuous radius law defined 
over the whole spine curve.

   
 - Create a third point between 

Point.2 and Point.3 with a 
radius of 90mm.
- Define the Interpolation 
Mode: Linear (straight 
interpolation) or Cubic 
(smooth interpolation). Here 
we chose the Linear mode.

 

6.  Click Close to return to the Fillet 
Definition dialog box.

7.  Click Preview to see the filleted 
surface.

●     The spine curve must must be curvature continuous.

●     At least two points must be selected on the spine.

●     If the spine is closed, only one point is selected.

●     You can edit a point, by right-clicking it and choosing the Edit Point contextual item.

●     You can add a point by right-clicking and choosing the Create Point contextual item.

●     Points are automatically reordered in the list, according to their ratio on the spine.

   
 

BiTangent Fillet with Multi-
ribbons

 

 The Faces to keep option lets you 
manage multi-ribbons. 

 

Open the ShapeFillet2.CATPart 
document.
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1.  Select two surfaces.
2.  Set the Radius value as 20.
3.  Click Preview.

 

As you selected two ribbons, an error 

message pops up asking you to process 

each ribbon in a separate operation.

 

4.  Click OK in the dialog box.

The solutions are shown in 
red.

 

5.  In the Faces to keep field, 
select the face(s) you want to 
keep to create the shape fillet.

 

6.  Click Preview to see the filleted 
surface.

The Multi-Output capability is available.
 

  

 

You can uncheck any of the Trim support check buttons. In this case, the support element involved will not be 
trimmed and assembled to the filleted surface.
By default, both trimming check buttons are checked, thus relimiting both support elements.
In the examples below, we changed the filleted surface's color to better visualize it.



With only one support element trimmed With both support elements trimmed

 
The Trim option is only available with the Generative Shape Design 2 product.

   

 
5.  Use the combo to choose the desired type of extremity for the fillet:

 

●     Smooth: a tangency constraint is 
imposed at the connection between 
the fillet surface and the support 
surfaces, thus smoothing the 
connection

●     Straight: no tangency constraint is imposed at the connecting point 

between the fillet and the initial supports, generating sometimes a 

sharp angle.

 

 
●     Maximum: the fillet surface is 

limited by the longest selected 
support's edge

●     Minimum: the fillet surface is limited by the shortest selected 
support's edge.



 

6.  Click OK to create the shape fillet.

The surface (identified as Fillet.xxx) is added to the specification tree.
  

●     In case the selected supports are partially tangent, it is advisable to create an edge fillet.

●     Parameters can be edited in the 3D geometry. To have further information, please refer to the Editing 
Parameters chapter.

●     Stacking commands is available.

 

 



Creating Tritangent Shape Fillets
This task shows how to create a shape fillet between three surfaces.
The fillet surface is obtained by rolling a sphere between the selected surfaces. It involves the removal 
of one of the three faces selected.

Open the ShapeFillet4.CATPart document.

 
1.  Click the Shape Fillet icon  .

The Fillet Definition dialog box 

appears.

2.  Choose the Tritangent Fillet Type.

 
3.  Select a surface as the first support 

element.

4.  Select another surface as the 

second support element.

5.  Select the surface to be removed. 

The fillet will be tangent to this 

face.

Up to six fillet locations may be 
possible. 
To help you decide on the 
location an arrow is displayed on 
each selected surface. You can 
click on the arrows to specify the 
desired fillet location.
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6.  Click Preview to see the filleted 

surface.

 

You can uncheck any of the Trim support check buttons. In this case, the support element involved 
will not be trimmed and assembled to the filleted surface.
By default, both trimming check buttons are checked, thus relimiting both support elements.

With only one support element trimmed With both support elements trimmed

 
The Trim option is only available with the 
Generative Shape Design 2 product.

 

7.  Use the combo to choose the 

desired type of extremity for the 

fillet:
 



 

●     Smooth: a tangency constraint is 
imposed at the connection between the 
fillet surface and the support surfaces, 
thus smoothing the connection

Smooth fillet

 

●     Straight: no tangency constraint is 

imposed at the connecting point 

between the fillet and the initial 

supports, generating sometimes a 

sharp angle.

Straight fillet

 

●     Maximum: the fillet surface is limited 
by the longest selected support's edge

 

Maximum fillet



●     Minimum: the fillet surface is limited 
by the shortest selected support's 
edge.

Minimum fillet

8.  Click OK to create the shape fillet.

The surface (identified as Fillet.xxx) is added to the specification tree.

 
●     In case the selected supports are partially tangent, it is advisable to create an edge fillet.

 

●     Parameters can be edited in the 3D geometry. To have further information, please refer to the 
Editing Parameters chapter.

●     Stacking commands is available.

 

 



Creating Edge Fillets

Edge fillets are useful to provide a transitional surface along a sharp internal edge of a surface.

This task shows how to create a constant radius fillet along the internal edge of a joined surface.
The fillet surface is obtained by rolling a sphere over the selected edge.

 
●     Keeping Edges

●     Limiting Fillets

●     Ignoring Edges

●     Trimming Overlapping Fillets

●     Filleting Volumes

Open the EdgeFillet1.CATPart document.

1.  Click the Edge 

Fillet icon .

The Edge Fillet 

Definition dialog 

box appears. 

   
 

2.  Select the edge 

to be filleted.

You can also 

select a face, 

provided there 

is no 

ambiguity as 

to the edge(s) 

to be filleted. 
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3.  Use the combo to select the desired type of extremity for the fillet:

●     Straight: no tangency constraint is imposed at the connecting point between the fillet and the initial 

support, generating sometimes a sharp angle

●     Smooth: a tangency constraint is imposed  at the connection between the fillet surface and the support 
surfaces, thus smoothing the connection

●     Maximum: the fillet surface is limited by the longest selected edge

●     Minimum: the fillet surface is limited by the shortest selected edge

(Refer to Shape Fillets)

4.  Enter the value 

of the fillet 

Radius.

A preview of the 

fillet appears.

5.  You can choose the Propagation type:

●     Tangency: the fillet is propagated up to the first edge that is not continuous in tangency.

●     Minimal: the fillet is propagated up to the first geometric limitation.

 
Use the More>> button to access further options: Edge(s) to keep, Limiting element, and Blend corner.

6.  Click OK to 

create the fillet 

surface.

The surface 
(identified as 
EdgeFillet.xxx) 
is added to 
the 
specification 
tree. 

 

 
Check the Trim support elements option to relimit the support elements and assemble them to the fillet.



Keeping Edges 

You may also need to 
explicitly indicate edges 
that should not be 
filleted, if a radius is too 
large for example. In 
this case you cannot 
select boundary edges to 
be kept, but only 
internal edges, i.e. 
edges limiting two faces.

Open the 
EdgeFillet2.CATPart 
document.

To do this, proceed as 
above, but once you 
have selected the edge 
to be filleted, click the 
More to expand the 
dialog box, then click the 
Edge(s) to keep field 
and select the edge you 
wish to keep.

 
If you have difficulties selecting the edge, use the up/down arrows to display the preselection navigator.

CATIA displays this edge 
in pink, meaning that it 
will not be affected by 
the fillet operation. 

Then, click OK to create 
the fillet surface.

Limiting Fillets
While creating the fillet, you can limit it by selecting a surface that intersects it completely:
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1.  Once the edge to 
be filleted has 
been selected, 
and the radius 
keyed in, click 
Preview then the 
More>> button.

  

 2.  Click in the 
Limiting 
element(s) 
field, then select 
the trimming 
element(s).
These elements 
can either be 
surfaces, planes, 
or points on 
edges. 

An arrow 
indicates 
which portion 
of the fillet is 
to be retained.

●     You can use or more limiting elements.

●     You can define a limiting element just by clicking a point on one of the selected edges to be filleted.

3.  Click on this 

arrow to inverse 

it, if needed, to 

retain the 

opposite side of 

the fillet.

4.  Click OK to 

create the limited 

fillet.

In the 

illustration, 

the limiting 

surface has 

been hidden.



You can create limiting 
elements just by clicking 
on the edge to be 
filleted. 

The application displays 
this element as a blue 
disk.

Make sure that the 
limiting element is not 
larger than the initial 
element, as illustrated 
here. In this case, 
decrease the size of the 
limiting element as 
prompted by the 
warning message.

 You can select planes or 
points as limiting 
elements.

 

 Points must be located 
on the edge to be filleted 
and they must have 
been created using the 
On curve option 
available in the Point 
Definition dialog box.

   
 

Ignoring Edges  

 
When the update 
process detects that 
sharp edges (edges are 
considered as sharp 
when the angle between 
the two faces is greater 
than 0.5 deg) interrupt 
fillet operations, it is 
possible to continue 
filleting just by selecting 
an edge adjacent to the 
edge to be filleted. In 
the example below, the 
application displays the 
edge causing trouble in 
yellow:

   



 
An error message is 
issued, prompting you to 
select an edge adjacent 
to the filleted edge. Just 
by selecting the edge to 
the right of the 
previewed fillet, the 
application can then 
compute the whole fillet 
properly:

   

Trimming Overlapping Fillets
In some cases, fillets may be overlapping. The Trim ribbons option lets you solve this by trimming the fillets 
where they overlapping.

Open the EdgeFillet3.CATPart document.

1.  Click the Edge 

Fillet icon  

and, using the 

Ctrl key, select 

the edges at the 

base of the 

cylinder and the 

one along the 

vertical surface.

      

2.  Click Preview.

The two fillets 
clearly 
overlap.
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3.  In the Edge Fillet 

Definition dialog 

box, check the 

Trim ribbons 

option and click 

OK.

Note that the Trim ribbons option is available with the Tangency propagation mode: 

●     In Minimal mode, 
the Trim ribbons 
option is grayed, as 
it is implicitly active. 
The results would be 
trimmed fillets, and 
no propagation.

●     In Tangency mode, 
with the Trim 
ribbons option 
unchecked, the fillets 
intersect, with no 
trimming, and the 
propagation is 
performed.



●     In Tangency mode, 
with the Trim 
ribbons option 
checked, the fillets 
are trimmed and the 
propagation is 
performed.

  
 

Filleting Volumes  

Open the FilletingVolumes1.CATPart document.

1.  Click the Edge 

Fillet icon .

The Edge Fillet 

Definition dialog 

box appears. 

2.  Select the edge 

to be filleted.

3.  Set the Radius 

to 10mm.

4.  Click OK to 

create the fillet 

volume.

Extremities and Trim support options are grayed out, they cannot be used with volumes.
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 Note that the selection of the feature prevails over the selection of the sub-element.
To select a sub-element, you need to apply the ''Geometrical Element'' filter in the User Selection Filter toolbar.
For further information, refer to the Selecting Using A Filter chapter in the CATIA Infrastructure User's Guide.

 



Creating Variable Radius Fillets
This task shows how to create a variable radius fillet. In this type of fillet, the radius varies at 
selected points along a selected edge.
The fillet surface is obtained by rolling a sphere, which radius would vary, over the selected 
edge.

 

●     Limiting Fillets

●     Trimming Overlapping Fillets

●     Filleting Volumes

 Open the FilletVariableRadius1.CATPart document.

 
1.  Click the Variable Radius Fillet 

icon .

The Variable Edge Fillet dialog 

box appears.

2.  Select the edge to be filleted and 

click Preview.

The system detects the two 

vertices and displays the default 

radius value.
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3.  Use the combo to select the desired type of extremity for the fillet:

●     Straight: no tangency constraint is imposed at the connecting point between the fillet and 

the initial support, generating sometimes a sharp angle.

●     Smooth: a tangency constraint is imposed at the connection between the fillet surface and 

the support surfaces, thus smoothing the connection

●     Maximum: the fillet surface is limited by the longest selected edge

●     Minimum: the fillet surface is limited by the shortest selected edge

(Refer to Shape Fillets)

4.  You can also choose the propagation type:

●     Tangency: the fillet is propagated up to the first edge that is not continuous in tangency.

●     Minimal: the fillet is propagated up to the first geometric limitation.

5.  To add an additional point on the 

edge to make the variable radius 

fillet, click the Points field and 

select a point on the edge.

6.  Enter a new Radius value for this 

point.

7.  Set the Propagation mode to 

Cubic to obtain a smooth 

transition from one radius to 

another.

 



8.  Click OK to confirm the operation.

The surface (identified as EdgeFillet.xxx) is added to the specification tree.

This is the fillet you would obtain using 
the Linear propagation mode. In this 
case there is a straight transition from 
one radius to another.

 

Limiting Fillets

This option is only available with the Generative Shape Design 2 product.

 While creating the fillet, you can limit it by selecting an element (plane or surface) that 
intersects it completely:

1.  Once the edge to be filleted has been selected, and the radius keyed in, click Preview 

then the More>> button.



2.  Click in the Limiting element(s) 

field, then select the trimming 

element(s). Here we chose 

Extrude.7.

These elements can either be 

surfaces, planes, or points on 

edges. 

An arrow indicates which 
portion of the fillet is to be 
retained.

If needed, you can click on this 
arrow to inverse it, to retain 
the opposite side of the fillet.

●     It is possible to use one or more limiting elements.

●     You can define a limiting element just by clicking a point on one of the selected edges to be 
filleted.

3.  Click OK to create the limited 

fillet.

In the illustration, the limiting 

surface has been hidden.



●     You can create limiting elements just 
by clicking on the edge to be filleted. 

The application displays this element as a 
blue disk.

 
●     You can select points as limiting elements. These points must be located on the edge to be 

filleted and they must have been created using the On Curve option available in the Point 

Definition dialog box.

 
●     You can also define variable radius fillets on closed edges.

However, the application defines a default vertex on closed edges when applying the Edge Fillet 
command. To define the fillet, you need to remove this vertex first of all, then use 3D points 
only.

Note that the Linear variation mode is not valid for closed edges or closed sets of edges that 
are continuous in tangency. In these cases, the Cubic mode is automatically applied. 

●     Check the Trim support elements option to relimit the support elements and assemble 
them to the fillet.

This option is only available with the Generative Shape Design 2 product.

  
 

Trimming Overlapping Fillets
●     In some cases, fillets may be overlapping. The Trim ribbons option lets you solve this by 

trimming the fillets where they overlapping. For further information on this option, refer to 
Trimming Overlapping Fillets.



●     Make sure the support involved does 
not present any sharp edge, because 
the fillet would be relimited, and may 
yield unexpected results, or could not 
be computed. For example, in the 
illustration, the fillet cannot be 
propagated along the whole edge 
because the fillet is stopped onto the 
vertical edge.
In this case, you should try to 
remove this discontinuity by either 
filleting the sharp edge or modifying 
the support surfaces. 

 
●     Use the More>> button to display further options: 

❍     the edge that should not be filleted (see Edge Fillet)

❍     the circle fillet using a spine (see Variable Radius Fillet Using a Spine)

❍     the Blend corner(s) option (see Reshaping Corners).

The Circle Fillet and the Blend Corner options are only available with the Generative Shape 
Design 2 product.

   
 

Filleting Volumes  

Open the FilletingVolumes1.CATPart document.

1.  Click the Variable Radius Fillet 

icon .

The Variable Edge Fillet dialog 

box appears. 

2.  Select the edge to be filleted.

3.  Set the Radius to 10mm.
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4.  Click OK to create the fillet 

volume.

The Trim support option is grayed out, it cannot be used with volumes.

 Note that the selection of the feature prevails over the selection of the sub-element.
To select a sub-element, you need to apply the ''Geometrical Element'' filter in the User 
Selection Filter toolbar.
For further information, refer to the Selecting Using A Filter chapter in the CATIA Infrastructure 
User's Guide.

 

 



Creating Variable Bi-Tangent Circle Radius 
Fillets

Using a Spine

 
This command is only available with the Generative Shape Design 2 product.

This task shows how to create a variable bi-tangent circle radius fillet on an edge or 
consecutive edges that do not present any tangency continuity. The propagation along the 
edge(s) can be done smoothly when selecting a spine along which an arc of circle is slid. 
Cutting the resulting fillet surface by a plane normal to the spine would result in a circle of the 
specified radius value.

Using this type of radius may help solve twisted fillets created when using any other type of 
fillet.

 

Open the FilletVariableRadius2.CATPart document.
To find out more on variable radius fillets, refer to Variable Radius Fillets.

 
1.  Click the Variable Radius Fillet icon 

.

2.  Select the edge(s) to be filleted and 

click Preview.

The Variable Edge Fillet dialog box 
appears. 
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The fillet is previewed on the 
geometry.

3.  Change the radius value to 50mm.

4.  Expand the Variable Edge Fillet dialog box and check the Circle Fillet option:



5.  Select the line as a spine.

 

6.  Click OK to create the variable fillet.

The surface (identified as EdgeFillet.xxx) is 
added to the specification tree.



 

●     The same operation without checking the 
Circle Fillet option would have led to the 
following fillet:

●     You can use any curve as a spine, provided it covers all selected edges, i.e. it is longer than 
the set of selected edges.

●     In some cases, fillets may be overlapping. The Trim ribbons option lets you solve this by 
trimming the fillets where they overlapping. For further information on this option, refer to 
Trimming Overlapping Fillets.

 
●     Use the More>> button to display further options: 

❍     the edge that should not be filleted (see Edge Fillet)

❍     the circle fillet using a spine (see Variable Radius Fillet Using a Spine)

❍     the Blend corner(s) option (see Reshaping Corners).

 

 



Creating Face-Face Fillets
This task shows how to create a face-face fillet.
The fillet surface is obtained by rolling a sphere, which radius is larger than the distance 
between the selected elements, between the selected surfaces.

You generally use the Face-Face fillet command when there is no intersection between the 
faces or when there are more than two sharp edges between the faces.

 

●     Limiting Elements

●     Hold Curve

●     Filleting Volumes

Open the FaceFillet1.CATPart document.

1.  Click the Face-Face Fillet 

icon  .

The Face-Face Fillet Definition 

dialog box appears.

2.  Select the two Faces to 

fillet.

      

3.  Select the Extremities type, 

that is the relimitation mode.

 
●     Straight: no tangency constraint is imposed at the connecting point between the fillet and 

the initial support, generating sometimes a sharp angle

●     Smooth: a tangency constraint is imposed  at the connection between the fillet surface and 
the support surfaces, thus smoothing the connection

●     Maximum: the fillet surface is limited by the longest selected edge

●     Minimum: the fillet surface is limited by the shortest selected edge

(Refer to Shape Fillet)
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4.  Enter a radius value in the 

Radius field if you are not 

satisfied with the default one. 

This value must be greater 

than 0.

5.  Click Preview.

     

6.  Click OK.

The faces are filleted. This 
fillet is indicated in the 
specification tree.

Check the Trim support elements option to relimit the support elements and assemble them 
to the fillet.

7.  Click the More>> button.

Limiting Elements
While creating the fillet, you can limit it by selecting an element (plane or surface) that 
intersects it completely in the Limiting element field prior to selecting the trimming element. 
For further details, refer to Limiting Fillets.

This option is only available with the Generative Shape Design 2 product.

     

Hold Curve

This option is only available with the Generative Shape Design 2 product.

 Instead of entering a radius value, you can use a "hold curve" to compute the fillet. Depending 
on the curve shape, the fillet radius value is then more or less variable.



1.  Select both faces as shown 
then Join.2 as the hold curve. 

The curve must be sketched 
on one of the selected faces.

2.  Select Sketch.4 as the spine.
The spine provides a better 
control of the fillet.

To compute the fillet, the 
application uses circles 
contained in planes normal 
to the spine. It is then 
possible to control the 
shape of the fillet.

The spine can be a wireframe element or a sketcher element.

3.  Preview the fillet.
4.  Repeat the operation and 

select Sketch.3 as the spine.
5.  Click OK to create the fillet.

 

For more information, please refer to the CATIA V5 Part Design documentation.

 

Filleting Volumes  

Open the FilletingVolumes1.CATPart document.
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1.  Click the Face-Face Fillet 

icon  .

The Face-Face Fillet Definition 

dialog box appears.

2.  Select the two Faces to 

fillet.

3.  Set the Radius to 10mm.

4.  Click Preview.

5.  Click OK to create the fillet 

volume.

Extremities and Trim support options are grayed out, they cannot be used with volumes.

 Note that the selection of the feature prevails over the selection of the sub-element.
To select a sub-element, you need to apply the ''Geometrical Element'' filter in the User 
Selection Filter toolbar.
For further information, refer to the Selecting Using A Filter chapter in the CATIA Infrastructure 
User's Guide.



Creating Tritangent Fillets

This option is only available with the Generative Shape Design 2 product.

This task shows how to create a tritangent fillet. 

The creation of tritangent fillets involves the removal of one of the three faces selected, as the 
fillet surface is obtained by rolling a sphere, which radius is automatically computed to be 
larger than the removed surface, between the selected surfaces.

Open the Tritangent1.CATPart document.

1.  Click the Tritangent Fillet 

 icon.

The Tritangent Fillet Definition 

dialog box appears.

2.  Select the two Faces to fillet.

3.  Select the Extremities that is 

the relimitation mode:

●     Straight: no tangency constraint is 

imposed at the connecting point 

between the fillet and the initial 

support, generating sometimes a 

sharp angle.

 
●     Smooth: a tangency constraint is imposed at the connection between the fillet surface and 

the support surfaces, thus smoothing the connection

●     Maximum: the fillet surface is limited by the longest selected edge

●     Minimum: the fillet surface is limited by the shortest selected edge

(Refer to Shape Fillets)
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4.  Select the Face to remove.

The fillet will be tangent to this 

face. 

5.  Click OK.

The faces are filleted. The 
creation of this fillet is 
indicated in the specification 
tree.

●     Check the Trim support elements option to relimit the support elements and assemble 
them to the fillet.

●     While creating the fillet, you can limit it by selecting an element (plane or surface) that 
intersects it completely. This capability is available when clicking the More>> button, and 
clicking within the Limiting element field prior to selecting the trimming element. For 
further details, refer to Limiting Fillets.

   
 

Filleting Volumes  

Open the FilletingVolumes2.CATPart document.

1.  Click the Tritangent Fillet 

 icon.

The Tritangent Fillet Definition 

dialog box appears.

2.  Select the two Faces to fillet.
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3.  Select the Face to remove.

The fillet will be tangent to this 

face.

4.  Click OK to create the fillet 

volume.

Extremities and Trim support options are grayed out, they cannot be used with volumes.

 Note that the selection of the feature prevails over the selection of the sub-element.
To select a sub-element, you need to apply the ''Geometrical Element'' filter in the User 
Selection Filter toolbar.
For further information, refer to the Selecting Using A Filter chapter in the CATIA Infrastructure 
User's Guide.

 



Reshaping Corners  

Sometimes, when filleting, you can see that corners resulting from the operation are not 
satisfactory. This capability lets you quickly reshape these corners.

Open the BlendCorner1.CATPart document.

1.  Click the Edge Fillet icon  

and fillet the edges as shown 

using 5 mm as the radius value.

This option is available through the 

Variable Radius Fillet command  too.

Be careful when selecting edges as the 
order of selection affects the final shape 
of the fillet. This explains why you may 
sometimes encounter error messages 
when filleting. 
To obtain the shape we need for our 
scenario, please select the edges counter-
clockwise.

2.  Taking a closer look at the corner, 

you can notice that the edges 

need to be rounded again. 

3.  After launching the Edge Fillet dialog box to edit the fillet, click the More>> button to 

access additional options.
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4.  Click the Blend corner(s) button 

to detect the corner to reshape. 

In our example, only one corner is 

detected. The application shows it 

in the geometry area (3D text).

 

When the application detects several corners, it is not possible to reshape just a few of them: 
all of them will be edited.

The setback distance field determines for each edge a free area measured from the 
vertex along the edge. In this area, the system adds material so as to improve the 
corner shape.

 
5.  Enter a value in the setback distance field. For example, 13.

 

6.  Click Preview to examine the 

result.

 



To edit the distance for the top edge, 
click 13 and enter 22 as the new value in 
the Setback distance field.

 

7.  Repeat the operation for the edge 

below using the same distance 

value.

8.  Click OK to confirm the operation. The corner is reshaped.

 



 Translating Geometry

 
This task shows you how to translate one, or more, point, line or surface element.

Open the Translate1.CATPart document.

 
1.  Click the Translate icon 

.

 The Translate 
Definition dialog box 
appears as well as the 
Tools Palette.

2.  Select the Element to be translated.

3.  Select the Vector Definition.

Direction, distance

1.  Select a line to 

take its 

orientation as 

the translation 

direction or a 

plane to take 

its normal as 

the translation 

direction.

You can also 
specify the 
direction by 
means of X, 
Y, Z vector 
components 
by using the 
contextual 
menu on the 
Direction 
field. 
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2.  Specify the 

translation 

Distance by 

entering a 

value or using 

the spinners.

Point to Point

1.  Select the 

Start point.

2.  Select the End 
point.

Coordinates
1.  Define the X, 

Y, and Z 
coordinates.
In the example 
besides, we 
chose 50mm 
as X, 0mm as 
Y, and -100 as 
Z.

4.  Click OK to create the translated element.

The element (identified as Translate.xxx) is added to the specification tree.
The original element is unchanged.

  
●     Use the Hide/Show initial element button to hide or show the original element for the translation.

 
●     Choose whether you want the result of the transformation to be a surface or a volume by switching to either 

Surface or Volume option. This switch only concerns volumes since the transformation of a surface can only be 
a surface. Thus in case of multi-selection of volumes and surfaces, the switch only affect volumes.
Note that the switch between surface and volume is greyed out when editing the feature.
To have further information about volumes, please refer to the corresponding chapter.

Note that the selection of the feature prevails over the selection of the sub-element.
To select a sub-element, you need to apply the ''Geometrical Element'' filter in the User Selection Filter toolbar.
For further information, refer to the Selecting using a Filter chapter in the CATIA Infrastructure User's Guide.



 

●     Use the Repeat object after 
OK checkbox to create 
several translated surfaces, 
each separated from the 
initial surface by a multiple of 
the Distance value.
Simply indicate in the Object 
Repetition dialog box the 
number of instances that 
should be created and click 
OK.

 
●     The elements to be translated are kept next time you enter the command and you change the vector definition.

●     You can select an axis system as the Element to be translated, providing it was previously created.
The element is identified as Translate.xxx in the specification tree, however the associated icon is the axis 

system's .

 
Parameters can be edited in the 3D geometry. To have further information, please refer to the Editing Parameters 
chapter.
The following capabilities are available: Stacking Commands, Selecting Using Multi-Output, Measure Between and 
Measure Item.

 



 Rotating Geometry

 
This task shows you how to rotate geometry about an axis.

Open the Transform1.CATPart document.

 
1.  Click the Rotate icon .

 

 The Rotate Definition dialog box 
appears as well as the Tools 
Palette.

2.  Select the Element to be rotated.

3.  Select a line as the rotation Axis.

4.  Enter a value or use the drag 

manipulator to specify the rotation 

Angle.

5.  Click OK to create the rotated element.

The element (identified as Rotate.xxx) is added to the specification tree.

●     Use the Hide/Show initial element button to hide or show the original element for the 
translation.

 
●     Choose whether you want the result of the transformation to be a surface or a volume by 

switching to either Surface or Volume option. This switch only concerns volumes since the 
transformation of a surface can only be a surface. Thus in case of multi-selection of 
volumes and surfaces, the switch only affect volumes.
Note that the switch between surface and volume is greyed out when editing the feature.
To have further information about volumes, please refer to the corresponding chapter.
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Note that the selection of the feature prevails over the selection of the sub-element.
To select a sub-element, you need to apply the ''Geometrical Element'' filter in the User 
Selection Filter toolbar.
For further information, refer to the Selecting Using A Filter chapter in the CATIA Infrastructure 
User's Guide.

●     Use the Repeat object after OK 
checkbox to create several rotated 
surfaces, each separated from the 
initial surface by a multiple of the 
Angle value.
Simply indicate in the Object 
Repetition dialog box the number of 
instances that should be created and 
click OK.

 
●     You can select an axis system as the Element to be rotated, providing it was previously 

created.

The element is identified as Rotate.xxx in the specification tree, however the 

associated icon is the axis system's .

●     You can edit the rotated element's parameters. Refer to Editing Parameters to find out how 
to display these parameters in the 3D geometry.

The following capabilities are available: Stacking Commands,  Selecting Using Multi-Output, 
Measure Between and Measure Item.

 

 



Performing a Symmetry on Geometry 

 
This functionality is P2 for FreeStyle Shaper, Optimizer, and Profiler.

 
This task shows you how to transform geometry by means of a symmetry operation.

Open the Transform1.CATPart document.

 
1.  Click the Symmetry icon .

 

The Symmetry Definition dialog 
box appears as well as the Tools 
Palette.

2.  Select the Element to be transformed by symmetry.

3.  Select a point, line or plane as Reference element.

The figure below illustrates the resulting 

symmetry when the line is used as 

reference element.

The figure below illustrates the resulting 

symmetry when the point is used as reference 

element. 
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4.  Click OK to create the symmetrical element.

The element (identified as Symmetry.xxx) is added to the specification tree.

●     Use the Hide/Show initial element button to hide or show the original element for the 
translation.

 
●     Choose whether you want the result of the transformation to be a surface or a volume by 

switching to either Surface or Volume option. This switch only concerns volumes since the 
transformation of a surface can only be a surface. Thus in case of multi-selection of 
volumes and surfaces, the switch only affect volumes.
Note that the switch between surface and volume is greyed out when editing the feature.
To have further information about volumes, please refer to the corresponding chapter.

●     You can select an axis system as the Element to be transformed, providing it was 
previously created.
The element is identified as Symmetry.xxx in the specification tree, however the associated 

icon is the axis system's .

Note that the selection of the feature prevails over the selection of the sub-element.
To select a sub-element, you need to apply the ''Geometrical Element'' filter in the User 
Selection Filter toolbar.
For further information, refer to the Selecting using a Filter chapter in the CATIA Infrastructure 
User's Guide.

The following capabilities are available: Stacking Commands and Selecting Using Multi-Output.

 

 



Transforming Geometry by Scaling 

 
This task shows you how to transform geometry by means of a scaling operation.

Open the Transform1.CATPart document.

 
1.  Click the Scaling icon .

 The Scaling Definition 
dialog box appears as well 
as the Tools Palette.

2.  Select the Element to be transformed by scaling.

3.  Select the scaling Reference point, plane or planar surface.

4.  Specify the scaling Ratio by entering a value or using the drag manipulator.

The figure below illustrates the 
resulting scaled element when the 
plane is used as reference element 

(ratio = 2).

The figure below illustrates the resulting scaled element 
when the point is used as reference element (ratio = 2).

5.  Click OK to create the scaled element.

The element (identified as Scaling.xxx) is added to the specification tree.

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/Transform1.CATPart


●     Use the Hide/Show initial element button to hide or show the original element for the 
translation.

 
●     Choose whether you want the result of the transformation to be a surface or a volume by 

switching to either Surface or Volume option. This switch only concerns volumes since the 
transformation of a surface can only be a surface. Thus in case of multi-selection of 
volumes and surfaces, the switch only affect volumes.
Note that the switch between surface and volume is greyed out when editing the feature.
To have further information about volumes, please refer to the corresponding chapter.

Note that the selection of the feature prevails over the selection of the sub-element.
To select a sub-element, you need to apply the ''Geometrical Element'' filter in the User 
Selection Filter toolbar.
For further information, refer to the Selecting using a Filter chapter in the CATIA Infrastructure 
User's Guide.

●     Use the Repeat object after OK 
checkbox to create several scaled 
surfaces, each separated from 
the initial surface by a multiple of 
the initial  Ratio value.
Simply indicate in the Object 
Repetition dialog box the number 
of instances that should be 
created and click OK.

The following capabilities are available: Stacking Commands and Selecting Using Multi-Output.

 

 



Transforming Geometry by Affinity

 
This task shows you how to transform geometry by means of an affinity operation.

Open the Transform1.CATPart document.

 
1.  Click the Affinity icon .

 

 The Affinity Definition dialog box 
appears as well as the Tools Palette.

2.  Select the Element to be transformed by affinity.

3.  Specify the characteristics of the Axis system to be used for the affinity operation:

●     the Origin (Point.1 in the figures below)

●     the XY plane (the XY plane in the figures below)

●     the X axis (Line.1 in the figures below).

4.  Specify the affinity Ratios by entering the desired X, Y, Z values.

The figure below illustrates the resulting affinity
with ratios X = 2, Y =1 and Z=1.

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/Transform1.CATPart


The figure below illustrates the resulting affinity
with ratios X = 2, Y =1 and Z=2.

The figure below illustrates the resulting affinity
with ratios X = 2, Y =2.5 and Z=2



5.  Click OK to create the affinity element.

The element (identified as Affinity.xxx) is added to the specification tree.

●     Use the Hide/Show initial element button to hide or show the original element for the 
translation.

 
●     Choose whether you want the result of the transformation to be a surface or a volume by 

switching to either Surface or Volume option. This switch only concerns volumes since the 
transformation of a surface can only be a surface. Thus in case of multi-selection of 
volumes and surfaces, the switch only affect volumes.
Note that the switch between surface and volume is greyed out when editing the feature.
To have further information about volumes, please refer to the corresponding chapter.

Note that the selection of the feature prevails over the selection of the sub-element.
To select a sub-element, you need to apply the ''Geometrical Element'' filter in the User 
Selection Filter toolbar.
For further information, refer to the Selecting using a Filter chapter in the CATIA Infrastructure 
User's Guide.

The following capabilities are available: Stacking Commands and Selecting Using Multi-Output.

 

 



Transforming Elements
From an Axis to Another

 

This task shows you how to transform geometry positioned according to a given axis system 
into a new axis system. The geometry is duplicated and positioned according to the new axis 
system. One or more elements can be transformed at a time, using the standard multi-
selection capabilities.
See also Defining an Axis System.

Open the Transform2.CATPart document.

 
1.  Click the Axis To Axis icon .

 The Axis to Axis Definition dialog box 
appears as well as the Tools Palette.

2.  Select the Element to be transformed 

into a new axis system.

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/Transform2.CATPart


3.  Select the initial (Reference) axis 

system, that is the current one.

4.  Select the Target axis system, that is 

the one into the element should be 

positioned.

5.  Click OK to create the transformed element.

New geometry is now positioned into the new axis system.

The element (identified as Axis to axis transformation.xxx) is added to the specification tree.



●     Use the Hide/Show initial element button to hide or show the original element for the 
translation.

 
●     Choose whether you want the result of the transformation to be a surface or a volume by 

switching to either Surface or Volume option. This switch only concerns volumes since the 
transformation of a surface can only be a surface. Thus in case of multi-selection of 
volumes and surfaces, the switch only affect volumes.
Note that the switch between surface and volume is greyed out when editing the feature.
To have further information about volumes, please refer to the corresponding chapter.

●     You can select an axis system as the Element to be transformed, providing it was 
previously created.
The element is identified as Axis to axis transformation.xxx in the specification tree, 

however the associated icon is the axis system's .

Note that the selection of the feature prevails over the selection of the sub-element.
To select a sub-element, you need to apply the ''Geometrical Element'' filter in the User 
Selection Filter toolbar.
For further information, refer to the Selecting using a Filter chapter in the CATIA Infrastructure 
User's Guide.
The following capabilities are also available: Stacking Commands and Selecting Using Multi-
Output.

 

 



Inverting the Orientation of Geometry 

 
This task shows you how to easily invert the orientation of a surface or curve.

 
Open any document containing wireframe or surface type element.

 
1.  Select the Insert -> Operations ->  Invert Orientation... command.

2.  Select the surface or curve whose 

orientation is to be inverted.

An arrow is displayed on the geometry 

indicating the orientation of the element and 

the Invert Definition dialog box is displayed.

3.  Click the arrow to invert the orientation of the element, or click the Click to Invert 

button.

4.  Click OK to accept the inverted element.

The element (identified as Inverse.xxx) is added to the specification tree.
    

 

Once the orientation is inverted, the Click to Invert button changes to Reset Initial whether 
you changed the orientation using the button itself, or the arrow.

 

 



Creating the Nearest Entity of a Multiple 
Element

 
This task shows you how to create the nearest entity of an element that is made up from 
several sub-elements.

Open the Near1.CATPart document from the samples directory.

 
1.  Select the Insert -> 

Operations -> Near  

command.

The Near Definition dialog 
box appears. 

2.  Select the element that is made up from several sub-elements.

3.  Select a reference element whose position is close to the sub-element that you want to 

create.

The example below shows a parallel 
curve comprising two sub-elements

The example below shows the sub-element that is 
nearest to the reference point

4.  Click OK to create the element.

This element (identified as Near.xxx) is added to the specification tree.
   

The Near definition dialog box is automatically displayed, when a non-connex element is 
detected at creation time so that you can directly choose which element should be created.

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/Near1.CATPart


Creating Laws

 
This command is only available with the Generative Shape Design 2 product.

This task shows how to create evolution laws within a .CATPart document, to be used later on 
when creating Generative Shape Design elements, such as swept surfaces, or parallel curves.

 
Open the Law1.CATPart document.

 
1.  Click the Law  icon.

The Law Definition dialog box 
appears. 

2.  Select the reference line.

3.  Select a definition curve.

The law is computed as the distance between points on the reference line and their 

matching points onto the curve. 

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/Law1.CATPart


 Laws can be created using negative values.
The intersection between the reference line and the definition curve is taken into account to 
change the law evaluation sign. 
The direction lets allows you to choose which side of the reference line must be considered as 
positive.

    

 

If the X parameter on definition option is checked, the X parameter is displayed on the 
selected curve and represents the percentage of the curvilinear abscissa on this curve. The law 
is computed by projecting the start point normally onto the reference line.

   
You can analyze the law using the manipulator,, or specifying a value in the X field. This 
parameter represents the percentage of the curvilinear abscissa on this curve. The law is 
computed by projecting the start point normally onto the reference line.
The Y field indicates the distance between any point on the reference line and its matching 
point on the selected curve.

 
4.  Define the law amplitude by entering a value or using the graphic manipulators in the 

Scaling field.

 

When the law is applied to a geometric 
element, the latter usually is not of the same 
length as the reference line. Therefore a linear 
mapping is applied between the reference line 
and the element the law is applied to, 
resulting in a scaling of the law. 

In the illustration, the law is applied to a 
circular sweep (top) and to a parallel curve 
(bottom). The dotted lines represent the 
linear mapping between the law (middle) and 
the two elements to which it is applied.



5.  Click the Heterogeneous Law button 

to define the applied law unit (none for 

ratio law; degree, radian, or grade for 

angle law) and the distance measure 

units (current unit by default).

Two conversions will be performed 

during the law evaluation: 

●     conversion from the model unit 

(millimeters) to the stored measure unit

●     conversion form the stored applied law 

unit to the model unit (degrees) in case of 

an angle

6.  Click OK to create the law.

The law (identified as Law.xxx) is added to the specification tree.
It is now ready for use in the creation of other Shape Design elements. 

 

7.  Click the Parallel Curve icon  .

8.  In the Parallel Curve Definition dialog 

box, click the Law... button.

9.  Select the Law.1 from the specification 

tree.

10.  Click OK.

The law is applied to the selected 
element.



 

●     When the reference line and definition 
curve do not present the same length, 
only the common area is used to compute 
the law.



●     Check the Both sides option to generate a parallel curve symmetrically on each side of the 
selected curve.
Note that depending on the geometry, the elements may not appear symmetrical. They are 
if the curve is a line, otherwise, the resulting curves' shape may differ:

Resulting parallel curves
when a line is selected

Resulting parallel curves
when any curve is selected

●     When the X parameter on definition option is unchecked, the selected curve should not 
present several intersections with the plane normal to the reference line. If there are 
several intersections, the law cannot be evaluated and cannot be applied when creating 
geometric elements.

●     Laws created using the Knowledge Advisor product, being mathematical formulas, can be 
used with Generative Shape Design's operators, such as swept surfaces, or parallel curves 
for example.
For further information, refer to the Knowledge Advisor's User's Guide, Basic Tasks, 
Creating and Using a Knowledge Advisor Law.
Note that laws created with the Law icon of Generative Shape Design product, can be 
referenced by laws created with Knowledge Advisor product.

 

 



Extrapolating Surfaces

 
This task shows you how to extrapolate a surface boundary.

 
Open the Extrapolate1.CATPart document.

1.  Click the Extrapolate icon .

The Extrapolate Definition dialog box appears.

2.  Select a surface Boundary.

3.  Select the surface to be Extrapolated.

4.  Specify the Limit of the extrapolation by either:

●     entering the value of the extrapolation length

●     selecting a limit surface or plane

●     using the manipulators in the geometry.

5.  Specify the Continuity type:

●     Tangent

●     Curvature

Tangent Curvature

6.  Specify Extremities conditions between the extrapolated surface and the support surface. 

●     Tangent: the extrapolation sides are tangent to the edges adjacent to the surface boundary.

●     Normal: the extrapolation sides are normal to the original surface boundary.

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/Extrapolate1.CATPart


Tangent Normal

7.  Specify the Propagation type:

●     Tangency continuity to propagate the extrapolation to the boundary's adjacent edges.

●     Point continuity to propagate the extrapolation around all the boundary's vertices.

 

 Tangent continuity Point continuity

8.  Check the Assemble result option if you want the extrapolated surface to be assembled to the support surface.

 This option is now also available with the Curvature continuity.  

9.  Click OK to create the extrapolated surface.

The surface (identified as Extrapol.xxx) is added to the specification 
tree.

The Internal Edges option enables to determine a privileged direction for the extrapolation. You can select one or more edges (in the 
following example we selected the edge of Surface.1) that will be extrapolated in tangency. You can also select a vertex once you have 
selected an edge in order to give an orientation to the extrapolation.

You can only select edges in contact with the boundary.



No edges selected One selected edge

The Internal Edge option is not available with the Wireframe and Surface product.

You can extrapolate several elements at a time. In this case, refer to Editing a List of Elements to find out how to display and manage the 
list of selected elements.

The Up to element Type, the Extremities, and the Internal Edges options are not available with the Curvature continuity type.

 



Extrapolating Curves

 
This task shows you how to extrapolate a curve.

 
Open the Extrapolate2.CATPart document.

 
1.  Click the Extrapolate icon .

The Extrapolate Definition dialog box appears. 

2.  Select an endpoint on a curve.

3.  Select the curve to be Extrapolated (it can be a wire, an edge, a curve or a line)

4.  Select the extrapolation type:

❍     Length: enter the value in the Length field or use the manipulators in the 3D geometry.

In Curvature mode, this length actually is the distance on the tangent extrapolation at which a plane normal to the 

curve is located. This plane is used to split the extrapolated curve.

●     Up to: the Up to field is enabled. Select a curve belonging to the same support as the curve 

to be extrapolated (surface or plane).

4.  Specify Continuity conditions:

❍     Tangent: the extrapolation side is tangent to the curve at the selected endpoint.

❍     Curvature: the extrapolation side complies with the curvature of the selected curve.

This option is not available with the Up to type with a support.

Length extrapolation in Tangent mode Length extrapolation in Curvature mode
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 Up to extrapolation in Tangent mode  
If needed and if the  initial curve lies on a plane or surface, you can select this support. In this case the extrapolated curve lies 
on the surface too, and is relimited by the support boundary.

Extrapolation without support Extrapolation with a support

5.  Click OK to create the extrapolated curve.

The curve (identified as Extrapol.xxx) is added to the specification tree.

 

 



Editing Surfaces and Wireframe Geometry
Generative Shape Design provides powerful tools for editing surfaces and wireframe geometry. 

Edit definitions: double-click on the element in 
the tree and modify its parameters 

Select using a filter: select an object, and use 
the Selection Filter toolbar to manage element 
types and modes.

Replace elements: select the element to be 
replaced, choose the Replace... contextual 
command, then select the replacing element.

Create elements from an external file: key in 
space coordinates of elements into an Excel file 
containing macros, then run the macro.

Select implicit elements: press and hold the 
Shift key while clicking the element to which 
the implicit element belongs.

 Manage the orientation of geometry: double-
click a line or a plane in the specification tree, 
and change the Angle value.

Move elements from a geometrical set: select 
the element, use the Change Body contextual 
menu, select the element before which it 
should be inserted

 
Copy and paste: select the element(s) to be 
copied, click the Copy icon, select the target 
geometrical set, then click the Paste icon.

Delete geometry: select the element, choose 
the Delete command, set the deletion options

Deactivate elements: select the element to be 
deactivated, choose the Deactivate contextual 
menu and choose to deactivate its children as 
well, if needed.

 Isolate geometric elements: select the element 
to be isolated, choose the xxx object -> Isolate 
contextual menu.

 Edit parameters: click Preview while creating 
the element, or, if the element is already 
created, select it and choose the xxx object -> 
Edit Parameters contextual menu.

 Upgrade features: select the elements to be 
upgraded, choose the xxx object -> Upgrade 
contextual menu.



Editing Surface and Wireframe Definitions

 
This task shows how to edit the definition of an already created geometric element.

 
1.  Activate the Definition dialog box of the element that you want to edit in one of the 

following ways:

●     Select the element then choose the xxx.object -> Definition menu item from the 

contextual menu

●     Select the element then choose the Edit -> xxx.object -> Definition command

●     Double-click the element identifier in the specification tree

2.  Modify the definition of the element by selecting new reference elements or by entering 

new values.

3.  Click OK to save the new definition. 

 

 



Replacing Elements

This task shows how to replace a geometric element by another.
This may be useful when a modification occurs late in the design as the whole geometry based onto the element that is replaced is 
updated according to the new specifications coming from the replacing elements.

Open the Replace1.CATPart document.

 
1.  Right-click  the pink curve (Profile.1) and choose 

the Replace contextual menu. 

The Replace dialog box appears. 

     

2.  Click the With field and select the blue curve in the 

geometry.

The Replace dialog box is updated accordingly 
and the geometry displays the curves 
orientation.

 
You can check the Delete replaced elements and exclusive parents if you do not need these elements for later operations.

 

A warning message is issued if the element to replace is a 
published element.

●     Click Yes to replace the published element

●     Click No to cancel the operation and close the Replace 
dialog box.

In our example, we published Profile 1.
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3.  Click OK to validate the replacement.

The geometry is updated accordingly. 

 

 



Creating Elements From An External File
You can create points, curves, and multi-sections surfaces from a Microsoft Excel spreadsheet 
containing macros, and in which you define: 

●     the points space coordinates

●     the points through which the curves pass

●     the curves used as profiles for the multi-sections surface.

Only Excel sheets created with Excel 97 and subsequent versions are supported.
Therefore this capability is available with WindowsTM only.

Open any .CATPart document containing a Geometrical Set or an Ordered Geometrical Set.

1.  Open the ElementsFromExcel.xls file from the Samples directory into Excel, and enable 

the macros.

The document looks like this:

   

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/ElementsFromExcel.xls


It contains: 
●     instructions, such as StartMulti-SectionsSurface and EndMulti-SectionsSurface, StartCurve and 

EndCurve between which other instructions or numerical data are given.

●     numerical data that are point space coordinates: X, Y, Z respectively from the left to the right

●     a final End instruction

In the above example, a multi-sections surface is to be created based on three curves. The first 
and second curve pass through four points, and the third curve passes through five points.

The elements will be created from top to bottom, i.e. the four points of the first curve will be 
created, then the curve itself, then the points making up the second curve and the latter itself, 
and so forth.

You can add rows to create more elements or delete rows to edit elements or delete them (point), 
then save the spreadsheet.

2.  From Excel, 

select the 

Tools -> 

Macro -> 

Macros menu 

item.

The Macro 

dialog box 

is 

displayed. 

3.  Select the  

Feuil1.Main 

macro and 

click Run. 

   



The User Info dialog 
box is displayed. 

4.  Key in the type of element to be generated: 

●     1: to generate only the point(s)

●     2: to generate the points and the curve(s)

●     3: to generate the points, curves and multi-sections surface(s)

5.  Click OK.

The 
elements 
(points, 
curves, and 
multi-
sections 
surface) are 
created in 
the 
geometry. 
The 
specification 
tree is 
updated 
accordingly. 

●     The Generative Shape Design or Wireframe and Surface workbench needs not to be loaded, 
provided a CATIA session is running and a .CATPart document is loaded.

●     The curve definition is limited to 500 points, and the multi-sections surface definition to 50 
splines, with the delivered macro. This can be modified using the Excel macro edition 
capabilities.

 



Selecting Implicit Elements

 

There are many ways of selecting geometrical elements either in the geometry as described in 
the CATIA Infrastructure User's Guide, Selecting Objects section, or in the specification tree.

However, specific to wireframe and surface elements are some implicit elements, such as the 
axis of a cylinder, or the vertex of a cone for instance, participating in the creation of a feature 
yet not directly selectable as a separate element.

This task shows how to select these implicit elements.

 
Open the Cylinder1.CATPart document.

 
1.  Click the Spline icon 

 and successively 

select the four points.

The Spline 

Definition dialog 

box looks like this:

2.  Select Point.3 from the list, to impose a tangency constraint on this point. 

Note that you cannot select the cylinder's surface. 
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3.  Press and hold the 

Shift key, then move 

the pointer over the 

cylinder. 

The cylinder's axis is 

automatically 

detected as a 

selectable element to 

indicate a direction, 

and displayed.

4.  Click anywhere on the 

cylinder's surface, still 

holding the Shift key 

pressed down.

The tangency 

constraint 

direction, based on 

the cylinder's axis, 

is displayed at the 

selected point.

5.  Click OK to create the 

spline tangent to the 

cylinder at the 

selected point.



Managing the Orientation of Geometry

This task shows you how to manage the orientation of modified geometry.

This capability is only available with the Line and Plane functionalities.

Open the Orientation1.CATPart document.

1.  Double-click Line.2 in the specification tree.

The Line dialog box is displayed.

 
2.  Change the Angle value from 

180deg to 90deg.

 3.  Click OK to validate the modification.

 
The Orientation Management 
dialog box is displayed.

 

●     Click Yes to align the modified geometry with the original orientation.

An inverse element is created that replaces the original line or plane (here Line.2). The 

inversion is proposed according to the following criteria: the normal vectors to the planes or 

the tangent vectors to the lines, before and after edition, have a null or negative scalar 

product.

●     Click No to align the modified geometry with new orientation.

Refer to '' Inverting the Orientation of Geometry'' to have further information about the Inverse 
functionality.

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/Orientation1.CATPart


Moving Elements From a Geometrical Set

 

This task shows how to move any element from a Geometrical Set to another location within 
another body (Hybrid Body or Geometrical Set).

 

Open any .CATPart document containing several geometrical elements.
You can also open the GeometricalSets2.CATPart document.

 
1.  From the specification tree, select the 

element then choose the xxx.object -

> Change Geometrical Set...  item 

from the contextual menu.

Multi-selection of elements of different types is supported. However, note that in this case, the 
contextual menu is not available, and that you can access this capability using the Edit menu 
item.

The Change Body dialog box is 
displayed.

2.  Select the Destination Body for the selected element.

Here we selected Geometrical_Set.3.

You can do so by selecting the Body in the specification tree, or using the drop-down 

list from the dialog box.

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/GeometricalSets2.CATPart


3.  Select the element above which the 

one you already selected is to be 

inserted.

You can directly select this positioning element. In this case the Destination field of the 
Change Body dialog box is automatically updated with the Body to which this second element 
belongs.

4.  Click OK in the dialog box.

The element selected first is moved 

to its new location in the 

specification tree, but geometry 

remains unchanged. 

   

 

●     Check the Change body unshared 
parents option to move all parents of the 
first selected element to its new location, 
provided these parents are not shared by 
any other element of the initial body.
In this case, all the unshared parents are 
highlighted prior to the move.



●     Check the Change body all parents 
option to move all parents of the first 
selected element to its new location, 
regardless of whether these parents are 
used (shared) by any other element of the 
initial body.
In this case, all the parent elements are 
highlighted prior to the move.

   

●     You can move a whole branch, i.e. a whole 
body and its contents, at a time.
Here we moved Geometrical_Set.3 last in 
Geometrical_Set.1.

See also Managing Geometrical Sets.

 



Copying and Pasting

 
This task shows how to copy and paste geometrical set entities in your part design.

 
1.  Select the elements that you want to copy either directly in the part geometry or in the 

specification tree.

2.  Select the Edit -> Copy command.

3.  Click the Geometrical Set entity in the tree where you want to paste the selected 

elements.

4.  Select the Edit -> Paste command.

The elements are copied into the target Geometrical Set.

●     The identifiers of copied elements are incremented with respect to the original elements.

●     The original elements and copied elements can be edited independently.

●     A few elements cannot be copied/pasted as such. They need their parent element to be 
copied as well. This is the case with boundaries, extracts (basic and multiple edges), and 
fillets for example.
In this case, you may also consider using PowerCopies.

 

 



Deleting Surfaces and Wireframe Geometry
 

Deleting a Specific Element

 
This task shows how to delete geometry from your design.

 Open the Delete1.CATPart document.

 
1.  Select the entity you want to 

delete.  

2.  Select the Delete command either 

from the Edit menu or the 

contextual menu.

The Delete dialog box appears. 

3.  Set the desired options for managing the deletion of parent and children entities.

Two options are available: 
●     Delete exclusive parents: deletes the geometry on which the element was created. This 

geometry can be deleted only if it is exclusively used for the selected element

●     Delete all children: deletes the geometry based upon the element to be deleted, in other 
words, dependent elements

●     Delete aggregated elements: deletes the geometry based upon the elements 
aggregated to the element to be deleted

4.  Click OK to validate the deletion.

  

 

While deleting elements you may want to replace children of the deleted elements. To do this, 
click the More>> button to display the Advanced Children Management area, and refer to the 
Replacing Elements task as the replacement principles are the same.

 For further information, refer to "Deleting Features" in the Part Design User's Guide.
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Deleting Useless Elements

 
This command is only available with the Generative Shape Design 2 product.

 
This task shows how to delete all un-referenced elements, i.e. not participating in the creation 
of other geometrical elements.

 

Please note that the command would delete all the elements of the part, if you do not wish all 
elements to be deleted, you have to specify it.

 
Open the Delete1.CATPart document.

 
1.  Choose the Tools -> Delete useless elements menu item.  

The Delete Useless Elements dialog box appears. 
It lists all the wireframe and surface elements, datum or not, that are present in the 
document or in other documents when working in context (in a CATProduct 
document referencing CATPart documents). 

 
When an element is used by a Part Design feature, its status is Keep, used by solid, meaning 
it cannot be deleted.
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2.  Select an element you wish to keep from the list, and using 

the contextual menu, choose the Keep menu item.

The list of un-referenced elements is automatically 

updated, indicating a new status for the selected element 

(Keep) and which elements are to be kept as a 

consequence (Keep, propagate status).

In the bottom left corner of the dialog box, the global 

status is also updated.

3.  Click OK to confirm the deletion of all elements listed  with the Delete status.

●     Use the Delete contextual menu item, to delete an element which status is either Keep or 
Keep, propagate. 
Also available in the contextual menu, are the Center Graph and Reframe On items.

●     Bodies, whether Geometrical Sets, Ordered Geometrical Sets or PartBodies located directly 
below the main Part are not displayed in the list, as when creating a new document, they 
are necessarily empty of geometric elements, and it does not make sense to delete them.

 

 



Deactivating Elements
This task shows how to inactivate a geometric element.
This may be useful when, in a complex part, a branch of the part should not be affected by an 
update, or is not updating correctly for instance.
This capability will let you work on the other elements present in the document while ignoring a 
specific element.
Deactivated elements are identified by the () symbol in the specification tree. Also refer to 
Symbols Reflecting an Incident in the Geometry Building.

Open the Join3.CATPart document.

 
1.  Right-click  the element to be deactivated from the specification tree, and choose the 

XXX object -> Deactivate contextual command. 

Here we select Extrude.4. 

●     If the selected element does not have any children, it 
is directly deactivated. This is indicated by a symbol in 
the specification tree: 

    
 

  
●     If the selected element has children, the Deactivate 

dialog box appears, listing the elements to be 
deactivated, and their children as affected elements.

In this case, the geometry is displayed in red, as if 
needing an update.

http://arbre1dsy/spuCXR14/Doc/online/cfyugprt_C2/cfyugsymbol4.htm
http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/Join3.CATPart


There are two deactivation modes: 
●     Copy mode: the deactivation is performed on the modification operation of the feature 

(providing a modification of a feature of same dimension). When selected, the feature can 
be seen in the 3D geometry.
Here are the features concerned by this mode: 

❍     Projection

❍     Curve Smooth

❍     Blend (with Trim option only)

❍     Corner (with Trim option only)

❍     Shape Fillet (with Trim option only)

❍     Connect Curve (with Trim option only)

❍     Parallel Curve

❍     Offset

❍     Variable Offset

❍     Rough Offset

❍     3D Curve Offset

❍     Split (on the Element to cut)

❍     Trim (on the Element to cut)

❍     All transformations in creation and modification modes

❍     Extrapolating Surfaces (with Assemble Result option only)

❍     Extrapolating Curves (with Assemble Result option only)

❍     Join (copy of the first element)

❍     Healing (copy of the first element)

❍     Combine

❍     Develop

❍     Wrap Curve

❍     Wrap Surface

❍     Bump

❍     Shape Morphing

●     Destructive mode: the deactivation makes the feature unusable. When selected, the 
feature cannot be seen in the 3D geometry.
Here are the features concerned by this mode: 

❍     Line

❍     Plane

❍     Circle

❍     Reflect Line

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/sdgugbt0202.htm
http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/sdgugbt0207.htm


❍     Spiral

❍     Spline

❍     Helix

❍     Intersection

❍     Extrude

❍     Revolution

❍     Cylinder

❍     Sweep (except tangent sweeps with trim option)

❍     Multi-Sections Surface

You are advised to propagate the deactivation by checking the Deactivate impacted 
elements button when it is a destructive one.

 For instance, the corner using the trim option replaces the tangency curve. Therefore the 
deactivation is performed in copy mode. However, the corner without the trim option is a curve 
creation operation. Therefore, the deactivation is performed in destructive mode.

  

 

When elements are imported using multi-part links (external references) or using a Copy-Paste 
As result with link, the deactivation concerns the link, not the feature. As a consequence, the 
feature can still be selected.

2.  Click OK.

The selected element and its children are 
deactivated.
The ( ) symbol is displayed in the specification 
tree, and the corresponding geometry is 
hidden. 

It is not possible to deactivate datum elements as they do not have an history. Indeed, a 
deactivation would destroy their geometry and a reactivation would therefore be impossible.

●     To re-activate the elements, right-click their name in the specification tree and choose the 
XXX object -> Activate contextual command. 

●     Multi-selection is available, i.e. you can select several elements to be deactivated at a time. 
In this case the Deactivate dialog box will show a list of the selected elements.

 

 

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/sdgugbt0104.htm


Isolating Geometric Elements

 

This task shows you how to isolate a geometric element, that is how to cut the links the feature 
has with the geometry used to create it.

To perform this task, create a plane using an offset of 20mm from a pad's face.

1.  Prior to isolating the plane, note that if you edit the offset value...

 

 ...you can obtain this kind of result:
 



 2.  Right-click the plane as the element you want to isolate. The element you can isolate 

can be:

❍     a plane

❍     a line

❍     a point

❍     a circle

3.  Select the xxx object -> Isolate command from the contextual menu.

The geometrical link between the plane and the face is no longer maintained. This 

means that the face is no longer recognized as the reference used to create the plane, 

and therefore, you can no longer edit the offset value.

The way the plane was created is ignored. You can check this by double-clicking the 

plane: the Plane Definition dialog box that appears indicates that the plane is of the 

explicit type.

In the specification tree, the application indicates isolated elements via a red symbol in 

front of the geometrical element.

 

 
An isolated feature becomes a datum feature. For more information, refer to Creating Datums.



Editing Parameters

This task shows how to view dimensions in the 3D geometry when creating or editing a 
feature. 

This command is available on the following commands:

 
Operator Type Sub- Type Parameter 

displayed

Bump   Length, 
Deformation, 
Distance
(Maximum distance 
along the 
deformation 
direction from the 
deformed surface)

Circle Center and Radius Radius, Start Angle, 
End Angle

Center and Point  Start Angle, End 
Angle

Two Points and 
Radius

Radius

Bitangent and 
Radius

 Radius

Center and 
Tangent

Point as 
center 
element

Radius

Corner   Radius

Curve Parallel   Constant (Offset 
Distance)

Diabolo   Draft Angle

Extrapolate Length  Length, Limit Type

Extrude   Length 1, Limit 1
Length 2, Limit 2 

Helix   Taper Angle, 
Starting Angle
Length: Pitch
Length: Height

Line Angle/Normal to 
Curve

 Angle

Point-Point



 

Length : Start, End
Infinite Start Point: 
End
Infinite End Point: 
Start
Infinite: /

Point-Direction

Angle-Normal to 
Curve

Tangent to Curve

Normal to Surface

Bisecting

Offset   Offset Value

Plane Angle/Normal to 
Plane

Angle 
(Angle/Normal to 
Plane and 
Angle/Normal to 
Curve)

Offset from Plane  Length, Offset 
Distance

Point Coordinates  Length, X, Y, Z 
coordinates

On Curves  Length, Length

On Plane  Length, H, V

On Surface  Length, Distance

Polyline   Radius, Radius at 
point

Reflect Line   Angle

Revolve   Angle1, Angle2

Rotate   Rotation Angle

Shape Fillet Bi-Tangent Fillet  Radius

Sphere   Parallel Start Angle, 
Parallel End Angle, 
Meridian Start 
Angle, Meridian End 
Angle

Radius, Radius

Spiral End Angle

Angle and Radius  Length: Start 
Radius
Length: End Radius

Angle and Pitch  Length: Start 
Radius
Length: Pitch

Radius and Pitch  Length: Start 
Radius
Length: End Radius
Length: Pitch



Sweep Explicit Sweep  Angle

Linear Sweep Two Limits Length1, Length2

With 
Reference 
Surface

Angle, Length1, 
Length2

With 
Reference 
Curve

Angle, Length1, 
Length2

With Draft 
Direction

Angle, Length1, 
Length2

Translate Distance and 
Direction

 Distance

     

Create any of the features above.
Let's take an example by performing a rotation. 

1.  Once you selected the 

inputs to create the 

rotated element, click 

Preview to display the 

associated parameters in 

the 3D geometry.

2.  Double-click the angle 

value in the 3D 

geometry.

The Parameter 

Definition dialog box 

appears.



3.  Use the spinners to 

modify the value.

The display 

automatically updates 

and the object is 

modified accordingly.

You can also modify the angle 
value using the Angle 
manipulators.

●     To display the parameters' values, you need to click the Preview button. Otherwise, only 

manipulators are displayed.

●     To edit the parameters once the feature is created, select it in the specification tree, right-

click xxx.1object -> Edit Parameters from the contextual menu.

 
●     If you want the parameters to be kept permanently, check the Parameters of features 

and constraints option in Tools -> Options -> Infrastructure -> Part Infrastructure -

> Display.



Upgrading Features

This task aims at improving the upgrade of a feature by manually upgrading it.

Open the Upgrade1.CATPart document.

1.  Right-click the feature that needs to be upgraded.

2.  Select the Upgrade item from the contextual menu.

In our scenario, Plane.1 needs to be upgraded.

 May the orientation of 
the element be modified 
by the upgrade, a 
warning message is 
issued.
If no dialog box is 
displayed, it means that 
the orientation of the 
geometry is unchanged.

   
 

In the 3d geometry, a 
red and a green arrow 
show the orientation 
before and after the 
upgrade.

  
Upgrading a feature enables to create its 3D parameters.
See Editing Parameters.

  

●     Note that only the algorithm linked to the topology and the geometry of the feature is 
upgraded.

●     This capability is not available with sketches.

 

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/Upgrade1.CATPart


Using Tools
Generative Shape Design provides powerful tools to help you manage and analyze your surfaces and 
wireframe geometry. 

Display parents and children: select the feature under study, 
the Tools -> Parent / Children... command and use the 
diverse contextual commands to display parents and 
children.

 
Scan Toolbar

Quick selection: click the icon, and select the element.

Scan the part and define local objects: Select the the Edit -
> Scan or Define in Work Object... command, click the 
buttons to move from one local feature to the other, then the 
Exit button.

 
Tools Toolbar

 
Update your design: select the element and click the icon or 
use the contextual menu

 
Define an axis-system: set the origin and X, Y, and Z 
directions

Use the historical graph: select an element, click the icon 
and work in the graph

Work with a support: click the icon and select a plane or 
surface as support element

Work with a 3D support: click the icon and select a define 
the 3D support type: Reference or Local

Snap on a point: snap to the nearest intersection point when 
working with a support 

Work on support activity: define the default current support 
to be selected when a working support is required

Create plane systems: select a plane system type, a 
direction, and an origin.

Create datums: click the icon to deactivate the History mode

 
Perform a temporary analysis: select this mode once you 
enter the Offset command in order to check the connections 
between curves or surfaces



Insert elements: click the icon to automatically insert a new 
element after its main parent

 Keep the initial element: click either icon to retain or not the 
element on which you are performing an operation.

Display only the current body: click the icon to display only 
the features of the current geometrical set (or ordered 
geometrical set) and therefore greatly improve the 
application performances whenever you edit these features. 

Instantiate PowerCopies: click this icon to manage and 
browse catalogs. 

Instantiate PowerCopies: Select the Insert -> Instantiate 
From Document command, select the document or catalog 
containing the  powercopy, complete the Inputs within the 
dialog box selecting adequate elements in the geometric 
area.

Select bodies using the body selector: click the combo, 
choose a body, release the combo

 
Analysis Toolbar

Check connections between surfaces: select the surfaces, 
and set the analysis type and parameters

 
Check connections between curves: select two curves, 
specify the type of analysis (distance, tangency, curvature) 
and set the analysis parameters
Perform a draft analysis: select the surface, set the analysis 
mode and color range parameters, and manipulate the 
surface
Perform a surfacic curvature analysis: select the surface, set 
the analysis mode and color range parameters, and 
manipulate the surface
Perform a curvature analysis: select a curve or surface 
boundary, specify the curvature comb parameters (spikes 
number and length, orientation, etc.)

 
Apply a dress-up: set the display options then apply or 
remove the visualization options on selected elements.

Display information on elements: click the icon and select 
any element

 
Constraints Toolbar

Create constraints: select the element to be constrained

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/sdgugat0202.htm#hj-catalog
http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/sdgugat0202.htm#hj-instantiatefromdoc
http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/sdgugat0202.htm#hj-instantiatefromdoc


Create constraints on several elements: multi-select element 
and check the adequate options

 
Annotations Toolbar

Create a text with leader: click this icon, select a face and 
enter your text in the dialog box

Create a flag note with leader: click this icon, select the 
object you want to represent the hyperlink, enter a name for 
the hyperlink and the path to the destination file

 
View/Annotation Planes

Create a projection view/annotation plane: click this icon and 
select a planar element.

Create a section view/annotation plane: click this icon and 
select a planar element.

Create a section cut view/annotation plane: click this icon 
and select a planar element

 
Apply Material Toolbar

Apply a material: select an object, click the icon, and select a 
material

 
Miscellaneous

Apply a thickness: select a surface, the Tools -> Thin Parts 
Attribute... command and define the thickness 

Analyze using parameterization: select the Tools -> 
Parameterization Analysis... command and define a filter 
for your query

Manage groups: choose the Create Group contextual menu 
on a geometrical set and select the group's elements

Edit groups: choose the Edit Group contextual menu on a 
group

Collapse/Expand groups: choose the Collapse/Expand Group 
contextual menu on a group

Move groups: choose the Change Body contextual menu and 
select a new geometrical set



 
Repeat objects: select an object, choose the Object 
Repetition... menu item and key in the number of object 
instances
Stack commands: right-click an editable field, choose the 
contextual menu item allowing the creation of another 
element.

 
Select using multi-selection: select one or more elements 
through the Multi-Selection dialog box and validate you 
modification to return to the current command
Select using multi-output: select several elements, click OK. 
The Multi Output feature appears in the specification tree, 
grouping elements

 
Manage multi-result operations: select the element(s) to 
keep in case the result in not connex



Displaying Parents and Children

 

The Parent and Children command enables you to view the genealogical relationships between the 
different components of a part.  

It also shows links to external references and explicitly provides the name of the documents containing 
these references.

If the specification tree already lets you see the operations you performed and re-specify your design, 
the graph displayed by the Parent and Children capability proves to be a more accurate analysis tool. We 
recommend the use of this command before deleting any feature.

 

Open the Parent_R9.CATPart document.

 

1. Select the feature of interest, that is Pad1.

2. Select the Tools -> Parent/Children... command (or the Parent/Children... contextual 
command). 

A window appears containing a graph. This graph shows the relationships between the different 
elements constituting the pad previously selected.

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/Parent_R9.CATPart


 

If you cannot see the element of interest in the specification tree because you have created a large 
number of elements, right-click this element in the graph then select the Center Graph contextual 
command: the element will be more visible in the specification tree.

3. Position the cursor on Pad 1 and select the Show All Children contextual command.  

You can now see that Sketch 2 and Sketch 3 have been used to create two additional pads.

Here is the exhaustive list of the diverse contextual commands allowing you to hide parents and 
children. These commands may prove quite useful whenever the view is overcrowded. 

●     Show Parents and Children

●     Show Children

●     Show All Children

●     Hide Children

●     Show Parents

●     Show All Parents

●     Hide Parents

 4. Position the cursor on Sketch.1 and select the Show Parents and Children contextual command. 

We can see that Sketch.1 has been created on xy plane. 

Moreover, you can see that it is a published element.

http://arbre1dsy/spuCXR14/Doc/online/cfyugprt_C2/cfyugpublish.htm


5. Now, select EdgeFillet1 in the graph.

The application highlights the fillet in the specification tree, in the graph and in the geometry area.

6. Position the cursor on EdgeFillet1 and select the Show Parents and Children contextual command.

The parent Pad.1 is displayed.

 

●     Double-clicking on the components alternately shows or hides parents and children.

●     The Edit contextual command can be accessed from any element. For example, right-click 
EdgeFillet.1 and select Edit. The Edge Fillet dialog box appears. You can then modify the fillet. When 
done, the  Edge Fillet dialog box closes as well as the Parents and Children window close and the fillet 
is updated. 

 
7. Close the window and select MeasureEdge3 from the specification tree.

 8. Select the Tools -> Parent/Children... command.

The graph that displays shows Pad.2 as MeasureEdge3's parent.

 



 

9. Select the Show All Parents contextual command.

Sketch.2 as Pad.2's parent is now displayed. In turn, Sketch.2's own parent Pad.1 is displayed and 
so on.

 



Quick Selection of Geometry
This task shows how to access rapidly to sub-elements in the geometry without scrolling in the 
specification tree and while already being in a command. You simply identify the generating 
element of the final element, without necessary trace the parents, especially if the generating 
element is not visible.

 
Open the QuickSelect1.CATPart document.

1.  Click the Offset icon 

 to perform an offset 

of the Extrude.2 surface.

The Offset Surface 
Definition dialog box 
appears. 

When you want to select the Extrude.2 surface as the Surface to offset, you notice that the 

root surface is not visible in the 3D geometry as it is in no show.

In order to retrieve this surface, you can use the Quick Select shared capability.

 
2.  Click the Quick Select  icon.

 
3.  Move the pointer over the geometry.

Just like in the regular selection mode, the element is highlighted in the geometry area, 

and the object name is highlighted in the specification tree. Moreover, the identity of 

the pre-selected element is displayed in the status bar: 

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/QuickSelect1.CATPart


 

4.  Click the element 

(Split.1).

Information is displayed on the 

whole geometry: 

●     in green: the feature 

selected using the standard 

selection tool

●     in red: its direct parents

●     in purple: the "generating" 

element, that is the feature 

generating the underlying 

surface/curve where you 

initially selected the element.

If you display the element's graph using the the Show Historical Graph icon , you can 

better relate the elements to its "parents:



 

●     The Split.1 is the last generated element, to the left of the graph, and is displayed in 
green.

●     The Project.1 is its direct parent, as shown in the graph and is displayed in red.

●     The Fillet.1 is another direct parent, but is also the generating one, as it is the first element 
that unite other independent elements (the extruded surfaces)  that lead to the creation of 
the split. Therefore it is displayed in purple, the precedence being given to the generating 
element over the direct parent.

 

Along with the information onto 
the geometry, the Quick Select 
dialog box is displayed: it 
indicates which element has 
been selected, as well as its 
parents, and children where 
applicable.

       



Within the dialog box, navigate 
in the Parents / Children graph in 
order to retrieve the root 
surface: select the Fillet.1 
element as Quick Select, then 
the Extrude.2 element. The 
latter is set as the current 
element.

The Quick Select dialog box is 
updated accordingly: 

The contextual menu is available 
on the current element, 
displaying standard commands 
such as Reframe On, Delete, 
Replace, etc.

5.  Use the check buttons at 

the bottom of the dialog 

box to  display or hide a 

number of elements in 

the geometry.

●     If you check the Hide other 

elements and the Parents 

button, you see this:

●     If you check the Hide other 
elements and Current (i.e. 
the only filleted surface) 
buttons, you see this:

●     If you check Children button 
only (i.e. the projection and 
the split), you see this:

6.  Click OK in the dialog box. 



The Quick Select dialog box 

closes and you return to the 

Offset Surface Definition dialog 

box.

The Surface field is valuated 

with the Fillet.1 surface you 

previously selected.

 
7.  Specify the Offset.

8.  Click OK to create the offset surface.

●     You can double-click on any arrow, not necessarily the generating parent as shown above, 
to edit any of the elements. 

●     You can also edit any of the elements by using the contextual menu available on all 
elements from the Quick Select dialog box, as well as from the texts in the geometry. 

 

●     You can select another "final" 
element directly in the 
geometry, without having to 
reselect the Quick Select 

 icon.

●     Click in space to deselect any geometry and reset the quick selection without deselecting 
the icon.

 



Scanning a Part and Defining In Work 
Objects  

 

This task shows how to scan the part and define a current object without taking the complete 
part into account. Therefore, it is useful for the analysis of the better understanding of the 
part design.
Both geometrical sets and ordered geometrical sets can be scanned. 

 
Open the Scan1.CATPart document.

 
1.  Select the Edit -> Scan or Define in Work Object... command or click the  

icon from the Select toolbar.

The Scan toolbar appears enabling you to navigate through the structure of your part. 
Moreover, the part can be updated feature by feature.

You actually need to click the buttons allowing you to move from one current feature to the 
other. Sketch elements are not taken into account by the command.

2.  Select the Scan mode to define the way of scanning:

Structure

All features of the part are now scanned in the order of display in the specification tree. 
The current position in the graph corresponds to the in work object.

Internal elements of sketches, part bodies and bodies, ordered geometrical sets, and 
elements belonging to a geometrical set are not taken into account by this mode.

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/Scan1.CATPart


 

1.  Click the Display 

Graph icon .

The Scan Graph 
dialog box appears 
and displays all 
the features 
belonging to 
Scan1 part.

 
Update

All features of a part are scanned in the order of the update (which is not necessarily the 
order of the specification tree). 
The current position in the scan graph does not correspond to the in work object: indeed the 
underlined object in the graph is not necessarily the one underlined in the specification tree. 

●     Datum features appear first; geometrical sets, ordered geometrical sets and deactivated 
features do not appear in the Scan Graph.

●     The part is put in no show, so is its 3D display, in order to build a new 3D display that 
contains the same features but in a different order.

 Deactivated features appear in the Scan Graph.

As a consequence, if a geometrical set or an ordered geometrical set is in no show, it is 
ignored and its elements are considered as being in show. 
To put the contents of this geometrical set or ordered geometrical set in no show, use the  
Geometrical_Set.x object -> Hide components contextual command.
Refer to the Hiding/Showing Geometrical Sets or Ordered Geometrical Sets and Their 
Contents chapter for further information.



 

1.  Click the Display 

Graph icon .

The Scan Graph 

dialog box appears 

and displays all 

the features 

belonging to 

Scan1 part.

3.  Select a feature in the Scan 

Graph or in the specification 

tree. The application highlights 

the feature in question in the 

specification tree as well as in 

the geometry area and make it 

current.

In our example, we chose 

EdgeFillet.1.

●     A preview of the current object's 
parents is available: surfaces 
appear as transparent and edges as 
dotted yellow lines.

●     If a parent of the in work object is 
in no show, it is temporarily shown 
when its child is the in work object.



 
4.  Click the Previous arrow  

to move to the previous 

feature, that is Pad.1

5.  Click the First arrow  to 

move to the first feature, that 

is Point.4 (the last datum 

point).

In case there are several datum 
features, the application highlights the 
last one as there are all scanned at the 
same time.

6.  Click the Next arrow  to 

move to the next feature, that 

is Sketch.1.

Scanning Next and Previous skip 

datum and deactivated features.

 
7.  Click the Last arrow  to 

move to the last feature, that is 

Point.2.

Moving to the next or last feature 
enables to update elements that are 
not up-to-date.

8.  Click the First to Update  icon to move to the first element to be updated and 

consequently update it.



If both geometry and part 
are up-to-date, an 
information panel appears.

 
9.  Click this icon again to find the 

next element to be updated 

and so on until an information 

panel appears to inform you 

that both geometry and part 

are up-to-date.

 

 
10.  Click the Play Update icon  to replay the update of the geometry.

A progression bar is displayed, while the scenario is being replayed.

 

 In case there are update errors, the replay stops at the first error. The Update Error dialog 
box opens.

11.  Click the Exit button  to exit the command.

In the geometry area and the specification tree, the application highlights the 
current object.
If the object was in no show, it is put in show as long as it stays current.



 

Defining a feature as current without scanning the whole part is possible using the Define in 
Work Object contextual command on the desired feature. This feature is put in show if 
needed, and keeps its status even if another feature is defined as the in work object.

 
When clicking a sub-element in the 3D geometry, it is in fact the feature used to generate 
this sub-element which is selected as the in work object. Likewise, this feature is edited when 
double-clicking a sub-element.

To display 3D parameters attached to Part Design features, check the Parameters of 
features and constraints option in the Tools -> Options -> Infrastructure -> Part 
Infrastructure -> Display.

 



Updating Your Design

 

This task explains how and when you should update your design.

The point of updating your design is to make the application take your last operation into 
account. Indeed some changes to geometry or a constraint may require rebuilding the part. To 
warn you that an update is needed, CATIA displays the update symbol next to the part name 
and displays the corresponding geometry in bright red.
To update a part, the application provides two update modes: 

●     automatic update, available in Tools -> Options -> Mechanical Design -> Assembly 

Design -> General tab. If checked, this option lets the application update the part when 

needed.

●     manual update, available in Tools -> Options -> Mechanical Design -> Assembly 

Design -> General tab, it lets you control the updates of your part. You simply need to 

click the Update icon  whenever you wish to integrate modifications. 

 
Non-updated wireframe and surface elements are displayed in red.

 
1.  To update the part, click the Update icon .

A progression bar indicates the evolution of the operation. 

 
You can cancel the undergoing update by clicking the Cancel button available in the Updating... 
dialog box.

●     Keep in mind that some operations such as confirming the creation of features (clicking 
OK) do not require you to use the update command. By default, the application 
automatically updates the operation.

●     The Update capability is also available via Edit -> Update and the Update contextual 
command. 



●     To update the feature of your choice, just select that feature and use the Local  Update 

contextual command.

●     Besides the update modes, you can also choose to visualize the update on the geometry as 
it is happening by checking the Activate Local Visualization option from the Tools -> 
Options -> Infrastructure -> Part Infrastructure, General tab.

In this case, as soon as you have clicked the Update icon :

1.  the geometry disappears from the screen
2.  each element is displayed as it is updated, including elements in No Show 

mode. Once they have been updated, they remain in No Show mode.

Interrupting Updates

 

This task explains how to update a part and interrupt the update operation on a given feature 
by means of a useful message you previously defined.

 
Open any document containing geometric elements.

 
1.  Right-click an element from the specification tree and choose the Properties contextual 

menu item.

The Properties dialog box is displayed. 

2.  From the Mechanical tab, check the Associate stop update option.

3.  Enter the text to be displayed when the updating process will stop when reaching this 

element.

4.  Click OK to confirm and close the dialog box.



The Stop Update.1 feature is displayed in the 
specification tree, below the element for which it was 
defined.

5.  Whenever it is needed, click the Update icon  to update the whole part.

The updating process stops after having updated the element selected above, and 

issues the message as has been defined earlier:

6.  Click Yes or No, depending on what you intend to do with the geometry created based 

on the selected element.

 

Would you no longer need this capability, you can: 
●     right-click the element for which the stop was defined, choose the Properties contextual 

command and check the Deactivate stop update option from the Mechanical tab: the 
update will no longer at this element.

You notice that when the capability is deactivated, the Stop Update icon changes to:  in 

the specification tree.

●     right-click Stop Update.1 from the specification tree, and choose the Delete contextual 
command.

 



Defining an Axis System
This task explains how to define a new three-axis system locally. There are two ways of defining it: either by selecting 
geometry or by entering coordinates.

Open the PowerCopyStart1.CATPart document.

1.  Select the Insert -> 

Axis System  command 

or click the Axis 

System icon .

The Axis System 
Definition dialog box 
is displayed.

An axis system is composed of 
an origin point and three 
orthogonal axes. For instance, 
you can start by selecting the 
vertex as shown to position the 
origin of the axis system you 
wish to create. The application 
then computes the remaining 
coordinates. Both computed 
axes are then parallel to those 
of the current system. The axis 
system looks like this:

 It can be right or left-handed. This information is displayed within the Axis System Definition dialog box. 
You can choose from different types of axis system:

Origin 

Instead of selecting the geometry to define the origin point, you can use one of the following contextual commands 
available from the Origin field:

●     Create Point: for more 
information, refer to Points

●     Coordinates: for more 
information, refer to Points

●     Create Midpoint: the origin 
point is the midpoint 
detected by the application 
after selection of a 
geometrical element.
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●     Create Endpoint: the 
origin point is the endpoint 
detected by the application 
after selection of a 
geometrical element 

 
Axis System Types 

You can choose from different 
types of axis systems:

 

●     Standard: defined by a point 
of origin and three 
orthogonal directions (by 
default the current 
directions of the compass)

Here only the point was 
selected and nothing specified 
for the axes.

   

●     Axis rotation: defined as a 
standard axis system and a 
angle computed from a 
selected reference

Here the Y axis was set to the 
standard axis system Y axis, 
and a 15 degrees angle was set 
in relation to an edge parallel to 
the X axis.



●     Euler angles: defined by 
three angle values as 
follows:

Angle 1= (X, N)
a rotation about Z transforming 
vector X into vector N.

Angle 2= (Z, W)
a rotation about vector N 
transforming vector Z into 
vector W.

Angle 3= (N, U)
a rotation about vector W

2.  Select the point as shown to position the origin of the axis system you wish to create. The application then 

computes the remaining coordinates. Both computed axes are then parallel to those of the current system. The 

axis system looks like this:

3.  If you are not satisfied with x axis, for instance click the X axis field and select a line to define a new direction 

for x axis.

The x axis becomes collinear with this line.



●     It can be a line created 
along the surface edge, for 
example, using the Create 
Line contextual menu on 
the selection field, and 
selecting two surface 
vertices.
Similarly you can create 
points, and planes.

●     You can also select the 
Rotation contextual menu, 
and enter an angle value in 
the X Axis Rotation dialog 
box.

4.  Click the y axis in the geometry to reverse it.

Checking the Reverse button next to the Y Axis field reverses its direction too.

5.  You can also define axes 

through coordinates. 

Right-click the Z Axis 

field and select the 

Coordinates contextual 

command. The Z Axis 

dialog box appears.

6.  Key in X = -1, retain the 

Y and Z coordinates, 

and click Close.

The axis system is 
modified accordingly, 
and is now left-
handed.



7.  Click More... to display the More... dialog box.

The first rows contains the coordinates of the origin point. The coordinates of X axis are displayed in the 

second row. The coordinates of Y and Z axis are displayed in the third and fourth row respectively.

As you are defining your axis system, the application detects if its axes are orthogonal or not. Inconsistencies are 
revealed via the Update diagnosis dialog box.

8.  Uncheck the Current option if you do not want to set your axis as the reference. The absolute axis at the 

bottom right of the document then becomes the current three axis system.

9.  Uncheck the Under the 

axis system node 

option if you do not 

want the axis system to 

be created within the 

Axis system node in the 

specification tree.



It will be 

created 

either in 

the current 

geometrical 

set or right 

after the 

current 

object in 

an ordered 

geometrical 

set. In this 

case, the 

axis 

system 

becomes 

the new 

current 

object.

10.  Click OK.

The axis system is created.

When it is set as current, it is highlighted in the specification tree.

 
11.  Right-click Axis System.1 from the specification tree and select the Axis System.1 object -> Set as current 

contextual command. Axis System.1 is now current. You can then select one of its plane, to define a sketch 

plane for example.

●     You can change the location of the axis system and put it in a geometrical set.

To do so, select it in the specification tree, right-click and select Axis System.1 object -> Change Geometrical 

Set. Choose the destination of the axis system using the drop-down list.

Please refer to the Managing Geometrical Sets chapter to have more information.

 
●     If you create a point using the coordinates method and an axis system is already defined and set as current, the 

point's coordinates are defined according to current the axis system. As a consequence, the point's coordinates are 
not displayed in the specification tree.

 
●     You can contextually retrieve the current local axis direction.

Refer to the Stacking Commands chapter to have further information.

 
●     There is an associativity between the feature being created and the current local axis system. Therefore when the 

local axis system is updated after a modification, all features based on the axis direction are updated as well.

●     Local axes are fixed. If you wish to constrain them, you need to isolate them (using Isolate contextual command) 
before setting constraints otherwise you would obtain over-constrained systems.



 
The display mode of the axes is different depending on whether the three-axis system is right-handed or left-

handed and current or not. 

THREE-AXIS SYSTEM CURRENT AXIS DISPLAY MODE

right-handed yes solid

right-handed no dashed

left-handed yes dotted

left-handed no dot-dashed

 

Editing an Axis System
You can edit your axis system by double-clicking it and entering new values in the dialog box that appears. You can 
also use the compass to edit your axis system. 

Note that editing the geometrical elements selected for defining the axes or the origin point affects the definition of the 
axis system accordingly.

Right-clicking Axis System.X object in the specification tree lets you access the following contextual commands:

●     Definition...: redefines the axis system

●     Isolate: sets the axis system apart from the geometry

●     Set as Current/Set as not Current: defines whether the axis system is the reference or not.

The Under the axis system node option is not available when editing an axis system.

 

 



Using the Historical Graph

 
This command is only available with the Generative Shape Design 2 product.

 
This task shows how to use the Historical Graph.

 
1.  Select the 

element for 

which you 

want to 

display the 

historical 

graph.

2.  Click the 

Show 

Historical 

Graph icon 

.

The 
Historical 
Graph 
dialog box 
appears. 

The following icon commands are available. 
●     Add graph

●     Remove graph

●     Reframe graph

●     Surface or Part graph representation

●     Parameters filter

●     Constraints filter.

3.  Just close the dialog box to exit this mode.



Working with a Support
This task shows how to create a support. It may be a plane or a surface.
This will allow you to automatically reference a surface or plane as the supporting element whenever you need one, 
when creating lines for example. You will no longer have to explicitly select the support element.
It will also allow you to create reference points on the fly in the support, whenever you need a reference point to create 
other geometric elements.

 
●     Creating a support from a surface

●     Creating a support from a plane

●     Creating an infinite axis from the active work on support

Open the WorkOnSupport1.CATPart document.

Creating a support from a surface

 
1.  Click the Work 

on Support 

icon .

The Work On 

Support dialog 

box appears.

2.  Select the surface to be used as support element.

If a plane is selected, a grid is displayed to facilitate visualization. 

3.  Optionally, 

select a point.

By default the 

surface's 

midpoint is 

selected.

4.  Click OK in the 

dialog box. 

The element 

(identified as 

Working 

support.xxx) is 

added to the 

specification 

tree under the 

Working 
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supports node.

Creating a support from a plane

 
1.  Click the Work on Support icon  .

2.  Select the plane 

to be used as 

support 

element.

The Work On 

Support dialog 

box is 

displayed, 

allowing you to 

define the 

plane: 

By default, the Grid type is set to Cartesian, to define a Cartesian plane. 

A grid can also be displayed to facilitate visualization. You can hide it by checking the Hide grid option.

 
3.  Select a point, as the support plane's origin.

By default the plane's origin is selected. Beware of the plane representation not being located at the plane's origin. In 
this case, the default point, really is displayed at the origin and therefore not necessarily onto the plane representation.

4.  Define the First direction scale (H for horizontal), by setting Primary spacing and Graduations values.

5.  If needed, select a direction to specify the H direction.

You can right-click in the editable field to display the contextual menu and define the direction (by defining its 

vector, creating a line, and so forth).

6.  If you wish, you can define another scale for the Second direction scale (V for vertical), thus allowing 

distortions of the grid. Check the Allow distortions option to activate the Primary spacing and Graduations 

fields of the second direction.

 
●     Check the Shade grid plane option to visualize the support plane as a solid geometric element.

This is possible only if the View mode is adequate.



 
●     Check the Selectable grid option to enable the selection of sub-elements of the grid (lines and points) as a support 

for a future selection.

Selected sub-elements are featurized.

 
●     Check the Furtive grid option to see the grid only when it is parallel to the screen.

This option is only active only if the Selectable grid option is checked.

 
●     Check the Position grid plane parallel to screen to reset the grid visualization parallel to the screen.

 The Primary spacing and Graduations options are defined in Tools -> Options -> Shape -> Generative Shape 

Design.

Please refer to the Customizing section for further information.

7.  Click OK in the 

dialog box. 

The element 

(identified as 

Working 

support.xxx) is 

added to the 

specification 

tree.

  

Creating an infinite plane from a limited planar surface
Open the WorkOnSupport3.CATPart document.

 

1.  Click the Work 

on Support 

icon  .

2.  Select a face of 

Extrude.1.

 

 

A warning message is 

issued asking you 

whether you wish to 

create an infinite work 

on support from this 

face.
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●     If you click Yes, the 

plane is inserted in 

the current 

geometrical set or 

ordered 

geometrical set and 

is used as the 

Support. You will 

be able to create 

features on this 

support.

   

 

●     If you click No, only 

the face is used as 

the Support. You 

will only be able to 

create features on 

this limited face.

  
 

Creating an infinite axis from the active work on support
 

This capability is only available with the Rotate and Helix commands.
Let's take an example with the Rotate command.

Open the WorkOnSupport2.CATPart document.

1.  Click the Rotate icon  .

The Rotate dialog box displays.

2.  Select the Spline as the element to be rotated.

3.  Select the axis.

 
There are two ways to 
create an infinite axis 
on the fly:

a.  Click anywhere 
on the Work on 
Support. 
The point and 
the axis needed 
for the axis are 
created.
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b.  Select a point in 
the 3D 
geometry.
The axis is 
created through 
this point and is 
normal to the 
active Work on 
Support.

 
4.  Click OK to create the rotated element.

The axis is an infinite line normal to the support and passing through the featurized point. This line is aggregated 

to the Rotate.x feature and put in no show. 

This capability is available with a Work on Support defined by a planar element (whether finite or not).

 
Setting a work 
on support as 
current

 

 By default the last 
created working 
support is displayed in 
red in the specification 
tree.
Use the Set As 
Current/Set As Not 
Current contextual 
menu on the working 
support features, or 
the Working 
Supports Activity 

 icon to define 

which is the default 
current support that 
will be automatically 
selected when entering 
a command that 
requires a working 
support.

 
Snapping to a point

 Click the Snap to point icon  to snap the point being created onto the nearest intersection point on the grid.

  
●     Use the Get Features on Support contextual menu on the working support features to retrieve the features 

created from a single or a multi-selection works on support. As a result, the retrieved features are selected in the 
current editor and highlighted in the specification tree, therefore allowing you to use them more easily.



 
●     Points created while 

in the Work on 
Support command, 
regardless of the 
type of working 
support created 
(surface or plane), 
are aggregated 
under the Working 
support and put in 
no show.

   
 

●     Regardless of the 
type of working 
support created 
(surface or plane), 
once you choose to 
work on the 
support, you can 
directly click onto 
the support to 
create points. This 
capability is 
available with 
commands such as 
point, line, spline, 
polyline, and most 
commands where 
you need to select 
points as inputs.
The created points 
using a support are 
aggregated under 
the parent 
command that 
created them and 
put in no show in 
the specification 
tree.

 
●     Working supports can be edited, updated, or deleted just as any other feature.
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Working with a 3D Support

This command is only available with the Automotive BiW Template product.

This task shows how to create a 3D support. It is composed of three regular grid of lines, 
generally set on the three main planes of the part, that aggregates 3 selectable work on 
supports.
It allows you to create reference points on the fly on each support, whenever you need a 
reference point to create other geometric elements. You will no longer have to explicitly select 
the support element.
It also allows you to create sub-elements of the grid on the fly (points, edges). These features 
do not appear neither in the specification tree nor in the 3D geometry but are aggregated 
under the feature using them.

Open the WorkOnSupport1.CATPart document.

 
1.  Click the Work on Support 3D icon 

.

The Work on Support 3D dialog box 

appears.

●     Each of three grid lines has one default primary spacing of 100mm for each direction. The 
three directions of the main axis system define the grids directions.
You can edit the spacing values by clicking on the spacing tag to edit and modify them.
Note that you can modify these values at creation, not at edition, and that there can only 
be one value per grid.
Grids are used both as an input to create geometry as well as visual help.

●     You can also modify the name of the labels of the main directions by clicking on the 
direction tag.
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Labels' directions and primary spacing are defined in Tools -> Options -> Shape -> 
Generative Shape Design.
Please refer to the Customizing section for further information.

 

2.  Choose the Labels position:

❍     Full screen: labels are displayed all around the screen

❍     Bottom/Left: labels are displayed on the bottom left of the screen

❍     None: no label is displayed

 

3.  Define the Support Type: 

❍     Reference: the 3D support is created according to the main axis system. There can 

be only one reference 3D work on support.

❍     Local: a local axis system must be specified. There can be as many local 3D works 
on support as desired.

4.  Click OK in the dialog box. 

Here is an example with a reference and 

a local 3D work on support.

The elements (identified as Working 

support 3D.xxx) are added to the 

specification tree under the Working 

supports node.

   



5.  Select the Top View  icon from the 

Quick View toolbar.

The active work on support is visualized 

and labels are displayed on each straight 

line. 

●     The work on support must be 

parallel to one of the three planes 

to be visualized. As a 

consequence, the active 3D work 

on support may be seen 

independently in each view of the 

same document.

●     If you move the compass, the 3D 

work on support is no longer 

parallel to the screen.

 
 Note:
 

●     There can only be one active 3D work on support at the same time.

●     When the local axis system is modified, all related features are updated.

 Setting a work on support as 
current

 

 By default, the last created working support is 
displayed in red in the specification tree.
Use the Set As Current/Set As Not Current 
contextual menu on the working support 
features, or the Working Supports Activity 

 icon to define which is the default current 

support that will be automatically selected when 
entering a command that requires a working 
support.
You can also set the axis system as not current 
to reactivate the three planes and define the 
reference 3D support as the current support.



 
Snapping to a point

 Click the Snap to point icon  to snap the point being created onto the nearest intersection 

point on the grid.

Switching the featurization to lines or planes

 

Use the Support Featurize Line icon  to switch the featurization of the grid lines to lines. 

Conversely, use the Support Featurize Plane icon  to switch the featurization of the grid 

lines to planes.
Featurized lines and planes are created normal to the current grid.

  

●     Use the Get Features on Support contextual menu on the working support features to 
retrieve the features created from a single or a multi-selection works on support. As a 
result, the retrieved features are selected in the current editor and highlighted in the 
specification tree, therefore allowing you to use them more easily.

 

●     Once you choose to work on the 3D support, you can directly click onto the support to 
create points. This capability is available with commands such as point, line, spline, 
polyline, and most commands where you need to select points as inputs.
The created points using a support are aggregated under the parent command that created 
them and put in no show in the specification tree.

●     Each 3D working support can be edited, updated, or deleted just as any other feature.
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Creating Plane Systems
The Plane System command provides tools letting you define a number of planes in a given 
direction. Planes can then be used as reference planes or supports when creating other items.

In structure applications, you can, for example, define reference planes in each ship direction 
to assist you place structural elements. You must define one plane system for each direction. 
This task shows you how to create a regular asymmetric, a irregular asymmetric and a semi-
regular plane system. 

1.  Click the Plane System  icon.

●     In the Generative Shape Design workbench, this icon is to be found in the Tools toolbar. 
You can also select Insert -> Advanced Replication Tools -> Plane System...

●     In the Structure Preliminary Layout workbench, this icon is to be found in the Structure 
Grid Set toolbar. Having selected this command, you also need to select an entry in the 
specification tree under which you want to create a new CATPart to locate your plane 
system before proceeding. If you want to use an existing CATPart, then select that CATPart 
in the tree.

●     For Structure Functional Design, switch to the Generative Shape Design workbench.

The Plane System dialog box appears.



2.  Select the type of plane system you want to create: 

Five types are available:

●     Regular symmetric

●     Regular asymmetric

●     Semi-regular

●     Irregular symmetric

●     Irregular asymmetric.

Symmetric Plane Systems 

Symmetric plane systems are created in similar fashion to asymmetric plane systems. The 
difference being that they have the same number of planes on either side of the origin.

Creating a Regular Asymmetric Plane System

3.  Select a plane or a line to define the direction of the plane system.

If you select a plane, the center of the plane is automatically taken as the origin of the plane 
system and an arrow appears showing the direction. 

You can, if desired, change the origin.



 

4.  If you selected a line, select a point to define the origin, 

Or,

If you selected a plane and want to change the origin, click the Origin field and select a 

point.

●     Use the Reverse button in the dialog box or select the arrow in the geometry area to invert 
the direction.

●     The contextual menus in Direction and Origin fields let you create appropriate geometry 
directly without having to exit the current command.

5.  Specify the primary subset: 

●     Specify the distance between two planes in the Spacing field.

●     Enter a prefix identifying all planes in this set.
Planes are identified by this prefix plus a positive or negative number that increments away 
from the origin. Plane numbers are positive in the direction of the plane system. The origin 
is identified by prefix.0. 

●     Specify the number of planes.
The number you enter is the number of planes you want to create on either side of the 
origin. Note that the number of planes does not include the plane at the origin.

4.  Optionally, check Allow secondary subset to group a number of planes in the primary 

subset together and create a secondary subset: 

●     Specify the step. For example, enter 4. 
Every fourth primary subset plane will belong to the secondary subset.

●     Enter a prefix identifying all planes in this set.

Note: The plane at the origin always belongs to the primary subset.



Select the subset in the specification tree to visualize all planes in this set in the geometry 
area.

6.  Click OK when done to create a plane system along the specified direction.

Creating an Irregular Asymmetric Plane System
Plane systems can be created by importing a TSV (tab-separated) file containing the definition 
of the plane system. 

This file must be formatted as follows:

positive_or_negative_absolute_distance_from_origin<TAB>subset_prefix
where <TAB> denotes a TAB character

and should contain an entry 0<TAB>subset_prefix. Typically, 

-4800  WEB
-4200  FRM
-3600  FRM
-3000  FRM
-2400  WEB
...
0  FRM



...
 2300  WEB
 2700  WEB

Notes: 

●     Do not type space characters using the space bar.

●     It is not necessary to specify the positive sign '+' when entering positive distances. 

It defines a plane system in one ship direction only but can contain as many subsets as 
desired.

3.  Select a plane or a line to define the direction of the plane system.

If you select a plane, the center of the plane is automatically taken as the origin of the plane 
system and an arrow appears showing the direction. 

You can, if desired, change the origin.
 

4.  If you selected a line, select a point to define the origin,

Or, 

If you selected a plane and want to change the origin, click the Origin field and select a 

point.



●     Use the Reverse button in the dialog box or select the arrow in the geometry area to invert 
the direction.

●     The contextual menus in Direction and Origin fields let you create appropriate geometry 
directly without having to exit the current command.

5.  Click Browse... and navigate to the file containing the plane system definition.

6.  Click OK when done to create a plane system along the specified direction.

Creating a Semi-Regular Plane System
The semi-regular option lets you easily and rapidly define a plane system comprising groups of 
planes with different spacings.

 



3.  Select a plane or a line to define the direction of the plane system.

If you select a plane, the center of the plane is automatically taken as the origin of the plane 
system and an arrow appears showing the direction. 

You can, if desired, change the origin.
 

4.  If you selected a line, select a point to define the origin, 

Or,

If you selected a plane and want to change the origin, click the Origin field and select a 

point.

●     Use the Reverse button in the dialog box or select the arrow in the geometry area to invert 
the direction.

●     The contextual menus in Direction and Origin fields let you create appropriate geometry 
directly without having to exit the current command.

 
5.  Specify the primary subset: 

●     Specify the distance between two planes in your first group in the Spacing field.

●     Enter the number of the last plane having the specified spacing in the End field.

●     Click Add to confirm your first group.

The first group is identified in the list view control and the Start field incremented to display the 
number of the first plane in your second group.

 



 ●     Repeat to specify the spacing and the number of the last plane to be created with this 
spacing, then click Add.

●     Continue until satisfied.

 Note: If the current spacing is the same as the spacing of the previous group, any new planes 
are added to the previous group.

 

 
●     Enter a prefix identifying all planes in the primary set.

Planes are identified by this prefix plus a positive or negative number that increments away 
from the origin. Plane numbers are positive in the direction of the plane system. The origin 
is identified by prefix.0. 

6.  Optionally, check Allow secondary subset to group a number of planes in the primary 

subset together and create a secondary subset:

●     Specify the step. For example, enter 4. 
Every fourth primary subset plane will belong to the secondary subset.

●     Enter a prefix identifying all planes in this set.

Notes: The plane at the origin always belongs to the primary subset.
Select the subset in the specification tree to visualize all planes in this set in the geometry 
area.

 
Adding Groups to Your Plane System

 
●     Click in the list view control to return to the Add mode.

 
Modifying Groups in Your Plane System



 ●     Select the group you want to modify.

●     Enter a new spacing value or modify the End value to change the number of planes in the 
group.
Note: You cannot modify the Start value.

●     Click Modify.

The plane system is updated. Changing the number of planes in any one group does not affect 
the number of planes in other groups. 

Note: Click in the list view control to cancel unwanted modifications that have not been 
confirmed using Modify.

 
Removing Groups

 
●     Select the group you want to remove.

●     Click Remove.

7.  Click OK when done to create a plane system along the specified direction.

 



Creating Datums

 

This task shows how to create geometry with the History mode deactivated.
 In this case, when you create an element, there are no links to the other entities that were 
used to create that element.

1.  Click the Create Datum icon  to deactivate the History mode.

It will remain deactivated until you click on the icon again. 

If you double-click this icon, the Datum mode is permanent. You only have to click 
again the icon to deactivate the mode. 

A click on the icon activates the Datum mode for the current or the next command. 

 
The History mode (active or inactive) will remain fixed from one session to another: it is in 
fact a setting.

 

 



Inserting Elements

 
This command is only available with the Generative Shape Design 2 product.

This task shows how to create a geometric element and automatically inserting it next to its main 
parent in the specification tree.
This may be useful to add an element that was not not initially designed, while retaining its logical 
positioning within the specification tree.
All children of the main present are then attached to the inserted element.
Open the Insert01.CATPart document.
It contains, amongst other geometric elements, an extruded surface that has been translated.

1.  Click the Insert Mode icon .

It stays active and you can select another icon. 

2.  Click the Split icon . 

3.  Successively select 

the extruded surface 

(Extrude.1) and the 

plane (Plane.1) as 

the splitting 

element. 

4.  Click OK in the Split Definition dialog box. 

The Split.1 element is created and inserted directly below the Extrude.1 element, and the 
translated surface is split as well, as the splitting operation takes place chronologically before the 
translation.

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/Insert01.CATPart


5.  Right-click the 

Split.1 element in 

the specification tree 

and choose the 

Parent/children 

contextual menu. 

The Parents and Children 
dialog box is displayed.

The Extrude.1 and Plane.1 

are parents of the split 

surface, which children is 

the translated surface 

(Translate.1).

Would the insert mode not been activated, the splitting operation would have been recorded in 
the specification tree, at the end of the currently active geometrical set, and the translated 
surface would not have been split:



Using the Parent/children 
contextual menu, on the 
split surface, you notice that 
the Split.1 element does not 
have any children.

This insertion capability is available when creating: 
●     shape fillets

●     split elements

●     trimmed elements

●     extrapolated surfaces or curves

●     joined elements

●     inverted elements



Keeping the Initial Element
This task shows you how to retain an element on which you are performing an operation. When this command 
is active, as soon as you perform an action in which you create or modify geometry, you are in fact working on 
a copy of the initial element.

 
The Keep and No Keep 

modes can be activated 

via the Keep Mode and 

No Keep Mode icons in 

the Tools toolbar.

 

Keep Mode
 The implementation of this mode allows modification features to have the same behavior as creation features.

This mode is identical for both geometrical set and ordered geometrical set environments, whatever type of 
the input and output (= result) elements are, that is to say whether they are datum or not.

The input element:

●     remains in the show area

●     can be detected and selected in the 3D geometry

●     can be detected in the specification tree

Let's take an example with the Split command:

A surface and a line are 
created. The surface is 
to be intersected with 
the line.



1.  Check that the 

Keep Mode 

mode  is 

activated.

2.  Click the Split 

icon .

3.  Split the surface 

by the line.

The whole 

surface 

remains in the 

show area.

Double-clicking the Keep Mode icon lets you work in a global mode: as a consequence, all created features 
will be in Keep mode. 

  

 
No Keep Mode
The No Keep mode is only available with the modification commands. It has no impact on the creation 
commands.
Here are the list of commands impacted by the No Keep mode.

 

Command Conditions

3D Curve Offset  

All transformations  

Blend With Trim support

Bump  

Combine  

Connect Curve With Trim mode

Corner With Trim Support

Curve Smooth  

Develop  

Diabolo No GSD plane as input

Extrapolate With Assemble result

Fillet With Trim Support

Healing  

Inverse  

Join  

Near  

Offset  



Parallel Curve  

Project  

Shape Morphing  

Split No GSD plane as input

Sweep Tangent sweep with Trim Support

Trim  

Variable Offset  

Wrap Curve  

Wrap Surface  

 
The implementation of this mode depends on the type of the input and output (= result) elements, that is to 
say whether they are datum or not.
This mode transforms contextual creation features into modification features.

 
Datum Input and Datum Result

 This mode is identical, whatever the environment (geometrical set or ordered geometrical set).
 The input element:

●     is deleted

●     is replaced by the created feature (if their dimensions are strictly identical)

●     its child features are impacted

=> Behavior 1 (see table below)

Let's take an example with the Split command.

A datum curve, a point 
on the curve, and a 
surface based on this 
curve are created.



 

1.  Check that the 

No Keep Mode 

 and the 

Create Datum 

 icons are 

activated.

2.  Click the Split 

icon .

3.  Split the curve by 

the point.

The input 

curve is 

replaced by 

the resulting 

split curve and 

the surface is 

impacted.

 

 

 
Feature Input and Datum Result

 

a.  Geometrical 
set 
environment

 

 

The input element:
●     is put in the no show area

●     cannot be detected and selected in the 3D geometry

●     can be detected and selected in the specification tree

●     its child features are not impacted

=> Behavior 2 (see table below)

Let's take an example with the Project command.



A sketch and a surface 
are created. The sketch 
is to be projected onto 
the surface.

1.  Check that the 

No Keep Mode 

icon  is 

activated.

2.  Click the Project 

icon . 

3.  Click the Create 

Datum icon 

.

4.  Project the 

element 

(Sketch.2) onto 

the surface 

(Extrude.1)

The input 

sketch is put 

in no show 

and a datum 

curve is 

created.



 

The input element:
●     is put in the no show area

●     cannot be detected and selected in the 3D geometry

●     can be detected and selected in the specification tree

●     its child features are impacted if the created feature is inserted before them

Let's take an example with the Split command.

An extruded surface is 
created and a line 
intersects it (Line.2).
The extruded surface 
has a child feature 
(Split.1) and is defined 
as the current object.

1.  Check that the 

No Keep Mode 

icon  is 

activated.

2.  Click the Split 

icon . 

3.  Click the Create 

Datum icon 

.

4.  Split the 

extruded surface 

with the line.

The extruded 

surface is put 

in no show 

and its child 

feature is 

impacted: its 

input is now 

the new 

surface 

 
b.  Ordered geometrical set environment

(Surface.1).



Therefore, when the Datum mode is associated to the No Keep mode and the result can replace the input, the 
behavior is the one described above.

  

 
Datum or Feature Input and Feature Result

 
a.  Geometrical set environment

 

The behavior is the same as above (Feature Input and Datum Result).

=> Behavior 2 (see table below)
  

 
b.  Ordered geometrical set environment

 

The input element:
●     is in the ghost area

●     cannot be detected and selected in the 3D geometry

●     can be detected and selected in the specification tree

●     its child features are impacted if the new feature is the created inserted before them

=> Behavior 3 (see table below)

Let's take an example with the Offset command.

A fill and a translate of 
this fill are created. The 
translate is thus a child 
of the fill.
The fill is defined as the 
current object.



1.  Check that the 

No Keep Mode 

icon  is 

activated.

2.  Click the Offset 

icon  and 

offset Fill.1.

The offset 

surface is 

created before 

the translate. 

The fill is 

absorbed and 

the translate 

is impacted. 

Double-clicking the No Keep Mode icon lets you work in a global mode: as a consequence, all created 
features will be in No Keep mode. 

  
 To conclude with the No Keep mode, here is a table summarizing the different behaviors:

 

  Datum 
Result

Feature 
Result

Datum 
Input

Geometrical Set Behavior 1 Behavior 2

Ordered 
Geometrical Set Behavior 1 Behavior 3

    

Feature 
Input

Geometrical Set Behavior 2 Behavior 2

Ordered 
Geometrical Set Behavior 2 Behavior 3

  
●     The default option is Keep mode for creation features and, and No Keep mode for modification features.

●     Features created using the contextual menu are always set in Keep mode.

●     If a sub-element is selected as an input of a command in No Keep mode, it is not put in the no show area. 

●     When editing a feature, you cannot change its mode.



Selecting Bodies

This command is only available with the Generative Shape Design 2 product.

This task shows how to rapidly select a specific Body, whether a Geometrical Set, an Ordered Geometrical 
Set or  PartBody, using the Body Selector. This is especially useful when the specification tree is hidden or 
too large to be easily manipulated, in the case of a large document for example.

 
Open the PowerCopyStart1.CATPart document.

1.  From the Tools 

toolbar, click 

the arrow on 

the drop-down 

list to display 

the list of 

Bodies present 

in the 

document.

2.  Choose the 

body you want 

to work in, 

from the list.

The 

selected 

body is 

displayed in 

the Body 

Selector's 

field, and 

underlined 

in the 

specification 

identifying 

it as the 

current 

body. 

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/PowerCopyStart1.CATPart


●     All Bodies are displayed in the list alphabetically, whether they are in Show or No Show mode.

●     This command is equivalent to selecting the Body in the specification tree using the  icon, right-

clicking it and choosing the Define In Work Object command.
To rename your Body, you need to follow five steps:

1.  Select the object from the specification tree
2.  Choose the Properties contextual menu
3.  Click the Feature Properties tab in the Properties dialog box
4.  Key in a new Name
5.  Click OK in the Properties dialog box.

 



Checking Connections Between Surfaces

This task shows how to analyze how two surfaces are connected, following a blend, match, or fill operation for 
example.
Three types of analyses are available.

❍     Distance: the values are expressed in millimeters

❍     Tangency: the values are expressed in degrees

❍     Curvature: the values are expressed in percentage.

Open the ConnectChecker1.CATPart document.

1.  Select both surfaces to be analyzed.

2.  Click the Connect Checker icon  in 

the Shape Analysis toolbar.

The Connect Checker dialog box is 
displayed as well as another dialog box 
showing the color scale and identifying 
the maximum and minimum values for 
the analysis type. 

The Auto Min Max button enables to 
automatically update the minimum and 
maximum values (and consequently all 
values between) each time they are 
modified.

 

Check the Internal edges option if you want to analyze the internal connections.

By default, the check box is unchecked.

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/ConnectChecker1.CATPart


Two cases are available:
●     Surfaces are isolated.

Only geometrical connections are checked, that is all pairs of neighboring surface edges within the tolerance 
given by the Maximum gap.
Depending on the Maximum gap value, interference connections may be detected, for instance when surfaces 
have a size smaller the Maximum gap. In this case, you must decrease the Maximum gap value or join the 
surfaces to be analyzed (see next point)

●     Surfaces are joined (using the Join command for instance) and the Internal edges option is checked. 
Topological connections are checked first, that is all edges shared by two topological surfaces. Then, the 
corresponding pairs of surface edges are checked to detect any geometrical connections within the tolerance 
given by the Maximum gap.

  

 

3.  Choose the analysis type to be performed: Distance, Tangency or Curvature.

4.  Set the Maximum gap above which no analysis will be performed. All elements apart from a greater value 

than specified in this field are considered as not being connected, therefore do not need to be analyzed.

Be careful not to set a Maximum gap greater than the size of the smallest surface present in the 

document.

 

In the color scale, the Auto Min Max button 
enables to automatically update the minimum and 
maximum values (and consequently all values 
between) each time they are modified.

   

●     You can right-click on a color in the color scale 
to display the contextual menu:

   



- Edit: it allows you to modify the 
values in the color range to highlight 
specific areas of the selected surface. 
The Color dialog box is displayed 
allowing the user to modify the color 
range. 

- Unfreeze: it allows you to perform a linear interpolation between non defined colors. 
The unfreezed values are no longer highlighted in green. 

- No Color: it can be used to simplify the analysis, because it limits the number of displayed colors in 
the color scale. In this case, the selected color is hidden, and the section of the analysis on which that 
color was applied takes on the neighboring color. 

●     You can also right-click on the value to display 
the contextual menu:

   
 - Edit: it allows you to modify the 
edition values. The Value Edition dialog 
box is displayed: enter a new value 
(negative values are allowed) to 
redefine the color scale, or use the 
slider to position the distance value 
within the allowed range, and click OK.
The value is then frozen, and displayed 
in a green rectangle.

- Use Max/Use Min : it allows you to evenly distribute the color/value interpolation between the current 
limit values, on the top/bottom values respectively, rather than keeping it within default values that may 
not correspond to the scale of the geometry being analyzed. Therefore, these limit values are set at a 
given time, and when the geometry is modified after setting them, these limit values are not dynamically 
updated. 

 The Use Max contextual item is only possible if the maximum value is higher or equal to the medium 
value. If not, you first need to unfreeze the medium value.

Only the linear interpolation is allowed, meaning that between two set (or frozen) colors/values, the 
distribution is done progressively and evenly.

The color scale settings (colors and values) are saved when exiting the command, meaning the same values will be 
set next time you edit a given draft analysis capability.
However, new settings are available with each new draft analysis.



5.  Check the analysis results on the 

geometry.

Here we are analyzing the distance 
between the surfaces. Each color 
section indicates on the geometry the 
distance between the surfaces.

There may be a tangency discontinuity while a curvature continuity exists. This may appear for instance 
in the case of two non tangent planar surfaces.

From the Connect Checker dialog box, you can choose a number of visualization and computation options: 
●     the comb: that is the spikes corresponding to the distance in each point

●     the envelope: that is the curve connecting all spikes together

●     Information: that is the minimum and maximum values displayed in the 3D geometry

Finally, the scaling option lets you define the visualization of the comb. In automatic mode the comb size 
is zoom-independent and always visible on the screen, otherwise you can define a coefficient multiplying 
the comb exact value.

6.  Check the Information button:

Two texts are displayed on the 
geometry localizing the minimum and 
maximum values of the analysis as 
given in the Connect Checker dialog 
box.

You can also choose the discretization, 
that is the numbers of spikes in the 
comb (check the Comb option to see 
the difference).
The number of spikes corresponds to 
the number of points used for the 
computation:



 
●     Light: 5 spikes are displayed.

This mode enables to obtain consistent 
results with the visualization of sharp 
edges.
An edge is considered as sharp if its 
tangency deviation is higher than 0.5 
degree. To only detect tangency 
deviations on sharp edges, specify a 
deviation of 0.5 degree minimum.

To visualize sharp edges, make sure 
the View -> Render Style -> 
Shading with Edges and Hidden 
Edges option is checked.

 
●     Coarse: 15 spikes are displayed

●     Medium: 30 spikes are displayed

●     Fine: 45 spikes are displayed

The Full result is only available with the Generative Shape Design 2 product. 

The number of selected elements and the number of detected connections are displayed below the color range.

7.  Click the Quick... button to obtain a 

simplified analysis taking into account 

tolerances.

The comb is no longer displayed.
The Connect Checker dialog box 
changes to this dialog box.

The Maximum gap and information 
are retained from the full analysis.
The maximum deviation value is also 
displayed on the geometry.

You can use the check button to select one or several analyses (up to three). As a consequence, the colorful area 
displaying the deviation tolerance between the surfaces shows the continuity whose value is the lowest.

In the case you select several types of continuity, the Information button is greyed out.

 
●     You can check the Overlapping button to highlight where, on the common boundary, the two surfaces overlap. 

In this case the other analysis types are deactivated.

●     You can check the Information button to display the minimum and maximum values in the 3D 
geometry, or uncheck it to hide the values.

In P1 mode, only the quick analysis is available.



8.  Use the spinners to define the deviation 

tolerances.

For example, the red area indicates all 
points that are distant of more than 0.1 
mm.

The maximum deviation values on the 
current geometry are displayed to the 
right of the dialog box.

9.  Click OK to create the analysis.

The analysis (identified as Surface Connection Analysis.x) is added to the specification tree (P2 only).

This allows the automatic update of the analysis when you modify any of the surfaces, using the control 

points for example.

If you do not wish to create the analysis, simply click Cancel.

●     You can edit the color range in both dialog boxes by double-clicking the color range manipulators (Connect 
Checker) or color areas (Quick Violation Analysis) to display the Color chooser.

●     If you wish to edit the Connection Analysis, simply double-click it from the specification tree.

●     If you no longer need the Connection Analysis, right-click Connection Analysis in the specification tree, and 
choose Delete.

●     The curvature difference is calculated with the following formula:

(|C2 -  C1|) / ((|C1 + C2|) / 2)

The result of this formula is between 0% et 200%.

●     You can analyze internal edges of a surfacic 
element, such as a Join for example, by 
selecting only one of the initial elements:

●     You can create an analysis on an entire geometrical set simply by selecting it in the specification tree.



Checking Connections Between Curves
This task shows how to analyze how two curves are connected, following a blend, or match 
operation for example.
Four types of analyses are available.

❍     Distance: the values are expressed in millimeters

❍     Tangency: the values are expressed in degrees

❍     Curvature: the values are expressed in percentage

❍     Overlapping: the system detects overlapping curves

Open the ConnectChecker2.CATPart document.

1.  Select both curves to 

be analyzed.

2.  Click the Curve 

Connect Checker icon 

 in the Shape 

Analysis toolbar.

The Connect 
Checker dialog box 
is displayed. At the 
same time a text is 
displayed on the 
geometry, indicating 
the value of the 
connection 
deviation.

You can choose the 
type of analysis to 
be performed using 
the combo: 
distance, tangency 
or curvature.

 

In P1 mode, only this mode is available (no quick mode available).

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/ConnectChecker2.CATPart


This step is P2 only for 

Wireframe and Surface. 

3.  Press the Quick button.

The dialog box 

changes along with 

the text on the 

geometry.. 

With our example, 

the text in the 

geometry 

disappears because 

the distance 

between the two 

curves is smaller 

than the set 

Distance value.

4.  Check the Tangency 

button:

A text is displayed 
on a green 
background (as 
defined by default 
for the Tangency 
criterion) to indicate 
that the Tangency 
criterion is not 
respected, because 
the first text 
displayed is the one 
for which the set 
tolerance is not 
complied with. You 
can then increase 
the Tangency value, 
or modify the 
geometry to comply 
with your needs. 



5.  Similarly, if you check 

the Curvature value, 

the displayed text 

indicates that the 

curvature between the 

two analyzed curves is 

greater than the set 

value.

6.  Modify the tolerance 

values, or the 

geometry to comply 

with the tolerances. 

For example, if you 

modify the Tangency 

value to set it to 16 

degrees, the geometry 

instantly reflects the 

compliance with the 

new value. 

The maximum deviation values on the current geometry are displayed to the right of the dialog 
box.

7.  Click OK to create the analysis.

The analysis (identified as Curve Connection Analysis.x) is added to the specification 

tree.

This allows the automatic update of the analysis when you modify any of the curves, 

using the control points for example (see Editing Curves Using Control Points).

If you do not wish to create the analysis, simply click Cancel.

●     Double-click the Curve Connection Analysis from the specification tree to edit it.



●     You can analyze internal 
edges of a element, such 
as a Join for example, by 
selecting only one of the 
initial elements:

●     Use the Overlapping mode to highlight  where, on the common boundary, the two curves 
overlap.
When the Overlapping button  is checked, other analysis types are deactivated.
In Full mode, a text is displayed indicating whether the curves overlap.

The Overlapping mode is not available with the Wireframe and Surface product.

●     The curve connection checking analysis is permanent in P2 mode only, i.e. it is retained in 
the specification tree for later edition and on the geometry till you reset or delete it, whereas 
in P1 mode, it is present at a time, but not retained when exiting the command.

 



Performing a Draft Analysis

●     This command is not available with the Generative Shape Design 1 product.

●     Used in Part Design workbench, this command requires the  configuration mode.

This task shows how to analyze the draft angle on a surface.
The Draft Analysis command enables you to detect if the part you drafted will be easily removed. 

This type of analysis is performed based on color ranges identifying zones on the analyzed element where the deviation from the draft 
direction at any point, corresponds to specified values.
These values are expressed in the unit as specified in Tools -> Options -> General -> Parameters -> Unit tab. 
You can modify them by clicking on their corresponding arrow or by entering a value directly in the field.
Open the DraftAnalysis1.CATPart document.

●     The visualization mode should be set to Shading With Edges in the View -> Render Style command

●     The discretization option should be set to a maximum: in Tools -> Options -> Display -> Performances, set the 3D Accuracy -> 
Fixed option to 0.01.

●     Check the Material option in the View -> Render Style -> Customize View command to be able to see the analysis results on the 
selected element. Otherwise a warning is issued.

●     Uncheck the Highlight faces and edges option in Tools -> Options -> Display -> Navigation to disable the highlight of the 
geometry selection.

1.  Select a surface.

It is highlighted. 

2.  Click the Draft Analysis icon  in the 

Shape Analysis toolbar.

The Draft Analysis dialog box is displayed. It gives 
information on the display (color scale), the draft 
direction and the direction values.
The Draft Analysis.1 dialog box showing the color 
scale and identifying the maximum and minimum 
values for the analysis is displayed too. 

 

 

Mode option

The mode option lets you choose between a quick and a full analysis mode. These two modes are completely independent.
The default mode is the quick mode. It simplifies the analysis in that it displays only three color ranges.

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/DraftAnalysis1.CATPart


Quick mode Full mode

In P1 mode, only the quick mode is available.

●     You can right-click on a color in the color scale to 
display the contextual menu:

   

- Edit: it allows you to modify the values in 
the color range to highlight specific areas of 
the selected surface. The Color dialog box 
is displayed allowing the user to modify the 
color range. 

- Unfreeze: it allows you to perform a linear interpolation between non defined colors. 
The unfreezed values are no longer highlighted in green. 

- No Color: it can be used to simplify the analysis, because it limits the number of displayed colors in the color scale. In this 
case, the selected color is hidden, and the section of the analysis on which that color was applied takes on the neighboring 
color. 

●     You can also right-click on the value to display the 
contextual menu:

   
 - Edit: it allows you to modify the edition 
values. The Value Edition dialog box is 
displayed: enter a new value (negative 
values are allowed) to redefine the color 
scale, or use the slider to position the 
distance value within the allowed range, 
and click OK.
The value is then frozen, and displayed in a 
green rectangle.

- Use Max/Use Min : it allows you to evenly distribute the color/value interpolation between the current limit values, on the 
top/bottom values respectively, rather than keeping it within default values that may not correspond to the scale of the 
geometry being analyzed. Therefore, these limit values are set at a given time, and when the geometry is modified after 
setting them, these limit values are not dynamically updated. 



 The Use Max contextual item is only possible if the maximum value is higher or equal to the medium value. If not, you first 
need to unfreeze the medium value.

Only the linear interpolation is allowed, meaning that between two set (or frozen) colors/values, the distribution is done 
progressively and evenly.

The color scale settings (colors and values) are saved when exiting the command, meaning the same values will be set next time you 
edit a given draft analysis capability.
However, new settings are available with each new draft analysis.
Display option

●     Uncheck the Color Scale checkbox to remove the Draft Analysis.1 dialog box.

This dialog box only appears in edition mode.

●     Activate the On the fly checkbox and move the 

pointer over the surface.

This option enables you to perform a local 

analysis.

Arrows are displayed under the pointer, 

identifying the normal to the surface at the 

pointer location (green arrow), the draft direction 

(red arrow), and the tangent (blue arrow). As you 

move the pointer over the surface, the display is 

dynamically updated.

Furthermore, circles are displayed indicating the plane 
tangent to the surface at this point.
The displayed value indicates the angle between the 
draft direction and the tangent to the surface at the 
current point.
It is expressed in the units set in using the Tools -> 
Options -> General -> Parameters -> Units tab.

The On the fly analysis can only be performed on the elements of the current part.

Note that you can activate the On the fly option even when not visualizing the materials. It gives you the tangent plane and the 
deviation value.

●     Click the Inverse button to automatically reverse 

the draft direction:

When several elements are selected for 

analysis, the draft direction is inverted for 

each element when the button is clicked. 

In case of an obviously inconsistent result, do not 
forget to invert locally the normal direction via the 
Inverse button.

The manipulator on the draft direction allows you to materialize the cone showing the angle around the direction.



Direction in the cone Direction out of the cone
●     Right-click the cone angle to display the Angle 

Tuner dialog box.
When you modify the angle using the up and 
down arrows, the value is automatically updated 
in the color scale and in the geometry.

Please note that you cannot modify the angle below the minimum value or beyond the maximum value.

Full mode

Quick mode

    



●     Right-click the Direction vector to display the 

contextual menu.

It allows you to:

●     hide / show the cone

●     hide / show the angle

●     hide / show the tangent

●     lock / unlock the analysis position

●     keep the point at this location

A Point.xxx appears in the specification 

tree.

In P1 mode, the Keep Point option is not available.

Direction

By default the analysis is locked, meaning it is done according to a specified direction: the compass w axis.
In P1 mode, the default analysis direction is the general document axis-system's z axis.

●     Click the Locked direction icon , and select a direction (a line, a plane or planar face which normal is used), or use the 

compass manipulators, when available.

Using the compass manipulators Selecting a specific direction 

●     Click the Compass icon  to define the new current draft direction.

The compass lets you define the pulling direction that will be used from removing the part.

You can display the control points by clicking the Control Points  icon, yet the draft analysis is still visible, then allowing you to 

check the impact of any modification to the surface on the draft analysis.



3.  Once you have finished analyzing the surface, click OK in the Draft Analysis dialog box.

The analysis (identified as Draft Analysis.x) is added to the specification tree. 

This capability is not available in P1 mode.

●     Note that settings are saved when exiting the command, and redisplayed when you select the Draft Analysis icon again.

●     Be careful, when selecting the direction, not to deselect the analyzed element.

●     A draft analysis can be performed just as well on a set of surfaces.

●     If an element belongs to an analysis, it cannot be selected simultaneously for another analysis, you need to remove the current 
analysis by deselecting the element to be able to use it again.

●     In some cases, even though the rendering style is properly set, it may happen that the analysis results are not visible. Check that the 
geometry is up-to-date, or perform an update on the involved geometric element(s).

●     The analysis results depend of the current object. May you want to change the scope of analysis, use the Define in Work object 
contextual command.

 



Performing a Surfacic Curvature Analysis

●     This command is not available with the Generative Shape Design 1 product.

●     Used in Part Design workbench, this command requires the configuration mode.

This task shows how to analyze the mapping curvature of a surface.

Open the SurfacicAnalysis1.CATPart document.

 
●     The discretization option should be set to a maximum: in Tools -> Options -> Display -> Performances, set the 3D Accuracy -> 

Fixed option to 0.01.

●     Check the Material option in the View -> Render Style -> Customize View command to be able to see the analysis results on 
the selected element.

You can now perform an analysis on the fly even if the Material option is not checked. No warning message is issued as long as no 
element is selected.

 
●     Uncheck the Highlight faces and edges option in Tools -> Options -> General -> Display -> Navigation to disable the 

highlight of the geometry selection.

1.  Select a surface.

2.  Click the Surfacic Curvature Analysis icon  in the Shape Analysis toolbar.

The Surfacic curvature dialog box is displayed, and the analysis is visible on the selected element. It gives information on the 

display (color scale), the draft direction and the direction values.

The Surfacic Curvature.1 dialog box showing the color scale and identifying the maximum and minimum values for the 

analysis is displayed too. 

●     You can right-click on a color in the color scale to display 

the contextual menu:

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/SurfacicAnalysis1.CATPart


- Edit: it allows you to modify the values in the 
color range to highlight specific areas of the 
selected surface. The Color dialog box is displayed 
allowing the user to modify the color range.

- Unfreeze: it allows you to perform a linear interpolation between non defined colors. 
The unfreezed values are no longer highlighted in green. 

- No Color: it can be used to simplify the analysis, because it limits the number of displayed colors in the color scale. In this 
case, the selected color is hidden, and the section of the analysis on which that color was applied takes on the neighboring 
color. 

●     You can also right-click on the value to display the 
contextual menu:

 - Edit: it allows you to modify the edition values. 
The Value Edition dialog box is displayed: enter a 
new value (negative values are allowed) to 
redefine the color scale, or use the slider to 
position the distance value within the allowed 
range, and click OK.
The value is then frozen, and displayed in a green 
rectangle. 

- Use Max/Use Min: it allows you to evenly distribute the color/value interpolation between the current limit values, on the 
top/bottom values respectively, rather than keeping it within default values that may not correspond to the scale of the 
geometry being analyzed. Therefore, these limit values are set at a given time, and when the geometry is modified after 
setting them, these limit values are not dynamically updated. 

 The Use Max contextual item is only possible if the maximum value is higher or equal to the medium value. If not, you first need to 
unfreeze the medium value.

- Interpolation: by default the interpolation is linear.

Type

3.  Select the type analysis:

In the following examples, we defined minimum and maximum values and used the on the fly option (except for Limited and Inflection 
Area type)

●     Gaussian

 



●     Minimum: to display the minimum curvature value

●     Maximum: to display the maximum curvature value



    

●     Limited: the quick mode is displayed and the Limited Radius type is selected.

In the Surfacic curvature dialog box, you are able to modify the radius value using the up and down arrows. The value is 

automatically updated in the color scale.

 

 

●     Inflection Area: enables to identify the curvature orientation: 

❍     In green:  the areas where the minimum and maximum curvatures present the same orientation

❍     In blue: the areas where the minimum and maximum curvatures present opposite orientation

See also Creating Inflection Lines. Note that these inflection lines are always created within the green area, i.e. when the curvature 

orientation is changing.



 

Display options

●     Uncheck the Color Scale checkbox to remove the Surfacic Curvature Analysis.1 dialog box.

●     Activate the On the fly checkbox and move the pointer 

over the surface.

This option enables to perform a local analysis.

The curvature and radius values are displayed under the 

pointer, as well as the minimum and maximum curvature 

values and the minimum and maximum curvature 

directions. As you move the pointer over the surface, the 

display is dynamically updated.

The values are expressed in the units set in using the 

Tools -> Options -> General -> Parameters -> Units 

tab.

The displayed values may vary from the 
information displayed as the Use Max / Use Min 
values, as it is the precise value at a given point 
(where the pointer is) and does not depend on the 
set discretization. 

●     The On the fly analysis can only be performed on the 
elements of the current part. It is not available with the 
Inflection Area analysis type.

●     You cannot snap on point when performing a local on the 
fly analysis.

 Right-click a point to display the contextual menu. It allows you to :

- keep the point at this location (under the pointer)
- keep the point corresponding to the minimum value
- keep the point corresponding to the maximum value

A Point.xxx appears in the specification tree. 

 

In P1 mode, this contextual menu is not available. 



 

●     Activate the 3D MinMax checkbox to locate the minimum and maximum values for the selected analysis type.

 

Analysis options

 ●     Uncheck both Positive only and Radius Mode analysis options to get analysis values as curvature values

 



●     Check the Positive only analysis option to get analysis values as positive values.

 

 ●     Check the Radius Mode analysis option to get analysis values as radius values.

 

These options are not available with the Limited and Inflection Area analysis types.

  

4.  Once you have finished analyzing the surface, click OK in the Surfacic Curvature Analysis dialog box.

The analysis (identified as Surfacic Curvature Analysis.x) is added to the specification tree.

This capability is not available in P1 mode.

●     You can display the control points by clicking the  icon, still viewing the surfacic curvature analysis. This allows you to check the 

impact of any modification on the surface.
Here are examples using the 3D MinMax capability.



If you double-click the Surfacic Curvature Analysis.xxx in the specification tree, the Minimum and Maximum values are updated in the 
Surfacic Curvature.1 analysis but not in the color scale. 

To update the values in the color scale, right-click the minimum value and the maximum value and select respectively Use Min / Use 
max from the contextual menu.

 



●     Surfacic curvature analyses can be performed on a set of surfaces.

●     If an element belongs to an analysis, it cannot be selected simultaneously for another analysis, you need to remove the current 
analysis by deselecting the element to be able to use it again.

●     In some cases, even though the rendering style is properly set, it may happen that the analysis results are not visible. Check that 
the geometry is up-to-date, or perform an update on the involved geometric element(s).

●     The analysis results depend of the current object. May you want to change the scope of analysis, use the Define in Work object 
contextual command.

●     You can customize the values expressed in the color scale and in the 3D geometry.
To do so, select the Tools -> Options -> General -> Parameters and Measures -> Unit command, then define or redefine the 
default units.
For further information, refer to the Customizing Units chapter in the CATIA Infrastructure User's Guide documentation.



Performing a Curvature Analysis

This task shows how to analyze the curvature of curves, or surface boundaries.

Open the Analysis1.CATPart document.

 When analyzing surface 
boundaries:  

 

●     if you select the surface, the 
analysis is performed on all its 
boundaries

●     if you select a specific 
boundary, the analysis is 
performed only on this 
boundary.

1.  Click the Porcupine 

Curvature Analysis icon 

.

2.  Select the curve.

Automatically the curvature comb 
is displayed on the selected curve:

 

3.  Define the analysis 

parameters in the 

Curvature Analysis dialog 

box.

●     Use the Project on Plane 

checkbox  to analyze the 

projected curve in the selected 

plane referenced by the 

compass.

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/Analysis1.CATPart


●     If you uncheck the Project On 

Plane option, the analysis is 

performed according to the 

curve orientation. This is the 

default option.

4.  Use the spinners to adjust the number of strikes and modify the density.

5.  You can also decide to 

halve the number of spikes 

in the comb clicking as 

many times as wished the 

/2 button.

This option is particularly useful 
when the geometry is too dense to 
be read but the resulting curve 
may not be smooth enough for 
your analysis needs.

You could just as well double the 
number of spikes using the X2 
button.

6.  Similarly, click the /2 

button to fine-tune the 

amplitude (size) of the 

spikes, and re-compute the 

analysis curve accordingly.



 

7.  Click Curvilinear to switch 

from the Parametric 

discretization mode to the 

Curvilinear analysis. You 

will get something like this:

 
8.  Check the Automatic option optimizes the spikes length so that even when zooming in or out, the spikes are 

always visible.

 

9.  Check the Logarithm 

option to display the 

logarithmic values in the 

3D geometry.

Displaying these values does not 
modify the analysis.

10.  Click Reverse, you will get 

something like this:

That is the analysis 
opposite to what was 
initially displayed. This is 
useful when from the 
current viewpoint, you 
do not know how the 
curve is oriented.



11.  Use the Particular 

checkbox to display at 

anytime the minimum and 

the maximum points. 

Inflection points are displayed only 
if the Project on Plane and 
Particular checkboxes are checked.

12.  The Inverse Value checkbox displays the inverse value in Radius, if Curvature option is selected, or in 

Curvature, if Radius option is selected.

 
●     You can right-click on any of 

the spikes and select Keep 
this Point to keep the current 
point at this location.
A Point.xxx appears in the 
specification tree. 
If you check the Particular 
option, you have more options: 

❍     Keep all inflection points

❍     Keep local minimum 

(corresponds to the 

absolute minimum under 

the running point)

❍     Keep local maximum 
(corresponds to the 
absolute maximum under 
running point)

❍     Keep global minimum (in 
case there are two curves, 
the point will be found on 
one or other of the curves)

❍     Keep global maximum 
(in case there are two 
curves, the point will be 
found on one or other of 
the curves)



This option is only available in P2 mode in FreeStyle Shaper, Optimizer, and Profiler.

13.  Finally, click the  icon to display the curvature graph:

The curvature profile and amplitude of the analyzed curve is represented in this diagram.

When analyzing a surface or several curves, i.e. when there are several curvature analyses on elements that are not 
necessarily of the same size for example, you can use different options to view the analyses. 

For example, when analyzing a 
surface, by default you obtain this 
diagram, where the curves color 
match the ones on the geometry. 



●     Same vertical length : all 

curves are displayed according 
to the same vertical length, 
regardless of the scale

●     Same origin : all curves 

are displayed according to a 
common origin point on the 
Amplitude scale

●     Vertical logarithm scale : 

all curves are displayed 
according to a logarithm scale 
for the Amplitude, and a 
linear scale for the Curve 
parameter.

Depending on the chosen option, values displayed in the diagram are updated.

The last icon  is used to reframe the diagram within the window, as you may move and zoom it within the window.



14.  Right-click a curve and 

choose one of the following 

options from the contextual 

menu:

●     Remove: removes the curve

●     Drop marker: adds Points.xxx 

in the specification tree

●     Change color: displays the 

Color selector dialog box that 

enables you to change the 

color of the curve.

15.  Slide the pointer over the diagram to display the amplitude at a given point of the curve.

You can slide the pointer over the diagram and the 3D analysis.

Click the x in the top right corner to close the diagram.

16.  Click OK in the Curvature Analysis dialog box once you are satisfied with the performed analysis.

The analysis (identified as Curvature Analysis.x) is added to the specification tree.

In case of clipping, you may want to temporarily modify the Depth Effects' Far and Near Limits. See Setting Depth 

Effects in CATIA Infrastructure User Guide.

 

 



Applying a Dress-Up

This task shows you how to display or hide permanent control points and curve/surface 
segments on elements for analyses purposes.

Open the DressUp1.CATPart document.

1.  Select Apply Dress-Up  

from the Insert -> Analysis 

menu bar.

The Dress-Up Options dialog 

box is displayed.

2.  Set the type of visualization you 

want to apply to geometric 

elements.

You can choose: 

●     to display, or not, control 

points

●     the control points type

●     to display, or not, 

segments.

3.  Select the element on which you 

wish to display the control 

points.

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/DressUp1.CATPart


4.  Click Apply.

The control points and mesh 
lines are displayed on the 
selected element.

5.  Activate the Segmentation 

option, uncheck the Control 

Points, then click Apply.

 A contextual menu is available when 
selecting an arc limit of a curve. It 
enables you to either keep the arc limit 
you right-clicked or all the arc's limits. 

●     Keep this arc limit: a 3D point 
appears in datum mode in the 
specification tree

●     Keep all arc's limits: all the 3D 
points used to create the 3D curve 
appear in datum mode in the 
specification tre

6.  Click OK. 

The visualization options are as defined by the user and remain on the selected 

elements till you select the Remove Visualization Options icon  from the Insert -

> Analysis menu bar, or till you modify them using the Dress-Up Options dialog box 

again.

The visualization options are applied globally to the document, meaning that you can apply 
different options to several elements, but if you save, close then open the document again, the 
options defined last will be applied to all the elements on which visualization options have 
been set.



●     Multi-selection applies with these display capabilities:

 

 



Displaying Geometric Information
On Elements

This command is only available with the Generative Shape Design 2 product.

This task shows you how to display or hide geometric information on geometrical elements, 
such as any curve, or surface, either as a stand-alone element, or taking part in the 
composition of another element (intersection curve, cylinder axis, face of a pad, and so forth)

Open the GeometricInformation1.CATPart document, or any .CATPart document containing 
geometrical elements.

1.  Click the Geometric Information icon .

2.  Select the element for which you want to display information either in the geometric 

area or in the specification tree.

The Geometric Analysis dialog box is 
displayed.

Information, such as:

●     the element type (Nurbs surface or curve, Pline, planes, etc.)

●     whether the element has been trimmed, or not

●     the number of segments (components) in both U & V direction (where applicable)

●     the degree of the element in both U & V direction (where applicable)

is displayed in the dialog box.
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Moreover, a vector representing the 

element's orientation (U for a curve, 

and U & V for a surface) is displayed 

on the geometrical element itself. 

●     Uncheck the Geometric Information icon  to exit the command, or simply click 

another icon.

●     You cannot select an element from the specification tree as the selected element might be 
too complex (i.e. be composed of more than one cell) and the system cannot determine 
which element is to be analyzed.

 
●     The geometry type is categorized as follows: 

 

Displayed Type What is it ?

NupbsCurve Non Rational NURBS Curve

NupbsSurface Non Rational NURBS Surface

NurbsCurve Rational NURBS Curve

NurbsSurface Rational NURBS Surface

PNupbs Parametric non rational curve on a surface

PNurbs Rational parametric curve

PSpline Parametric curve on a surface

PLine Isoparametric curve on a surface

Line Line or line segment

Plane Plane or planar face

Cylinder Cylinder

Helix Helix

FilletSurface Procedural Fillet surface

SweepSurface Procedural Sweep surface

Tabulated Cylinder Procedural Extrude surface.

IntCurve Intersection curve, that is resulting from the 
intersection of two surfaces

MergedCurve The aggregate of two curves with different 
limits or parameterizations.

 

 



Creating Constraints

This command is only available with the Generative Shape Design 2 product.

This task shows how to set geometric constraints on geometric elements. 

Such a constraint  forces a limitation. For example, a geometric constraint might require that 
two lines be parallel. 

 
To set a 
constraint  
between 
elements:

1.  Multi-select two 

or three 

elements to be 

constrained.

2.  Click the 

Constraint 

defined in 

dialog box 

icon .

The Constraint 
Definition dialog box 
appears indicating the 
types of constraint you 
can set between the 
selected elements.

3.  Select one of the available options to specify that the corresponding constraint is to be 

made.

4.  Click OK.

The corresponding constraint  symbol appears on the geometry. 



To set a 
constraint on a 
single element:

1.  Select the 

element to be 

constrained.

2.  Click the 

Constraint 

icon .

  
The corresponding 
constraint  symbol 
appears on the 
geometry. 

 

 

 



Creating a Text with Leader

This task shows you how to create an annotation text with leader

A text is assigned an unlimited width text frame. 
You can set  graphic properties (anchor point, text size and justification) either before or after you 
create the free text.
You can change any text to another kind at any time.

Open the Common_Tolerancing_Annotations_01 CATPart document.

●     Improve the highlight of the related geometry, see Highlighting of the Related Geometry for 3D 
Annotation.

1.  Double-click the Projected View.1 annotation plane to activate it. 

2.  Click the Text with Leader icon:   

3.  Select the face as shown to define a location for the arrow end of the leader.

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/Tolerancing/Common_Tolerancing_Annotations_01.CATPart
http://arbre1dsy/spuCXR14/Doc/online/cfyugfdt_C2/cfyugfdtcu0200.htm
http://arbre1dsy/spuCXR14/Doc/online/cfyugfdt_C2/cfyugfdtcu0200.htm


If the active view is not valid, a message appears informing you that you cannot use the 
active view.
Therefore, the application is going to display the annotation in an annotation plane normal 
to the selected face.
For more information, see View/Annotation Planes.

The Text Editor dialog box appears.

4.  Enter your text, for example "New Annotation" in the dialog box.

http://arbre1dsy/spuCXR14/Doc/online/cfyugfdt_C2/cfyugfdtut0100.htm


5.  Click OK to end the text creation. You can click anywhere in the geometry area too.

The text appears in the geometry. 
The text (identified as Text.xxx) is added to the specification tree.

 The leader is associated with the element you selected. If you move either the text or the 
element, the leader stretches to maintain its association with the element.

 Moreover, if you change the element associated with the leader, application keeps the 
associativity  between the element and the leader.

 Note that using the Text Properties toolbar, you can define the anchor point, text size and 
justification.

You can move a text using either the drag capability.
Note also that you can resize the manipulators
For more information, refer to Customizing for 3D Functional Tolerancing & Annotations.



Creating a Flag Note with Leader

This task shows you how to create an annotation flag note with Leader.

A flag note allows you to add links to your document and then use them to jump to a variety of 
locations, for example to a marketing presentation, a text document or a HTML page on the intranet.
You can add links to models, products and parts as well as to any constituent elements.

A flag note is assigned an unlimited width text frame. 
You can set  graphic properties (anchor point, text size and justification) either before or after you 
create the free text.
You can change any flag note to another kind at any time.

Open the Common_Tolerancing_Annotations_01 CATPart document.

●     Improve the highlight of the related geometry, see Highlighting of the Related Geometry for 3D 
Annotation.

1.  Double-click the Projected View.1 annotation plane to activate it.

 

2.  Click the Flag Note with Leader icon:   

3.  Select the face as shown to define a location for the arrow end of the leader.

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/Tolerancing/Common_Tolerancing_Annotations_01.CATPart
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http://arbre1dsy/spuCXR14/Doc/online/cfyugfdt_C2/cfyugfdtcu0200.htm


If the active view is not valid, a message appears informing you that you cannot use the 
active view.
Therefore, the application is going to display the annotation in an annotation plane normal to 
the selected face.
For more information, see View/Annotation Planes.

The Manage Hyperlink dialog box appears. 

 You may specify the flag note's name link in the Name field.

 You may specify one or several links associated with the flag note in the URL field clicking the 
Browse... button.

 In the Link to File or URL list  you can see the list of links.

 To activate one of them, select it and click the Go to button.

 To remove one of them, select it and click the Remove button.

 To edit one of them, select it and click the Edit button.

http://arbre1dsy/spuCXR14/Doc/online/cfyugfdt_C2/cfyugfdtut0100.htm


4.  Enter your flag note name, for example "New Annotation" in the dialog box and specify a link: 

www.3ds.com

5.  Click OK to end the flag note creation. You can click anywhere in the geometry area too.

The flag note appears in the geometry.

The leader is associated with the element you selected. If you move either the text or the 
element, the leader stretches to maintain its association with the element.

 Moreover, if you change the element associated with the leader, application keeps the 
associativity  between the element and the leader.



 Note that using the Text Properties toolbar, you can define the anchor point, text size and 
justification.

The flag notes (identified as Flag Note.xxx and its name between brackets) are added to the 
specification tree in the Notes group.

You can move a flag note using either the drag capability.
Note also that you can resize the manipulators
For more information, refer to Customizing for 3D Functional Tolerancing & Annotations.



Creating a Projection View/Annotation Plane 

This task shows you how to create a projection view /annotation plane.
See Using a View for more information.
See also Creating a Section View/Annotation Plane, Creating a Section Cut View/Annotation Plane.

Open the Common_Tolerancing_Annotations_01 CATPart document.

1.  Click the Projection View icon:  

2.  Select the face as shown.

You have to select a planar element only to perform this command.

The projection view is created.
Projection views are represented by a blue reference axis, its normal axis is red until you 
create an annotation, and are identified as Projection View.3 in the specification tree. 

http://arbre1dsy/spuCXR14/Doc/online/cfyugfdt_C2/cfyugfdtut0101.htm#hj-Projection View/Annotation Plane
http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/Tolerancing/Common_Tolerancing_Annotations_01.CATPart


3.  Right-click the annotation plane in the geometry or in the specification tree and select the 

Invert Normal contextual menu. 

The projection view normal is reversed. 





Creating a Section View/Annotation Plane 

This task shows you how to create a section view /annotation plane.
See Using a View for more information.
See also Creating a Projection View/Annotation Plane, Creating a Section Cut View/Annotation 
Plane.

Open the Common_Tolerancing_Annotations_01 CATPart document.

1.  Click the Section View icon:  

2.  Select the face as shown.

You have to select a planar element only to perform this command.

The section view is created.
Section views are represented by a green reference axis, its normal axis is red until you 
create an annotation, and are identified as Section View.1 in the specification tree.

http://arbre1dsy/spuCXR14/Doc/online/cfyugfdt_C2/cfyugfdtut0101.htm#hj-Projection View/Annotation Plane
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Creating a Section Cut View/Annotation Plane  

This task shows you how to create a section cut view /annotation plane.
See Using a View for more information.
See also Creating a Projection View/Annotation Plane, Creating a Section View/Annotation Plane.

Open the Common_Tolerancing_Annotations_01 CATPart document.

1.  Click the Section Cut View icon:  

2.  Select the face as shown.

You have to select a planar element only to perform this command.

The section cut view is created.
Section views are represented by a yellow reference axis, its normal axis is red until you 
create an annotation, and are identified as Section Cut View.1 in the specification tree.

http://arbre1dsy/spuCXR14/Doc/online/cfyugfdt_C2/cfyugfdtut0101.htm#hj-Projection View/Annotation Plane
http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/Tolerancing/Common_Tolerancing_Annotations_01.CATPart




Applying a Material

 

This task explains how to apply a pre-defined material as well as to interactively re-position the mapped 
material.

A material can be applied to: 
●     a PartBody, Surface, Body or Geometrical Set (in a .CATPart document). You can apply different 

materials to different instances of a same CATPart. 

●     a Product  (in a .CATProduct document)

●     instances of a  .model, .cgr, .CATPart (in a .CATProduct document).

 Materials applied to .CATPart, .CATProduct and .cgr documents can be saved in ENOVIAVPM. 
For detailed information on ENOVIAVPM, refer to the ENOVIAVPM User's Guide.

 

Within a CATProduct, you should not apply different materials to different instances of a same Part 
because a material is part of the specific physical characteristics of a Part. Therefore, this could lead to 
inconsistencies.

Open the ApplyMaterial.CATProduct document. 

 To visualize the applied material, select the Shading with Material icon from the View Toolbar.

1.  Select the element(s) on which the material should be applied. 

If you want to apply a material simultaneously to several elements, simply select the desired 

elements (using either the pointer or the traps) before applying the material.

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/ApplyMaterial.CATProduct


 2.  Click the Apply Material icon . 

The Library dialog box opens. It contains several pages of sample materials from which to 
choose. 
From V5R14 onwards, two new families are provided with the default material library: 
Painting and Shape Review. In addition to these two new families, more materials have been 
added to the already existing families. For instance, when working with the Wood family you 
can now choose the Mahogany type, the Cedar type, the Kingwood type, etc.
For a complete description of the families provided with the default material library, refer to 
"Material Sample Library" in this guide.
Each page is identified by a material family name on its tab (each material being identified by 
an icon) if you select the Display icons mode... 

 

 ...or each page is identified by a material family name in a pulldown list if you select the 
Display list mode:

 

 

Clicking the Open a material library  icon opens the File Selection dialog box which 
lets you navigate through the file tree to your own material libraries. 
You can, of course, use the default library (see What You Should Know Before You Start in 
this guide) by choosing "Default Material Catalog".

The pulldown list will display the list of previously opened material libraries. 
Note: when you reopen the dialog box, the last chosen material library will be placed on top 
of the list and used by default unless you select another one.

 

Depending on the document environments (i.e. the method to be used to access your 
documents) you allowed in the Tools->Options->General->Document tab, an additional 
window such as the one displayed below may appear simultaneously to the File Selection 
dialog box to let you access your documents using an alternate method:

http://arbre1dsy/spuCXR14/Doc/online/cfyugrendering_C2/images/dblibrary01NLS.gif
http://arbre1dsy/spuCXR14/Doc/online/cfyugrendering_C2/images/dblibrary03NLS.gif


 

 In our example, four document environments have been allowed among which the DLName 
environment. If you want to access your texture files using DLNames, for instance, just click 
the Logical File System button: this will open a specific dialog box dedicated to the 
DLName environment.
For detailed information on this dialog box, refer to Opening Existing Documents Using the 
Browse Window.

3.  Select a material from any family, by a simple click. 

 Once a material is selected, you can drag and drop or copy/paste it onto the desired element 
directly from the material library.

You can also double-click a material or click it once then select the Properties contextual 
menu to display its properties for analysis purposes. 

4.  Click the Link to file checkbox if you want to map the selected material as a linked object and 

have it automatically updated to reflect any changes to the original material in the library. 

Two different icons (one with a white arrow  and one without ) identify linked and 
non-linked materials respectively in the specification tree.

Note: You can edit linked materials. Doing so will modify the original material in the library. 
If you want to save changes made to the original material, use the File->Save All 
command. 

When no object is selected in the specification tree, you can select the Edit->Links... 
command to identify the library containing the original material. You can then open this 
library in the Material Library workbench if desired.

http://arbre1dsy/spuCXR14/Doc/online/cfyugbas_C2/cfyugbrowsewindow.htm
http://arbre1dsy/spuCXR14/Doc/online/cfyugbas_C2/cfyugbrowsewindow.htm


You can also use the Paste Special... command to paste material as a linked object. You can 
copy both unlinked and linked materials. You can, for example, paste a linked material on a 
different element in the same document as well as on an element in a different document. 
For more information, see Copying & Pasting Using Paste Special... in this guide. 

 
5.  Click Apply Material to map the material onto the element. 

The selected material is mapped onto the element and the specification tree is updated. In 
our example, the material was not mapped as a linked object. 

 

A yellow symbol may be displayed to indicate the material inheritance mode. For more 
information, refer to Setting Priority between Part and Product in this guide. 

Material specifications are managed in the specification tree: all mapped materials are 
identified. To edit materials (for more information, see Modifying Materials), simply right-click 
the material and select Properties from the contextual menu or double-click the material. 
You can also run searches to find a specific material in a large assembly (for more 
information, see Finding Materials in this guide) as well as use copy & paste or drag & drop 
capabilities.

Unless you select in the specification tree the desired location onto which the material should 

be mapped, dragging & dropping a material applies it onto the lowest hierarchical level (for 

instance, dragging and dropping onto a part will apply the material onto the body and not 

onto the part itself).

However, note that a material applied onto a body has no impact on the calculation of the 

part physical properties (mass, density, etc.) since only the physical properties of the part, 

and not those of the body, will be taken into account.



6.  Click OK in the Library dialog box. 

The object looks the following way: 

 

Note: applying materials to elements affects the physical and mechanical properties, for 
example the density, of elements. 

7.  Right-click the material just mapped in the specification tree and choose the Properties item. 

The Properties dialog box is displayed:

 



8.  Choose the Rendering tab to edit the rendering properties you applied on the element. 

9.  If necessary; change the material size to adjust the scale of the material relative to the 

element. 

10.  Click OK in the Properties dialog box, when you are satisfied with the material mapping on the 

element. 



Note: Appropriate licenses are required to use the Analysis and Drafting tabs. 

If you are working in "Materials" visualization mode (i.e. the "Materials" option is checked in 
the Custom View Modes dialog box) with no material applied to your object, this object will 
be visualized using default parameters which only take into account the color defined in the 
object graphic properties. 
As a consequence, an object with no mapped material will appear as if made of matte plastic, 
non-transparent and without any relief.

11.  Use the 3D compass to interactively position the material: 

Note that material positioning with the 3D compass is only possible in the Rendering, Product 
Structure, Part Design and DMU Navigator workbenches.

 

●     Select the material in the specification tree:

 

The compass is automatically snapped and the mapping support (in this case, a 
cylinder) appears, showing the texture in transparency.
If necessary, zoom in and out to visualize the mapping support which reflects the 
material size.

 

●     Pan and rotate the material until satisfied with the result. You can:
❍     Pan along the direction of any axis (x, y or z) of the compass (drag any compass axis)

❍     Rotate in a plane (drag an arc on the compass)

❍     Pan in a plane (drag a plane on the compass)

❍     Rotate freely about a point on the compass (drag the free rotation handle at the top 
of the compass):



 

 
●     Use the mapping support handles to stretch the material texture along u- and v- axes (as 

you can do it with the slider in the Scale U, V fields displayed in the Texture tab):

 

For more information on manipulating objects using the 3D compass, refer to the Version 5 
Infrastructure User's Guide.

 

More about materials

Contrary to materials with no texture (such as "Gold"), materials with a texture (such as "Teak") are 
applied with an external link to their texture image. Therefore, this link is displayed when using the File-
>Desk, Edit->Links... or File->Send To command.
In the example below, "Italian Marble" has been applied onto Chess.CATPart and the link to the 
corresponding .jpg image appears when displaying the Links dialog box:



 

 

 

 



Applying a Thickness

This command is only available with the Generative Shape Design 2 product.

This task shows how to apply a thickness onto a surface.

Open the Thickness1.CATPart document.

1.  Select Tools -> Thin Parts Attribute.

The Thin Parts Attribute definition 
dialog box displays.

2.  Select the surface.

3.  Choose the input values 

for Thickness 1 (indicated 

by the arrow) and 

Thickness 2 using the 

spinners.

Check the Reverse Direction button to inverse the direction of thickness 1 and 2.

4.  Click OK to apply the thickness.

 

Thicknesses 1 and 2 appear in the 
specification tree, as the surface's 
attributes.

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/Thickness1.CATPart


Analyzing Using Parameterization
This task enables to analyze the CATPart structure and shows how to isolate specific features 
within a part. This is particularly useful when managing power copies, for example.

Open the Parameterization1.CATPart document.

1.  Select Tools -> Parameterization Analysis...

The Parameterization Analysis 
dialog box opens. 

 

      

2.  Use the Filter combo and choose to 

display Root Features. 

The query is launched and the 

viewer automatically updates. 

 Deactivated features as well as 
datum features are displayed.
However, if you want to display 
deactivated features only, select 
the Inactivated Features filter. 
Similarly, select the Isolated 
Features filter to display both 
deactivated and datum features.

      

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/Parameterization1.CATPart


 

3.  Click the Display Body Structure 

icon  to display the graph 

keeping the tree structure.

Each feature is displayed within its 

own body.

●     Features displayed in the viewer can be used in the same way as in the specification tree: 
double-click a feature to edit it, or use the contextual menu to reframe on or display its 
properties, for example.

●     The viewer can still be open while performing other operations.
Available filters are:

❍     All Sketches

❍     Over-constrained sketches

❍     Fully-constrained sketches

❍     Under-constrained sketches

❍     Inconsistent sketches

❍     External references

❍     Inactivated features

❍     Root features

❍     Leaf features

❍     Isolated features

❍     Features in error

❍     Waiting for update features

❍     Features with stop update

❍     Features with active stop update

❍     Knowledge formulas, Rules, and Checks

❍     Bodies



 For further information about sketches, refer to the Analyzing and Resolving Over-
Constrained or Inconsistent Sketches chapter in the Sketcher documentation.
For further information about Isolated features, refer to the Isolating Geometric 
Elements chapter.
For further information about Features with stop update and active stop update, 
refer to the Updating Your Design chapter.
For further information about knowledge formulas, refer to the Knowledge Advisor 
documentation.
For further information about Bodies, refer to the Part Design documentation.



Managing Groups

 

This command is only available with the Generative Shape Design 2 product.
It is not available with Ordered Geometrical Sets.

 

This task shows how to manage groups of elements in a Geometrical Set entity as follows: 
●     creating a group

●     editing a group

●     collapsing and expanding a group

●     moving a group to a new body

 

A group is a visualization element that applies on a geometrical set entity. Thus a group cannot 
exist without a geometrical set.
A group enables to reorganize the specification tree when it becomes too complex or too long 
and deals with the structure of the part being created.

Open the Groups1.CATPart document.

Creating a group

 
1.  Right-click the desired Geometrical Set entity 

in the specification tree.

2.  Choose the Geometrical Set.x object -> 

Create Group command from the contextual 

menu.

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/Groups1.CATPart


The Group dialog box appears. 
The Support area indicates the name of 
the Geometrical Set entity where the 
group is to be created.

3.  If needed, modify the proposed default group 

name that appears in the Name area.

   



4.  Select entities to be included in the group 

and remain visible in the tree.

Other entities become hidden.

 

5.  Click OK to create the group.

In the Group dialog box you can:
●     click the check box to specify whether group is expanded or collapsed.

●     click the Remove Group button to reset the group definition.

Editing a group

 
1.  Right-click the desired group in the specification tree and select the Group-

Geometrical Set.x object -> Edit Group... command from the contextual menu. 

2.  You can then:

●     rename the group

●     remove the group

●     add entities to the group.

Collapsing and expanding a group 



 

1.  To collapse a group, right-click the desired group in the specification tree and select the 

Group-Geometrical Set.x object -> Collapse Group command from the contextual 

menu. 

The portion of the specification tree related to the group appears reduced.

2.  To expand a collapsed group, right-click the desired group in the specification tree and 

select the Group-Geometrical Set.x object -> Expand Group command from the 

contextual menu. 

All the entities belonging to the group are then visible in the specification tree.

Moving a group to a new body 

 
1.  Right-click the desired group in the 

specification tree and select the Group-

Geometrical Set.x object -> Change 

Geometrical Set command from the 

contextual menu. 

The Change Body dialog box appears.

2.  Select the new body where the group is to be 

located.

By default, if you select a body, the group is positioned last within the new body. 
However, you can select any element in the new body, before which the group will 
be located.

See also Moving Elements From an Geometrical Set.

3.  Click OK to move the group to the new body.



 You have the possibility, when creating a new feature, to integrate it or not as an input in a 
group.
Please refer to the General Settings chapter in the Customizing section.

 

 



Repeating Objects

 

This task shows how to create several instances of objects as you are currently creating one 
object.
This command is available for: 

●     points on a curve

●     lines at an angle or normal to a curve

●     planes at an angle

●     offset planes

●     offset surfaces (refer to the corresponding chapter in the documentation)

●     or when performing a translation, a rotation or a scaling on an object.

 
1.  Select an object, as listed above. 

2.  Click the Object Repetition  icon or 

select the Insert -> Advanced Replication 

Tools -> Object Repetition... menu 

item.

The Object Repetition dialog box is 

displayed. 

3.  Key in the number of instances of the object you wish to create.

4.  Check the Create in a new Body option if you want all object instances in a separate 

body.

A new Geometrical Set will be created automatically.

If the option is not checked the instances are created in the current Body.

5.  Click OK.

The object is created as many times as required in the Object Repetition dialog box.

 

See each specific object creation for further details on what parameter is taken into account for 
the repetition.



Stacking Commands

This task shows how to stack commands, that is create another basic object in the current command without leaving 
it.

Let's take an example with the Line functionality.

Open a new Part document.

1.  Click the Line icon  .

The Line Definition dialog box appears.

2.  Use the combo to choose the desired line type.

Here we chose the Point-Point line type: two points 

are required to create the line.

As no point already exits, you will have to create them.

 

3.  Right-click the Point 1 field.

4.  Select Create Point from the contextual menu.

   

 The Point Definition dialog box appears.

5.  Use the combo to choose the desired point type.

Here we chose the On Plane type.

6.  Choose the Plane.

7.  Click OK.



 The Point Definition dialog box closes and you return to the Plane Definition dialog box.
The Point.1 field is valuated with the point you have just created.

 
8.  Right-click the Point 2 field.

9.  Repeat steps 4 to 7.

 The Point Definition dialog box closes and you return to the 
Plane Definition dialog box.
The Point.2 field is valuated with the point you have just 
created and a line is previewed between Point 1 and Point 2.

 
10.  Click OK to create the line.

 
Features created using stacked commands are now 
aggregated under the parent command that created them and 
put in no show in the specification tree.

 

11.  Edit the created line.

12.  Right-click the Point 1 field.

You can access generic contextual commands such as 

Center Graph, Reframe On, Hide/Show, 

Properties, and Other Selection.

For Center Graph and Reframe On, refer to the Part 

Design User's Guide.

For Hide/Show, refer to Hiding Objects, for 

Properties, refer to Displaying and Editing Graphic 

Properties, and for Other Selection, refer to Selecting 

Using the Other Selection... Command. All these 

chapters can be found in the CATIA Infrastructure 



User's Guide.

These commands can also be accessed contextually from the 
specification tree.

 



Selecting Using Multi-Selection

This capability enables you to perform multi-selection of elements and validate the selection.

 

1.  Choose the selection type:

●     Select : enables you to select elements or deselect elements in the 3D geometry or 

in the specification tree. 
Use the Ctrl key to select several elements, and the Shift key to deselect already selected 
elements. 

 
●     Selection Trap : enables you to select elements by drawing a trap.

Elements must be entirely located inside the trap to be selected.

 
●     Intersecting Trap : enables you to select elements by drawing a trap.

Elements can either be located inside the trap or be intersected by the trap to be 
selected.

 
●     Polygon Trap : enables you to select elements by drawing a closed polygon.

Any element inside the polygon will be selected.

 
●     Paint Stroke Trap : enables you to select elements by drawing a paint stroke 

across them.

 
●     Outside Trap Selection : enables you to select elements outside the trap.

Any object strictly outside the trap will be selected.

 
●     Intersecting Outside Trap Selection : enables you to select elements outside the 

trap.
Any object strictly outside or partially outside the trap will be selected.

 
●     Control Mode : enables you to validate any selection at once.



 
●     List of selected items : enables you to display the dialog box containing the list of 

selected items.
The number of selected items is displayed in the field to the left of this icon.
If there are less than one selected element, this button is disabled.

 
●     Finish : enables you to finish and validate the multi-selection.

 The Tools Palette closes and you go back to definition dialog box.

 Multi-selection is available when editing a single feature: double-click it in the specification 
tree to display the Tools Palette and perform multi-output selection.



Selecting Using Multi-Output
This capability enables to keep the specification of a multi-selection input in a single operation.
It is available with the following functionalities:

●     Intersections

●     Projections

●     All transformations: translation, rotation, symmetry, scaling, affinity and axis to axis

●     Developed wires 

Let's take an example using the Projection and Translation functionalities.

Open the Multi-Output1.CATPart document.

1.  Click the Projection icon  .

The Projection Definition dialog box 
appears, as long as the Tools Palette 
toolbar.

2.  Select Translate.1 as first element 

to be Projected.

   
 

3.  Click the Projected field again, or

3.  Click the bag icon  to display 

the elements list.

The Projected dialog box opens.

4.  Select as many elements as you 

need for your projection. 

5.  Click Close to return to the 

Projection Definition dialog box.

The number of selected 

elements is displayed in the 

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/Multi-Output1.CATPart


Projected field.

Use the Remove and Replace buttons to 

modify the elements list.

You can now select one or more 
geometrical sets and multi-outputs as 
inputs of the multi-selection.
In that case, all their direct children are 
selected.

 

6.  Select Extrude.1 as the Support 

element. 

7.  Select Normal as Projection type.

8.  Click OK to create the projection 

elements.

 

The projection is identified as Multi 
Output.1 (Project) in the specification 
tree.

The created elements are aggregated 
under Multi Output.1.

You can create several multi-outputs in the specification tree, each one grouping one type of 
elements.



9.  Click the Translate icon .

The Translate Definition dialog box 

appears. 

 

10.  Select Translate.1 and Translate.2 

as the Elements to be translated.

11.  Select Direction, distance as the 

Vector Definition.

12.  Select Extract.2 as the Direction.

13.  Select -50mm as the Distance.

14.  Click OK to create the translated 

element.

The translation is identified as Multi 
Output.2 (Translate) in the specification 
tree and appears below Multi Output.1. 

The created elements are aggregated 
under Multi Output.2.



●     When one or several features are in error under a multi-output (during creation or edition), 

an error message is issued after clicking Preview or OK and displays all features in error.

You are able to manually delete or deactivate the feature(s) in error. When editing the 

multi-output, deactivated features are not displayed.

 
●     You can deactivate all the elements of a multi-output. As a consequence, the multi-output 

feature disappears from the 3D geometry and erroneous elements can no longer be 
generated.
Similarly, you can activate all the elements of a deactivated multi-output.
To have further information on deactivation, please refer to the Deactivating Features 
chapter.

 
●     Multi-selection is available when editing a single feature: double-click it in the specification 

tree and click the bag icon to replace it or add new elements.

 
●     Multi-outputs and elements aggregated under a multi-output can be edited separately, 

simply by double-clicking it in the specification tree. Elements can be modified (added, 
replaced, or removed): the corresponding multi-output automatically updates.

 
●     Unshared features are aggregated under the parent command that created them and put in 

no show in the specification tree.
Shared features are not aggregated under the parent command.

 
●     The datum capability is available. If an element is in error, it cannot be created as a datum 

element; only elements that could be generated from the multi-selection are created.



 Managing Multi-Result Operations

This task shows you how to manage the result of an operation in the case this result is not 
connex.

 Several possibilities are offered:
●     keep all the sub-elements

●     keep one sub-element using the Near command

●     keep one sub-element using the Extract command

●     use pointing elements and select a sub-element to keep

 

Keeping all sub-elements
A surface and a spline lying on this 
surface are created.
A parallel curve of the spline is to be 
created. 

1.  Click the Parallel Curve icon 

.

The Parallel Curve Definition 

dialog box is displayed.

2.  Select the spline as the Curve.

3.  Select the surface as the 

Support.

4.  Click OK.



 

The Multi-Result Management dialog 
box appears.

5.  Check the keep all the sub-

elements option to keep a non 

connex result.

6.  Click OK.

The curve (identified as 

Parallel.xxx) is added to the 

specification tree.

 
Keeping one sub-element using the Near command

 
The multi-result feature has 
no children

 

A cylinder is created.
Reflect lines on this cylinder are to be 
created. 



1.  Click the Reflect Lines icon 

.

The Reflect Line Definition dialog 

box is displayed.

2.  Select the cylinder as the 

Support.

3.  Select a direction.

4.  Define 50 as the Angle value.

5.  Click OK.

 

 

The Multi-Result Management dialog 
box appears.

6.  Check the keep only one sub-

element using a Near option 

to create a nearest entity of the 

multiple element, that is the 

reflect lines.

7.  Click OK.

The Near Definition dialog box 

appears and the reflect line is 

automatically filled in the 

Multiple Element field.

8.  Select a plane as the Reference 

Element.

9.  Click OK.

The line (identified as Reflect 

Line.xxx) and the nearest 

element (identified as Near.xxx) 

are added to the specification 



tree. The reflect line is put in no 

show. 

 
The multi-result feature has several children
Open the Multi-Result1.CATPart 
document.

1.  Double-click the Fillet.1 in the 

specification tree.

The Fillet Definition dialog box 

opens.

2.  Modify the radius value: set it to 

15mm.

3.  Click OK.

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/Multi-Result1.CATPart


 

The Multi-Result Management dialog 
box appears.
The multi-result feature contains a near 
that is displayed in the Extracts and 
Nears tab.

4.  Double-click Near.1.

The Near Definition dialog box 

appears and the fillet is 

automatically filled in the 

Multiple Element field.

5.  Select Point.1 as the Reference 

Element.

6.  Click OK.

 

7.  Click OK in the Multi-Result 

Management dialog box.

The Offset element, that uses 

the Near element as the surface 

to be offset, is modified 

accordingly.

 For further information about the Near command, refer to the Creating the Nearest Entity of a 
Multiple Element chapter in the Generative Shape Design documentation.

 Keeping one sub-element using the Extract 
command

 
The multi-result feature has 
no children

 



Two sketches are created.
A combine curve is to be created 
between them.

1.  Click the Combine icon .

The Combine Definition dialog 

box is displayed.

2.  Select the Normal type.

3.  Successively select the two 

curves to be combined.

4.  Uncheck the Nearest solution 

option. 

5.  Click OK.

 

The Multi-Result Management dialog 
box appears.

6.  Check the keep only one sub-

element using an Extract 

option to create an extract of 

the multiple element, that is the 

combine curves.

7.  Click OK.

The Extract Definition dialog box 

appears.



 

8.  Select one of the combine 

curves in the 3D geometry as 

the Element to extract.

The selected element is 

highlighted.

9.  Click OK.

The curve (identified as 

Combine.xxx) and the extracted 

element (identified as 

Extract.xxx) are added to the 

specification tree. The combine 

curve is put in no show.

 

 
The multi-result feature has several children
Open the Multi-Result2.CATPart 
document.

1.  Double-click Intersect.1.

The Intersection Definition dialog box appears.

2.  Click OK.

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/Multi-Result2.CATPart


 

The Multi-Result Management dialog 
box appears.
The multi-result feature contains an 
extract that is displayed in the Extracts 
and Nears tab.

3.  Double-click Extract.1.

The Extract Definition dialog box 

opens.

4.  Select another vertex as the 

Element to extract, as shown 

besides.  

5.  Click OK.

 

6.  Click OK in the Multi-Result 

Management dialog box.

The line, that uses the Extract 

element as the point, is 

modified accordingly.

 
For further information about the Extract command, refer to the Extracting Geometry chapter 
in the Generative Shape Design documentation.



Using pointing element and select a sub-element to 
keep

Using a Near
Open the Multi-Result3.CATPart 
document.

1.  Double-click Intersect.1.

The Intersection Definition 

dialog box appears.

2.  Replace Line.1 by Spline.1 as 

the Second element by 

selecting it in the 3D geometry.

3.  Click OK.

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/Multi-Result3.CATPart


 

The Multi-Result Management dialog 
box appears.

4.  Double-click Line.1 to modify its 

specifications.

The Line Definition dialog box 

opens.

5.  Replace Intersect.1 by Point.1 

as the Point.

6.  Click OK.

In the Multi-Result Management 

dialog box, there is no pointing 

element any more.

7.  Check the keep only one sub-

element using a Near option 

to create a nearest entity of the 

multiple element, that is 

Intersect.1.

8.  Click OK.

The Near Definition dialog box 

appears and the intersect 

element is automatically filled in 

the Multiple Element field.

9.  Select the axis system as the 

Reference Element.



10.  Click OK.

The nearest element (identified as Near.xxx) is added to the specification tree before 

the line and is set as current. 

 

 

The line, that now uses Point.1, is 
modified accordingly. 

Using an Extract
Open the Multi-Result4.CATPart 
document.

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/Multi-Result4.CATPart


1.  Double-click Combine.1.

The Combine Definition dialog 

box appears.

2.  Click OK.

 

The Multi-Result Management dialog 
box appears.

3.  Check the keep only one sub-

element using an Extract 

option to create an extract of 

the multiple element, that is the 

combine curves.

4.  Click OK.

The Extract Definition dialog box 

appears and the combine 

element is automatically filled in 

the Multiple Element field.

5.  Select the axis system as the 

Reference Element.



6.  Select one of the combine 

curves in the 3D geometry as 

the Element to extract.

The selected element is 

highlighted.

7.  Click OK.

The extracted element 

(identified as Extract.xxx) is 

added to the specification tree. 

●     Several multi-result features can be contained within a multi-output.

●     The options set in the dialog box are retained when exiting then returning to the Multi-
Result Management function.



Advanced Tasks 
The advanced tasks you will perform in the Generative Shape Design workbench include managing 
the specification tree and  interoperating with other workbenches.

Managing Geometrical Sets and Ordered Geometrical Sets
Creating a Curve From Its Equation

Creating a Parameterized Curve
Patterning

Managing Power Copies
Measure Tools

Using Hybrid Parts
Working with the Generative Shape Optimizer Workbench

Working with the Developed Shapes Workbench
Working With The Body in White Templates

Creating Volumes

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/sdgugat0102.htm


Managing Geometrical Sets and
Ordered Geometrical Sets

Manage geometrical sets: select a Geometrical Set in the specification tree, use the Insert -
> Geometrical Set menu command, or Remove Geometrical Set or Change 
Geometrical Set contextual menus.

Manage ordered geometrical sets: select an Ordered Geometrical Set in the specification tree, 
use the Insert -> Ordered Geometrical Set menu command.

Insert a body into an ordered geometrical set: select the Insert -> Body in a Set menu 
command and enter the name of the body you wish to insert into the ordered geometrical 
set.

Duplicate geometrical sets: click this icon and select the geometrical set to be duplicated.

 
Hide/show geometrical sets or ordered geometrical sets and their contents: select the 
geometrical set or the geometrical set to be hidden and use the Hide/Show capabilities.



Managing Geometrical Sets   
Geometrical sets enable to gather various features in a same set or sub-set and organize the 
specification tree when it becomes too complex or too long. You can put any element you wish 
in the geometrical set, it does not have to be structured in a logical way. The order of these 
elements is not meaningful as their access as well as their visualization is managed 
independently and without any rule.

 

This task shows how to manage geometrical sets within the specification tree. This involves: 

●     inserting a geometrical set

●     removing a geometrical set

●     changing body

●     sorting the contents of a geometrical set

●     reordering components

You will find other useful information in the Managing Groups and Hiding/Showing chapters.

●     You can insert and manipulate geometrical sets in the specification tree in much the same 
way as you manage files in folders.

●     These management functions have no impact on the part geometry.

●     You should refer to the Copying and Pasting section for information about how geometrical 
sets can be used in a part edition context.

●     When loading the Generative Shape Design workbench, a Geometrical Set automatically 
becomes the current body. 
This also means that only the results of the Hybrid Body, i.e. the result of all the operations 
performed on geometry, is visible and not any intermediate state of the Hybrid Body.

●     You can define the Generative Shape Design feature that is to be seen when working with 
another application, such as Generative Structural Analysis for example. 

   
To do this, while in the Generative 
Shape Design workbench: 

1.  Choose the Tools -> 
External View... menu item
The External View dialog box 
is displayed.

2.  Select the element belonging 
to a Geometrical Set that 
should always been seen as 
the current element when 
working with an external 
application.

3.  Click OK in the dialog box.



The selected element will be the visible element in other applications, even if other 
elements are created later in the .CATPart document, chronologically speaking.

To check whether an external view element has already been specified, choose the 
Tools -> External View... menu item again. The dialog box will display the name of 
the currently selected element. This also allows you to change elements through the 
selection of another element. Note that you cannot deselect an external view 
element and that only one element can be selected at the same time.

Open any .CATPart document containing Geometrical Sets.
You can also open the GeometricalSets2.CATPart document.

  

Inserting a Geometrical Set

1.  In the specification tree, select an element as the location of the new geometrical set. 

This element will be considered as a child of the new geometrical set and can be a 

geometrical set or a feature.

2.  Select the Insert -> Geometrical Set 

menu command.

The Insert Geometrical Set dialog box 

is displayed.

The Features list displays the elements 

to be contained in the new geometrical 

set.

3.  Enter the name of the new geometrical 

set.

4.  Use the Father drop-down list to 
choose the body where the new 
geometrical set is to be inserted. All 
destinations present in the document 
are listed allowing you to select one to 
be the father without scanning the 
specification tree. They can be:

❍     geometrical sets

❍     parts

5.  Select additional entities that are to be 

included in the new geometrical set.

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/GeometricalSets2.CATPart


If all selected entities belong to the same 
geometrical set, the father of the new 
geometrical set is automatically set to the 
father of these entities.

 
6.  Click OK to create the geometrical set 

at the desired location.

The result is immediate. CATIA 

displays this new Geometrical Set.x, 

incrementing its name in relation to 

the pre-existing bodies, in the 

specification tree. It is created after 

the last current geometrical set and 

is underlined, indicating that it is the 

active geometrical set. The next 

created element is created within 

this geometrical set.

●     You cannot create a geometrical set within an ordered geometrical set and vice versa.

●     This Insert Geometrical Set dialog box is only available with the Generative Shape Design 2 
product.

 You can check the Create a Geometrical Set when creating a new part option in Tools -> 

Options -> Infrastructure -> Part Infrastructure -> Part Document tab if you wish to 

create a geometrical set as soon as you create a new part. For more information about this 

option, please refer to the Customizing section of the Part Design User's Guide.

Removing a Geometrical Set
Two methods are available:

●     If you want to delete the geometrical set and all its contents:

1.  Right-click the geometrical set then select the Delete contextual command.

 
●     If you want to delete the geometrical set but keep its contents:

This is only possible when the father location of the geometrical set is another geometrical 
set. This is not possible when the father location is a root geometrical set.



1.  Right-click the desired geometrical set then select the Geometrical Set.x object -> 

Remove Geometrical Set contextual command.

The geometrical set is removed and its constituent entities are included in the father 
geometrical set.

You cannot delete a feature within a geometrical set created on the fly. Indeed this geometrical 
set is considered as private and can only be deleted globally.

Moving a Geometrical Set to a New Body

 
1.  From the specification tree, select the 

element then choose the Geometrical 

Set.object -> Change Geometrical 

Set...  item from the contextual menu.

Multi-selection of elements of different types is supported. However, note that in this case, the 
contextual menu is not available, and that you can access this capability using the Edit menu 
item.

The Change Body dialog box is 
displayed.

The list of destinations is 
alphabetically sorted.



2.  Select the Destination body where the geometrical set is to be located.

Here we selected Geometrical_Set.3.

You can do so by selecting the Body in the specification tree, or using the drop-down 

list from the dialog box.

By default, if you select a body, the geometrical set is positioned last within the new 

body. However, you can select any element in the new body, before which the 

moved geometrical set will be located.

3.  Select the element above which the 

one you already selected is to be 

inserted.

You can directly select this positioning element. In this case the Destination field of the 
Change Body dialog box is automatically updated with the Body to which this second element 
belongs.

4.  Click OK to move the geometrical set 

to the new body.

The element selected first is moved 

to its new location in the 

specification tree, but geometry 

remains unchanged. 



   

 

●     Check the Change body unshared 
parents option to move all parents of the 
first selected element to its new location, 
provided these parents are not shared by 
any other element of the initial body.
In this case, all the unshared parents are 
highlighted prior to the move.

●     Check the Change body all parents 
option to move all parents of the first 
selected element to its new location, 
regardless of whether these parents are 
used (shared) by any other element of the 
initial body.
In this case, all the parent elements are 
highlighted prior to the move.

   

●     You can move a whole branch, i.e. a whole 
body and its contents, at a time.
Here we moved Geometrical_Set.3 last in 
Geometrical_Set.1.



Sorting the Contents of a Geometrical Set
You may need to sort the contents of a Geometrical Set, when the geometric elements no 
longer appear in the logical creation order. In that case, use the Auto-sort capability to reorder 
the Geometrical Set contents in the specification tree (geometry itself is not affected). 
The Geometrical_Set.1 contains two extruded 
surfaces based on point-point lines. The 
specification tree looks like this:

   

1.  Right-click the Geometrical_Set.1 from 

the specification and choose the 

Geometrical_Set.1 object -> 

AutoSort command.

Instantly, the contents of the 

Geometrical Set are reorganized to 

show the logical creation process.

The geometry remains unchanged.



Reordering Components within a Geometrical Set
 This capability enables you to reorder elements inside the same geometrical set.

1.  Right-click the Geometrical_Set.1 from 

the specification tree and choose the 

Ordered Geometrical Set.1 object -

> Reorder Children command.

The Reorder Children dialog box is 

displayed.

2.  Select an element.

3.  Use the arrows to move an element up 

or down.

 

Reordering Features 
 The Reorder command allows you to move a feature in a Geometrical Set. These features can 

be:
●     solids

●     shape features

●     sketches

 

Replacing Features
 This capability is only available on shape features.

Please refer to the Replacing or Moving Elements chapter in the Part Design User's Guide.
 To manage this capability, the Do replace only for elements situated after the In Work 

Object option is available in Tools -> Options -> Part Infrastructure ->  General tab. It 
allows you to make the Replace option possible only for features located below the feature in 
Work Object and in the same branch.

 



Managing Ordered Geometrical Sets
Geometrical sets enable to gather various features in a same set or sub-set. The order of these features is not meaningful as their access 
as well as their visualization is managed independently and without any rule. However flexible, this structure does not fit the design 
process.
That is why ordered geometrical sets introduced notions of succession of steps that define the design, and absorption.
Creation features create a new object and modification features create a new state in an existing object as well as absorb the preceding 
state(s). Absorbed features are no longer visible nor accessible, as if ''masked'' by their absorbing feature.
In an ordered geometrical set, the order of apparition of features in the specification tree is consistent with the steps of creation of the 
design.
Unlike features within a geometrical set, features in an ordered geometrical set can be set as current: a given step of the design creation 
is chosen and what is located after it is not accessible nor visible.

  
This task shows how to manage ordered geometrical sets within the specification tree. This involves: 

●     inserting an ordered geometrical set

●     defining an in work object

●     visualizing features within an ordered geometrical set

●     removing an ordered geometrical set

●     removing a feature within an ordered geometrical set

●     sorting the contents of an ordered geometrical set

●     reordering components within an ordered geometrical set

●     reordering features

●     modifying children

●     replacing features

●     inserting and deleting inside and ordered geometrical set

You will find other useful information in the Managing Groups, Hiding/Showing, and Copying and Pasting chapters.
You can define the Generative Shape Design feature that is 
to be seen when working with another application, such as 
Generative Structural Analysis for example. 

To do this, while in the Generative Shape Design 
workbench: 

1.  Choose the Tools -> External View... 
menu item.
The External View dialog box is displayed.

2.  Select the element belonging to a 
Geometrical Set that should always been 
seen as the current element when working 
with an external application.

3.  Click OK in the dialog box.

The selected element will be the visible element in other applications, even if other elements are created later in the .CATPart 
document, chronologically speaking.

To check whether an external view element has already been specified, choose the Tools -> External View... menu item 
again. The dialog box will display the name of the currently selected element. This also allows you to change elements through 
the selection of another element. Note that you cannot deselect an external view element and that only one element can be 
selected at the same time.

Open any .CATPart document containing Geometrical Sets.
You can also open the OrderedGeometricalSets1.CATPart document.

Inserting an Ordered Geometrical Set

1.  In the specification tree, select an element as the location of the new ordered geometrical set. 

This element will be considered as a child of the new ordered geometrical set.

Inserting an Ordered Geometrical Set does not break the succession of steps as the order applies to all the elements of a same 

root ordered geometrical set.

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/OrderedGeometricalSets1.CATPart


2.  Select the Insert -> Ordered Geometrical Set 

menu command.

The Insert ordered geometrical set dialog box is 

displayed.

The Features list displays the elements to be 

contained in the new ordered geometrical set.

3.  Enter the name of the new ordered geometrical set 

you wish to insert.

4.  Use the Father drop-down list to choose the body 
where the new ordered geometrical set is to be 
inserted. All destinations present in the document are 
listed allowing you to select one to be the father 
without scanning the specification tree. They can be:

❍     ordered geometrical sets

❍     parts

By default the destination is the father of the current object. 
By default the ordered geometrical set is created after the 
current feature.

5.  Select additional entities that are to be included in the 

new ordered geometrical set.

If all selected entities belong to the same ordered 
geometrical set, the father of the new ordered geometrical 
set is automatically set to the father of these entities.

 

6.  Click OK to create the ordered geometrical set at the 

desired location.

The result is immediate. CATIA displays this new 

Ordered Geometrical Set.x, incrementing its name 

in relation to the pre-existing bodies, in the 

specification tree. It is created after the last 

current ordered geometrical set and is underlined, 

indicating that it is the active ordered geometrical 

set. 

●     You can insert an ordered geometrical set after the current feature.

●     You cannot create an ordered geometrical set within a geometrical set and vice versa.

You can now insert a body into an ordered geometrical set.
For further information, refer to the Inserting a Body into an Ordered Geometrical Set chapter.

This Insert ordered geometrical set dialog box is only available with the Generative Shape Design 2 product.

 
Defining an In Work Object

 The next created element is created after the In Work object.
If the new feature to be inserted is a modification feature, features after the In Work object may be rerouted to the new created feature.

 
Visualizing features in an Ordered Geometrical Set

 
It can be useful to temporarily see its future geometry.
To do so, you can check the Future geometry option in Tools -> Options -> Part Infrastructure ->  Display tab. It allows you to also 
display the geometry located after the current feature.

 
●     Only features that come before the current object and that are not absorbed by any feature preceding the current object are visualized 

in the specification tree.



 

 
●     A color assigned to a feature is propagated to all the features that successively modify this feature and so on.

This is why it is possible to set a specific color only on creation features.
Therefore, changing the color of a modification feature modifies the color of the initial state.

Here Extrude.1 is absorbed by Split.1. Therefore the color of Extrude.1 is propagated onto Split.1.

 

The same behavior applies on Show/No show attributes.

 
Selecting Features within an Ordered Geometrical Set

 The selection of features located after the current feature or absorbed features is not possible.

 

Here, for instance, when editing Extrude.1, the selection of Offset.1 is not possible because Offset.1 is located after Extrude.1 which is the 
current object. A black sign indicates that this selection is not possible. Additionally, the application displays a tooltip explaining why it is 
not possible. 
To ensure the consistency between the visualization in the 3D geometry and the selection in the specification tree, features that cannot be 
visualized in the 3D geometry cannot either be selected in the specification tree.

 

 However, if you want to allow the selection of geometrical elements absorbed by other elements or the selection of geometrical elements 
located after the element being created, you can check the Enable selection of drawn geometry or Enable the selection of future 
geometry options in Tools -> Options -> Part Infrastructure ->  General tab.
As a consequence, the succession of steps of the ordered geometrical set is no longer respected. We advise you not to check these options 
but rather work in a geometrical set environment. 
If these options are unchecked, selecting elements whose geometry is not visible any more is not possible. 



Removing an Ordered Geometrical Set

1.  Right-click the ordered geometrical set then select the Delete contextual command.

The ordered geometrical set and all its contents are deleted.

Removing a Feature within an Ordered Geometrical Set

1.  Right-click the feature then select the Delete contextual command.

 
●     deletion of a modification feature: the system reroutes the children on the element that is modified. Therefore the deleted feature will 

be replaced by the modified feature of upper level.
In our scenario, Split.1 is deleted. As a consequence, Offset.1 now points Extrude.1.

 

 ●     deletion of a creation feature: no reroute is possible.

Sorting the Contents of an Ordered Geometrical Set
 You may need to sort the contents of an ordered geometrical set, when the geometric elements no longer appear in the logical creation 

order. It may be the case if you enabled the selection of drawn or future geometry options. In that case, use the Auto-sort capability to 
reorder the ordered geometrical set contents in the specification tree.
The Ordered Geometrical Set.1 contains a line based on two points lines. The specification tree looks like this:

 

1.  Right-click the Geometrical_Set.1 from the specification and choose the Ordered Geometrical Set.1 object -> AutoSort 

command.

Instantly, the contents of the Ordered Geometrical Set are reorganized to show the logical creation process.

The geometry remains unchanged. Datum features are put first in the specification tree.



 

Reordering Components within an Ordered Geometrical Set
This capability enables you to reorder elements inside the same ordered geometrical set.

 Reordering a creation feature based upon a modification feature

Open the Reorder1.CATPart document.

The Ordered Geometrical Set contains Split.1 (in blue) that splits Fill.1 by a purple vertical plane, and Offset.1 (in red) is an offset of 
Split.1.

 

1.  Right-click the Ordered Geometrical Set.1 from the 

specification tree and choose the Ordered 

Geometrical Set.1 object -> Reorder Children 

command.

The Reorder Children dialog box is displayed.

2.  Select the element to be rerouted.

Here we chose to reorder Offset.1 (creation feature) 

before Split.1 (modification feature).

3.  Use the arrow to move Offset.1 up.

4.  Click OK.

Offset.1 is now located before Split.1 in the 

specification tree.

  

If you define Split.1 as the In Work object, you can see that Offset.1 is now based upon Fill.1.
Split.1 was not rerouted since Offset.1 does not modify Fill.1.

 

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/Reorder1.CATPart


 

 Reordering a modification feature based upon a modification feature

Open the Reorder2.CATPart document.

The Ordered Geometrical Set contains Split.2 (in blue) that splits Split.1 by a vertical plane. Split.1 itself splits Fill.1 (delimited by Sketch.1 
in purple).

 

1.  Right-click the Ordered Geometrical Set.1 from the 

specification tree and choose the Ordered 

Geometrical Set.1 object -> Reorder Children 

command.

The Reorder Children dialog box is displayed.

2.  Select the element to be rerouted.

Here we chose to reorder Split.2 (modification 

feature) before Split.1 (modification feature).

3.  Use the arrow to move Split.2 up.

4.  Click OK.

Split.2 is now located before Split.1 in the 

specification tree.

 Split.2 is rerouted onto the input feature modified by Split.1, that is Fill.1 (in blue).
Otherwise Split.2 would still split Split.1 which comes after in the specification tree.

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/Reorder2.CATPart


 

 

Indeed, when you edit Split.2, you can notice that the Split.2 
was rerouted onto Fill.1.

   
 

And since Split.2 now modifies Fill.1, Split.1 was rerouted 
onto Split.2.

  

An error message is issued if you try to move an element towards a position that breaks the order rules.

Note that the feature defined as the In Work object after the Reorder operation is not affected by this operation from an update point of 
view:

●     when reordering upward, the feature located just before the new position of the reordered feature becomes the In Work object.

●     when reordering downward, the feature just before the original position of the reordered feature becomes the In Work object.

You can use the Scan command after the Reorder operation to see what moved step by step.

 
Reordering Features 

 The Reorder command allows you to move a feature in an Ordered Geometrical Set. These features can be:
●     Generative Shape Design features

●     sketches

For further information, please refer to the Reordering Features chapter in the Part Design User's Guide.
 

Modifying Children 
 The Modify Children command allows you to modify the contents of an ordered geometrical set by selecting its first and last component, as 

well as destroy it.

This command is only available on sub-ordered geometrical sets.

1.  Right-click the sub-ordered geometrical set from the 

specification tree and choose the Ordered 

Geometrical Set.x object -> Modifying children. 

The Edit dialog box opens with the First Element 

and Last element fields automatically valuated with 

the first and last elements of the ordered geometrical 

set.

 
2.  Select the elements you wish to place first and last.

In our scenario, we chose Line.1 as the first element and Split.1 as the last element.



 

 
3.  Click OK.

The specification tree is modified consequently. 

Elements before or after the first and last elements are rerouted in the father ordered geometrical set.

 

The Modify children command also allows you to remove the sub-ordered geometrical set. As a consequence, elements are rerouted in the 
father ordered geometrical set.

 

 
Replacing Features

 Please refer to the Replacing or Moving Elements chapter in the Part Design User's Guide.
  
 The Do replace only for elements situated after the In Work Object option is available in Tools -> Options -> Part 

Infrastructure ->  General tab. It restricts the Replace capability only on features located before the feature in Work Object and in the 
same branch.
As a consequence, the succession of steps of the ordered geometrical set is no longer respected. We advise you not to check this option 
but rather work in a geometrical set environment. 

 
Switching From Ordered Geometrical Set to Geometrical Set

 While in an ordered geometrical set environment, you may want to switch to a geometrical set environment (for instance, if you do not 
want to work in an ordered environment any more).

1.  Right-click the Ordered Geometrical Set.1 from the specification tree and choose the Ordered Geometrical Set.1 object -> 

Switch to geometrical set command.

The Ordered Geometrical Set.1 becomes Geometrical Set.1. 

Features after the current object that were not visualized in the ordered geometrical set are put in no show in the geometrical set.



 

●     This command is only available on a root ordered geometrical set.

●     Switching from geometrical set to ordered geometrical set is not possible.

●     Colors may be modified.

 
Inserting and Deleting Inside an Ordered Geometrical Set

 Inside an ordered geometrical set, the Insert and Delete commands may have impacts that result in replace actions based on absorption 
rules.

Open the OrderedGeometricalSets2.CATPart document.

Here, the edge fillet (Edge Fillet.1) is the current object.

 

 A split feature (Split.1) is inserted just after EdgeFillet.1. This new feature absorbs EdgeFillet.1 and therefore the latter is no more 
displayed and cannot be referenced by any feature located after the Split.1 in the specification tree. 

 

 To ensure the ordering rule, the links to the absorbed feature (EdgeFillet.1) must be rerouted to the inserted feature (Split.1). This 
replacement applies to all the features inside the root ordered geometrical set (Ordered Geometrical Set.1) located after the inserted 
feature and to all the features located inside other ordered geometrical sets roots (here, Ordered Geometrical Set.2).

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/OrderedGeometricalSets2.CATPart


This replace action may not be applicable; in this case a 
warning message is issued. 
Using our example, had we selected the other side of Split.1, 
the replacement of the edge to extrapolate (defined in 
Extrapol.1 feature) would not have been possible.

  
 As a consequence of the replace action, the affected features (that is Extrapol.1 and Offset.1) become "not updated". The update following 

the insertion may also produce an error and in this case the design will have to be modified so that the inserted feature is compatible with 
the entire design. 

The replace actions performed by the Delete command are generally the opposite of the replace actions performed by Insert command. 
Using our example, deleting Split.1 leads to the replacement of Split.1 by EdgeFillet.1. Nevertheless, bear in mind that deleting a feature 
can lead to a configuration different from the one preceding the insertion of a feature (for instance, if inserting a Trim feature, all inputs 
will be replaced by this feature but if deleting it, the Trim feature will be replaced by its main input).

  
 Based on this mechanism stand two methodologies for: 

●     multiple references to an intermediate state of design inside an ordered geometrical set,

●     external links to the "end design" specified inside an ordered geometrical set.

 Multiple references

 Inside a root ordered geometrical set, a feature can be the input of several features (all creation features, except for the last feature, 
according to the order in the specification tree, which can be a modification feature). In some cases, the design may require to create 
several modification states of a same feature. To do so, it is necessary to create copies (Copy/Paste As Result With Link). 

Open the OrderedGeometricalSets3.CATPart document.

 This example shows how to allow multiple modifications of EdgeFillet.1 feature, considered as an "intermediate state of design". A copy of 
the feature, representing the exported view, is inserted just after it. In the beginning of every sub-set where this state of design will be 
used, a copy of the copy is created, representing the imported view. 
Using this construction, modifications applied to EdgeFillet.1 or to the copies of the copy (imported views) will affect only the design in Sub 
OGS.1.

 

 External Links

 The replace actions due to design modifications (insertion and deletion) do not affect external links (that is the links between an external 
element from the .CATPart document and a feature inside an ordered geometrical set). To ensure that the links will always reference the 
last state of design, it is necessary to create a copy (Copy/Paste As Result With Link) of the last current feature in a new ordered 
geometrical set. This copy can possibly be published. As a consequence, the external link will have to reference this copy or its publication.

Open the OrderedGeometricalSets4.CATPart document.

 In this example, Surface.2 is a copy of EdgeFillet.1.
The external link has to reference Surface.2 or its publication. 

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/OrderedGeometricalSets3.CATPart
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 A split feature is inserted after EdgeFillet.1. As a consequence, Surface.2 is rerouted to Split.1 and so is the external link.
 



 Inserting a Body into an Ordered 
Geometrical Set

This task shows you how to insert a body into an ordered geometrical set.

Open the OrderedGeometricalSets1.CATPart document.

1.  Select the Insert -> Body in a  Set... command. 

The Insert body dialog box is displayed.

 
2.  Enter the name of the body you wish to insert into the ordered geometrical set. Our 

part contains no bodies, so enter a name as you are creating the body. For example, 

enter New Body.

 

 3.  Use the Father drop-down list to choose the body where the new ordered geometrical 
set is to be inserted. In our example, set Ordered Geometrical Set.1. All destinations 
present in the document are listed allowing you to select one to be the father without 
scanning the specification tree. They can be:

❍     ordered geometrical sets

❍     parts

By default the destination is the father of the current object. By default the body is created 
after the current feature.

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/OrderedGeometricalSets1.CATPart


 4.  Set the Father option to the name of the ordered geometrical set you need. In our 

example, set Ordered Geometrical Set.1.

Possible destinations are the part and all Ordered Geometrical Sets already defined in 

the part. By default the destination is the father of the current object. By default the 

body is created after the current feature.

5.  It is possible to select elements of the Ordered Geometrical Set to put these elements 

inside the body when creating it. Only consecutive elements can be selected. Volumes 

and bodies cannot be selected. In case of selection of elements, the destination became 

automatically the father of the selected elements and cannot be changed any more. 

Select for example, Split.1 and Offset.1.

5.  Click OK to confirm the operation.

The result is immediate.

 

 
You can now create the features you need in the new body inserted into the Ordered 

Geometrical Set.



Duplicating Geometrical Sets and
Ordered Geometrical Sets

This command is only available with the Generative Shape Design 2 product.

 
This task shows how to duplicate geometrical sets and ordered geometrical sets from the 
specification tree.

You will find other useful information in the Managing Geometrical Sets and the Managing 
Ordered Geometrical Sets sections. 

Open the PowerCopyStart1.CATPart document.

1.  Click the Duplicate 

Geometrical Set  

icon, or select the 

Insert -> Advanced 

Replication Tools -> 

Duplicate 

Geometrical Set 

menu item.

2.  Select the geometrical 

set to be duplicated. 

It can be selected 

within the current 

.CATPart document, or 

from any other 

.CATPart document.

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/PowerCopyStart1.CATPart


3.  Complete the Inputs 

within the dialog box 

by selecting the 

adequate element in 

the geometric area.

4.  If needed, click on the 

Use identical name 

button to automatically 

select all the elements 

with the same name.

This is especially useful 

when the input is the 

same one repeated 

several time.

 

Check the Repeat option to be able to repeat the duplication.
In this case, once you have clicked OK in  the Insert Object dialog box, the latter remains 
open, the Geometrical Set's Inputs are listed and ready to be replaced by new inputs, as 
described above.
Modified parameters using Parameters button are retained as well for the next instantiation.
To exit the command, you then need to uncheck the Repeat button or click Cancel.

5.  Click OK.

The new geometrical 

set is created in the 

specification tree.



The identifiers of copied elements are incremented with respect to the original elements.
The original elements and copied elements can be edited independently.

 



Hiding/Showing Geometrical Sets or
Ordered Geometrical Sets

and Their Contents

 

This task shows how to use the Hide/Show command on different level of geometrical sets and ordered geometrical 
sets and for different purposes. Indeed you can:  

●     hide/show a complete geometrical set or ordered geometrical set

●     hide/show contents of a geometrical set or an ordered geometrical set

●     hide/show an element while in a command

●     hide/show an element belonging to an ordered geometrical set

  

Open any .CATPart document containing Geometrical Sets or Ordered Geometrical Sets.
You can also open the GeometricalSets1.CATPart document to have an example with Geometrical Sets and the 
OrderedGeometricalSets1.CATPart document to have an example with Ordered Geometrical Sets.

Hiding/Showing a Geometrical Set or an Ordered Geometrical Set

 This contextual menu allows you to hide/show a geometrical set or an ordered geometrical set whether current or 
not.

1.  In the specification tree, select the 

geometrical set or ordered geometrical 

set you wish to hide/show

2.  Right-click to display the contextual 

menu and choose the Hide/show 

command.

The geometrical set or ordered geometrical set 
is hidden, if it was visible, or becomes visible, if 
it was hidden.

Visible geometrical set Hidden geometrical set

Hiding or Showing a geometrical set or an ordered geometrical set as a whole can also be done using the Hide/Show 

 icon.

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/GeometricalSets1.CATPart
http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/OrderedGeometricalSets1.CATPart


It is not possible to hide a sub-ordered geometrical set using the Hide/Show contextual command. However you 

can use the Hide components contextual command as explained hereafter.

 
Hiding/Showing Contents of a Geometrical Set or Ordered Geometrical Set 

 This contextual menu allows you to hide/show all features in a geometrical set or an ordered geometrical set (even 
sketches), whether current or not.

1.  In the specification tree, select the geometrical set or the ordered geometrical set whose solid elements you 

want to hide/show.

2.  Right-click and choose Geometrical_Set.x object -> Show components contextual command to restore 

the view if the elements were hidden, or Geometrical_Set.x object -> Hide components contextual 

command to hide visible elements. 

Visible contents Hidden contents

It is advised to use this method to hide contents of a geometrical set or an ordered geometrical set, rather than using 

the Hide/Show contextual command: indeed when a geometrical set or an ordered geometrical set is in show, its 

contents are as well. This method enables to quickly show an element of a geometrical set or an ordered geometrical 

set .

      

Hiding/Showing an element while in a command

 This contextual menu allows you to hide/show an element of the current geometrical set or ordered geometrical set, 
while using a command.



1.  Click the Line icon  and select two 

points to create a line.

2.  Right-click the element to be hidden 

from the specification tree or the 

geometry, and choose the Hide/Show 

contextual command.

The selected element is hidden without 

exiting the currently active command.

3.  Click OK in the Line dialog box to create 

the line.

4.  Repeat the operation on the element 

again to re-display it.

 
Hiding/Showing an element belonging to an Ordered Geometrical Set

 This contextual menu allows you to hide/show a modification feature.
If a modification feature is put in no show, all features absorbed by this feature are in no show too.



1.  Right-click the element (Split.1) to be 

hidden from the specification tree or the 

geometry, and choose the Hide/Show 

contextual command.

 As Split.1 is absorbed by Extrude.1,  Extrude.1 
is also put in no show.

  

Note that you can hide/show all elements of a document, according to their type. To do this, simply use the Tools -> 
Show or Tools -> Hide menu and choose the adequate element type (All Points, All Lines, All Curves, All 
Sketches, All Surfaces, All Planes, All Geometrical Sets, All Bodies, All Axis Systems, All Elements, All 
Selected Elements, All Except Selected Elements).

 

 



Creating a Curve From Its Equation

 
This task shows how to create a curve by defining its equation as a law.

 

You must have access to the Knowledge Advisor product.

Make sure the Relations and Parameters options are active in the Tools -> Options -> Infrastructure -> 

Part Infrastructure -> Display tab.

Open a new .CATPart document.

 
1.  In the Generative Shape Design workbench, 

define a working support using the Work on 

Support icon  .

The Work on Support dialog box appears. 

2.  Select the yz plane, for example, and click OK in the updated Work on Support dialog box without 

modifying any other parameter.

The Working Support.1 is created, and the system automatically moves into this plane.
You now want to create a horizontal line as the abscissa axis. 

3.  Click the Line icon .

The Line dialog box is displayed. 

4.  Right-click in the Point 1 field, and choose the 

Create point contextual menu.



The Point Definition dialog box is displayed, 
the Point type and Plane fields being 
automatically filled.

5.  Create a point at H:0mm and V:0mm, and click 

OK.

6.  Repeat the operation, right-click the Point 2 field 

from the Line dialog box to create another point 

at H:100mm and V:0mm, then click OK in the 

Point Definition dialog box.

7.  Click OK in the Line dialog box to create the line

 
You may want to hide the grid by checking the Hide grid option from the Work On Support dialog box.

8.  From the Knowledge toolbar, click the Law  icon.

The Law Editor dialog box is displayed in which you name the law to be created, give it a description 
and a storage location. 

9.  Click OK.

The Law Editor dialog box is updated. The right-hand part allows you to create the parameters to be 
used in the law. The left-hand part is the law edition box. 



10.  Create two real type parameters FormalReal.1 and FormalReal.2, then enter the law below into the 

edition window: FormalReal.1 = 5*sin(5*PI*1rad*FormalReal.2)+ 10

11.  Click OK to create the law.

12.  In the Generative Shape Design workbench, click the Parallel Curve icon  .

The Parallel Curve Definition dialog box is displayed.

13.  Select the line created in Step 7 as the reference 

Curve.

14.  Click the Law button and select the Law.1 you 

have juste created from the specification tree.

15.  Click OK.



A curve parallel to the selected one is created, taking 
the law into account, i.e. it is defined by the equation 
entered as a law using the Knowledge Advisor.

 



Creating a Parameterized Curve

This task shows how to create a planar curve defined by two formulas.

 

You must have access to the Knowledge Advisor product.

Make sure the Relations and Parameters options are active in the Tools -> Options -> Infrastructure -> Part Infrastructure -> 

Display tab.

Open a new .CATPart document.

1.  Create two points using the following coordinates:

Point.1: X=0, Y=0, and Z=22

Point.2: X=0, Y=0, and Z=75

 

 
2.  Define line between these two points.

It is created along the the Z axis of the axis-system, using the Point-Point option.

 

3.  From the Knowledge toolbar, click the Law  icon.

The Law Editor dialog box is displayed in which you name the law to be created, give it a description and a storage location. 
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4.  Click OK.

The Law Editor dialog box is updated. The right-hand part allows you to create the parameters to be used in the law. The left-hand 
part is the law edition box. 

5.  Create one real type parameter t and one length type parameter x, then enter the law below into the edition window: 

x=40mm+100mm*(t-0.5)**2

6.  Click OK to create the law.

 
7.  Create a second law using one real type parameter t and one length type parameter y, then entering the following law into the edition 

window: y=40mm+200mm*(t-0.5)*(0.25-t)*(0.75-t)

 
8.  Create a parallel curve, using the Line.1 created in step 2 as the reference Curve to be offset, and the ZX plane of the axis system as 

the Support on which the reference curve lies.

9.  Click the Law... button and select the Law.1 you have just created from the specification tree.

10.  Click OK.

A curve parallel to the selected one is created, taking the law into account, i.e. it is defined by the equation entered as a law using 

the Knowledge Advisor.
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11.  Create a second parallel curve, using Line.1 as the reference Curve and the YZ plane as the Support.

12.  Click the Law... button and select Law.2.

13.  Click OK to create the parallel curve with a variable law.

 



 

 
14.  Use the Combine command to create a curve resulting from the intersection of the extrusion of the two parallel curves.

 

 

 
15.  Use the Project command to project the combined curve onto the xy plane:

Choose the combined curve as the element to be projected, the xy plane as the Support, and the Z axis as the Direction.  
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 Here is the parameterized curve (in blue) obtained by two formulas:

It is not advised to create closed parameterized curves.



Patterning

Create rectangular patterns: select the element to be duplicated, define the creation directions, 
choose the parameters you wish to define and set these parameters

Create circular patterns: select the element to be duplicated, define the axial reference, the 
creation direction, choose the parameters you wish to define and set these parameters

 



Creating Rectangular Patterns

 

This task shows how to use create rectangular patterns, that is to duplicate an original wireframe or surface-type element at the location of 
your choice according to a rectangular arrangement.
This means that you will need to define a 2-axis system using two directions.

Open the Pattern1.CATPart document.

 
1.  Click the Rectangular Pattern  icon.

2.  Select the element you wish to replicate as a pattern.

The Rectangular Pattern Definition dialog box is displayed. Each tab is 
dedicated to a direction you will use to define the location of the 
duplicated element.

3.  Click the Reference element field and select a direction to 

specify the first direction of creation.

 

To define a direction, you may select a line, a planar face or surface edge.
You can reverse this direction by clicking the Reverse button.

4.  Set the duplication parameters by choosing the number of instances, the spacing between instances, or the total length of the zone 

filled with instances.

Three options are available:

1.  Instances & Length: the spacing between instances is automatically computed based on the number of instances and 

the specified total length

2.  Instances & Spacing: the total length is automatically computed based on the number of instances and the specified 

spacing value

3.  Spacing & Length: the number of instances is automatically computed to fit the other two parameters.

For each of these cases only two fields are active, allowing you to define the correct value.

 
If you set Instances & Length or Spacing & Length parameters, note that you cannot define the length by using formulas.
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5.  Click the Second Direction tab to define the same 

parameters along the other direction of the rectangle.

 

You can delete instances of your choice when creating or editing a 
pattern. To do so, just select the points materializing instances in the 
pattern preview.

The instance is deleted, but the point remains, as you may wish to 
click it again to add the instance to the pattern definition again.

6.  Click the  More>> button to display further options.

These options let you position the instances in relation to the 

first selected element.

7.  Increase the Row in direction 2 to 2.

You notice that the first selected pattern now is the second 

instance in the vertical direction, as this was the second 

selected direction.

 

The Simplified representation option lets you lighten the pattern geometry, when more than 15 instances are generated. What you need 
to do is just check the option, and click Preview. The system automatically simplifies the geometry:



Previewed simplified geometry Simplified geometry
You can also specify the instances you do not want to see by double-clicking them. These instances are then represented in dashed lines 
during the pattern definition and then are no longer visible after validating the pattern creation. The specifications remain unchanged, 
whatever the number of instances you view. This option is particularly useful for patterns including a large number of instances.

8.  Click OK to create the pattern.

The pattern (identified as RectPattern.xxx) is added to the 
specification tree. 

Patterning Volumes
 

Open the PatterningVolumes1.CATPart document.
 

1.  Click the Rectangular Pattern  icon.

2.  Select the element you wish to replicate as a pattern.

The Rectangular Pattern Definition dialog box is displayed.

3.  Click the Reference element field and select a direction to 

specify the first direction of creation.

4.  Set the duplication parameters by choosing the number of 

instances, the spacing between instances, or the total length 

of the zone filled with instances.

 

5.  Click OK to create the pattern.
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Creating Circular Patterns

 

This task shows how to use create circular patterns, that is to duplicate an original wireframe or surface-type element at the location of 
your choice according to a circular arrangement.

Open the Pattern2.CATPart document.

 
1.  Click the Circular Pattern  icon.

2.  Select the element to replicate as a pattern.

Here we selected the multi-sections surface.

The Circular Pattern Definition dialog box is 

displayed.

3.  Click the Reference element field and select a 

direction to specify the first direction of creation, 

that is the rotation axis (Line.2).

●     To define a direction, you can select a line, an edge or 
a planar face.
Should you select a face, the rotation axis would be 
normal to that face.

●     You can click the Reverse button to inverse the 
rotation direction.

4.  Define the Axial Reference by choosing the Parameters type:

●     Instance(s) & total angle: the number of patterns 
as specified in the instances field are created, in the 
specified direction, and evenly spread out over the 
total angle.

   
●     Instance(s) & angular spacing: the number of 

patterns as specified in the instances field are created 
in the specified direction, each separated from the 
previous/next one of the angular angle value.
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●     Angular spacing & total angle: as many patterns 
as possible are created over the total angle, each 
separated from the previous/next one of the angular 
angle value.

   
●     Complete crown: the number of patterns as 

specified in the instances field are created over the 
complete circle (360°deg). 

   
●     Instances & unequal angular spacing: the number 

of patterns as specified in the instances field are 
created using a specific angular spacing between each 
instance.
Angular spacing values are displayed between each 
instance.

To edit the values between each instance, you need to 
edit them individually. Select the angular spacing of 
interest, then choose one of the methods described 
hereafter: For instance, if you wish to change 72 degree 
for 100 degree for the angular spacing selected as shown 
in our picture, you can:

a.  double-click the angle value in the 3D geometry. 
This displays the Parameter Definition dialog box 
in which you can enter the new value. 

b.  directly enter the new value in the Angular 
spacing field of the Circular Pattern Definition 
dialog box. 

 

If you set Instance(s) & total angle or Angular spacing & total angle parameters, note that you cannot define the length by using 
formulas.



Now you are going to add a crown to this pattern.

5.   Click the Crown Definition tab, and choose 

which parameters you wish to define the crown.

This figure may help you define these 

parameters:

 
●     Circle(s) and crown thickness: you define the number of circles and they are spaced out evenly over the specified crown thickness

●     Circle(s) and circle spacing: you define the number of circles and the distance between each circle, the crown thickness being 
computed automatically

●     Circle(s) spacing and crown thickness: you define the distance between each circle and the crown thickness, and the number of 
circles is automatically computed.

For example, using the values described above 
for the Angular spacing & total angle option, 
you could define the crown as: 

 

Note that a few patterns are created beyond the surface.  

You can delete instances of your choice when creating or 
editing a pattern. To do so, just select the points 
materializing instances in the pattern preview.

The instance is deleted, but the point remains, as you 
may wish to click it again to add the instance to the 
pattern definition again.

6.  Click the More>> button to display further 

options:

These options let you position the instances in 

relation to the first selected element.



Using these options, you can change the position of the 

selected element within the crown. For example, if you 

set the Rotation angle parameter to 30° and you 

uncheck the Radial alignment of instance(s) option, 

this is what you obtain: the initially selected element has 

moved 30° from its initial location, based on the rotation 

direction, and all instances are normal to the lines tangent 

to the circle.

 

●     The Simplified representation option lets you lighten the pattern geometry, when more than 15 instances are generated. What 
you need to do is just check the option, and click Preview. The system automatically simplifies the geometry:

Not simplified geometry Simplified geometry
You can also specify the instances you do not want to see by double-clicking them . These instances are then represented in dashed 
lines during the pattern definition and then are no longer visible after validating the pattern creation. The specifications remain 
unchanged, whatever the number of instances you view. This option is particularly useful for patterns including a large number of 
instances.

●     When checking the Radial alignment of instances, all instances have the same orientation as the original feature. When 
unchecked, all instances are normal to the lines tangent to the circle.

  

7.  Click OK to create the pattern.

The pattern (identified as CircPattern.xxx) is 

added to the specification tree.

Patterning Volumes
 

Open the PatterningVolumes2.CATPart document.
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1.  Click the Circular Pattern  icon.

2.  Select the element you wish to replicate as a 

pattern.

The Circular Pattern Definition dialog box is 

displayed.

3.  Click the Reference element field and select a 

direction to specify the first direction of creation.

4.  Define the Axial Reference by choosing the 

Parameters type:

 

5.  Click OK to create the pattern.

 

 



Managing Power Copies

 
Create PowerCopies: Select the Insert ->Advanced Replication Tools -> PowerCopy 
Creation command, select the elements making up the PowerCopy from the specification 
tree, define a name for the PowerCopy and its reference elements then choose an icon for 
identifying it.

 
Instantiate PowerCopies: Select the Insert -> Instantiate From Document command, 
select the document or catalog containing the  powercopy, complete the Inputs within the 
dialog box selecting adequate elements in the geometric area.

 
Save PowerCopies into a Catalog: Select the PowerCopy from the specification tree, select the 
Insert -> Advanced Replication Tools -> PowerCopy Save In Catalog... command, 
enter the catalog name and click Open.
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Creating PowerCopies

 

This task shows how to use create PowerCopy elements, to be reused later.
A PowerCopy is a set of features (geometric elements, formulas, constraints and so forth) that are 
grouped in order to be used in a different context, and presenting the ability to be re-specified 
according to the context when pasted.
This PowerCopy captures the design intent and know-how of the designer thus enabling greater 
reusability and efficiency.

Open the PowerCopyStart1.CATPart document.

 
1.  Click the PowerCopy Creation  icon, or select the Insert -> Knowledge 

Templates -> Power Copy... menu item.

The PowerCopy Definition dialog box is displayed. 

2.  Select, from the specification tree, the elements to be included in the PowerCopy. 

The 
PowerCopy 
Definition 
dialog box is 
automatically 
filled with 
information 
about the 
selected 
elements.

3.  Define the PowerCopy as you wish to create it:

The Definition tab lets you assign a name to the PowerCopy and presents its 
components in the 3D viewer.
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The Inputs 
tab lets you 
rename the 
reference 
elements 
making up 
the 
PowerCopy.

You can do that for clarification purposes as to their roles,  by selecting the elements in the viewer 
and entering a new name in the Name field.
In this example, we renamed all three elements and in brackets you still can read the elements' 
default name based on their type.

The 
Parameters 
tab lets you 
define which 
of the 
parameter 
values used 
in the 
PowerCopy 
you will be 
able to 
modify at 
instantiation 
time.

Simply check the Published button.

Use the Name field to give a more explicit name to the element.

The 
Documents 
tab shows 
the complete 
path and role 
of Design 
tables that 
are 
referenced 
by an 
element 
included in 
the Power 
Copy.

       



The Icon tab 
lets you 
modify the 
icon 
identifying 
the 
PowerCopy 
in the 
specifications 
tree.  

A subset of icons is available from the Icon choice button.
If you click ..., the Icon Browser opens, giving you access to all the graphic icons installed with the 
CATIA software.

Use the 
Grab screen 
button to  
capture an 
image of the 
PowerCopy 
to be stored 
with its 
definition in 
the catalog 
(see Saving 
PowerCopies 
into a 
Catalog).

Use the Remove preview button to delete the image captured with the Grab screen button.

4.  Click OK to create the PowerCopy.

The PowerCopy is displayed close to the top of the specification tree.
     

 

●     Double-click the PowerCopy in the specification tree to display the PowerCopy Definition 
dialog box and edit its contents.

●     A formula is automatically included in a Power Copy definition when all its parameters are 
included.
Otherwise, i.e. if at least one parameter is not selected as part of the Power Copy, you have to 
manually select the formula to make it part of the definition. If you do so, all the formula's 
parameters that have not been explicitly selected, are considered as inputs of the Power Copy.

●     Once your power copy is created, do not delete the referenced elements used to make up the 
PowerCopy. 

Measure Tools cannot be used with PowerCopies.



Instantiating Power Copies

 

This task shows how to instantiate PowerCopies once they have been created as described in Creating PowerCopies.
There are two ways to do this: 

1.  using the PowerCopy Instantiation menu item
2.  using a catalog

Furthermore, the use of the Replace viewer, regardless of the instantiation type, is detailed.

Open the PowerCopyDestination1.CATPart document.

Using the icon or menu item: 

 
1.  Click the Instantiate From Document  icon or select the Insert -> Instantiate From Document  menu item.

The File Selection dialog box is displayed allowing you to navigate to the document or catalog where the  power copy is stored.

 

2.  Select the document containing the Powercopy, and click Open.

Here we selected the PowerCopyStartResults1.CATPart 

document.

The Insert Object dialog box is displayed.

Use the Reference list to choose the correct PowerCopy 
when several have been defined in the document and key in 
a Name for the instantiated reference.

3.  Complete the Inputs within the dialog box by selecting the 

adequate element in the geometric area.
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4.  If needed, click on the Use identical name button to automatically select all the elements with the same name.

This is especially useful when the input is the same one repeated several time.

5.  You can also click on the Parameters button to display the 

Parameters dialog box and modify values.

Here we increased the Radius1 value to 25 mm.

6.  Use the Create formulas button to automatically create a 

formula on every parameters with the same name provided 

there are any.

7.  Click Close.

 

The Documents button lets you access the list of documents (such as design tables) pointed by one of the elements making up the 
Power copy. 
If there are documents, the Documents dialog box opens and you can click the Replace button to display the File Selection dialog box 
and navigate to a new design table to replace the initial one.
When no document is referenced, the Documents button is grayed within the Insert Object dialog box.

8.  Click OK to create the PowerCopy instance.

The PowerCopy is instantiated in context, meaning its limits are automatically re-defined taking into account the elements on 
which it is instantiated.

 



 

●     When instantiating from the same document, use the PowerCopy object -> Instantiate contextual menu to display the Insert 
Object dialog box directly.

●     The  icon is always grayed when instantiating Power Copies. It is available with User Features and allows you to create and 

modify URLs.

●     Check the Repeat button to be able to repeat the instantiation.
In this case, once you have clicked OK in  the Insert Object dialog box, the latter remains open, the PowerCopy's Inputs are listed 
and ready to be replaced by new inputs, as described above.
Modified parameters using Parameters button are retained as well for the next instantiation.
To exit the command, you then need to uncheck the Repeat button or click Cancel.

 Using the catalog: 

 

You need to have a catalog available, created either:
●     using the Catalog capability, see Infrastructure User's Guide

●     using the Insert -> Advanced Replication Tools -> PowerCopy Save In Catalog... menu item.

1.  Click the Open catalog  icon.

If accessing a catalog for the first time, you need to navigate to the catalog location. This location is stored in the settings for 

faster access later on.

2.  Select the catalog containing the PowerCopy you wish to instantiate.

3.  Select the PowerCopy to be instantiated, then you can:

●     drag and drop it onto the reference element

●     double-click the PowerCopy 

●     or right-click on the PowerCopy in the dialog box and use the Instantiate contextual menu.

From then on, you instantiate the PowerCopy as described above starting on step 3.

Using the Replace Viewer

 

In some cases, when instantiating a powercopy, the replacing element does not present the same sub-elements as the replaced 
element. Therefore you need to clearly indicate in a specific dialog box, the Replace Viewer, how to rebuild the geometry from the 
replacing element. In the following example, the replacing sketch does not have the same number of vertices as the initial sketch, and 
you are prompted to indicate on what edge the filleted surfaces are to be created.

Open the PowerCopyReplace1.CATPart document.

1.  Expand the PowerCopy entry in the specification tree, right-click the PowerCopy.1 feature,  and choose PowerCopy.1 object -

>  Instantiate command.

2.  Select Sketch.2 to replace Sketch.1.

The Replace Viewer is displayed, showing to the left the initial sketch and the edges selected to create the two fillets in the 

initial geometry, and to the right the replacing sketch on which you are prompted to specify edges.
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3.  Select the edges on the replacing sketch.

4.  Click Close in the Replace Viewer.

5.  Select the XY plane, or click the Use Identical Name button to select it as the needed plane.

6.  Click OK in the Insert Object dialog box.

The PowerCopy is instantiated and the filleted surfaces are computed as per the selection in the Replace Viewer.



Make sure to select the edges as proposed in the Replace Viewer. For 
example, you cannot invert Edge.1 and Edge.2 if Edge.3 remains 
where specified in the example above. Otherwise, the system will not 
be able to re-build the geometry based on these specifications, and the 
Update Diagnosis dialog box will be displayed prompting you to edit 
the geometry.

The feature defined as the current object corresponds to the last instantiated component of the PowerCopy.

Working with the datum mode is independent from the instantiation type: indeed PowerCopies behave as a Copy as Specified and not 
as a Copy as Result.
For further information about the various formats available when pasting elements, please refer to the Using the Paste Special... 
Command in CATIA Infrastructure User's Guide documentation.

 A panel allows you to select alternate document access methods. 
See Opening Existing Documents Using the Browse Panel in CATIA Infrastructure User Guide.
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Saving PowerCopies into a Catalog

 
This task shows how to use store Power Copy elements into a catalog, for later use as described in 
Instantiating a PowerCopy.

Open the PowerCopyStartResults1.CATPart document.

 
1.  Select the PowerCopy from the specification tree for example.

2.  Click the 

PowerCopy 

Save In 

Catalog  

icon or choose 

the Insert -> 

Knowledge 

Templates -> 

Save In 

Catalog... 

menu item.

The Catalog 

Save dialog 

box is 

displayed: 

●     When creating a 
catalog for the first 
time, click the ... 
button to display 
the Open dialog 
box, and navigate 
to the location 
where you wish to 
create a catalog.
Then simply key in 
the catalog name 
and click Open.
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●     If you wish to add a PowerCopy to an existing catalog, simply activate the Update an existing 
catalog option in the Catalog Save dialog box.

By default, the Catalog Save dialog box recalls the catalog accessed last.

3.  Click OK.

The PowerCopy has been stored in the catalog.

 

 



Measure Tools
You can create a link between a measure and a parameter (length or angle) using the following 
methods:

Measuring distances and angles: Click the Measure Between icon, set the measure type and 
mode in the Measure Between dialog box, then select two entities.
Measuring properties: Click the Measure Item icon, then select an item.

Measuring Inertia: Click the Measure Inertia icon, then select an item.



Measuring Distances between Geometrical Entities 
The Measure Between command lets you measure distance between geometrical entities. You can measure:

●     Minimum distance and, if applicable angles, between points, surfaces, edges, vertices and entire products
Or,

●     Maximum distance between two surfaces, two volumes or a surface and a volume.

 This section deals with the following topics:

Measuring minimum distance and angles
Measuring maximum distance

Measuring distances in a local axis system
Customizing measure between

Editing measures
Creating geometry from measure results

Exact measures on CGRs and in visualization mode
Measuring angles

Updating measures
Using measures in knowledgeware

Measure cursors

Insert the following sample model files: ATOMIZER.model, BODY1.model, BODY2.model, LOCK.model, NOZZLE1.model, 
NOZZLE2.model, REGULATION_COMMAND.model, REGULATOR.model, TRIGGER.model and VALVE.model. 

They are to be found in the online documentation filetree in the common functionalities sample folder cfysm/samples.

Restriction: Neither Visualization Mode nor cgr files permit selection of individual vertices.

Note: In the No Show space, the Measure Between command is not accessible.

Measuring Minimum Distance and Angles
 This task explains how to measure minimum and, if applicable, angles between geometrical entities (points, surfaces, 

edges, vertices and entire products).

 

1. Click the Measure Between  icon. 

In DMU, you can also select Analyze-> Measure Between from the menu bar.

The Measure Between dialog box appears.

http://arbre1dsy/spuCXR14/Doc/online/cfyugmeasure_C2/cfyugmeasureedit.htm
http://arbre1dsy/spuCXR14/Doc/online/cfyugmeasure_C2/cfyugmeasuregeometry.htm
http://arbre1dsy/spuCXR14/Doc/online/cfyugmeasure_C2/cfyugmeasureexact.htm
http://arbre1dsy/spuCXR14/Doc/online/cfyugmeasure_C2/cfyugmeasureassociative.htm
http://arbre1dsy/spuCXR14/Doc/online/cfyugmeasure_C2/cfyugmeasureknowledge.htm


  
By default, minimum distances and if applicable, angles are measured.

By default, measures made on active products are done with respect to the product axis system. Measures made on 
active parts are done with respect to the part axis system. 
Note: This distinction is not valid for measures made prior to Version 5 Release 8 Service Pack 1 where all measures are 
made with respect to the absolute axis system.  

Dialog box options
●     You can also measure distances and angles with respect to a local V5 axis system. 

●     A Keep Measure option in the dialog box lets you keep the current and subsequent measures as features. This is 
useful if you want to keep the measures as annotations for example. 

Some measures kept as features are associativeand can be used to valuate parameters or in formulas.

In the Drafting and Advanced Meshing Tools workbenches, measures are done on-the-fly. They are not 
persistent. This means that they are not associative and cannot be used as parameters.

  
●     A Create Geometry option in the dialog box lets you create the points and line corresponding to the minimum distance 

result. 

●     A Customize... option opens the Measure Between Customization dialog box and lets you set the display of measure 
results.

Accessing other measure commands

●     The Measure Item command  is accessible from the Measure Between dialog box. 

●     In DMU, the Measure Thickness command is also accessible from the Measure Between dialog box. For more 
information, see the DMU Space Analysis User's Guide.

 
P1-Only Functionality

In P1, the Measure Tools toolbar appears. 
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This toolbar has two icons:

 

●     Measure Dialogs : lets you show or hide the associated dialog box.

●     Exit Measure : lets you exit the measure. This is useful when the dialog box is hidden.

2. Select the desired measure type.  

Notice that the image in the dialog box changes 
depending on the measure type selected.

 

 

Defining Measure Types
●     Between (default type): measures distance and, if applicable, angle between selected items.

●     Chain: lets you chain measures with the last selected item becoming the first selection in the next measure.

●     Fan: fixes the first selection as the reference so that you always measure from this item.

3. Set the desired mode in the Selection 1 and Selection 2 mode drop-down list boxes.

Defining Selection 1 & Selection 2 Modes
●     Any geometry (default mode): measures distances and, if applicable, angles between defined geometrical entities 

(points, edges, surfaces, etc.). 
Note: The Arc center mode is activated in this selection mode.

This mode recognizes the axis of cylinders and 
lets you measure the distance between two 
cylinder axes for example. 

Selecting an axis system in the specification 
tree makes the distance measure from the axis 
system origin.
You can select sub-entities of V5 axis systems 
in the geometry area only. For V4 axis 
systems, distances are always measured from 
the origin.



 
●     Any geometry, infinite: measures distances and, if applicable, angles between the infinite geometry (plane, line or 

curve) on which the selected geometrical entities lie. Curves are extended by tangency at curve ends. 

Line Plane Curve

The Arc center mode is activated and this mode also recognizes cylinder axes. For all other selections, the 
measure mode is the same as any geometry.

Any geometry, infinite Any geometry

●     Picking point: measures distances between points selected on defined geometrical entities. Always gives an 
approximate measure.

 In the DMU section viewer, selecting two picking points on a curve gives the distance along the curve between 
points (curve length or CL) as well as the minimum distance between points.

Notes: 

●     Both points must be located on the same curve element.

●     The minimum distance option must be set in the Measure Between Customization dialog box.

  

 



  
●     Point only: measures distances between points. Dynamic highlighting is limited to points.

●     Edge only, Surface only: measures distances and, if applicable, angles between edges and surfaces respectively. 
Dynamic highlighting is limited to edges or surfaces and is thus simplified compared to the Any geometry mode. All 
types of edge are supported.

  
●     Product only: measures distances between products. 

Products can be specified by selecting product geometry, for example an edge or surface, in the geometry area or the 
specification tree.

●     Picking axis: measures distances and, if applicable, angles between an entity and an infinite line perpendicular to the 
screen.

Simply click to create infinite line perpendicular 
to the screen. 

●     Intersection: measures distances between points of intersection between two lines/curves/edges or a line/curve/edge 
and a surface. In this case, two selections are necessary to define selection 1 and selection 2 items.

  Geometrical entities (planar surfaces, lines and curves) are extended to infinity to determine the point of 
intersection. Curves are extended by tangency at curve ends.

 

Line-plane Curve-plane Curve-curve

 

  Note: Only intersections which result in points of intersection are managed. 



●     Edge limits: measures distances between endpoints or midpoints of edges. Endpoints only are proposed on curved 
surfaces.

●     Arc center: measures distances between the centers of arcs.

●     Center of 3 points arc: measures distances between the centers of arcs defined by 3 points.

To define arc center, click three points on the 
geometry. 

Note: The resulting measure will always be 
approximate and non associative.

●     Coordinate: measures distances between coordinates entered for selection 1 and/or selection 2 items.

4. Set the desired calculation mode in the Calculation mode drop-down list box.

Defining the Calculation Mode
●     Exact else approximate (default mode): measures access exact data and wherever possible true values are given. If 

exact values cannot be measured, approximate values are given (identified by a ~ sign).

●     Exact: measures access exact data and true values are given. Note that you can only select exact items in the 
geometry area or specification tree.
In certain cases, in particular if products are selected, a warning dialog box informs you that the exact measure could 
not be made. 
After some geometric operations, vertices (and corresponding macropoints) may combine several representations on 
different supports (curves or surfaces). These representations are not all located in the same position in space which 
means that the exact position of the vertex cannot be determined. Only one vertex representation is visualized. 
Measure Between measurements are made with respect to the visualized representation. Measuring distance between 
two points therefore depends on the chosen representation. Any calculation errors are due to the fact that the exact 
position of the vertex cannot be determined.

●     Approximate: measures are made on tessellated objects and approximate values are given (identified by a ~ sign).

Note: You can hide the display of the ~ sign using the Tools -> Options command (General ->  
Parameters and Measure -> Measure Tools).

5. Click to select a surface, edge or vertex, or an entire product (selection 1).

Notes: 
●     The appearance of the cursor has changed to assist you.

●     Dynamic highlighting of geometrical entities helps you locate items to click on.

6. Click to select another surface, edge or vertex, or an entire product (selection 2).

A line representing the minimum distance vector is drawn between the selected items in the geometry area. Appropriate 
distance values are displayed in the dialog box. 

Note: For reasons of legibility, angles between lines and/or curves of less than 0.02 radians (1.146 degrees) are not 
displayed in the geometry area.
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By default, the overall minimum distance and angle, if any, between the selected items are given in the Measure Between 
dialog box.

The number of decimal places, the display of trailing zeros and limits for exponential notation is controlled by the Units 
tab in the Options dialog box (Tools ->Options, General ->Parameters and Measure). For more information, see the 
Infrastructure User's Guide.

7. Select another selection and, if desired, selection mode.

8. Set the Measure type to Fan to fix the first selection so that you can always measure from this item.

9. Select the second item.



10.Select another item.

Using the Other Selection... command in the contextual menu, you can access the center of spheres.

11.Click OK when done. 

If you checked the Keep Measure option in the Measure 
Between dialog box, your measures are kept as features 
and your specification tree will look something like this if 
measures were made on the active product.

Or like this, if measures were made on the active part. 

Note: If the product is active, any measures on parts are 
placed in No Show.

Some measures kept as features are associative. In 
Design Mode, if you modify a part or move a part in a 
product structure context and the measure is impacted, it 
will be identified as not up-to-date in the specification 
tree. You can then update it locally have it updated 
automatically. 

When measures are used to valuate parameters, an 
associative link between the measure and parameter is 
created. Measures can also be used in formulas.

Sectioning measure results

Having made and kept your measure, select it then click the Sectioning  icon to section measure results. The plane is 

created parallel to the direction defined by the measure and sections entities selected for the measure only. All section 
plane manipulations are available.

Note: You may need an appropriate license to access the Sectioning command.

 

 
 

Customizing Measure Between
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Customizing lets you choose what distance you want to 
measure:

●     Minimum distance (and angle if applicable)

●     Maximum distance

●     Maximum distance from 1 to 2.

Note: These options are mutually exclusive. Each time 
you change option, you must make your measure again.

By default, minimum distances and if applicable, angles 
are measured.

You can also choose to display components and the 
coordinates of the two points (point 1 and point 2) 
between which the distance is measured.

What you set in the dialog box determines the display of 
the results in both the geometry area and the dialog box.

 
 

Measuring Maximum Distance
  You can measure the maximum distance between two surfaces, two volumes or a surface and a volume.

Distance is measured normal to the selection and is always approximate.  Two choices are available:

 
●     Maximum distance from 1 to 2: gives the maximum distance of all distances measured from selection 1.

Note: This distance is, in general, not symmetrical.

  

  
●     Maximum distance: gives the highest maximum distance between the maximum distance measured from selection 1 

and the maximum distance measured from selection 2.

  Note: All selection 1 (or 2) normals intersecting selection 1 (or 2) are ignored.



  

1. Click Customize... and check the appropriate maximum distance option in the Measure Between Customization dialog box, 
then click OK.

 2. Make your measure:
●     Select the desired measure type

●     Set the desired selection modes

●     Set the desired calculation mode

●     Click to select two surfaces, two volumes or a surface and a volume.

  

 
3. Click OK when done.

 

 
 

Measuring Distances in a Local Axis System
 An Other Axis option in the dialog box lets you measure distance in a local axis system.

This type of measure is associative: if you move the axis system, the measure is impacted and can be updated.

You will need a V5 axis system.

1. Select the Other Axis checkbox in the dialog box.

2. Select a V5 axis system in the specification tree or geometry area.
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3. Make your measure.

In the examples below, the measure is a minimum distance measure and the coordinates of the two points between 
which the distance is measured are shown.

Same measure made with respect to absolute axis system:

Note: All subsequent measures are made with respect to the selected axis system. 

4. To change the axis system, click the Other Axis field and select another axis system.

5. To return to the absolute axis system, click to clear the Other Axis checkbox.

 
6. Click OK when done.

 

 
 



Measuring Angles
●     Exact angles

●     Complementary angles

Exact Angles

The Measure Between command lets you measure exact angles between the following geometrical 
entities that have (at least) one common point.

Two lines (even if not in the same plane): A line and a  curve:

Two curves:

Note: In the above three cases, if entities intersect more than once, the measure is made at the 
point of intersection nearest the point at which selection 1 is made.



A curve and a surface:

Note: If the curve and surface intersect more than once, the measure is made at the point of 
intersection nearest the point of the selection on the curve.

A line and a surface: A line and a plane:

Two surfaces: You can also measure the angle between two surfaces provided both surfaces are 
planar.



Complementary Angles

You can obtain the complementary angle (360° - the initial angle measured) when measuring 
between two curves: drag the angle line to show the complementary angle.

Note: The dialog box and knowledge parameters are refreshed. The value of the complementary 
angle is stored along with the measure.

 

 



Measure Cursors

 

The appearance of the Measure Between and Measure Item cursor changes as you move it 
over items to reflect the measure command you are in and to help you identify the selection. 
Dynamic highlighting of surfaces, points, and vertices, etc. also helps you locate items to click 
on.

 Measure Between Measure Item Geometry

 

  
 Surface

 

 
 Planar surface

 

 
 Line

 

 
 Curve

 

 
 Point

 

 
 Circle

 
Sphere

 
Cylinder

 

 
 Volume

 In Measure Between, a number (1 for selection 1 
and 2 for selection 2) identifies where you are in 
your measure. 

 



Measuring Properties 
The Measure Item command lets you measure the properties associated to a selected item (points, edges, surfaces and 
entire products). 

 This section deals with the following topics:

Measuring properties
Measuring in a local axis system

Customizing the display
Editing measures

Create Geometry from measure results
Exact measures on CGRs and in visualization mode

Updating measures
Using measures in knowledgeware

Measure cursors
Insert the following sample model files: ATOMIZER.model, BODY1.model, BODY2.model, LOCK.model, NOZZLE1.model, 
NOZZLE2.model, REGULATION_COMMAND.model, REGULATOR.model, TRIGGER.model and VALVE.model. 

They are to be found in the online documentation filetree in the common functionalities sample folder cfysm/samples.

 

Restriction: Neither Visualization Mode nor cgr files permit selection of individual vertices.

Note: In the No Show space, this command is not accessible.

Measuring Properties

 

This task explains how to measure the properties associated to a selected item.

 

1.Switch to Design Mode (Edit ->Representations ->Design Mode).

2.Set View -> Render Style to Shading with Edges.

Note: You cannot use this command, if Shading only is selected.
3.Click the Measure Item  icon. 

In DMU, you can also select Analyze -> Measure Item from the menu bar.

The Measure Item dialog box appears.
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By default, properties of active products are measured with respect to the product axis system. Properties of active 
parts are measured with respect to the part axis system. 
Note: This distinction is not valid for measures made prior to Version 5 Release 8 Service Pack 1 where all measures are 
made with respect to the absolute axis system. 

Dialog box options
●     You can also measure properties with respect to a local V5 axis system. 

●     The Keep Measure option lets you keep current and subsequent measures as features. This is useful if you want to 
keep measures as annotations for example.

Some measures kept as features are associativeand can be used to valuate parameters or in formulas. 
In the Drafting and Advanced Meshing Tools workbenches, measures are done on-the-fly. They are not 
persistent. This means that they are not associative and cannot be used as parameters.

 
 

●     A Create Geometry option in the dialog box lets you create the center of gravity from measure results. 

●     A Customize... option lets you customize the display of measure results.

Accessing other measure commands
●     The Measure Between command is accessible from the Measure Item 

dialog box. Simply click one of the Measure Between icons in the 
Definition box to switch commands. 

●     In DMU, the Measure Thickness command is also accessible from the 
Measure Item dialog box. For more information, see the appropriate task 
in the DMU Space Analysis User's Guide.

P1-Only Functionality

In P1, the Measure Tools toolbar appears. 
This toolbar has two icons:

 

●     Measure Dialogs : lets you show or hide the associated dialog box.

●     Exit Measure : lets you exit the measure. This is useful when the dialog box is hidden.

4.Set the desired measure mode in the Selection 1 mode drop-down list box.

Defining the Selection 1 Mode
●     Any geometry (default mode): measures the properties of the selected item (point, edge, surface or entire product).

●     Point only: measures the properties of points. Dynamic highlighting is  limited to points.

●     Edge only: measures the properties of edges. All types of edge are supported.

●     Surface only: measures the properties of surfaces.

In the last three modes, dynamic highlighting is limited to points, edges or surfaces depending on the mode 
selected, and is thus simplified compared to the Any geometry mode.

  
●     Product only: measures distances between products. 

Products can be specified by selecting product geometry, for example an edge or surface, in the geometry area or 
the specification tree.

  
●     Angle by 3 points: measures the angle between two lines themselves defined by three points.
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  To define lines, select three existing points in the geometry area 
or in the specification tree.
Note: You cannot select picking points.
Smart selection is offered. This means that a sphere or circle, for 
example, are seen as points.

The resulting angle is always positive. It is measured in a 
counterclockwise direction and depends on the order in which 
points were selected as well as your viewpoint (the normal to the 
plane is oriented towards you).

  

 You can drag the angle line to show the complementary angle 
(360° - the initial angle measured).

You can also obtain the complementary angle when measuring the 
angle on arcs.

Note: The dialog box and knowledge parameters are refreshed. 
The value of the complementary angle is stored along with the 
measure.

  
●     Thickness (DMU only): measures the thickness of an item. For more information, see the appropriate task in the 

DMU Space Analysis User's Guide.

●     The Measure Item command lets you access the radius of an exact cylinder or sphere.

●     The Measure Item command also recognizes ellipse-type conic sections. 

●     Using the Other Selection... command in the contextual menu, you can access the axis of a cylinder as well as the 
center of a sphere to, for example, measure between two cylinder axes.

5.Set the desired calculation mode in the Calculation mode drop-down list box.



Defining the Calculation Mode
●     Exact else approximate (default mode): measures access exact data and wherever possible true values are given. If 

exact values cannot be measured, approximate values are given (identified by a ~ sign).

●     Exact: measures access exact data and true values are given. Note that you can only select exact items in the 
geometry area or specification tree.
In certain cases, in particular if products are selected, a warning dialog box informs you that the exact measure 
could not be made. 

●     Approximate: measures are made on tessellated objects and approximate values are given (identified by a ~ sign).

Note: You can hide the ~ sign using the Tools -> Options command (General ->Parameters and 
Measure ->Measure Tools).

6.Click to select the desired item.

Note: The appearance of the cursor has changed to assist you. 

The dialog box gives information about the selected item, in our case a surface and indicates whether the result is an 
exact or approximate value. The surface area is also displayed in the geometry area.
The number of decimal places, the display of trailing zeros and limits for exponential notation is controlled by the Units 
tab in the Options dialog box (Tools-> Options, General-> Parameters and Measure). For more information, see 
the Infrastructure User's Guide.

7.Try selecting other items to measure associated properties.

Note: For reasons of legibility, angles measured by Angle by 3 points or on an arc of circle of less than 0.02 radians 
(1.146 degrees) are not displayed in the geometry area.
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8.Click OK when done. 

If you checked the Keep Measure option in the Measure Item dialog box,  
your measures are kept as features and your specification tree will look 
something like this if properties of the active product were measured.

Or like this, if properties were those of the active part. 

Note: If the product is active, any measures made on the active part are 
placed in No Show.

Some measures kept as features are associative. In Design Mode, if you 
modify a part or move a part in a product structure context and the measure 
is impacted, it will be identified as not up-to-date in the specification tree. 
You can then update it locally have it updated automatically. 

When measures are used to valuate parameters, an associative link between 
the measure and parameter is created. Measures can also be used in 
formulas.

 
  

Customizing the Display
 Customizing lets you choose the properties you want to see displayed in both the geometry area and the dialog box.

1.Click Customize... in the Measure Item dialog box to see the properties the system can detect for the various types of 
item you can select. By default, you obtain:
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Edges

The system detects whether the edge is a line, curve or arc, taking model accuracy into account and displays the 
properties as set in the Measure Item Customization dialog box.

Note: If the angle of an arc is less than 0.125 degrees, only the arc length is displayed in the geometry area. 
The angle and radius are not displayed.

Surfaces
●     Center of gravity: The center of gravity of surfaces is visualized by a point. In the case of non planar surfaces, the 

center of gravity is attached to the surface over the minimum distance.

●     Plane: gives the equation of a planar face. The equation of a plane is: Ax + By + Cz + D=0.

Note that there is an infinite number of equations possible (and an infinite number of solutions for values ABC 
and D). The result given by Measure Item does not necessarily correspond to that in the feature specification. 
This is because the measure is based on topology and does not know the feature specification associated with 
the measured item.

●     Perimeter: Visualization mode does not permit the measure of surface perimeter.



2.Set the properties you want the system to detect, then click Apply or Close.
The Measure Item dialog box is updated if you request more properties of the item you have just selected.

3.Select other items to measure associated properties.

 
  

Measuring Properties in a Local Axis System
 An Other Axis option in the dialog box lets you measure properties in a local axis system.

This type of measure is associative: if you move the axis system, the measure is impacted and can be updated.
 You will need a V5 axis system. 

1.Select the Other Axis checkbox in the Measure Item dialog box.

2.Select a V5 axis system in the specification tree or geometry area.
3.Make your measure.

Measure made with respect to local axis system: Same measure made with respect to 
absolute axis system:

Note: All subsequent measures are made with respect to the selected axis system. 
 4.To change the axis system, click the Other Axis field and select another axis system.
 5.To return to the main axis system, click to clear the Other Axis checkbox.
 6.Click OK when done. 

 



Measuring Inertia 

The Measure Inertia command lets you measure:
●     3D inertia properties of surfaces and volumes (explained below)

●     2D inertia properties of plane surfaces.

Note: In the No Show space, this command is not accessible.

 
This section deals with the following topics:

Measuring 3D inertia
Measuring 2D inertia 

Customizing your measure
Exporting measure inertia results

Creating geometry from measure results
Notations used

Inertia equivalents
Principal axes

Inertia matrix with respect to the origin O
Inertia matrix with respect to a point P

Inertia matrix with respect to an axis system
Moment of inertia about an axis

Updating measures
Using measures in knowledgeware

Measuring 3D Inertia

This task explains how to measure the 3D inertia properties of an object. 

You can measure the 3D inertia properties of both surfaces and volumes, as well as retrieve the 
density or surface density if valuated from V4 model type documents. You can also retrieve inertia 
equivalents set in Knowledgeware formulas. 

The area, density, mass and volume (volumes only) of the object are also calculated.

Note: You cannot measure inertia properties of either wireframe or infinite elements.

For examples showing 3D inertia properties measured on surfaces. To find out more about notations 
used.

Insert the Valve.cgr document from the samples folder. It is to be found in the online documentation 
filetree in the common functionalities sample folder cfysa/samples.

1. Click the Measure Inertia  icon. 

In DMU, you can also select Analyze -> Measure Inertia from the menu bar.
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The Measure Inertia dialog box appears. By default 3D inertia properties are measured.

The Measure 2D Inertia icon lets you measure 2D inertia properties of plane surfaces.

Dialog box options
●     A Keep Measure option in the dialog box lets you keep current and subsequent measures as 

features in the specification tree. Some measures kept as features are associative and can be 
used as parameters.
 

 In the Drafting workbench, the Keep Measure option is not available. Measures are done 
on-the-fly. They are not persistent. This means that they are not associative and cannot 
be used as parameters.

  
●     A Create Geometry option lets you create the center of gravity and the axis system for principal 

axes in a part from inertia results.

●     An Export option lets you write results to a text file.

●     A Customize... option lets you define what will be computed and displayed in the dialog box.

Note: When you move the cursor over the geometry or specification tree, its appearance changes 

to reflect the measure command you are in. 

2. Click to select the desired item in the specification tree, for example Valve. 

Selecting Items
●     In the geometry area, you can select individual faces and edges on cgr files and in Visualization 

mode.
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●     Ctrl-click in the geometry area or the specification tree to add other items to the initial selection.

●     Shift-click in the specification tree to make a multiple selection.

●     Drag (using the left mouse button) to select items using the bounding outline.

●     (P2 only) Use the Group command to make your multiple selection.

Notes: 

●     Only items of the same type can be included in a multiple selection or a bounding 
outline; you cannot mix volumes and surfaces.

●     Inertia measures made on a multiple selection of items are not associative.

The Dialog Box expands to display the results for the selected item.  

The measure is made on the selection, geometry, assembly or part. To measure the inertia of 
individual sub-products making up an assembly and see the results in the document window, you 
must select the desired sub-product.
In our example, the item selected has no sub-products. 



 

The dialog box identifies the selected item and indicates whether the calculation is exact or 
approximate: 

●     In Design mode, measures access exact data and wherever possible true values are given. Note 
that it is possible to obtain an exact measure for most items in design mode.

●     In Visualization mode, measures are made on tessellated items and approximate values are 
given.

In addition to the center of gravity G, the principal moments of inertia M and the matrix of inertia 
calculated with respect to the center of gravity, the dialog box also gives the area, volume (volumes 
only), density and mass of the selected item.

You can also compute and display the principal axes A. To do so, you must first activate the 
appropriate option in the Measure Inertia Customization dialog box.

 The density is that of the material, if any, applied to a product, part or part body:
●     If no density is found, a default value is displayed. You can, if desired, edit this value. If you do 

so, all the other inertia values are re-calculated. The default value is 1000 kg/m3 for volumes 
and 10 kg/m2 for surfaces.

●     If sub-products or part bodies have different densities, the wording Not uniform is displayed.

Notes:

  
●     You can access the density of parts saved as CGR files and opened in visualization mode. This 

functionality is available in both a part and a product context. 

To do so:
❍     Select the Save density in cgr option in the Meaure Tools tab (Tools ->Options ->General -

>Parameters and Measure).

❍     Open a part to which material has been applied and save as CGR type.
The density is stored in the CGR file.

Important: The material must be applied to the part node. If materials are applied to part 



bodies, no density is saved.
●     Close the Part document.

●     Open the CGR file or switch to DMU Space Analysis and insert the part saved as CGR, then 
measure the inertia.

  
●     You must be in design mode to access the density of part bodies to which materials have been 

applied.

●     Unless specified otherwise, material inheritance is taken into account.

●     Density is a measure of an item's mass per unit volume expressed in kg/m3; surface density is 
a measure of an item's mass per unit area expressed in kg/m2.

The number of decimal places, the display of trailing zeros and limits for exponential notation is 
controlled by the Units tab in the Options dialog box (Tools ->Options, General ->Parameters 
and Measure). 
In the Geometry Area, axes of inertia are 
highlighted and a bounding box parallel to the 
axes and bounding the selected item also 
appears. 

Color coding of axes:

●     Red: axis corresponding to the first 
moment M1

●     Green: axis corresponding to the second 
moment M2

●     Blue: axis corresponding to third moment 
M3.

3. Click Customize...  to customize the inertia computation and define what will be exported to the text 
file.

4. Click OK when done.

 If you checked the Keep Measure option in 
the Measure Inertia dialog box, your 
measures are kept as features and your 
specification tree will look something like this.

Some measures kept as features are 
associative and can be used as parameters.

 You can write a macro script to automate your task. See Space Analysis on the Automation 
Documentation Home Page.

 

http://arbre1dsy/spuCXR14/Doc/online/cfyugmeasure_C2/cfyugmeasureassociative.htm
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Customizing Your Measure
You can, at any time, define what will be 
computed and displayed in the Measure 
Inertia dialog box.

1. Click Customize... in the Measure Inertia 
dialog box.

The Measure Inertia Customization dialog box 
opens.

Note: The inertia properties checked here are 
also the properties exported to a text file. 

 2. Click the appropriate options to compute and 
display in appropriate tabs of the Measure 
Inertia dialog box the:

●     Inertia equivalents

●     Principal axes

●     Inertia matrix with respect to the origin O

●     Inertia matrix with respect to a point P

●     Inertia matrix with respect to an axis 
system

●     Moment of inertia about an axis

3. Click Apply or OK in the Measure Inertia Customization dialog box when done.

 



Measuring 2D Inertia

This task explains how to measure the inertia properties of plane 2D surfaces. 

You can measure the area, center of gravity, principal moments, inertia matrix as well as the 
principal axes.
You can measure the inertia properties of plane surfaces including DMU sections. The area of 
the surface is also calculated.

Note: You cannot measure inertia properties of either wireframe or infinite elements.
To find out more about notations used.

No sample document provided.

1. Click the Measure Inertia  icon. 

In DMU, you can also select Analyze -> Measure Inertia from the menu bar.

The Measure Inertia dialog box appears.

2. Click the Measure 2D Inertia   icon.

 

 

Dialog box options 
●     A Keep Measure option in the dialog box lets you keep current and subsequent 

measures as features. Some measures kept as features are associative and can be 
used as parameters.
Note: This option is not available in the Drafting workbench.

●     An Export option lets you write results to a text file.

●     A Customize... option lets you define what will be computed and displayed in the 
dialog box.

When you move the cursor over the geometry or specification tree, its appearance 

changes to reflect the measure command you are in. 

http://arbre1dsy/spuCXR14/Doc/online/cfyugmeasure_C2/cfyugmeasureassociative.htm
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3. Click to select a plane 2D surface in the geometry area or the specification tree.

The Dialog Box expands to display the results for the selected item.  

The dialog box identifies the selected item, in our case a DMU section, and indicates 
whether the calculation is exact or approximate: 

●     In Design mode, measures access exact data and wherever possible true values 
are given. Note that it is possible to obtain an exact measure for most items in 
design mode.

●     In Visualization mode, measures are made on tessellated items and approximate 
values are given.

In addition to the center of gravity G, the principal moments of inertia M and the 
matrix of inertia, the dialog box also gives the area of the selected item.

The center of gravity G is computed with respect to the document axis system. The 
matrix of inertia is expressed in an axis system whose origin is the center of gravity 
and whose vectors are the axes of inertia.

Note: The matrix of inertia and the principal moments do not take density into 



account.

You can also compute and display the principal axes A. To do so, you must first 
activate the appropriate option in the Measure Inertia Customization dialog box.

The number of decimal places, the display of trailing zeros and limits for exponential 
notation is controlled by the Units tab in the Options dialog box (Tools ->Options, 
General ->Parameters and Measure). 
In the Geometry Area, the axes of inertia 
are highlighted and a bounding box parallel 
to the axes and bounding the selected item 
also appears. 

Color coding of axes:

●     Red: axis corresponding to the first 
moment M1

●     Green: axis corresponding to the second 
moment M2

4. Click OK in the Measure Inertia dialog box.

If you checked the Keep Measure option in the Measure Inertia dialog box, your 
measures are kept as features.

 

Customizing Your Measure
You can, at any time, define what will be 
computed and displayed in the tabs of the 
Measure Inertia dialog box. 

When measuring 2D plane surfaces, in 
addition to the properties computed by 
default, you can compute and display the 
principal axes.



1. Click Customize... in the Measure Inertia 
dialog box.

The Measure Inertia Customization dialog 
box opens.

Note: The inertia properties checked here 
are also the properties exported to a text 
file. 

 2. Click the appropriate options:
●     Principal axes

 3. Click Apply or OK in the Measure Inertia 
Customization dialog box when done.

 



Exporting Measure Inertia Results

 This task shows you how to export both 3D and 2D inertia results to a text file.

 Insert the Body1.cgr and the Body2.cgr documents from the common functionalities samples folder.

1. Select the root product and click the Measure Inertia icon.

The dialog box expands to display the results for the selected item.
2. Click Export to write the results to a text (*.txt) file.

Important: Results shown in the Measure Inertia dialog box only are exported.  Exported results are given in 
current units. 

3. Identify the file name and location in the Export Results dialog box that appears, then click Save.

Note: The examples given below concern 3D inertia results.

 

 Note:  If an assembly comprises sub-products or a part comprises part bodies, individual results for all sub-
products or part bodies are also exported and written to the text file.

 
If the principal axes A are exported, bounding box values are also exported.

  

where BBOx,y,z defines the origin and BBLx,y,z the length 
along the corresponding axis.

http://arbre1dsy/spuCXR14/Doc/online/cfyugmeasure_C2/images/inertiaexportNLS.jpg
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Note: When importing the text file into an Excel spreadsheet, do not forget to identify the pipe character (|) 
used as separator in the Text Import Wizard dialog box.

 



 

Notations Used for Inertia Matrices
This section will help you read the information given in the Measure Inertia dialog box for 
Inertia Matrix / G, Inertia Matrix / O, Inertia Matrix / P and Inertia Matrix / Axis System A.

Moments and Products of 3D Inertia

Iox Moment of inertia of the object 
about the ox axis:

Ioy Moment of inertia of the object 
about the oy axis:

Ioz Moment of inertia of the object 
about the oz axis:

Pxy Product of inertia of the object 
about axes ox and oy:

Pxz Product of inertia of the object 
about axes ox and oz:

Pyz Product of inertia of the object 
about axes oy and oz:

(where M is the mass of the object; units: kg.m2)

 
Moments and Products of 2D Inertia

Iox Moment of inertia of the surface 
about the ox axis:

Ioy Moment of inertia of the surface 
about the oy axis:

Pxy Product of inertia of the surface 
about axes ox and oy:

 (where A is the surface; units: m4)

Matrix of Inertia



 3D Inertia: 2D Inertia:

where I is the matrix of inertia of the object with respect to orthonormal basis Oxyz

Expression in Any Axis System:

I is the matrix of inertia with respect to orthonormal basis Oxyz. 

Huygen's theorem is used to transform the matrix of inertia:  (parallel axis 
theorem).

Let I' be the matrix of inertia with respect to orthonormal basis Pxyz

where  

 
M = {u,v,w}: transformation matrix from basis (Pxyz) to basis (Puvw)
TM is the transposed matrix of matrix M.

J is the matrix of inertia with respect to an orthonormal basis Puvw:

J = TM.I'.M

Additional Notation used in Measure Inertia command

Ixy = (-Pxy)

Ixz = (-Pxz)

Iyz = (-Pyz)

Note: Since entries for the opposite of the product are symmetrical, they are given only once 
in the dialog box.

IoxG Moment of inertia of the object about the ox axis with respect to the system Gxyz, 
where G is the center of gravity.



IoxO Moment of inertia of the object about the ox axis with respect to the system Oxyz, 
where O is the origin of the document.

IoxP Moment of inertia of the object about the ox axis with respect to the system Pxyz, 
where P is a selected point.

IoxA Moment of inertia of the object about the ox axis with respect to the system Axyz, 
where A is a selected axis system.

etc.

 



Inertia Equivalents 

If your document contains inertia equivalents set using Knowledgeware capabilities, then the Inertia 
command will not calculate the  inertia properties of the selected geometry but return the equivalent 
values.
The Equivalent box of the Measure Inertia dialog box 
indicates whether or not equivalents have been 
used: 

●     0: the measure is made on the selection, 
geometry or assembly

●     1 or more: One or more inertia equivalents are 
taken into account.

To display inertia equivalents in the Measure Inertia dialog box:
1. Click Customize... in the Measure Inertia dialog box.

The Measure Inertia Customization dialog box appears.
2. Check Equivalent in the Measure Inertia Customization dialog box.
3. Click Apply.

Equivalents are user parameters set using the Knowledgeware formula command  under parts or 

products and imported from text (*txt) or Excel (*xls) files. Sets of equivalent parameters must be valid 
to be taken into account. To be valid, all the properties shown in the example below must be listed.

An example of a text file follows. In text files, the name of the property and the value are separated by a 
tab stop.

Equivalent_IsSurface   false
Equivalent_IsVolume   true
Equivalent_Area     6m2
Equivalent_Volume 1m3
Equivalent_Mass    1000kg
Equivalent_COGx   75mm
Equivalent_COGy   -10mm
Equivalent_COGz   -25mm

 Equivalent_MatGxx 50000gxmm2
Equivalent_MatGyy 50000gxmm2
Equivalent_MatGzz 50000gxmm2
Equivalent_MatGxy 0gxmm2
Equivalent_MatGxz 0gxmm2
Equivalent_MatGyz 0gxmm2

In Excel files, simply list property names and values in two separate columns.

Importing Inertia Equivalents
1. Select the product to which you want to 

associate inertia equivalents.

2. Click the formula  icon.



 

3. Click Import... in the Formulas dialog box.

4. Select the text or Excel file containing the 
inertia equivalents in the file selection dialog 
box, then click Open. 

Parameters to be imported are listed.

5. Click OK to import all the parameters listed into the document.

Imported parameters are now displayed in the Formulas dialog box.

6. Click OK in the Formulas dialog box. 

You are now ready to run your inertia calculation.  

●     Having imported inertia equivalents, you no longer need the representations of the product or 
sub-products and you can de-activate them (Edit ->Representations). De-activated 
representations are unloaded. This frees the geometry area and improves system response time.

●     To display parameters in the specification tree, select the Parameters checkbox below Display in 
Specification Tree in the Display tab of the Options dialog box (Tools-> Options-> 
Infrastructure-> Part Infrastructure).

 



 

Measuring the Principal Axes A about which Inertia is 
Calculated

1. In the Measure Inertia Customization dialog box, click Principal axes.
2. Click Apply. 

The Inertia / G tab in the Measure Inertia dialog box becomes available.
 3. Click the Inertia / G tab to display the principal axes about which inertia is calculated.

Note: If you checked the Keep Measure option, bounding box values are also displayed 
in the specification tree.
You can create the axis system corresponding to the principal axes.

http://arbre1dsy/spuCXR14/Doc/online/cfyugmeasure_C2/cfyugmeasuregeometry.htm


 

Measuring the Inertia Matrix with respect to the Origin 
O of the Document
1. In the Measure Inertia Customization dialog box, click Inertia matrix / O.
2. Click Apply. 

The Inertia / O tab in the Measure Inertia dialog box becomes available. Entries for the inertia matrix 
appear in the specification tree.

3. Click the Inertia / O tab to display the inertia matrix of selected items with respect to the origin O of 
the document.



Measuring the Inertia Matrix with respect to a Point P
Insert or open the InertiaVolume.CATPart from the common functionalities sample folder 
cfysm/samples.

1. In the Measure Inertia Customization dialog box, click Inertia matrix / P. 

Note: Only points created in the Part Design workbench are valid.
2. Click Apply. 

The Inertia / P tab in the Measure Inertia dialog box becomes available.
 3. Click the Inertia / P tab.

4. Select the Select point checkbox.
5. Select a point in the geometry 

area: 

The coordinates of the point and 
the inertia matrix are given in the 
dialog box.

 

 

Selecting another item calculates the inertia matrix of the selected item with respect to the 
same point. To change point, click the Select point checkbox again, then select another 
point.

 

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/InertiaVolume.CATPart


Measuring the Matrix of Inertia with respect to an Axis 
System

Insert or open the InertiaVolume.CATPart from the common functionalities sample folder 
cfysm/samples.

1. In the Measure Inertia Customization dialog box, click Inertia matrix / axis system. 

Note: Only axis systems created in the Part Design workbench (Axis System command) are valid.

2. Click Apply. 

The Inertia / Axis System tab in the Measure Inertia dialog box becomes available.

3. Click the Inertia / Axis System tab.
4. Select the Select axis system checkbox.

5. Select an axis system in the specification tree: 

Note: You must select the axis system in the specification tree.

The name of the axis system as well as the origin O,  (U, V, W) -vectors and the matrix of inertia 
with respect to the axis system are given in the dialog box. Entries for the matrix of inertia appear in 
the specification tree.

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/InertiaVolume.CATPart


Selecting another item measure inertia properties of the selected item with respect to the same axis 
system. To change axis system, click the Select axis system checkbox again, then select another 
axis system.

If you checked the Keep Measure option in the Measure Inertia dialog box,  your matrix of inertia 
measures are kept as features and, if made with respect to a V5 axis system, are associative.

 

 



Measuring the Moment of Inertia about an Axis
Insert or open the InertiaVolume.CATPart from the common functionalities sample folder 
cfysm/samples.

1. In the Measure Inertia Customization dialog box, click Moment / axis to measure inertia with respect 
to an axis. 

Note: Only axes created in the Part Design workbench are valid.

2. Click Apply. 

The Inertia / Axis tab in the Measure Inertia dialog box becomes available.
 3. Click the Inertia / Axis tab.

4. Select the Select axis checkbox.

5. Select an axis in the geometry area: 

The equation and direction vector of the axis as well as the 
moment of inertia Ma about the axis and the radius of gyration 
are given in the dialog box.

Selecting another item measures the inertia of the selected item about the same axis. To change 
axis, click the Select axis checkbox again, then select another axis.

 

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/InertiaVolume.CATPart


3D Inertia Properties of a Surface

You can measure 3D inertia properties on exact and tessellated surfaces. Examples showing a surface and a DMU section are given 
below.

Insert or open the InertiaVolume.CATPart from the common functionalities sample folder cfysm/samples.

The DMU section is a tessellated surface.

 

 

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/InertiaVolume.CATPart


Using Hybrid Parts

 
This task shows how to create a hybrid part comprising wireframe, surface and solid geometry.

 

You must have access to the Part Design product.
Open the Hybrid1.CATPart document.

 
1.  In the 

Generative 

Shape Design 

workbench, 

open a 

document 

comprising 

solid entities.

2.  Click the Line 

icon  then 

create 

construction 

point-point 

lines between 

the opposite 

vertices of the 

two pads.

These lines 
are created 
in a 
Geometrical 
Set entity. 

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/Hybrid1.CATPart


3.  Click the Multi-

sections 

surface icon 

 and 

create a lofted 

surface 

between the 

curved edges 

of the two 

pads.
  

4.  Create another 

lofted surface 

between the 

bottom edges 

of the two 

pads.

  

5.  Click the 

Sweep icon 

 and 

create a swept 

surface 

between two 

opposite 

vertical edges 

of the two 

pads.

 



6.  Create another 

swept surface 

on the other 

side of the side 

of the two 

pads. 

7.  Click the Join 

icon  then 

select the four 

surfaces to 

create a single 

joined surface.

 

8.  Open the Part Design workbench and select the Closed Surface icon .

9.  Select the 

joined surface 

in order to 

close it.

The model 
and 
specification 
is updated 
with the 
Close 
Surface 
feature.

 



Working with the 
Generative Shape Optimizer Workbench

Create bumped surfaces: select a surface, a limit curve, the deformation center, direction, and 
value.
Deform surfaces based on curve wrapping: select the surface to be deformed then matching 
pairs or reference and target curves.
Deform surfaces based on surface wrapping: select the surface to be deformed, the reference 
surface then the target surface.
Deform surfaces based on shape morphing: select the surface to be deformed and deformation 
elements



Creating Bumped Surfaces

This command is only available with the Generative Shape Optimizer product.

This task shows how to create bumped surfaces, by deformation of an initial surface.

Open the Bump1.CATPart document.

1.  Click the Bump 

icon .

The Bump 
Deformation 
Definition 
dialog box is 
displayed.

2.  Select the 

surface to be 

deformed.

3.  Select the Limit 

curve, that is 

the curve 

delimiting the 

deformation 

area.

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/Bump1.CATPart


The limit 
curve needs 
to be lying on 
the surface to 
be deformed. 
If not, use the 
Create 
Projection 
contextual 
menu on the 
Limit curve 
field to project 
the limit curve 
on the 
surface.

4.  Select the 

Deformation 

center, that is 

the point 

representing the 

center of the 

deformation.

The deviation 
will be at its 
maximum at 
this point, and 
evolve 
towards the 
limit curve, 
where it 
should reach 
0.

5.  Select the curve 

indicating the 

Deformation 

direction.

The 

deformation is 

propagated 

along this 

direction. By 

default, the 

Deformation 

direction is 

normal to the 

deformed 

element.



6.  Set the Deformation distance, that is the maximum distance, along the Deformation direction, from the 

deformed surface towards the Deformation Center.

We keyed in 20mm.

7.  Click Preview to preview the bumped surface.

8.  Click the Add 

Param>> 

button to display 

further options.

You can: 
●     define the continuity to be kept between the deformed area and the surface outside the deformation area (point, 

tangent, or curvature continuity)

●     specify a projection direction if the Deformation Center does not lie within the selected surface to be deformed, so 
that it is projected onto it.

 
●     define a center 

curvature value to 
control the shape of 
the bump 
deformation.
If the value is:

❍     equal to 1 (case 
A), the shape is 
the default one 
(as if no value 
was defined)

❍     smaller than 1 
(case B), the 
shape is flatter

❍     bigger than 1 
(case C), the 
shape is steeper

Note: all values are 
allowed (positive, 
null, and negative 
values), however it 
is advised to define a 
value comprised 
between -1 and 5.

In case of a curvature continuity, the original continuity between the deformed area and the surface outside the 
deformation area will be at best kept but may be approximate in certain cases. 



9.  Click OK to 

validate the 

surface 

deformation.

The element (identified 

as Bump.xxx) is added 

to the specification tree.

 You can edit the bump's parameters. Refer to Editing Parameters to find out how to display these parameters in the 3D 
geometry.

 



Deforming Surfaces According to
Curve Wrapping

This command is only available with the Generative Shape Optimizer product.

This task shows how to deform surfaces basing the deformation on curve wrapping, that is matching each reference curve onto a target curve.
The deformation is then defined by the transformation of the reference curves into target curves.
The curves used for the deformation do not necessarily lie on the initial surface.
Several cases are presented here, from the simplest one to cases using various options. Note that whatever information is given in the first 
example also applies to the following examples. 

●     Basic curve wrapping deformation

●     Curve wrapping deformation with a fixed reference

●     Editing a deformed surface

●     How is the deformation computed ?

Open the WrapCurve1.CATPart document.

Basic Curve Wrapping Deformation

1.  Click the Wrap Curve icon .

The WrapCurve Definition dialog box is displayed.

 

2.  Select the surface to be deformed.

3.  Successively select the first reference curve and the first target curve.
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4.  Repeat this operation by selecting the second  reference curve then the 

second  target curve.

As you select pairs of reference/target curves, the curves list in dialog 

box is updated accordingly. 

   

5.  Click OK to create the deformed surface.

The element (identified as Wrap curve.xxx) is added to the specification tree.

●     You must always select successively a reference then a target curve to define a pair. You cannot select all reference curves, then all target 
curves for example.

●     You need to select only one pair of curves (reference and target) to be able to define the deformation by clicking Preview.

●     When several pairs of curves are selected, they must be ordered, not randomly selected

●     Reference curves should not intersect each other, nor should the target curves should intersect each other

Reference and target curves can be multi-cells. Joined, blended, or matched curves, for example, can be used as reference or target curves.

Curve Wrapping Deformation with a Fixed Reference
Some times you need to create a deformed surface in relation to another element, when you want to match two surfaces for example. The 
curve wrapping capability lets you fix an element that can be used by another one, thus allowing you to retain a connection between elements 
while deforming the initial surface.

1.  Click the Wrap Curve icon .

The Wrap Curve dialog box is displayed.

2.  Successively select the surface to be deformed, and the first reference 

curve.

3.  Right-click in space to display the contextual menu, and choose the Fixed 

reference curve.

The reference curve you selected previously now is fixed, i.e. you do not 

need a target curve, this curve being used to create the deformation.

In the target area of the list, no element is displayed.



4.  Select another pair of reference and target curves and click Preview.

A new surface is created based on the first reference curve and the 

second target curve.

5.  Click OK to create the deformed surface.

Because the first reference curve is an element used by the blended surface the 

connection between the two surfaces is retained.

Editing a Deformed Surface
Using the deformed surface you just created, this section shows you how to modify it by: 

●     inserting curve pairs

●     remove curve pairs

●     fix reference curves

●     add constraints onto the first and last curve pairs

1.  Double-click on the wrap curve surface you just created.

The dialog box is displayed containing the creation information.

2.  Within the list, select the second line (Reference: Line.9, Target: Spline.7) and click the Insert Before button.

The Reference field of the Current curves area gets active.



3.  Select a new reference curve (Line.8) and a new target curve (Spline.6), 

and click Preview.

The deformed surface now takes into account the new pair of curves.

To add a pair of curves as the last entry in the list, you need to select the ... line, 
and directly select the reference and target curves. 

With our example, we selected the ... line, then selected Line.7 and Spline.8 as 
reference and target curves respectively.

Just like you fixed a reference curve at creation time, you can do it when editing a wrap curve surface:

4.  Select the fourth line from the list in the dialog box, and check the Fix 

reference curve option.

The target curve is automatically removed from the Target column and field.

5.  Click Preview.

The resulting surface looks like this:

6.  Select the third line from the list in the dialog box, and click the Remove 

button, and click OK.

The selected pair of curves no longer being used to compute the 
resulting surface, the latter looks like this:

You can define further constraints on the deformed surface by means of the Constraints fields. You can choose to retain the initial surface's 

curvature or tangency constraint on the first, and/or last; pair of curves.

In case of a curvature or tangency continuity, the original continuity between the deformed area and the surface outside the deformation area 
will be at best kept but may be approximate in certain cases. 



Not keeping initial surface's constraint 
 on last reference/target curves 

Keeping initial surface's tangency 
constraint 

 on last reference/target curves 

Keeping initial surface's curvature continuity
 on last reference/target curves 

   
When the spine or the first reference/target curve (default spine) is too short in relation to the corresponding surface's bounding box, the 
curve is extrapolated according to this bounding box. Then other reference/target curves are extrapolated as well, in relation to this 
extrapolated spine.

How Is the Deformation Computed ?
The following diagrams will help you understand how the deformation is computed in relation to the entered data, i.e. reference/target curves 
and possible spine.

3D view, where: 
●     r1, r2 are the reference curves

●     t1, t2 are the target curves

●     P is a plane normal to the spine

Planar view, where: 
●     Ir1: is the intersection between P and r1

●     Ir2: is the intersection between P and r2

●     It1: is the intersection between P and t1

●     It2: is the intersection between P and t2

The deformation is computed in each plane P, normal to the spine. By default the spine is the first reference curve, but you can select a new 
spine using the Spine field in the Reference tab.

In each plane P, the system computes the intersection between the plane and each curve.
A curve (Cr) is created between the first intersection point (Ir1) and the last intersection point (Irn) on reference curves, passing through all 
the intersection points between these two.
Similarly, a curve (Ct) is created passing through all the intersections points between the first (It1) and the last intersection point (Itn) on 
target curves.

Then, for each point Q, resulting from the intersection of the surface to be deformed with the plane, Q is projected onto the curve Cr according 
to the projection direction (dir). This projection direction is the vectorial product of: vector(lspine, lr2) ^ vector normal to P.
The result of the projection of point Q is the point Qr, which parameter on Cr is v.
Similarly, a point Qt is created on the curve Ct, with the same v parameter as point Qr on curve Cr .

Then Qd, that is the transformation of point Q according to the wrap curve deformation, is obtained by adding: Q+vector(Qr,Qt)

 



Deforming Surfaces According to
Surface Wrapping

This command is only available with the Generative Shape Optimizer product.

This task shows how to deform surfaces basing the deformation on the projection of the element to be deformed onto two definition 
surfaces.

Open the WrapSurface1.CATPart document.

1.  Click the Wrap Surface icon .

The WrapSurface Deformation Definition dialog box is 

displayed.

2.  Select Surface 1. as the surface to be deformed.

3.  Select Surface 2. as the reference surface.

4.  Select Surface 3. as the target surface.

5.  Select the Wrap type:

❍     3D

❍     Normal

 

3D Wrap
 

The following diagram will help you understand how the deformation is computed in relation to the entered data, i.e. reference/target 
surfaces.

 

 
 Normal Wrap

The following diagram will help you understand how the deformation is computed in relation to the entered data, i.e. reference/target 
surfaces.

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/WrapSurface1.CATPart


 

  

6.  Click OK to create the deformed surface.

The surface to deform is put in no show.

The element (identified as Wrap surface.xxx) is added to the specification tree.

 

 3D Surface Wrapping Normal Surface Wrapping
 

When the definition surfaces (reference or target surface) are too short to allow the projection of the surface to deform, these 
surfaces are automatically extrapolated.

●     The size of the resulting element may not be identical to that of the initial element, if the reference and the target surfaces do not 
have the same size.

●     Reference and target surfaces must be mono-cell surfacic elements.



Deforming Surfaces According to
Shape Morphing

This command is only available with the Generative Shape Optimizer product.

This task shows how to deform surfaces basing the deformation on shape morphing, that is matching each reference curve or point 
(reference elements) onto a target curve or point (target elements)
The deformation is then defined by the transformation of the reference curves or points into target curves or points.
The elements used for the deformation do not necessarily lie on the initial surface.

Several cases are presented here, from the simplest one to cases using various options. Note that whatever information is given in the 
first example also applies to the following examples. 

●     Basic shape morphing deformation

●     Defining a limit element

●     Coupling points

●     Shape morphing with a fixed element

Open the ShapeMorphing1.CATPart document.

 
Basic shape morphing deformation

 

1.  Click the Shape Morphing icon .

The Shape Morphing Deformation Definition dialog box 
is displayed.

 

2.  Select the surface to be deformed.

 

3.  Successively select the first reference element and the 

first target element.

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/ShapeMorphing1.CATPart


4.  Repeat this operation by selecting the second reference 

element then the second target element.

 

As you select pairs of reference/target elements, the list in the 

Deformation Elements tab is updated accordingly. 

 

 
5.  Click Preview to previsualize the deformation.

 

 

The previsualization shows that:
●     the deformation is applied to a group of points

●     there is a constraints' mapping between the reference and the 
target curves.



 

6.  Click OK to create the deformed surface.

The element (identified as Shape Morphing.xxx) is added to the 

specification tree.

You can apply a constraint on the target element with the associated support surface.

The combo list displays the available continuity types depending on the reference/target elements you chose.

 
●     You selected a reference and a target elements: the Point and the Tangent continuity are available.

In the case of a Point continuity, the Support field is grayed.

In the case of a Tangent continuity, select a support surface so that the continuity is kept.

●     You selected only reference elements: all continuities (Point, Tangent, and Curvature) are available.

In the case of a Tangent or Curvature continuity, you do not need to select a support surface as the surface to deform is taken 

into account.

Defining a Limit Element
 You can define a limit curve to determine the area of the 

deformation and enable the other part of the surface to remain 
frozen.
Here is an example using Limit1. as Limit Curve and a Tangent 
Continuity.
The Reverse Direction  button enables to deform the surface on 
the other side of the limit curve. You can also click the arrow in 
the 3D geometry.

Coupling Points



 

Use this tab to define coupling points in order to map reference 
elements with target elements. 

Points must be located on reference and target curves.

 

●     You must always select successively a reference then a target element to define a pair. You cannot select all reference elements, 
then all target elements for example.

●     When several pairs of curves are selected, they must be ordered, not randomly selected

Reference and target curves can be multi-cells. Joined, blended, or matched curves, for example, can be used as reference or target 
curves.

Shape Morphing Deformation with a Fixed Element
Some times you need to create a deformed surface in relation to another element. The shape morphing capability lets you fix an 
element that can be used by another one, thus allowing you to retain a connection between elements while deforming the initial 
surface.

1.  Click the Shape Morphing icon .

The Shape Morphing Deformation Definition dialog box 
is displayed.

2.  Select the surface to be deformed.

3.  Select the first reference element.

4.  Click the Add button to add another reference element.

5.  Successively select the second reference element then the 

target element.



6.  Click OK to create the deformed surface.



Working with the
Developed Shapes Workbench

Develop wires and points: select a wireframe contour, a revolution surface, and if needed the 
developing type, point of origin, and further positioning parameters.
Unfold a surface: select a surface to unfold, a target plane, and if needed edges to tear, the 
origin and direction of the target plane.



Developing Wires and Points

This command is only available with the Developed Shapes product.

This task shows how to develop wires, and points, onto a revolution surface, that is to create a new wire by 
mapping a wire's planar abscissa and ordinate with abscissa and ordinate within a local axis-system on a surface, 
with respect to the surface's curvature.
The wire can be any curve or sketch, provided it is a manifold element. Therefore it cannot be, for example, a T or 
H-shaped element.

About Developing Wires
There are three modes of developing on a surface:  

1.  Develop-Develop
2.  Develop-Project
3.  Develop-Develop inverted

the difference being in the way the points are mapped onto the revolution surface.
The following illustration shows the three developing types, based on developing the black solid wire, the two black 
dotted wires representing the 1 and 2 coordinate lengths in the wire's axis-system.

 
●     In the case of the Develop-Develop option, a given point (p) of the wire is developed on the revolution surface 

by mapping its first coordinate as a curvilinear abscissa on the revolution surface (1 into 1') up to a (p') point 
(represented by the light blue dotted curve), then from that (p') point reporting the other coordinate of (p) as a 
curvilinear abscissa (2 into 2') along the revolution surface (dark blue dotted curve).
The resulting developed wire is the dark blue solid curve in the above illustration.

●     In the case of the Develop-Project option, a given point (p) of the wire is developed on the revolution surface 
by mapping its first coordinate as a curvilinear abscissa (1 into 1') onto a virtual cylinder passing through the 
point on support (default or user-defined), to generate a (p') point (represented by the light blue dotted curve), 
reporting the other coordinate parallel to the cylinder's revolution axis,  then projecting normally from that 
cylinder onto the revolution surface (light green dotted line).
The resulting developed wire is the light green solid curve in the above illustration.

●     In the case of the Develop-Develop inverted option, a given point (p) of the wire is developed along the 
revolution surface by mapping its first coordinate as a curvilinear abscissa on the virtual cylinder up to a (p'') 
point (represented by the pink dotted line), then from that (p'') point reporting the other coordinate of (p) as a 
a curvilinear abscissa along the revolution surface.
The resulting developed wire is the pink solid curve in the above illustration

●     In the case of a Develop inverse, a given wire is developed from the revolution surface. Therefore, a point on 
support needs to be specified in order to define the plane, tangent to this point, that will contain the resulting 
developed wire.
As an example, if you develop any of the wires in the above illustration using their original development 
method, the resulting developed wires will be the black solid curve.



As you can see, the results differ slightly, the developed curves not ending on the same point.
  

Open the Develop1.CATPart document.

1.  Click the Develop icon .

 The Develop Definition dialog box is 
displayed as well as the Multi-Selection 
dialog box allowing to perform multi-
selection.

 

     

2.  Select the wire to be developed.

By default, the plane containing this 
wire is automatically computed. 
However, when the wire is a line, you 
need to specify a Wire plane.

3.  Select the revolution surface onto which 

the wire is to be developed.

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/Develop1.CATPart


4.  Click Preview.

The axis-systems are displayed both 

on the wire's virtual plane and the 

surface. These are the default axis-

systems. By default, the origin of the 

support's axis-system is located at a 

point on the surface where the plane is 

parallel to the wire's plane.

However, it is usually more pertinent 

to specify exactly the axis-systems 

origin.

5.  Click the Point field and select a point, 

on the surface, defining the support axis-

system's origin.

The axis-systems are modified, the 

support's axis-system to coincide with 

the selected point, and the wire's axis-

system to retain the shortest distance 

between the two axis-systems' origins.

Consequently, the resulting wire is 

also modified.

6.  If you check the Position 2D wire then 

click the Show Parameters button to 

expand the dialog box and modify the 

wire axis-system's positioning.

The wire's axis-system turns green, meaning it 
can be edited, i.e. change location. You can 
directly move it in the geometry and the dialog 
box will be updated accordingly.



 
●     Specify the wire axis-system's origin by either entering coordinates, or selecting a point.

●     Specify the x-axis of the axis-system by either selecting a line or specifying a rotation angle in relation to the 
initial lowlight position.

●     Select the X-axis inverted check box to invert the x-axis orientation (while keeping the y-axis unchanged).

●     Select the Y-axis inverted check box to invert the x-axis orientation (while keeping the y-axis unchanged).

You could get something like this:

If you want to go back to the initial axis-system positioning, uncheck  the Position 2D wire button, and collapse 
the dialog box using the Hide parameters button.

7.  Click OK to create the developed wire.

The element (identified as Develop.xxx) is added 

to the specification tree.

●     You can then fill in the developed wire, to 
create a developed surface in one click (refer 
to the Creating Fill Surfaces chapter)

●     Three optional parameters are available from 
the Develop Definition dialog box allowing to 
apply a transformation to the wire prior to 
developing it. They are illustrated below by 
the developing of a square wire onto a 
surface:



1. Radiantness: allowing to specify a radial deformation ratio on the developed wire. This transformation 
is defined by the distance between the axis-system origin on the revolution surface and the revolution 
axis (R), and the ratio you specify in the Develop Definition dialog box. 

The formulas used to define the radiantness are:
x' = (R + y1 * Ratio) * x1 / (R + y1)
y' = y1
Where:
x1 and y1 are the coordinates of any point in the initial axis system of the wire to be developed
x' and y' are the coordinates the same point on the developed wire

Developing with positive radiantness value
(green curve)

Developing with negative radiantness value
(light blue curve)

2. Inclination: the angular deviation 
(d) from the default developing. 

The formulas used to define the 
inclination are:
x' = x1 + y1 tan(d)
y' = y1

You can combine these two options to develop a 
wire:

3. Intermediate radius: a ratio is applied to the wire's coordinates along the y axis, prior to developing 
it (i.e. the development operation itself is not affected, only the wire's shape is modified along y before 
the development). 



Developing with intermediate radius
value set to 2.

The square's length along y doubles.

Developing with intermediate radius
value set to 0.5.

The square's length along y reduced to half its  initial length..

Multi-selection of wires to be developed is available. Refer to Selecting Using Multi-Output.

 



Unfolding a Surface

This command is only available with the Developed Shapes product.

This task shows how to unfold a ruled surface.

Open the Unfold1.CATPart document.

1.  Click the Unfold icon .

The Unfold Definition dialog box appears.

 

 
2.  Select the Surface to unfold.

 

The unfolded surface is previewed and flag notes display 
candidate curves to tear (if any) in the 3D geometry.

It is positioned:

●     on the selected plane

●     such as the image of the selected point on the surface to 
unfold coincides with the selected point on the plane, and

●     such as the image of the tangent to the selected edge on the 
surface to unfold is collinear with the selected direction on 
the plane. 

If you move the mouse over a flag note, a longer message giving 
an accurate diagnosis is displayed.

 Information on the surface to unfold displays in the dialog box:

●     Origin: point on the surface to unfold. If no specific origin is selected, it is set to Default. By default, when possible, a corner of the 

surface to unfold is selected.

If a target plane is defined and a projection is possible, the origin is defined as the projection of the point, selected as the origin on the 

surface to unfold, onto the target plane. If not, the origin of the axis system of the target plane is selected as the default origin.

●     Direction: edge of the surface whose extremity is the point. If no specific direction is selected, it is set to Default. By default, when 

possible, an edge of the surface to unfold is selected.

If a target plane is defined and a projection is possible, the direction is defined as the projection of the tangent to the selected edge onto 

the target plane. If not, the direction of the target plane is selected as the first direction of the axis system of the target plane.

By default an origin and a direction are selected, and the result is positioned such as this origin and its image as well as the tangent to this 

direction and its image are coincident.

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/Unfold1.CATPart


 
3.  In the Target plane frame, select the plane on which the surface has to be unfolded (here we chose yz plane).

The plane is defined depending on the origin and the direction of the surface to unfold.

 4.  In the Curves to Tear tab, select as many internal and external curves or edges to tear as needed along which the surface is to be 

developed, so that constraints are solved. 

If no edge of the surface can be defined as candidate, an information message is issued and the Curves to Tear tab displays a list of 

edges to be selected.

The selection of curves or edges to tear is optional if there is no curve or edge to tear.

To deselect a curve to tear, simply click on it. The selection is possible again.

 

 Unfold using an internal edge to tear Unfold using an external edge to tear
If you do not select edges to tear though you need to, a warning message is issued and the different candidates are displayed in the 3D 
geometry.

●     To select an edge candidate to tear, double-click the information tag or click the edge directly in the 3D geometry (it is highlighted in 
yellow).

●     To select an edge to tear, double-click the information tag or click the edge directly in the 3D geometry (it is highlighted in green).

 7.  Click OK to unfold the surface.

The developed surface (identified as Unfold.x) is added to the specification tree.

 

Defining curves or points to transfer

Open the Unfold2.CATPart document.  

http://arbre1dsy/spuCXR14/Doc/online/cfysm_C2/samples/Unfold2.CATPart


1.  Click the Unfold icon .

The Unfold Definition dialog box appears.

2.  Select the Surface to unfold.

3.  In the Transfer tab, select points or curves on the 

surface to unfold or on the resulted unfolded surface.

4.  Select the type of transformation:

❍     Unfold: if you selected elements on the surface to 

unfold

❍     Fold: if you selected elements on the resulted 

unfolded surface

 

5.  Click Preview to see the unfolded surface and elements.

 

6.  Click OK to unfold the surface.

The developed surface (identified as Unfold.x) is added to the 

specification tree, as well as the transferred elements.

   
●     Mono- and multi-cell surfaces, as well as closed surfaces can be unfolded.

●     Multi-cell surfaces and surfaces with internal loops can be unfolded.

●     If no point or direction that is not linked to the edges to tear can be selected on the surface to unfold, you can split the surface to unfold 
(using the Keep both sides option to retain the split element after the operation) and unfold both sides.

    



●     Surfaces must be ruled surfaces of degree 1*N. Non ruled surfaces cannot be unfolded.
A ruled surface is a surface that can be created by sweeping out a linear profile of degree 1 along a guide of degree N.

●     Surfaces must have a null Gaussian curvature 

●     The origin and direction of the surface to unfold must not be located on an edge to tear.



Working With Automotive
Body in White Templates

Create junctions: select two or more sections, define coupling points and tangency constraints 
on these sections if needed 
Create a diabolo: select the seat surface, the base surface then the draft direction and the 
draft angle.

Create a hole: select the center point, the support surface and the punch direction.

Create a mating flange: select the base surface, the reference element, then define 
parameters.

Create a bead: select the base surface, the location point, and the reference direction.

Note that creating macros on the above features is not authorized. 



Creating Junctions

This command is only available with the BiW product.

This task shows how to create junction surfaces between existing surfaces. These surfaces must have been created from 
contours (sketches, splines, and so forth) provided these are not closed.

Open the Junction1.CATPart document.

1.  Click the Junction icon .

The Junction Surface Definition dialog box is 
displayed.

2.  Select two sections.

These can be surface boundaries or contour lying on 

surfaces.

Coupling curves on which the junction surface will be 
based are displayed between the two sections.

3.  Select another section.

New coupling curves are now displayed.

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/Junction1.CATPart


If the sections do not present the same number of vertices, the system automatically links the coupling curves to the sections 
retaining the maximum number of points.
In our example, two sections present four vertices whereas the last one present only three. The system found a solution by 
linking two curves to the same vertex on the last section. 

Use the Sections coupling combo list to specify if the coupling lines are to connect sections on their tangency discontinuity 
points (Tangency option) or on their tangency discontinuity and curvature discontinuity points (Curvature option).

4.  Click within the Coupling Point area then select a point 

on the section on which you wish to redefine a new 

passing point for the coupling curve.

5.  Click Preview to preview the junction surface:

By default the coupling curves and the junction surface are tangent to the contour plane's normal.

6.  Select a section from the list and click the surface on 

which it lies to add it as a support surface to the 

section, and therefore define a tangency constraint. 

The coupling curves are modified so as to be tangent 
to the selected surface.



You can also specify a user-defined coupling curve rather than 
an automatic one, by clicking the Coupling Curve tab, then 
selecting another curve connecting two sections of the junction.

This new coupling curve either replaces an automatic one, or 
results in a new computation of automatic coupling curves.

Indeed, in the following example, the user-defined coupling curve lies across the automatic ones. These are therefore 
recomputed to comply with the new constraint: 

Using automatic coupling curves only Recomputed automatic coupling curves when using a user-
defined coupling curve (blue curve)

7.  Click OK to create the junction surface:

The element (identified as Junction.xxx) is added to the 

specification tree.



●     You can select as many sections as you wish.

●     There is no specific selection order. You can select sections randomly and obtain the same result.

●     User-defined coupling curves must end on sections.

●     You cannot use a coupling point and a user-defined coupling curve ending on this coupling point.



Creating a Diabolo

This command is only available with the BiW product.

This task shows how to include a seat surface onto a base surface.

Open the Diabolo1.CATPart document.

1.  Click the Diabolo icon .

The Diabolo Definition dialog box is displayed.

 

2.  Select the Seat surface.

3.  Select the Base Surface.

4.  Select the Draft direction.

To define this direction, you can select either a plane, a line or an axis X, Y, Z.

The draft direction is not mandatory: the default direction is the normal direction to the seat surface.

5.  Select the Draft Angle.

The default draft angle value is 5 degree.

6.  Click OK.

The diabolo (identified as Diabolo.xxx) is added to the specification tree.

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/Diabolo1.CATPart


Diabolo with a 5 degrees as draft angle Diabolo with a 30 degrees as draft angle

Both seat and base surfaces must have a close contour and belong to one domain.

 



Creating a Hole

This command is only available with the Automotive BiW Template product.

This task shows how to create a hole, that consists of removing material from a body.

Open the Hole1.CATPart document.

1.  Click the Hole icon .

The Hole Definition dialog box is displayed.

 

 

Various shapes can be created:

●     round

●     slot (elongated hole)

●     rectangular

●     square

The shape is defined on a plane and projected along a direction on the surface. In that case, 
the nearest projection is used to create the hole. 

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/Hole1.CATPart


 

2.  Select the shape in the drop-down list.

3.  Click a point to be the Center Point in the geometry or in the specification tree.

4.  Select the Support Surface.

5.  Define the Orientation to align the major axis along a direction.

You do not need to define an orientation for the round holes.

 6.  Define the Punch Direction.

●     If the point lies on the support surface, by default it is the normal direction at the center point.

●     If the point does not lie on the support surface, you must define a punch direction. 

 

7.  Click Preview to visualize the hole.

8.  Define the shape dimensions.

To do so, either :

 

●     click the value to edit (here the 

rectangular length)

  

The Length dialog box opens to let you modify 

the dimension.

   

 

●     click the Size tab.

All dimensions related to the selected shape 
are displayed and can be modified.

Here are the parameters to be defined depending on the shape hole:



 

 Length Width Radius

Round   X

Slot X X  

Rectangular X X X

Square X  X

 

 

9.  Click OK to create the hole.

The element (identified as Hole.xxx) is added to the specification tree.

 

 Round hole
Radius = 5mm, Punch Dir. = Default

Slot hole
Length = 30mm, Width = 15mm

Orientation = zx plane, Punch Dir. = Line.1

 

 
Rectangular hole

Length = 40mm, Width = 10mm, Radius = 5mm
Orientation = yz plane, Punch Dir. = Default

Square hole
Length = 15mm, Radius = 2mm, Punch Dir. 

= xy plane



Creating a Mating Flange

This command is only available with the Automotive BiW Template product.

This task shows how to create a mating flange, in order to add a shape to a part.
This shape is a surface and can be used as a contact zone with another part in an assembly purpose.

Open the MatingFlange1.CATPart document.

1.  Click the Mating Flange icon .

The Mating Flange Definition dialog box 
is displayed.

 2.  Select the Base surface.

The base surface can have several faces and 
internal sharp edges.

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/MatingFlange1.CATPart


 

3.  Define the reference location to position the 

mating flange on the base surface:

●     Select a Reference element.

It can be:

❍     a plane or a surface.

The reference location is 

computed as an intersection with 

the base surface.

❍     a curve (as in our scenario): the 

curve can be either a 3D curve or 

a planar curve and must have a 

projection on the base surface 

along the reference direction. 

●     Select a Reference direction only if 

the reference element is a curve.

The reference location is a curve 

computed as a projection along the 

direction.

 

In both cases, the intersection or the 
projection curve must be long enough to 
join the base surface boundaries.

 The mating flange reference location feature is created in hidden mode and is temporarily shown during edition.

 

4.  Define the mating flange parameters by 

clicking the value to edit in the dialog box or 

by clicking the manipulators in the 3D 

geometry.

●     Width

●     Margin

●     Wrap



 5.  Click Preview.

 6.  Define the thickness:
 

 

●     Default Thickness: is generally the part 

thickness and is used as the default offset 

value. You can define its value either by 

entering a value in the field or using the 

manipulators in the 3D geometry.

   

●     Local Thickness: enables you to define 

multiple thickness values. They replace the 

default value and can be positive, negative, or 

null.

Select a sub-part of the reference element and 

define its value either by entering a value in the 

field or using the manipulators in the 3D 

geometry.

You can select several sub-parts, each one 

having its own local thickness. For each value, a 

corresponding 3D dimension is created in the 

3D geometry and can be edited by double-

clicking it.

In case no local value is defined, the Local 

Thickness field is grayed out. Otherwise, the 

corresponding sub-part and the 3D dimension 

are highlighted in the 3D geometry. If you 



select the highlighted sub-part, the local value 

is deleted and the default thickness value is 

used.

The thickness that is aggregated under the mating 

flange feature is the default thickness.
 

 

●     The Reverse Direction button allows you to 

inverse the thickness direction, according to the 

orientation of the reference element.

As as consequence, the mating shape is 

displayed on the other side of the base surface.

 

●     The Flip Flange button allows you to inverse 

the mating flange direction, according to its 

orientation.

As as consequence, the mating shape is 

displayed on the other side of the reference 

location.

 
●     The Base surface trim button enables you to 

trim the surface with the mating flange. 



●     The Both sides button enables to create a both-side mating flange using a second reference element.

By default, the Reference element, as well as the second Reference direction, are the same as the first 

reference element and direction, but you can choose other ones.

 

 With the same reference element With a second reference element

The Flip Flange button is greyed out.
 

 7.  Click OK to create the mating flange.



 

The new shape (identified as Mating Flange.xxx) is 
added to the specification tree.
Its reference location is aggregated under the 
Mating Flange feature and can be used as an input 
for a further operation.



 Creating a Bead

This command is only available with the Automotive BiW Template product.

This task shows how to create a bead, in order to add strength a part.
This shape is a surface and is a triangle bead shape.

Open the Bead1.CATPart document.

1.  Click the Bead icon .

The Bead Definition dialog box 
is displayed.

 2.  Select the Base surface.  

The base surface must have at least one 
internal sharp edge.  

 

3.  Select a point on the sharp edge.

4.  Define a Reference direction.

By default, it is the tangent 

direction to the location edge at 

the location point.

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/Bead1.CATPart


 

5.  Define the bead parameters by 

clicking the value to edit in the 

dialog box or by clicking the 

manipulators in the 3D geometry.

●     Height

●     Width

These values must be positive.

 6.  Click Preview.

 
7.  Click OK to create the bead.

 



Creating Volumes

The Volumes Toolbar is only available with the Generative Shape Optimizer product.

 
Creation of volumetric features

Volumetric features can be created in both Geometrical Set and Ordered Geometrical Set 
environments and are considered as creation features.

 
Modification of volumetric features

 

Several modification features enable to modify a volumetric feature into another volumetric 
feature:

●     Split

●     All fillets (but the shape fillet) : edge fillet, variable radius fillet, face-face fillet, and 
tritangent fillet

●     All transformations: rotate, translate, symmetry, scaling, affinity, and axis to axis

●     Patterns: circular pattern

 
General Behavior

 

The following commands can be used with volumetric features: 
●     Delete

●     Deactivate/Activate

●     Parent/Children

●     Datum mode

●     Reorder (note that it is not possible to reorder the volumetric feature before its parents)

●     Replace (a volumetric feature can only be replaced by another volumetric feature)

●     Show/no show

●     Stacking 

●     Search: ''Volumes'' type

  

When working with solids and volumes, the selection of the feature prevails over the 
selection of the sub-element.



 

To select a sub-element, you need to 

apply the ''Geometrical Element'' filter 

in the User Selection Filter toolbar. You 

can activate this toolbar by selecting 

the View -> Toolbars command and 

clicking User Selection Filter. 

 

●     The icons on the left lets you filter elements according to their type (point, curve, 
surface, volume)

●     The next two icons correspond to the filter modes:

❍      the ''Feature Element Filter'' selects the whole feature whether it is a sketch, 

product, pad, join, etc. 

❍      the ''Geometrical Element Filter'' enables to sub-elements of a feature such as 

faces, edges or vertices 
 

 For further information about this toolbar, refer to the Selecting Using a Filter chapter in the 
CATIA Infrastructure User's Guide.

Auto-intersections can occur: all of them may not be supported.

  

Create extruded volumes: select a profile, specify the extrusion direction, and define the 
start and end limits of the extrusion

Create revolution volumes: select a profile, a rotation axis, and define the angular limits of 
the revolution volume

Create multi-sections volumes: select section curves, guide curves if needed, then enter the 
required parameters

Create swept volumes: select the sub-type, then enter the required parameters

Create a thick surface: select the object to be thickened, define the offset directions and 
enter offset values

Create a close surface: select the surface to be closed

Create a draft: set the Selection by neutral face selection mode or select the face to be 
drafted, then enter the required parameters

Create a variable angle draft: select the face to be drafted, click as many points as you wish 
and then enter the required parameters

Create a draft from reflect lines: select the face to be drafted, then enter the required 
parameters

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/sdgugbt0614.htm


Create a shell: select the faces to be shelled and enter the thickness values

Create a sew surface: select the volume and the object to be sewn

Add volumes: select the volume to be added then the target volume 

Remove volumes: select the volume to be removed then the target volume 

Intersect volumes: select the first volume then the second volume 

Trim volumes: select the volume to trim then the cutting volume



Creating Extruded Volumes

 
This task shows how to create a volume by extruding a profile along a given direction.

 
Open the ExtrudedVolume1.CATPart 
document.

 
1.  Click the Volume Extrude icon  .

The Extruded Volume Definition 
dialog box appears. 

 
2.  Select the Profile to be extruded.

It can be either a profile or a surface.

The profile must be closed and planar and 
must not self-intersect.

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/ExtrudedVolume.CATPart


3.  Specify the Direction of extrusion.

You can select a line to take its 
orientation as the extrusion 
direction or a plane to take its 
normal as extrusion direction. 

You can also specify the direction 
by means of X, Y, Z vector 
components by using the 
contextual menu on the Direction 
area.

The direction must not be tangent (locally or 
not) to the profile to be extruded.

 
4.  Enter length values or use the graphic 

manipulators to define the start and 

end limits of the extrusion.

 

5.  Click OK to create the volume.

The volume (identified as Volume 

Extrude.xxx) is added to the 

specification tree.

You can click the Reverse Direction button to display the extrusion on the other side of the 

selected profile or click the red arrow in the 3D geometry.

 
Parameters can be edited in the 3D geometry. To have further information, please refer to the 
Editing Parameters chapter.

 



Creating Revolution Volumes

 
This task shows how to create a surface by revolving a planar profile about an axis.

 
Open the RevolutionVolume1.CATPart 
document.

 
1.  Click the Volume Revolve icon  

.

The Revolution Volume Definition 

dialog box appears. 

 

 2.  Select the Profile.

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/RevolutionVolume1.CATPart


●     The profile must be planar, closed or 
closed on the axis of the sketch.

●     There must be no intersection between 
the axis and the profile. However, if the 
result is topologically consistent, the 
surface will still be created.

●     The profile must not be perpendicular to 
the revolution axis.

●     If the profile is a sketch containing an 
axis, the latter is selected by default as 
the revolution axis. You can select 
another revolution axis simply by 
selecting a new line.

 

3.  Select a line indicating the desired 

Revolution axis.

It can be a line or the axis of a 

sketch.

4.  Enter angle values or use the graphic 

manipulators to define the angular 

limits of the revolution volume.

5.  Click OK to create the surface.

The volume (identified as Volume 

Revolve.xxx) is added to the 

specification tree. 



 Parameters can be edited in the 3D geometry. To have further information, please refer to the 
Editing Parameters chapter.

 



 Creating Multi-Sections Volumes

This task shows how to create a multi-sections volume by sweeping two or more closed 
section curves along an automatically computed or user-defined spine. The volume can be 
made to respect one or more guide curves. 

Open the VolumeLoft1.CATPart document.

1.  Click the Multi-sections 

Volume icon  .

The Multi-sections 
Volume Definition dialog 
box appears.

2.  Select two or more planar 

section curves.

The curves must be 
continuous in point.

A closing point can be 
selected for a closed 

Example of a multi-sections volume defined by three planar 
sections: 

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/VolumeLoft1.CATPart


section curves. 

3.  If needed, select one or 

more guide curves.

Guide curves must 
intersect each section 
curve and must be 
continuous in point.

The first guide curve will 
be a boundary of the 
multi-sections volume if 
it intersects the first 
extremity of each 
sections curve.

Similarly, the last guide 
curve will be a boundary 
of the multi-sections 
volume if it intersects 
the last extremity of 
each section curve. 

Example of a multi-sections volume defined by 2 planar 
sections and 2 guide curves: 

You can make a multi-sections volume tangent to an adjacent volume by selecting an end 
section that lies on the adjacent volume. In this case, the guides must also be tangent to the 
volume. 

In Figure 2 a multi-sections volume tangent to the existing volume has been created:



Figure 1
Figure 
2

You can also impose tangency conditions by specifying a direction for the tangent vector 
(selecting a plane to take its normal, for example). This is useful for creating parts that are 
symmetrical with respect to a plane. Tangency conditions can be imposed on the two 
symmetrical halves.
Similarly, you can impose a tangency onto each guide, by selection of a surface or a  plane 
(the direction is tangent to the plane's normal). In this case, the sections must also be tangent 
to the volume.

4.  In the Spine tab page, select the Spine check box to use a spine that is automatically 

computed by the program or select a curve to impose that curve as the spine. 

Note that the spine curve must be normal to each section plane and must be 
continuous in tangency.

In the Smooth parameters section, 
you can check: 

●     the Angular correction option 
to smooth the lofting motion 
along the reference guide 
curves. This may be necessary 
when small discontinuities are 
detected with regards to the 
spine tangency or the reference 
guide curves' normal. The 
smoothing is done for any 
discontinuity which angular 
deviation is smaller than 0.5 
degree, and therefore helps 
generating better quality for the 
resulting multi-sections volume.

●     the Deviation option to 
smooth the lofting motion by 
deviating from the guide 
curve(s).



5.  It is possible to edit the 

multi-sections volume 

reference elements by first 

selecting a curve in the 

dialog box list, or by 

selecting the text on the 

figure, then choosing a 

button to either:

●     remove the selected curve

●     replace the selected curve by 

another curve

●     add another curve

More possibilities are available with 
the contextual menu and by right-
clicking on the red text or on the 
object. For example, it is possible 
to remove and replace tangent 
volumes and closing points.



 

6.  Click OK to create the multi-sections volume.

The volume (identified as Multi-sections Volume.xxx) is added to the specification 
tree.

For further information about the other tabs, please refer to the Creating Multi-Sections 
Surfaces chapter.



 Creating Swept Volumes

This task shows how to create swept volumes that use an explicit or an implicit circular profile.

 You can create a swept volume by sweeping out a closed profile in planes normal to a spine curve while taking other user-
defined parameters (such as guide curves and reference elements) into account.

 
Explicit Profile

 

The following sub-types are available:
●     With reference surface

●     With two guide curves

●     With pulling direction

Open the VolumeSweep1.CATPart document.

 

 

1.  Click the Volume Sweep icon .

The Swept Volume Definition dialog box appears.

2.  Click the Explicit profile icon, then use the drop-down list to choose the subtype.

 
With reference surface

 

●     Select the Profile to be swept out (DemoProfile1).

●     Select a Guide curve (DemoGuide1).

●     Select a surface (by default, the reference surface is the 

mean plane of the spine) in order to control the position 

of the profile during the sweep.

Note that in this case, the guiding curve must lie 

completely on this reference surface, except if it is a 

plane. You can impose an Angle on this surface.

file:///E|/www/spuCXR14/SdgEnglish/sdgug.doc/src/samples/VolumeSweep1.CATPart


 
With two guide curves

 

●     Select the Profile to be swept out (DemoProfile1).

●     Select a first Guide curve (DemoGuide1).

●     Select a second Guide curve (DemoGuide2).

 
With pulling direction

 The With pulling Direction subtype is equivalent to the With reference surface subtype with a reference plane normal to the 
pulling direction.

 

●     Select the Profile to be swept out (DemoProfile1).

●     Select a first Guide curve (DemoGuide1).

●     Select a Direction (xy plane)



 
Circular Profile

 

The following subtypes are available:
●     Center and two angles

●     Center and radius

Open the VolumeSweep2.CATPart document.

 

 

1.  Click the Volume Sweep icon .

The Swept Volume Definition dialog box appears.

2.  Click the Circle profile icon, then use the drop-down list to choose the subtype.

 
Center and two angles

 
●     Select a Center Curve (DemoCurve1) and a 

Reference curve (DemoCurve2).

Angles cannot be modified and have fixed values, that is 0 
deg and 360 deg.

file:///E|/www/spuCXR14/SdgEnglish/sdgug.doc/src/samples/VolumeSweep2.CATPart


 

 
Center and radius

 

●     Select a Center Curve (DemoCurve2) and enter a 
Radius value (10mm).

 

For further information about the optional elements, please refer to the Creating Swept Surfaces Using an Explicit Profile and 
Creating Swept Surfaces Using a Circular Profile chapters.

file:///E|/www/spuCXR14/SdgEnglish/sdgug.doc/src/sdgugbt0205.htm
file:///E|/www/spuCXR14/SdgEnglish/sdgug.doc/src/sdgugbt0210.htm


Creating a Thick Surface

This task shows you how to add material to a surface in two opposite directions.

Open the ThickSurface1.CATPart document.

1.  Select the surface you wish to thicken, 

that is the extrude element.

 

2.  Click the Thick Surface icon .

The ThickSurface Definition dialog box 

opens.

 

In the geometry area, the red arrow that 

appears on the extrude element indicates the 

first offset direction. If you need to reverse 

the arrow, just click on it or click the Reverse 

Direction button in the dialog box.

 

3.  Enter 10mm as the First Offset value 

and 6mm as the Second Offset 

value.

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/ThickSurface1.CATPart


 
4.  Click OK.

The surface is thickened. The 

operation (identified as 

ThickSurface.x) is added to the 

specification tree.

Note that the resulting feature does 

not keep the color of the original 

surface, but is displayed in purple 

indicating it is a volume.



Creating a Close Surface

This task shows you how to close surfaces.

Open the CloseSurface1.CATPart document.

1.  Select the surface to be closed.

 

2.  Click the Close Surface icon .

The CloseSurface Definition dialog box opens.

 

3.  Click OK.

The surface is closed. The operation (identified 

as CloseSurface.x) is added to the 

specification tree.

Note that the resulting feature does not keep 

the color of the original surface, but is 

displayed in purple indicating it is a volume.

 

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/CloseSurface1.CATPart


 Creating a Draft

 Drafts are defined on molded parts to make them easier to remove from molds.
There are two ways of determining the objects to draft: either by explicitly selecting the object 
or by selecting the neutral element, which makes the application detect the appropriate faces 
to use.

This task shows you how to create a basic draft by selecting the neutral element.

Open the Draft1.CATPart document.

1.  Click the Draft Angle 

icon  from the 

Volume drafts sub-

toolbar.

The Draft Definition dialog box 
is displayed and an arrow 
appears on a plane, indicating 
the default pulling direction.
This dialog box displays the 
constant angle draft option as 
activated. If you click the icon 
to the right, you then access 
the command for creating 
variable angle drafts.

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/VolumeDraft1.CATPart


 

2.  Check the Selection 

by neutral face option 

to determine the 

selection mode. 

3.  Select the upper face 

as the neutral element. 

This selection allows 

the application to 

detect the face to be 

drafted.

The neutral curve is 

displayed in pink. The 

faces to be drafted are 

in dark red. 

The Support field is 

filled with the volume 

owning the selected 

face. 

 

4.  Set the Propagation option:

●     None: there is no propagation 

●     Smooth: the application integrates the faces propagated in tangency onto the 
neutral face to define the neutral element. 
For more about the neutral element, refer to A Few Notes about Drafts.

 

5.  Define the Propagation option..

By default, it is normal to the neutral face and is displayed on top of the part.



 

The Controlled by reference option is now activated, meaning that whenever you 
will edit the element defining the pulling direction, you will modify the draft 
accordingly.
Note that when using the other selection mode (explicit selection), the selected 
objects are displayed in dark pink. 

 

6.  The default angle value 

is 5. Enter 7 degrees as 

the new angle value.

The application 

displays the new angle 

value in the geometry.

7.  Click Preview to see 

the draft to be created. 

It appears in blue.

 

8.  Click OK to confirm the 

operation.

The element (identified 

as Draft.xxx) is added 

to the specification 

tree.

For further information about drafts, refer to the Creating Basic Drafts and Creating Drafts with 
Parting Elements chapters in the Part Design documentation.



 Creating a Variable Angle Draft

 Drafts are defined on molded parts to make them easier to remove from molds.
There are two ways of determining the objects to draft: either by explicitly selecting the object 
or by selecting the neutral element, which makes the application detect the appropriate faces 
to use.

Sometimes, you cannot draft faces by using a constant angle value. This task shows you an 
another way of drafting: by using different angle values.

Open the Draft1.CATPart document.

1.  Click the Draft Angle icon 

 from the Volume drafts 

sub-toolbar.

As an alternative, you can use the 

Draft Angle command , then 

click the Variable Angle Draft icon 

 available in the dialog box. For 

more information, see Creating a 
Draft. 

 The Draft Definition dialog box 
appears, displaying the variable 
angle draft option as activated. If 
you click the icon to the left, you 
then access the command for 
performing basic drafts.

 

2.  Select the Face to draft. 

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/VolumeDraft1.CATPart


Multi-selecting faces that are not 
continuous in tangency is not 
allowed for this command.

 

 
3.  Select the upper face as the 

Neutral Element.

An arrow appears on the 

part, indicating the default 

pulling direction. The 

application detects two 

vertices and displays two 

identical radius values.

The Support field is filled 

with the volume owning the 

selected face. 

 
4.  Increase the Angle value: 

only one value is modified 

accordingly in the geometry.
 

 
5.  To edit the other angle 

value, select the value in the 

geometry and increase it in 

the dialog box. For instance, 

enter 9. 

 

 

Alternatively, double-click this value 
to display the Parameter Definition 
dialog box, then edit the value. 



6.  To edit the other angle 

value, select the value in the 

geometry and increase it in 

the dialog box. For instance, 

enter 9. 

7.  Click Preview to see the 

draft to be created.

8.  Click the Points field to add 

a point.

9.  Click a point on the edge. 

10.  Enter a new angle value for 

this point: for example, 

enter 17. The new radius 

value is displayed.



 

11.  Click OK to confirm the 

operation.

The element (identified as 

Draft.xxx) is added to the 

specification tree.

For further information about drafts, refer to the Creating Basic Drafts and Creating Drafts with 
Parting Elements chapters in the Part Design documentation.



 Creating a Draft from Reflect Lines

This task shows you how to draft a face by using reflect lines as neutral lines from which the 
resulting faces will be generated. In this scenario, you will also trim the material to be created 
by defining a parting element.

Open the VolumeDraft2.CATPart document.

1.  Click the Draft Reflect Line icon 

 from the Volume drafts sub-

toolbar.

The Draft Reflect Line Definition dialog box 
is displayed and an arrow appears, 
indicating the default pulling direction. The 
default direction is normal to the face.

Clicking the arrow reverses the direction.

 

2.  Select the cylinder. 

The application detects one reflect 

line and displays it in pink. This 

line is used to support the drafted 

faces.

The Support field is filled with the 

volume owning the selected face. 

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/VolumeDraft2.CATPart


 

3.  Enter an angle value in the Angle 

field. For example, enter 11. The 

reflect line is moved accordingly.

4.  Click Preview to get an idea of 

what the draft will look like.

 
5.  Click More>> to access further 

options.

 

6.  Check the Define parting 

element option and select plane 

zx as the parting element.

 

 

7.  Click OK to confirm the operation.

The element (identified as 

Draft.xxx) is added to the 

specification tree.



For further information about limiting elements, refer to the Creating Basic Drafts chapter in 
the Part Design documentation.



 Creating a Shell

Shelling a feature means emptying it, while keeping a given thickness on its sides. Shelling 
may also consist in adding thickness to the outside. This task shows how to create a cavity.

Open the VolumeShell1.CATPart document.

1.  Click the Shell icon .

The Shell Definition dialog 

box is displayed.

 

2.  Select the Face to 

remove.

The Support Volume field 

is filled with the volume 

owning the selected face. 

 

3.  Enter 15mm in the 

Default inside thickness 

field.

 

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/VolumeShell1.CATPart


 

4.  Click OK.

The feature is shelled: the 

selected face is left open. 

This element (identified as 

Shell.xxx) is added to the 

specification tree.

 
5.  Double-click the shell to 

edit it.  

 

6.  Click the Other thickness 

faces field.

7.  Double-click the thickness 

value displayed on this 

face. 

10. In the dialog box that 

appears, enter 10mm and 

click OK. 

The length between the 

selected face and the shell 

is 10mm.

For further information about shells, please refer to the Creating Shells chapter in the Part 
Design documentation.



 Creating a Sew Surface

Sewing is a Boolean operation combining a surface with a body. This task shows you how to 
add or remove material by modifying the surface of the volume. 

Open the VolumeSew1.CATPart document.

1.  Click the Sew Surface icon .

The Sew Surface definition dialog box is 

displayed.

 

2.  Select the sewing Volume (here Add.1).

3.  Select the Object to sew onto the 

volume (here Join.1).

 
With topology simplification

 

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/VolumeSew1.CATPart


 Keep the Simplify geometry option active. 

Using this option, if in the resulting volume 

there are connected faces defined on the same 

geometric support (faces separated by smooth 

edges), these faces will be merged into one 

single face.

 

 

Arrows appear indicating the side where 
material will be added or kept. Note that clicking 
an arrow reverses the given direction. 
The arrows must point towards the volume.

 
4.  Click OK.

The surface is sewn onto the body. You 

may notice that the bottom of the 

volume is made of one single face. 

This element (identified as 

SewSurface.xxx) is added to the 

specification tree.

Click OK.

5.  To see the simplification, just hide 

Join.1. 

 
Without topology simplification 

 



 
6.  Double-click SewSurface.1 in the 

specification tree to edit it and 

deactivate the Simplify geometry 

option. 

7.  Click OK.

The bottom of the volume is made of 

three connected faces. The smooth 

edges resulting from the sewing appear 

because no topological simplification has 

been performed.

For more information about the Intersect body option, please refer to the Sewing Surfaces 

chapter in the Part Design documentation.



Adding Volumes

This task shows how to add a volume to another volume, that is uniting them.

Open the AddVolume1.CATPart document and make sure Geometrical Set.2 is the current 
body.

 This is your initial data: the Add part is composed of three geometrical sets.
 

1.  Click the Add icon  from the Volumes operations sub-

toolbar.

The Add dialog box opens.

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/AddVolume1.CATPart


 

2.  Select the volume to operate (ThickSurface.2).

3.  Select the destination volume (CloseSurface.1).

4.  Select a destination body after which the added volume will be located.

If the Geometrical Set or the Ordered Geometrical Set is current, the After field is 

valuated with the current body and will be located after its last feature.

 

5.  Click OK.

The operation (identified as Add.xxx) is added to the specification tree.

The specification tree and the Add part now look like this:

 

  

 

You will note that:
●     the material common to ThickSurface.2 and CloseSurface.1 has been removed,

●     both volumes keep their original colors.

  



●     Multi-selection is not possible.

●     You cannot edit the Add operation.



Removing Volumes

This task illustrates how to remove a volume from another volume.

Open the RemoveVolume1.CATPart document.

 This is your initial data: the Remove part is composed of two geometrical sets.
 

1.  Click the Remove icon  from the Volumes 

operations sub-toolbar.

The Remove dialog box opens.

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/RemoveVolume1.CATPart


 

2.  Select the volume to remove (CloseSurface.2).

3.  Select the volume from which it is removed (CloseSurface.1).

4.  Select a destination body after which the removed volume will be located.

If the Geometrical Set or the Ordered Geometrical Set is current, the After field is 

valuated with the current body and will be located after its last feature.

 

5.  Click OK.

The operation (identified as Remove.xxx) is added to the specification tree.

The specification tree and the Remove part now look like this:

 

  

●     Multi-selection is not possible.

●     You cannot edit the Remove operation.



Intersecting Volumes

The material resulting from an intersection operation between two volumes is the material shared 
by these volumes. This tasks illustrates how to compute two intersections.

Open the IntersectVolume1.CATPart document.

 This is your initial data: the Intersect part is composed of three geometrical sets.
 

1.  Click the Intersect icon  from the Volumes 

operations sub-toolbar.

The Intersect dialog box opens and to lets you determine 

the second body you wish to use. 

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/IntersectVolume1.CATPart


 

2.  Select the volume to intersect (CloseSurface.3).

3.  Select the volume to be intersected with (CloseSurface.1).

4.  Select a destination body after which the intersected volume will be located.

If the Geometrical Set or the Ordered Geometrical Set is current, the After field is 

valuated with the current body and will be located after its last feature.

 

5.  Click OK.

The operation (identified as Intersect.xxx) is added to the specification tree.

The specification tree and the Intersect part now look like this:

 

  
●     Multi-selection is not possible.

●     You cannot edit the Remove operation.



 Trimming Volumes

This task shows how to trim a volume to define the elements to be kept or removed while 
performing the union operation. 

Open the TrimVolume1.CATPart document and make sure Geometrical Set.2 is the current 
body.

 This is your initial data: the Trim part is composed of two shells contained in one geometrical 
set.

 

1.  Click the Union Trim icon  

from the Volumes operations sub-

toolbar.

The Trim Definition dialog box 

opens.

 

 
2.  Select the Volume to trim, i.e. 

Shell.2.

http://arbre1dsy/spuCXR14/Doc/online/sdgug_C2/samples/TrimVolume1.CATPart


 
3.  Select the Cutting Volume, i.e. 

Shell.1.

 

4.  Click the Faces to remove field 

and select Shell.2 's inner face.

The selected face appears in 

pink, meaning that the 

application is going to remove it.

 

5.  Click the Faces to keep field and 

select Shell.1 's inner face.

The selected face appears in light 

blue, meaning that the 

application is going to keep it.

Faces to remove and Faces to keep must belong to the same volumes as the selected 

Volume to trim and Cutting volume.

Clicking the Preview button lets you check if your specifications meet your needs or not.

 

6.  Click OK to compute the material to be removed.

The operation (identified as Trim.xxx) is added to the specification tree.

The specification tree and the Add part now look like this:



 

●     Avoid using input elements that are tangent to each other since this may result in 
geometric instabilities in the tangency zone. 

●     As much as possible, avoid selecting volumes trimmed by the operation. In some cases, 
defined trimmed volumes have the same logical name: the application then issues a 
warning message requiring a better selection. 



Generative Shape Design Interoperability
Optimal CATIA PLM Usability for Generative Shape Design



 Optimal CATIA PLM Usability for
Generative Shape Design

When working with ENOVIA V5, the safe save mode ensures that you only create data in CATIA 
that can be correctly saved in ENOVIA. Therefore, in interoperability mode, some CATIA V5 
commands are grayed out / hidden in the Generative Shape Design workbench.

ENOVIA V5 offers two different storage modes: Workpackage (Document kept - Publications 
Exposed) and Explode (Document not kept). 

 In Generative Shape Design workbench, when saving data into ENOVIA V5, the global 
transaction is guaranteed but only if the target is in Workpackage mode. All Generative Shape 
Design commands are thus available at all times in this mode.

To ensure seamless integration, you must have both a CATIA and ENOVIA session running.



Workbench Description

This section contains the description of the icons, menus and Historical Graph that are specific to the CATIA - Generative 
Shape Design workbench, which is shown below. 

You can click the hotspots on this image to see the related documentation.

 

 

Menu Bar
Select Toolbar

Wireframe Toolbar
Surfaces Toolbars
Operations Toolbar

Law Toolbar
Tools Toolbar

Generic Tools Toolbars
ReplicationToolbar

Selection Filter Toolbar
Advanced Surfaces Toolbar
Developed Shapes Toolbar

Volumes Toolbar
BiW Templates Toolbar

Historical Graph
Specification Tree 



Generative Shape Design Menu Bar 
The various menus and menu commands that are specific to Generative Shape Design are described 
below.

Start File Edit View Insert Tools Windows Help

Tasks corresponding to general menu commands are described in the Infrastructure User's Guide. 

Edit 
Please note that most of the edit commands available here are common facilities offered with the 
Infrastructure.

The specific Generative Shape Design edit commands depend on the type of object being edited: 
Geometrical Set, Linear Geometrical Set or other entity. 

Command... Description... 

Undo Cancels the last action

Repeat Repeats the last performed 
action

Update See Updating Your Design

Cut
Copy
Paste

See Copying and Pasting

Paste Special...
See Using the Paste Special... 
Command

Delete See Deleting Geometry

Search... Allows searching and selecting 
objects

Selection Sets...
Selection Sets Edition...
Find Owning Selection 
Sets...

Allows to define and modify 
selected objects as sets

Links...
Manages links to other 
documents. See Editing 
Document Links

Properties Allows displaying and editing 
object properties



Other Selection...
See Selecting Using the Other 
Selections... Command

Scan or Define in Work 
Object...

See Scanning a Part and 
Defining In Work Objects

Change Body...
Allows Managing Geometrical 
Sets

    

Edit Inputs...

Allows to edit the object 
inputs and parameters. Refer 
to the chapter Creating a User 
Feature in the Product 
Knowledge Template User's 
Guide.

Activate See Deactivating Elements
Deactivate

Change Body...
Allows Managing Geometrical 
Sets

AutoSort

Allows to reorder the 
Geometrical Set's children 
according to the logical 
construction order

Reorder Children See Editing Definitions



Create Group Allows Managing Groups

Show Components See Hiding/Showing 
Geometrical SetsHide Components

Reset Properties Allows resetting object 
properties

Insert 

For... See... 

Body... Refer to Inserting a New Body in the 
Part Design User's Guide

Body in a Set...
Inserting a Body into an Ordered 
Geometrical Set

Geometrical set... Managing Geometrical Sets

Ordered 
Geometrical Set...

Managing Ordered Geometrical Sets

Sketches Refer to the Sketcher User's Guide

Axis System... Allows the creation of local axis-system

Wireframe Insert -> Wireframe

Law See Creating Laws

Surfaces Insert -> Surfaces

Volumes Insert -> Volumes

Operations Insert -> Operations

Constraints Insert -> Constraints

Annotations Insert -> Annotations



Views/Annotation 
Planes

Insert -> Views/Annotation Planes

Analysis Insert -> Analysis

Advanced 
Replication Tools

Insert -> Replication Tools

Knowledge 
Templates

Insert -> Knowledge Templates

Instantiate From 
Document...

Instantiating PowerCopies

Instantiate From 
Selection...

Allows the creation of part templates. 
Refer to the chapter Creating a Part 
Template in the Product Knowledge 
Template User's Guide.

Advanced 
Surfaces

Insert -> Advanced Surfaces

Developed 
Shapes

Insert-> Developed Shapes

BiW Templates Insert -> BiW Templates

Insert -> Wireframe
For... See... 

Point... Creating Points
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Extremum... Creating Extremum Elements 

Extremum 
Polar...

Creating Polar Extremum Elements 

Line... Creating Lines

Axis... Creating an Axis

Polyline Creating Polylines

Plane... Creating Planes

Projection... Creating Projections 

Combine... Creating Combined Curves

Reflect Line... Creating Reflect Lines

Intersection... Creating Intersections 

Parallel 
Curve...

Creating Parallel Curves

3D Curve 
Offset...

Creating a 3D Curve Offset

Circle... Creating Circles

Corner... Creating Corners

Connect 
Curve...

Creating Connect Curves

Conic... Creating Conic Curves 

Spline... Creating Splines 

Helix... Creating a Helix

Spiral... Creating Spirals

Spine... Creating a Spine

Insert -> Surfaces
 For... See...

Extrude... Creating Extruded Surfaces 

Revolve... Creating Revolution Surfaces 

Sphere... Creating Spherical Surfaces 

Cylinder... Creating Cylindrical Surfaces

Offset... Creating Offset Surfaces 
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Variable 
Offset...

Creating Variable Offset Surfaces

Rough 
Offset...

Creating Rough Offset Surfaces

Sweep... Creating Swept Surfaces 

Adaptive 
Sweep ...

Creating Adaptive Swept Surfaces

Fill... Creating Fill Surfaces 

Multi-sections 
Surface...

Creating Multi-Sections Surfaces

Blend... Creating Blended Surfaces

Insert -> Volumes
For... See...

Volume 
Extrude...

Creating Extruded Volumes

Volume 
Revolve...

Creating Revolution Volumes

Multi-sections 
Volume...

Creating a Multi-Sections Volume

Volume 
Sweep...

Creating a Swept Volume

Thick Surface...Creating a Thick Surface

Close Surface...Creating a Close Surface

Draft... Creating a Draft

Draft Variable 
Angle

Creating a Variable Angle Draft

Draft Reflect 
Line...

Creating a Draft from Reflect Lines 

Shell... Creating a Shell

Sew Surface... Creating a Sew Surface

Add... Adding Volumes

Remove... Removing Volumes

Intersect... Intersecting Volumes

Union Trim Trimming Volumes
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Insert -> Operations
For... See... 

Join... Joining Curves and Surfaces

Healing... Healing Geometry

Curve 
Smooth...

Smoothing Curves

Untrim... Restoring a Surface

Disassemble... Disassembling Elements

Split... Splitting Geometry

Trim... Trimming Geometry

Boundary... Creating Boundary Curves 

Extract... Extracting Geometry 

Multiple Edge 
Extract...

Extracting Multiple Edges

Shape Fillet... Shape Fillets

Edge Fillet... Edge Fillets

Variable Fillet 
...

Variable Radius Fillets and Variable Bi-Tangent 
Circle Radius Fillets Using a Spine

Face-Face 
Fillet...

Face-Face Fillets

Tritangent 
Fillet...

Tritangent Fillets

Translate... Translating Geometry

Rotate... Rotating Geometry

Symmetry... Performing Symmetry on Geometry

Scaling... Transforming Geometry by Scaling

Affinity... Transforming Geometry by Affinity

Axis To Axis... Transforming Elements from an Axis to Another

Extrapolate... Extrapolating Geometry

Invert 
orientation...

Inverting the Orientation of Geometry 

Near... Creating Nearest Entity of a Multiple Element

Insert -> Constraints 



For... See...
Constraint 

Creating ConstraintsConstraint 
Defined in a 
Dialog Box...

Insert -> Annotations 
For... See...
Text with 
Leader

Creating a Textual Flag With Leader

Flag Note with 
Leader

Creating a Flag Note With Leader

Insert -> Views/Annotation Planes
For... See...

Projection View
Creating a Projection View/Annotation 
Plane

Section 
View/Annotation 
Plane

Creating a Section View/Annotation 
Plane

Section Cut 
View/Annotation 
Plane

Creating a Section Cut View/Annotation 
Plane

Insert -> Analysis
For... See...

Connect Checker Checking Connections Between Surfaces

Curve Connect 
Checker 

Checking Connections Between Curves 

Feature Draft 
Analysis

Performing a Draft Analysis

Surfacic 
Curvature 
Analysis

Performing a Surfacic Curvature Analysis

Porcupine 
Analysis

Performing a Curvature Analysis

Apply Dress-Up
Applying a Dress-Up

Remove Dress-
Up
Geometric 
Information

Displaying Geometric Information on 
Elements

Insert -> Advanced Replication Tools
For... See...

Object 
Repetition...

Repeating Objects



Points and 
Planes 
Repetition...

Creating Multiple Points

Planes 
Between...

Creating Planes Between Other Planes

Plane System... Creating Plane Systems

Rectangular 
Pattern...

Creating Rectangular Patterns

Circular 
Pattern...

Creating Circular Patterns

Duplicate 
Geometrical Set

Duplicating Geometrical Sets

Insert -> Knowledge Templates
 For... See...

Power Copy... Creating PowerCopies

UserFeature...
Allows the creation of user features. Refer to 
the chapter Creating a User Feature in the 
Product Knowledge Template User's Guide.

Document 
Template...

Allows the creation of part templates. Refer to 
the chapter Creating a Part Template in the 
Product Knowledge Template User's Guide.

Save in Catalog... Saving PowerCopies into a Catalog

Insert -> Advanced Surfaces
 For... See...

Bump... Creating Bumped Surfaces

WrapCurve Deforming Surfaces Based on Curve Wrapping

WrapSurface 
Deforming Surfaces According to Surface 
Wrapping

ShapeMorphing Deforming surfaces According to Shape Morphing

Insert -> Developed Shapes
 For... See...

Develop... Developing Wires and Points

Unfold... Unfolding a Surface

Insert -> BiW Templates
For... See...



Junction... Creating Junctions

Diabolo... Creating a Diabolo

Hole... Creating a Hole

Mating Flange... Creating a Mating Flange

Bead... Creating a Bead

Tools 
Please note that most of the Tools commands available here are common facilities offered with the 
Infrastructure.

Specific Generative Shape Design commands are described in the present document. 

For... See...

Formula Allows editing parameters and formula

Image Allows capturing images

Macro Allows recording, running and editing 
macros

Utility Using the Batch Monitor

Show
Allows to show a set of elements 
according to their type, or whether they 
are currently selected or not

Hide
Allows to hide a set of elements 
according to their type, or whether they 
are currently selected or not

In Work Object
See Scanning a Part and Defining In 
Work Objects

Parameterization 
Analysis...

Analyzing Using Parameterization

Parent/Children...Allows viewing the parents and children 
of a selected object

Show Historical 
graph...

Using the Historical Graph

Work on Support Working with a Support 

Snap to Point Working with a Support

Open Catalog... Allows catalog browsing and management

Delete useless 
elements...

Deleting Geometry

External View...
Allows specifying a feature as a reference 
for other products/applications 



Thin Parts 
Attribute...

Applying a Thickness

Customize... Allows customizing the workbench.

Visualization 
Filters... Allows layer filters management

Options... Allows customizing settings

Standards... See Managing Standards in the 
Interactive Drafting documentation

Conferencing Allows setting up of communication tools

Publication...
Allows to make documents publicly 
available.
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Select Toolbar
This toolbar contains the following tools to help you selecting and scanning objects.

 

See Selecting Using Multi-Selection

See Quick Edition of Geometry

See Scanning the part and Defining In Work Objects



Wireframe Toolbar 
This toolbar contains the following tools for creating wireframe elements. 

 
  

 
See Creating Points

See Creating Multiple Points

 
See Creating Extremum Elements

See Creating Polar Extremum Elements

See Creating Lines

See Creating an Axis

See Creating a Polyline

See Creating Planes

See Creating Projections

See Creating Combined Curves

 See Creating Reflect Lines

See Creating Intersections

See Creating Parallel Curves 

See Create a 3D Curve Offset

See Creating Circles

See Creating Corners 

See Creating Connect Curves 

See Creating Conic Curves

See Creating Splines 

See Creating an Helix

See Creating Spirals

See Creating a Spine
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Surfaces Toolbars 
This toolbar contains the following tools for creating surfaces.

 

 

See Creating Extruded Surfaces 

See Creating Revolution Surfaces

 See Creating Spherical Surfaces

See Creating Cylindrical Surfaces

See Creating Offset Surfaces 

See Creating Variable Offset Surfaces

See Rough Rough Offset Surfaces

See Creating Swept Surfaces 

See Creating Adaptive Swept Surfaces

See Creating Fill Surfaces 

See Creating Multi-section Surfaces

See Creating Blend Surfaces
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Operations Toolbars
These toolbars contain the following tools for performing operations on surface and wireframe 
elements.

 

 

 

See Joining Curves and Surfaces

 See Healing Geometry

 See Smoothing Curves

 See Restoring a Surface

 See Disassembling Elements 

See Splitting Geometry

See Trimming Geometry 

See Creating Boundary Curves 

See Extracting Geometry

 
See Extracting Multiple Edges



See Shape Fillets 

See Edge Fillets

See Variable Radius Fillets

See Face-Face Fillets

See Tritangent Fillets

See Translating Geometry

See Rotating Geometry

See Performing a Symmetry on Geometry

See Transforming Geometry by Scaling

See Transforming Geometry by Affinity

See Transforming Elements from an Axis to Another

See Extrapolating Surfaces and

See Extrapolating Curves



Law Toolbar
This toolbar contains the following tool for creating laws.

 

See Creating Laws



Tools Toolbar 
This toolbar contains the following tools to help you model your shape designs.

 

See Updating Constraints

See Axis system

See Using the Historical Graph

See Working with a Support

See Working with a 3D Support

See Working with a Support

See Working with a Support

See Creating Plane Systems

See Creating Datums

See Inserting Elements

 See Keeping the Initial Element

See Displaying the Current Body

 See Instantiating PowerCopies

 
See Instantiating PowerCopies

See Selecting Bodies
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Generic Tools Toolbars
These toolbars contain the following tools to help you manage constraints between geometric 
elements, perform analyses, and annotate elements in the documents.

 

    

See Creating Constraints

See Checking Connections between Surfaces

 See Checking Connections between Curves

See Performing a Draft Analysis

See Performing a Surfacic Curvature Analysis

See Performing a Curvature Analysis 

See Applying a Dress-Up

See Displaying Geometric Information on Elements

See Applying a Material Onto Surfaces

See Creating a Textual Flag With Leader

See Creating a Flag Note With Leader

See Creating a Projection View

See Creating a Section View

See Creating a Section Cut View



See Measuring Minimum Distances and Angles

See Measuring Properties

See Measuring Inertia

 



Replication Toolbar
This toolbar contains the tools to performing operations on surface and wireframe elements.

 

See Repeating Objects

See Creating Multiple Points

See Creating Planes Between Other Planes

See Creating Rectangular Patterns

See Creating Circular Patterns

See Duplicating Geometrical Sets

 See Creating PowerCopies

 See Saving PowerCopies into a Catalog

See Creating User Features

 See Saving User Features into a Catalog
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Selection Filter Toolbar
This toolbar contains the following tools to help you manage sub-geometry selection.

See Selecting using A Filter

 



Advanced Surfaces Toolbar
This toolbar, available only with the Generative Shape Optimizer product, contains the tools to create 
complex surfaces.

 

See Creating Bumped Surfaces

See Deforming Surfaces Based on Curve Wrapping

See Deforming Surfaces According to Surface Wrapping

See Deforming Surfaces According to Shape Morphing



Developed Shapes Toolbar
This toolbar, available only with the Developed Shapes, contains the tools to create developed 
surfaces.

 

See Unfolding a Surface

See Developing Wires



Volumes Toolbar
This toolbar contain the following tools to help you create volumetric features.

     

 

 

 

See Creating Extruded 
Volumes

See Creating Revolution 
Volumes

See Creating Multi-Sections 
Volumes

See Creating Swept Volumes

See Creating a Thick Surface

See Creating a Close Surface

See Creating a Draft

See Creating a Variable Angle 
Draft

See Creating a Draft From 
Reflect Lines

See Creating a Shell

See Creating a Sew Surface

See Adding Volumes
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See Removing Volumes

See Intersecting Volumes

See Trimming Volumes



BiW Templates Toolbar
This toolbar, available only with the BiW Templates product, contains the tools to create BiW design.

 

See Creating Junctions

See Creating a Diabolo

See Creating a Hole

See Creating a Mating Flange

See Creating a Bead

 



CATIA - Generative Shape Design Historical 
Graph 

In this chapter we will describe the Historical Graph's commands and contextual commands 
that are specific to the CATIA - Generative Shape Design workbench.

Historical Graph Commands 
 Command... Description...

Add Graph Adds a selected element to the graph.

Remove Graph Removes a selected element from the graph.

Reframe Centers the graph in the window.

Surface or Part graph representationGives a horizontal or vertical representation.

Parameters Displays any parameters associated with the elements 
in the graph.

Constraints Displays any constraints associated with the elements 
in the graph.

Historical Graph Contextual Commands 
Command... Description...
Reframe Centers the graph in the window.
Print Allows you to obtain a print of the graph.
Graph All Restores the graph to the window.
Clean Graph  Clears the graph from the window.
Refresh Refreshes the graph display.



Generative Shape Design
Specification Tree

Within the Generative Shape Design workbench, you can generate a number of elements that are 
identified in the specification tree by the following icons.

Further information on general symbols in the specification tree are available in Symbols Used in the 
Specification Tree.

Sketch Join

Geometrical Set Healing

Ordered Geometrical Set Curve smooth

Multi-Output Untrim

Point  Split

Multiple Points Trim

Extremum Boundary

Extremum Polar Extract

Line Fillet

Axis  Edge Fillet

Polyline Variable Radius Fillet

Plane  Face-Face Fillet

Multiple Planes  Tritangent Fillet

Circle Translate

Conic Rotate

Spiral Symmetry

Spline Scaling

Helix Affinity

Spine AxisToAxis
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Corner Extrapolate

Connect Curve Inverse

3D Curve Offset Near

Intersection Law

Parallel Curve Surface Connection Analysis

Reflect Line Curve Connection Analysis

Projection Surfacic Curvature Analysis

Combine Draft Analysis

Extrude Curvature Analysis

Revolve Projection View

Sphere Section View

Cylinder  Section Cut View

Offset Rectangular Pattern

Variable Offset  Circular Pattern

Rough Offset  Axis System

Sweep
Working support
3D Working Support

Adaptive Sweep Plane Systems

Fill Power Copy

Multi-Sections Surface Volume Extrude

Blend Volume Revolve

Develop Multi-Sections Volume

Unfold  Volume Sweep

Junction  Thick Surface

Diabolo  Close Surface
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Hole Volume Draft

Mating Flange Volume Draft Variable

Bead Volume Draft from Reflect Line

Bump Volume Shell

Wrapped curve  Volume Sew

Wrapped surface  Add Volume

Shape Morphing Remove Volume

   Intersect Volume

   Trim Volume



Generative Shape Design

 
This page deals with the Generative Shape Design options:

●     The General tab lets you define the tolerant modeling, axes visualization and groups options.

●     The Work On Support tab lets you define the work on support and the work on support 3D 
options.

 

  



General Settings
 

  
This page deals with the following settings:

●     Tolerant Modeling

●     Axes Visualization

●     Groups

●     Stacked Analysis

 

Tolerant 
Modeling

Input parameters
 

●     Merging distance: default value defining the distance below which elements are to be joined or healed.

This option is available with the following commands: Join and Healing.

  By default, this option is set to 0.001mm.
 

●     Tolerant laydown: in case the lay down of an input guide on a surface fails, you can check the Tolerant 

laydown button. When activated, a fixed lay down tolerance of 0.1mm is applied.

This option is available with the following commands: Parallel Curve, Sweep, Multi-Sections Surface, Blend, 
Split, Curve Smooth, 

Fill and Extrapol.

  By default, this 
option is unchecked.

 



Here is a scenario with 
the Sweep command.

1.  Create a 

tolerant swept 

surface and 

define a 

Deviation 

from guide of 

0.1 mm.

In our scenario 

we created a 

swept surface 

using an 

implicit linear 

profile and the 

''two limits'' sub-

type. We 

created Curve.1 

and Curve.2 as 

the guide 

curves.

2.  Create a 

parallel curve of 

Curve.1 using 

the swept 

surface as the 

support.

The creation of 

the parallel 

curve fails.

An error 

message opens 

informing you 

that the guide 

curve does not 

lie on the swept 



surface.

3.  Check the 

Tolerant 

laydown 

option.

4.  Perform step 2 

again.

The creation of 

the parallel 

curve is 

successful.

It is advised not to use a wire that lies on the edge of the sweep when working with the Tolerant laydown 

option.

Output parameters

●     Choose the Continuity Type:

❍     None: deactivates the smoothing result

❍     Tangency: enhances the current continuity to tangent continuity

❍     Curvature: enhances the current continuity to curvature continuity

This option is available with the following commands: Project and Parallel Curve.

  By default, the option is None.
 

●     You can specify a Maximum deviation to set the allowed deviation between the initial element and the 

smoothed element by entering a value or using the spinners. 

  By default, this option is set to 0.001mm.
This option is available with the following commands: Project, Parallel Curve, Sweep, Multi-Sections Surface, 

and Curve Smooth.

For the Sweep and Multi-Sections Surface commands, only the Deviation parameter can be defined from 

Tools -> Options (the Angular correction parameter cannot be defined here). The Deviation and 

Angular correction will be activated only if the smoothing type is set to Tangency or Curvature.

 

Axes 
Visualization



 

 Uncheck the Axes visualization limited to the bounding box of the input button to visualize an infinite 

axis in the 3D geometry.

  By default this 
option is checked.

 

 

 Option checked Option unchecked
 

Groups
 

Check the Integration of created features as group inputs option if you want each new feature to be 
included as an input in an existing group and remain visible in the specification tree.
If you uncheck this option, created features will not included in the group and will be hidden in the group tree 
(expand the group to be able to see it).

  By default this option is unchecked.
●     This option is only available when creating a new feature.

●     It is only available for features accessible in the Generative Shape Design workbench. All other features 
will not be included in the group even if the option is checked.

For further information, please refer to the Managing Groups chapter.

Stacked 
Analysis

 

 Check the Stacked analysis default behavior set as temporary option to automatically create a 
temporary analysis when checking connections between surfaces or curves.

  By default this option is unchecked.

This option is only available with the Offset command.



Working with a Support
 

  
 This page deals with the following settings:

●     Work On Support

●     Work On Support 3D

 

Work On Support

●     Define the First direction scale (H for horizontal), by setting Primary spacing and 

Graduations values.

 By default, this option is set to 100mm for primary spacing and 10 graduations.

●     If you wish, you can define another scale for the Second direction scale (V for vertical), 

thus allowing distortions of the grid. Check the Allow distortions option to activate the 

Primary spacing and Graduations fields of the second direction.

 By default, this option is unchecked.
 

Work On Support 3D
 



 
Grids definition
Define the default values for the grids, by defining Labels names and Primary Spacing 
values for each direction.

  By default, the Labels are set to X, Y, and Z for the first, second and third directions, and 
the Primary Spacing is set to 100mm for all directions.

 
Grids customization

 
●     Define the Grid labels unit, that is the coefficient of division for all straight lines units.

For example, the grid label unit is set to 1 and the X label for one line is set to 500. If you 

modify the grid label unit to 10, the X label will be 50.

 By default, this option is set to 1.
●     Define the Automatic Scale Factor, that is the scale to be used when the grid becomes 

too small. The factor is comprised between 2 to 10.

 By default, this option is set to 10.
●     Define the Maximum lines number to be displayed on the screen, from 70 up to 500 

lines.

  By default, this option is set to 70.
  
 

All these values will be used as the default values when creating a support.
  

For further information, please refer to the Working With a Support and Working With a 3D 
Support chapters.



Glossary 

             

A
affinity An operation in which an element is transformed by applying X, Y, Z 

affinity ratios with respect to a reference axis system.
 

C
child A status defining the hierarchical relation between a feature or 

element and another feature or element.
 

constraint A geometric or dimension relation between two elements.  

E
extrapolate An operation in which an element is extended a specified amount 

while respecting tangency or curvature conditions. Typically a surface 
boundary can be selected for in order to extrapolate the surface a 
specified length.

 

extruded surface A surface that is obtained by extruding a profile along a specified 
direction.

 

F
feature A component of a part.  

fill surface A surface that is obtained by filling a closed boundary that is made up 
from a number of segments.

 

fillet A curved surface of a constant or variable radius that is tangent to 
and  joins two surfaces. Together these three surfaces form either an 
inner or outer corner. 

 

G
guiding curve A curve, intersecting with a profile, and along which this profile is 

swept. See also spine. 
 

J
join An operation in which adjacent curves or adjacent curves can be 

assembled to make up one element.
 

M
multi-section surface A surface that is obtained by sweeping one or more planar section 

curves along a spine, which may be automatically computed or user-
defined. The surface can be made to follow one or more guide curves.

 



O
offset surface A surface that is obtained by offsetting an existing surface a specified 

distance.
 

P
parent A status defining the hierarchical relation between a feature or 

element and another feature or element.  

part A 3D entity obtained by combining different features. It is the content 
of a CATPart document.

 

part body A component of a part made of one or several features.  

profile An open or closed shape including arcs and lines.  

R
revolution surface A surface that is obtained by revolving a profile around an axis.  

rotate An operation in which an element is rotated by a specified angle about 
an given axis.

 

S
scaling An operation that resizes an element to a percentage of its initial size.  

sketch A set of geometric elements created in the Sketcher workbench. For 
instance, a sketch may include a profile, construction lines and points.

 

spine A curve which normal planes are used to position a profile when 
creating a surface (lofted or swept surface for example). The profile 
does not necessarily intersect with this spine. See also guiding curve.

 

split An operation in which one element is cut by another element.  

swept surface A surface obtained by sweeping a profile in planes normal to a spine 
curve while taking other user-defined parameters (such as guide 
curves and reference elements) into account.

 

symmetry An operation in which an element is transformed by means of a mirror 
symmetry with respect to a reference plane, line or point. 

 

T
translate An operation in which an element is displaced a specified distance 

along a given direction. 
 

trim An operation in which two element cut each other mutually.  

W
 

wireframe element Elements such as points, lines or curves that can be used to represent 
the outline of a 3D object. 

 



Index 

                     

    

Numerics
2D inertia 

measuring  

A
activating elements  
Adaptive Sweep 

command  
adding 

volumes  

adding volumes  
Affinity 

command  
analysis 

porcupine curvature  
analyzing 

curvature   

curve connection  

draft  

parameterization  

surface connection  
anchor point 

sweep  

angles   
Apply Dress-Up 

command  

Apply Material command  
applying 
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local visualization options  

material  
AutoSort Geometrical Set 

command  
AutoSort Ordered Geometrical Set 

command  
axis 

command  

creating  
Axis System 

command  
Axis To Axis 

command  

B
between closed contours 

blended surfaces  
between curves 

blended surfaces  
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command  
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wires  
Diabolo 

command  
Disassemble 

command  
disassembling 

curves  

surfaces  
discontinuities 

curves  
distance 

measuring  

distance (maximum) between surfaces and volumes  

distance (minimum) and angle between geometrical entities and points  
distances and angles 

measuring  
draft 

analyzing  
Draft Analysis 

command  

draft angle  

draft from reflect lines  
Duplicate Geometrical Set 
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Edit Group 
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Extrapolate 
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history  
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mapping 
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link  
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positioning  
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mating flange  

maximum distance  
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command  
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creating  
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creating  

non-updated  
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creating  
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surfaces  
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inserting  

managing  
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sorting  
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Parallel Curve 
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parameterization 

analyzing  
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edit  
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Paste 

command  
pasting 
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creating  
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command  
point 

creating  
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command  
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creating  
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command  
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analysis  
Porcupine Curvature Analysis 
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replacing element  
PowerCopy Creation 
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projecting  
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command  
propagation 
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material  
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Quick Select 

command  

R
Rectangular Pattern 
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command   
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ordered geometrical sets   
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Reorder Body 
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repeating 
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Replace 

command  

Replace Viewer  
replacing 

elements  
replacing element 
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Scaling 

command  

scaling  
Scan or Define in Work Object 

command  
select 

multi-selection  
selecting 

multi-output  

open bodies  

sub-elements  

sew surface  
shape 

fillets   
Shape Fillet 

command   

Shape Morphing  

shell  
Show All Children 

contextual menu item  
Show Components 

Command  
Show Historical Graph 

command   
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contextual command  
showing 
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geometrical sets  
single constraint 

creating  
smoothing 

curves  
sorting 

geometrical sets  
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Sphere 

command  
spheres 

creating  
Spine 

command  
spine 

face-face fillet   
spines 

creating  

curves  
Spiral 

command  
spirals 

creating  
Spline 

command  
splines 

creating  
Split 

command  
splitting 

elements  
stacking 

command  
sub-elements 
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surface 

developing  
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surface connection 
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deforming   

disassembling  

extrapolating  

healing  
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modifying   

offsetting  
Surfacic Curvature Analysis 

command  
Sweep 

command     
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sweeping      
swept surfaces 

circular profile  

conical profile  

creating      
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command  
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U
Unfold 

command  
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surface  
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Update 
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fillets  
Variable Radius Fillet 

command  
view/annotation plan 
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section cut  
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wireframe elements 

creating  

extracting  
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